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Předmluva 
 
 

Jak používat tuto příručku 
 
 

Účel této 
příručky 

Uživatelská příručka ABI PRISM®  7900HT Sequence Detection System and SDS 

Enterprise Database popisuje, jakým způsobem připravit k provozu, provádět údržbu 
a řešit možné problémy související s provozem Real-Time PCR přístroje ABI PRISM® 

7900HT, podavače mikrodestiček Zymark Twister®  a databáze SDS Enterprise. 
 

 Komu je příručka Tato příručka je určena vědeckým a ostatním laboratorním pracovníkům, kteří budou  
  určena  používat a provádět údržbu přístroje 7900HT s nebo bez databáze SDS Enterprise. 

 

 
Předpoklady Tato příručka předpokládá, že servisní technik společnosti Applied Biosystems 

provedl instalaci Vašeho systému 7900HT, podavače mikrodestiček a databáze SDS 
Enterprise, a že jste obeznámeni se: 

 

•   Základním ovládáním systému Microsoft®  Windows® , jako je používání 
myši, volba příkazů, práce s okny a používání hierarchického systému 
souborů. 

•   Elektronickými nástroji na uchovávání dat (pevné disky) a datovými soubory 
•   Přípravou reakcí a základními technikami práce v laboratoři 

 
    Práce s textem Pro lepší pochopení pracuje tato příručka s textem následujícím způsobem: 

 

•   Tučně jsou vyznačeny aktivní zásahy uživatele. Například: 

Napište 0, poté stiskněte Enter pro každé ze zbývajících polí. 
•   Kurzívou jsou vyznačena nová nebo důležitá slova a též zdůraznění. Například: 

Před provedením kalibrace barev vždy proveďte kalibraci pozadí. 

•   Znaménko (>) odděluje po sobě následující příkazy, které volíte 
z rozbalovacích nabídek. Například: 
Zvolte File > Open > Spot Set. 

 
Upozornění 

pro uživatele 
V dokumentaci Applied Biosystems se používají upozornění pro uživatele. Každé 
upozornění vyžaduje určitou míru pozornosti nebo aktivity, jak je popsáno níže: 
 

Poznámka (Note) – Poskytuje informace, které mohou být zajímavé nebo 
nápomocné, ale které nejsou kritické z hlediska používání přístroje. 
 

DŮLEŽITÉ! (IMPORTANT!) – Poskytuje informace, které jsou nezbytné 
pro správné ovládání přístroje, používání reagencií nebo bezpečné používání 
chemikálií. 

 
Výstražná 

upozornění 
Součástí uživatelské dokumentace jsou i výstražná upozornění. Podrobněji viz 
“Výstražná upozornění” na straně xiv. 
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Předmluva 
 
 

Kde získat více informací 
 
 

Související 
dokumentace 

Více informací o používání přístroje naleznete v příručkách: 
 

•   ABI PRISM 7900HT Sequence Detection System Quick Reference Cards – 
Poskytuje stručný popis kroků, jejichž provedení je nezbytné pro konkrétní 
použití přístroje 7900HT. 

•   SDS Software Online Help – Popisuje software Sequence Detection System 
a rady pro provádění běžných kroků. 

•   SDS Enterprise Database Administration Guide – Poskytuje informace pro 
administrátory databáze SDS Enterprise. 

 

PDF verzi této příručky a dokumentů Quick Reference Cards naleznete na 
instalačním CD pro software SDS 2.2. 
 
Poznámka:  Další dokumentace viz “Kde získat pomoc” na straně xii. 

 
Pošlete nám 
Vaše návrhy 

V Applied Biosystems vítáme Vaše komentáře a návrhy na zlepšení uživatelské 
dokumentace. Své připomínky můžete zaslat na adresu: 
 

techpubs@appliedbiosystems.com 
 

 
 

Kde získat pomoc 
 

Chcete-li kontaktovat technickou podporu Applied Biosystems v Severní Americe, 
volejte 1.800.899.5858. 

 

Nejaktuálnější služby a informace Technické podpory (Support) naleznete na adrese 
http://www.appliedbiosystems.com, kde klikněte na odkaz Support. 

 

Na stránkách technické podpory můžete: 
 

•    Prohledávat často kladené otázky - Frequently asked questions (FAQs) 

•    Přímo položit dotaz Technické podpoře 

•   Objednat uživatelské dokumenty Applied Biosystems, bezpečnostní listy 
(MSDS), certifikáty o analýze a další související dokumenty 

•    Stahovat dokumenty ve formátu PDF 

•    Získat informace o školení pro zákazníky 
•   Stahovat programové aktualizace a opravné balíčky 

 

Kromě toho je na stránkách technické podpory možné získat telefonní a faxová čísla 
všech oddělení Technické podpory a prodejních poboček Applied Biosystems. 
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Bezpečnost a elektromagnetická kompatibilita 
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Bezpečnost a elektromagnetická kompatibilita 
 
 

Bezpečnostní upozornění používaná v tomto dokumentu 
 
 

Výstražná 
upozornění 

V uživatelské dokumentaci Applied Biosystems jsou používána čtyři výstražná 
upozornění, a to na těch místech dokumentů, kde je zapotřebí upozornit na 
odpovídající rizika. Každé z těchto slov – DŮLEŽITÉ (IMPORTANT), 
VAROVÁNÍ (CAUTION), VÝSTRAHA (WARNING), NEBEZPEČÍ (DANGER) 
– vyžaduje potřebu určité úrovně pozornosti nebo aktivity jak je popsáno níže: 
 
Definice 
 

DŮLEŽITÉ! (IMPORTANT!)  – Poskytuje informace, které jsou nezbytné pro 
správné ovládání přístroje, používání reagencií nebo bezpečné používání 
chemikálií. 

    – VAROVÁNÍ Indikuje potenciálně nebezpečnou situaci, která, 
pokud se jí nevyhnete, může vést k malému nebo středně těžkému zranění. Lze též 
použít jako varování před nebezpečnými činnostmi. 

   – VÝSTRAHA Indikuje potenciálně nebezpečnou situaci, která, 
pokud se jí nevyhnete, může způsobit smrt nebo těžké zranění. 

   – NEBEZPEČÍ Indikuje bezprostřední nebezpečnou situaci, která, 
pokud se jí nevyhnete, způsobí smrt nebo vážné zranění. Používání tohoto výstražného 
upozornění je omezeno jen na nejzávažnější situace. 
 

Vyjma DŮLEŽITÉ! (IMPORTANT) se každé výstražné upozornění v dokumentaci 
Applied Biosystems objevuje spolu s bezpečnostními symboly ve výstražném 
trojúhelníku. Tyto výstražné symboly jsou totožné se symboly na přístrojích Applied 

Biosystems (viz “Symboly na přístrojích” na straně xv). 
 
Příklady 
 

Níže jsou uvedeny příklady použití výstražných upozornění: 
 

DŮLEŽITÉ!  Pro každou 96ti-jamkovou mikrodestičku musíte vytvořit samostatný 
seznam vzorků. 

  Lampa je velmi horká. Nedotýkejte se lampy dokud nevychladne 
na pokojovou teplotu. 

  CHEMICKÉ RIZIKO. Formamid. Expozice vede 
k podráždění očí, kůže a dýchacího ústrojí. Možné riziko vývojových vad a 
poškození plodu. Přečtěte si bezpečnostní list a dodržujte pokyny při manipulaci. 
Používejte prostředky ochrany očí, ochranný oděv a rukavice. 

 ELEKTRICKÉ RIZIKO. Nesprávně uzemněný přístroj 
může způsobit úraz elektrickým proudem. Uzemněte přístroj podle připojeného 
návodu. 
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Symbol Popis   

Symbol 
 

Popis 

 Označuje polohu hlavního spínače 
Zapnuto. 

 Označuje polohu hlavního spínače 
Vypnuto. 

  Ochranná svorka - označuje 
chráněný uzemněný výstup, který 
musí být uzemněn předtím, než je 
provedeno jakékoliv jiné elektrické 
připojení přístroje (připojení 
hlavního ochranného vodiče). 

 Označuje polohu hlavního spínače 
Zapnuto/Vypnuto (týká se spínače, 
který se ovládá stlačením). 

  Označuje výstup, který může 
být připojen na střídavý 
napájecí zdroj. 

 Svorka uzemnění. Neslouží jako 
ochranná svorka. 

  Označuje výstup, který může být 
připojen na střídavý nebo 
stejnosměrný napájecí zdroj. 

 

Symboly na přístrojích 
 
 

Symboly na přístrojích 
 
 

Elektrické 
symboly na 

přístrojích 

Následující tabulka popisuje elektrické symboly, které mohou být použity na 
přístrojích Applied Biosystems. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Bezpečnostní Následující tabulka popisuje bezpečnostní symboly, které mohou být použity na 
  symboly přístrojích Applied Biosystems. Každý symbol může být použit sám o sobě nebo 

v kombinaci s textem, který vysvětluje případné riziko (viz “Bezpečnostní označení 
na přístrojích” na straně xvi). Tyto bezpečnostní symboly se mohou rovněž objevit 
v textu tohoto nebo dalších dokumentů vedle označení DANGER (NEBEZPEČÍ), 
WARNING (VÝSTRAHA) a CAUTION (VAROVÁNÍ). 

 
Symbol Popis 

 Indikuje, že byste měli získat další informace z manuálu a pokračovat 
s patřičnou obezřetností. 

 Indikuje možný úraz elektrickým proudem a nutnost pokračovat 
s patřičnou obezřetností. 

 Indikuje horký povrch nebo jiné riziko související s vysokou teplotou a nutnost 
pokračovat s patřičnou obezřetností. 

 Indikuje přítomnost laseru a nutnost pokračovat s patřičnou obezřetností. 

 Indikuje přítomnost pohyblivých součástí a nutnost pokračovat s patřičnou 
obezřetností. 
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Bezpečnost a elektromagnetická kompatibilita 

 
 

Bezpečnostní označení na přístrojích 
 

Následující prohlášení CAUTION (VAROVÁNÍ), WARNING (VÝSTRAHA) a 
DANGER (NEBEZPEČÍ) mohou být použity na přístrojích Applied Biosystems 
v kombinaci s bezpečnostními symboly popsanými v předchozí části. 

 
English Česky 

CAUTION Hazardous chemicals. Read the Material 
Safety Data Sheets (MSDSs) before handling. 

VAROVÁNÍ  Nebezpečná chemikálie. Před použitím čtěte 
bezpečnostní list (MSDS). 

CAUTION Hazardous waste. Read the waste profile (if 
any) in the site preparation guide for this instrument 
before handling or disposal. 

VAROVÁNÍ Nebezpečný odpad. Před manipulací nebo 
likvidací čtěte informace o odpadu (jsou-li) v návodu na 
přípravu místa. 

CAUTION Hazardous waste. Refer to MSDS(s) and 
local regulations for handling and disposal. 

VAROVÁNÍ Nebezpečný odpad. Při manipulaci a likvidaci 
postupujte podle pokynů v bezpečnostním listu a místních 
předpisů. 

WARNING Hot lamp. VÝSTRAHA Horká lampa. 

WARNING Hot. Replace lamp with an Applied 
Biosystems lamp. 

VÝSTRAHA Horké. Zaměňte lampu za lampu Applied 
Biosystems. 

CAUTION Hot surface. VAROVÁNÍ Horký povrch. 

DANGER High voltage. NEBEZPEČÍ Vysoké napětí. 

WARNING To reduce the chance of electrical shock, do 
not remove covers that require tool access. No user-
serviceable parts are inside. Refer servicing to Applied 
Biosystems qualified service personnel. 

VÝSTRAHA Neodstraňujte kryty, na jejichž odstranění je 
zapotřebí nástrojů – riziko úrazu elektrickým proudem. 
Potřeba uživatelských zásahů v prostoru pod krytem je 
vyloučena. Servis provádí pouze kvalifikovaný technik 
Applied Biosystems. 

DANGER Class 3B laser radiation present when open 
and interlock defeated. Avoid direct exposure to laser 
beam. 

NEBEZPEČÍ Laserové záření třídy 3B při otevření a 
vypnutí kontaktní pojistky. Vyhněte se přímému vystavení 
se laserovému paprsku. 

DANGER Class 3B laser radiation when open. Avoid 
direct exposure to laser beam. 

NEBEZPEČÍ Laserové záření třídy 3B při otevření. 
Vyhněte se přímému vystavení laserovému paprsku. 

DANGER Class 3B laser radiation present when open 
and interlock defeated. Do not stare directly into the 
beam 

NEBEZPEČÍ Laserové záření třídy 3B při otevření a 
vypnutí kontaktní pojistky. Chraňte svůj zrak – nedívejte se 
přímo do paprsku. 

DANGER Class 3B laser radiation present when open. 
Do not stare directly into the beam. 

NEBEZPEČÍ Laserové záření třídy 3B při otevření. Chraňte 
svůj zrak – nedívejte se přímo do paprsku. 

DANGER Class 3B LED when open and interlock 
defeated. Do not stare directly into the beam. 

NEBEZPEČÍ Při otevření a vypnutí kontaktní pojistky 
třída 3B LED. Chraňte svůj zrak – nedívejte se přímo 
do paprsku. 

DANGER Class 3B LED when open. Do not stare 
directly into the beam. 

NEBEZPEČÍ Při otevření třída 3B LED. Chraňte svůj zrak 
– nedívejte se přímo do paprsku. 

CAUTION Moving parts. VAROVÁNÍ Pohyblivé součásti. 
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Obecná pravidla bezpečnosti při práci s přístrojem 
 
 

Obecná pravidla bezpečnosti při práci s přístrojem 
 

  RIZIKO PORANĚNÍ. Používejte tento výrobek pouze v souladu  
s postupy uvedenými v tomto dokumentu. Jiné používání než v souladu s instrukcemi  
Applied Biosystems může vést ke zranění nebo k poškození přístroje. 

 
Přemisťování a 

zvedání 
přístroje 

 
 
 
 
 
 

Přemisťování a 
zvedání počítačů a 

monitorů 

RIZIKO PORANĚNÍ. Přístroj smí přemisťovat pouze osoby 
nebo dodavatelé uvedení v návodu na přípravu místa. Rozhodnete-li se přístroj 
přemisťovat nebo zvedat poté, co byl instalován, provádějte to vždy v dostatečném 
počtu osob, za použití příslušného vybavení a odpovídajícím způsobem. Nesprávná 
manipulace může způsobit bolestivá a trvalá poranění zad. V závislosti na jeho 
hmotnosti může přemisťování nebo zvedání přístroje vyžadovat dvě a více osob. 

 

  Zvedání nebo přenášení počítačů a monitorů provádějte vždy 
v dostatečném počtu osob. V závislosti na hmotnosti počítače a/nebo monitoru může 
jejich přemisťování nebo zvedání vyžadovat dvě a více osob. 
 
Před zvedáním počítače a/nebo monitoru: 
 

•   Ujistěte se, že máte ke zvedání počítače nebo monitoru vhodné nástroje. 

•   Ujistěte se, že na předpokládané dráze pohybu přenášeného objektu se 
nenacházejí žádné překážky. 

•   Při zvedání předmětu se současně neotáčejte. 

•   Dbejte, aby vaše páteř byla při zvedání předmětu ve stabilní neutrální poloze. 

•   Všechny zúčastněné osoby musí postup zvedání a přenášení vzájemně 
koordinovat. 

•   Nevyjímejte předmět z krabice, namísto toho položte krabici na bok a přidržte 
ji, zatímco někdo jiný nechá její obsah opatrně vyklouznout ven. 

 
Ovládání 
přístroje 

Ujistěte se, že každý kdo ovládá přístroj: 
 

•   byl obeznámen s obecnými pravidly bezpečnosti pro práci v laboratoři a 
    zvláštními pravidly bezpečnosti týkajícími se tohoto přístroje. 
•   četl a pochopil veškeré související bezpečnostní listy (MSDS). Viz 
    „O bezpečnostních listech” na straně xviii. 

  RIZIKO PORANĚNÍ. Používejte tento výrobek pouze v souladu  
 s postupy uvedenými v tomto dokumentu. Jiné používání než v souladu s instrukcemi  
Applied Biosystems může vést ke zranění nebo k poškození přístroje. 
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 Bezpečnost a elektromagnetická kompatibilita 
 
 

 Bezpečná manipulace s chemikáliemi 
 
 

Výstraha – 
chemické riziko 

CHEMICKÉ RIZIKO. Před manipulací s jakýmikoliv 
chemikáliemi si prostudujte příslušný bezpečnostní list - Material Safety Data Sheet 
(MSDS), poskytnutý dodavatelem chemikálie, a řiďte se jeho pokyny. 

 

  CHEMICKÉ RIZIKO. Veškeré chemikálie nacházející se 
v přístroji včetně tekutin v hadičkách představují potenciální riziko. Před výměnou 
reagencií nebo součástí přístroje si vždy zjistěte, jaké chemikálie v něm byly 
použity. Při práci používejte prostředky ochrany očí, ochranný oděv a rukavice. 

  CHEMICKÉ RIZIKO. Čtyřlitrové zásobní a odpadní lahve 
mohou prasknout a protékat. Každou čtyřlitrovou láhev je nutné umístit do 
polypropylenového obalu. Při práci používejte prostředky ochrany očí, ochranný oděv 
a rukavice. 

 NEBEZPEČNÝ ODPAD. Nikdy nesbírejte nebo neuchovávejte 
odpad ve skleněných nádobách kvůli možnému riziku jejich rozbití. Zásobní a odpadní 
lahve mohou prasknout a protékat. Každou odpadní láhev je nutné umístit do 
polypropylenového obalu. Při práci používejte prostředky ochrany očí, ochranný oděv a 
rukavice. 

 
O bezpečnostních Výrobci chemikálií poskytují novým zákazníkům s dodávkou chemikálií bezpečnostní  

               listech listy. Bezpečnostní list je rovněž poskytnut spolu s dodávkou chemikálií v případě, že 
byl aktualizován. Bezpečnostní listy obsahují informace, které potřebujete pro bez-
pečné ukládání, manipulaci, přepravu a odstranění chemikálie. Obdržíte-li s dodáv-
kou chemikálie i bezpečnostní list, vždy jej založte – udržujte tyto listy aktuální 

 
Získání 

bezpečnostního 
listu 

Bezpečnostní listy pro chemikálie dodávané Applied Biosystems získáte vždy od 
Applied Biosystems. Tato služba je bezplatná a dostupná 24 hodin denně. Chcete-li 
získat bezpečnostní list: 
 
 

1.   Otevřete stránku https://docs.appliedbiosystems.com/msdssearch.html 
 

2.   V poli hledání zadejte název chemikálie, katalogové číslo nebo další informaci 
z bezpečnostního listu, který vás zajímá. Zvolte jazyk, klikněte na Search 
(Hledat). 

 

3.   Zvolte dokument, který vás zajímá, klikněte pravým tlačítkem myši na jeho 
název a zvolte jednu z následujících možností: 

•   Open – Otevření dokumentu 

•   Print Target – Vytištění dokumentu 
•   Save Target As – Stažení dokumentu ve verzi PDF do zvoleného adresáře 

 

4.   Chcete-li získat kopii dokumentu faxem nebo emailem, zvolte Fax or Email po 
levé straně názvu dokumentu ve výsledcích hledání, pak klikněte na RETRIEVE 
DOCUMENTS (ZÍSKAT DOKUMENTACI) na konci seznamu dokumentů. 

 

5.   Po zadání požadovaných informací klikněte na View/Deliver Selected 
Documents Now (Zobrazit/Stáhnout vybranou dokumentaci). 
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 Bezpečná manipulace s chemickým odpadem 
 
 

Pravidla 
manipulace 

s chemikáliemi 

Abyste minimalizovali riziko plynoucí z používání chemikálií, musíte: 
 

•  Přečíst a pochopit bezpečnostní listy dodávané výrobci chemikálií, a to ještě 
před tím, než začnete tyto chemikálie nebo rizikové materiály ukládat nebo 
s nimi manipulovat či pracovat. (Viz “O bezpečnostních listech” na straně 
xviii.) 

•   Minimalizujte kontakt s chemikáliemi. Používejte odpovídající osobní 
ochranné pomůcky pro práci s chemikáliemi (např. ochranné brýle, rukavice, 
ochranný oděv). Další bezpečnostní opatření naleznete v bezpečnostním listu. 

•   Minimalizujte inhalaci chemikálií. Neponechávejte nádoby s chemikáliemi 
otevřené. Používejte odpovídající větrání (například digestoř). Další 
bezpečnostní opatření naleznete v bezpečnostním listu. 

•   Pravidelně kontrolujte, zda nedošlo k vylití nebo rozsypání chemikálií. Pokud 
k tomu dojde, postupujte podle čistících procedur doporučených výrobcem 
chemikálie v bezpečnostním listu. 

•  Dodržujte všechna místní nebo národní nařízení a předpisy týkající se 
uchovávání chemikálií, manipulace s nimi a jejich odstraňování. 

 

 

 Bezpečná manipulace s chemickým odpadem 
 
 

Výstraha  - 
chemické 

riziko 

NEBEZPEČNÝ ODPAD. Při manipulaci s nebezpečným 
odpadem a při jeho odstraňování se řiďte pokyny v bezpečnostním listu a místními 
předpisy. 

  NEBEZPEČNÝ ODPAD. Odpady produkované přístroji Applied 
Biosystems představují potenciální riziko a mohou způsobit zranění, nemoc nebo 
smrt. 

 
Pravidla 

manipulace 
s chemickým 

odpadem 

Abyste minimalizovali riziko plynoucí z manipulace s chemickým odpadem, musíte: 
 

•   Přečíst a pochopit bezpečnostní listy, dodávané výrobci chemikálií z nichž 
odpad vzniká, předtím než začnete chemický odpad ukládat, manipulovat 
s ním nebo ho odstraňovat. 

•   Mít k dispozici primární i sekundární nádoby na odpad. (Primární nádoba na 
odpad je pro jeho okamžité shromažďování. Sekundární nádoba na odpad 
osahuje to, co vyteče nebo se vysype z primární nádoby. Obě nádoby musí 
odpovídat typu ukládaného odpadu a splňovat požadavky místních předpisů.) 

•   Minimalizovat kontakt s chemikáliemi. Při práci s chemikáliemi používejte 
odpovídající osobní ochranné pomůcky (např. ochranné brýle, rukavice, 
ochranný oděv). Další bezpečnostní opatření naleznete v bezpečnostním listu. 

•   Minimalizovat inhalaci chemikálií. Neponechávejte nádoby s chemikáliemi 
otevřené. Používejte odpovídající větrání (například digestoř). Další 
bezpečnostní opatření naleznete v bezpečnostním listu. 

•   Manipulovat s chemickým odpadem v digestoři. 

•   Pytle s odpadem zajistit svorkou. 

•   Odstraňovat odpad z odpadní nádoby a odstraňovat odpadní láhve v souladu se 
     správnou laboratorní praxí a místními předpisy. 
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Bezpečnost a elektromagnetická kompatibilita 
 
 

Složení odpadu Složení odpadu vznikajícího v souvislosti s činností přístroje ABI PRISM 7900HT  
je uvedeno v příručce  ABI PRISM 7900HT Sequence Detection System Site 

Preparation Guide. 
 

Složení odpadu je uvedeno v procentuálním zastoupení reagencií v odpadu vzniklém 
v průběhu instalace a při provádění typických experimentů, i když ve vaší laboratoři 
nemusí být prováděny typické experimenty. 

 

Informace o složení odpadu vám pomáhají plánovat způsoby manipulace a 
odstraňování odpadu, vytvářeného při provozu přístroje. Před touto manipulací či 
odstraňováním se seznamte se složením odpadu a informacemi v bezpečnostním listu. 

 

 
Odstranění odpadu Pokud při práci s přístrojem vznikne potenciálně nebezpečný odpad, musíte: 

 

•   Charakterizovat (analyzovat, pokud je to nutné) tento odpad, reagencie a 
substráty používané ve vaší laboratoři. 

•   Zajistit ochranu zdraví a bezpečnost všech pracovníků vaší laboratoře. 

•   Zajistit, že odpad z přístroje je ukládán, přenášen, transportován a odstraňován 
v souladu se všemi místními i národními předpisy. 

 

DŮLEŽITÉ!  Radioaktivní nebo biologické odpady mohou vyžadovat zvláštní způsoby 
zacházení a mohou se na ně vztahovat omezení stran možností jejich odstraňování. 

 

Bezpečná manipulace s elektrickým zařízením 
 

   NEBEZPEČÍ ÚRAZU ELEKTRICKÝM PROUDEM. Při 
ovládání přístroje ABI PRISM 7900HT bez ochranných krytů může dojít k vážnému 
úrazu elektrickým proudem. Neodstraňujte kryty přístroje. Po jejich odstranění je 
možný přístup ke zdrojům vysokého napětí 

Pojistky   NEBEZPEČÍ ÚRAZU ELEKTRICKÝM PROUDEM. Použití 
nevhodných pojistek nebo zdroje vysokého napětí může způsobit poškození a požár 
přístroje. Před zapojením přístroje se ujistěte, že byly správně instalovány pojistky, a 
že provozní napětí přístroje odpovídá napětí v elektrické síti ve vaší laboratoři. 

  NEBEZPEČÍ POŽÁRU. V zájmu nepřetržité ochrany před 
rizikem vzniku požáru používejte pouze pojistky typu a jmenovitého proudu 
odpovídajícího požadavkům přístroje. 

   Zdroj   NEBEZPEČÍ ÚRAZU ELEKTRICKÝM PROUDEM. Pro 
bezpečný provoz zařízení je nezbytné jeho uzemnění. Nikdy nepoužívejte přístroj, 
který není správným způsobem uzemněn. 

   NEBEZPEČÍ ÚRAZU ELEKTRICKÝM PROUDEM. Používejte 
pouze schválené elektrické kabely, odpovídající napětí ve vaší elektrické síti. 

   NEBEZPEČÍ ÚRAZU ELEKTRICKÝM PROUDEM. Připojte 
přístroj pouze do uzemněné zásuvky s odpovídajícím elektrickým proudem. 

 
Vysoké 
napětí 

Přístroj ABI PRISM 7900HT spadá do třídy II (přepětí) a je klasifikován jako přenosný 
přístroj. 
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       Pohyblivé součásti 
 
 

Pohyblivé součásti 
 

Pohyblivé součásti   RIZIKO PORANĚNÍ. Pohyblivé součásti se mohou zlomit či 
jinak poškodit. Při ovládání přístroje nesahejte na pohyblivé součásti. Před servisním 
zásahem vypojte přístroj ze sítě. 

   RIZIKO PORANĚNÍ. Při ovládání přístroje neodstraňujte kryt 
podavače. Nedávejte ruce do podavače je-li v chodu. 

 
 

Biologické riziko 
 
 

Biohazard BIOHAZARD. Biologické (lidské nebo zvířecí) vzorky jako 
např. tkáně, tělní tekutiny a krev mohou být zdrojem infekčních onemocnění. 
Postupujte podle všech místních/národních předpisů. Používejte prostředky 
ochrany očí, ochranný oděv a rukavice. Prostudujte si a postupujte podle pokynů 
v následujících publikacích: 
 

•   Doporučení U.S. Department of Health and Human Services publikované 
     v Biosafety in Microbiological and Biomedical Laboratories (č. 017-040- 

00547-4; http://bmbl.od.nih.gov) 

•   Occupational Safety and Health Standards, Bloodborne Pathogens 
(29 CFR§1910.1030; http://www.access.gpo.gov/nara/cfr/ 
waisidx_01/29cfr1910a_01.html). 

 
Další informace týkající se biologického rizika naleznete na: 
http://www.cdc.gov 

 

 
 

Bezpečná manipulace s laserem 
 
 

Laser 
 

Real-Time PCR systém ABI PRISM 7900HT používá laser třídy 3B. Za normálních 
provozních podmínek se jedná o laser třídy 3B. Jsou-li během určitých servisních 
zásahů vyřazeny z činnosti kontaktní pojistky, může laser způsobit trvalé poškození 
zraku a je tudíž za těchto podmínek zařazen jako laser třídy 3B. 
 

Real-Time PCR systém ABI PRISM 7900HT odpovídá požadavkům nařízení 21 CFR, 
1040.10 a 1040.11. 
 

Real-Time PCR systém ABI PRISM 7900HT byl testován podle a odpovídá 
požadavkům nařízení “Radiation Control for Health and Safety Act of 1968 
Performance Standard CFR 1040.” 
 

Real-Time PCR systém ABI PRISM 7900HT byl testován podle a odpovídá 
požadavkům nařízení EN60825-1, “Bezpečnost laserových zařízení – Část 1: 
Klasifikace zařízení, požadavky a pokyny pro používání.” 
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Bezpečnost a elektromagnetická kompatibilita 
 
 

Pravidla 
manipulace 

s laserem 

Pro bezpečný provoz laseru: 
 

•   Systém musí být instalován a udržován servisním technikem Applied Biosystems.  

•   Je-li přístroj v provozu, musí být všechny ochranné kryty na svých místech. 
V případě, že jsou všechny kryty na svých místech, žádné záření nelze 
detekovat. Je-li kterýkoliv z krytů sejmut během provozu laseru (v případě 
servisu při vypnutí kontaktních pojistek), vystavujete se možnosti expozice 
laserového záření vyššího než třídy 3B. 

•   Neodstraňujte bezpečnostní označení nebo nevypínejte kontaktní pojistky. 
 

Další informace 
k bezpečnému 
provozu laseru 

Další informace týkající se bezpečnostních předpisů naleznete v uživatelské 
dokumentaci, poskytnuté společně s laserem. 

  NEBEZPEČÍ LASEROVÉHO ZÁŘENÍ. Laser může trvale 
poškodit sítnici. Nikdy se nedívejte přímo do laserového paprsku. Odstraňte šperky a 
další předměty, které mohou odrážet paprsek do vašich očí. Neodstraňujte svrchní 
nebo boční kryty přístroje. Používejte odpovídající prostředky ochrany očí a 
v případě odstranění krytů během servisního zásahu na vstup do laboratoře umístěte 
varování o přítomnosti laseru. 

  NEBEZPEČÍ POPÁLENÍ LASEROVÝM PAPRSKEM. Je-li 
v kontaktu s kůží, může přehřátý laserový paprsek způsobit těžké popáleniny. 
NIKDY nepoužívejte laser pokud nemůže být ochlazován ventilátorem. Vždy 
používejte ochranné pomůcky pro práci s laserem. 

 

 

Bezpečná manipulace s laserem čtečky čárových kódů 
 
 

Laser 
 

Čtečka čárových kódů, která je součástí systému ABI PRISM 7900HT, je vybavena 
laserem třídy 2 (II). 

 

 
Bezpečná 

manipulace 
s laserem 

Lasery třídy 2 (II) jsou nízkoenergetické lasery s viditelným paprskem, který může 
způsobit poškození očí. Nikdy se nedívejte přímo do laserového paprsku. Skener je 
konstruován tak, aby laserový paprsek nebyl dostupný pro operátora přístroje při jeho 
běžném používání, údržbě nebo během předepsaných servisních zásahů. 

  NEBEZPEČÍ LASEROVÉHO ZÁŘENÍ. Lasery třídy 2 (II) 
mohou způsobit poškození očí. Nikdy se nedívejte přímo do laserového paprsku 
třídy 2 (II) nebo neobracejte tento paprsek proti očím někoho jiného. 

 

 

Bezpečná práce 
 

Správná ergonomie vašeho pracovního místa může snížit nebo eliminovat únavu, 
bolest a námahu. Tyto průvodní jevy můžete omezit nebo odstranit takovým 
umístěním vašeho systému, které umožní jeho pohodlné ovládání. 

  NEBEZPEČÍ SVALOVÉHO PORANĚNÍ. Toto nebezpečí je 
způsobeno např. ale nikoliv výlučně opakovanými pohyby, nevhodným umístěním, 
vysokou namáhavostí, udržováním těla ve statických pozicích, tlakem a dalšími faktory. 
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 Bezpečnost a elektromagnetická kompatibilita 
 
 

Abyste toto nebezpečí snížili: 
 

•   Používejte zařízení, které vám umožní pracovat v neutrálních pozicích 
s dobrou dostupností klávesnice, monitoru a myši. 

•   Umístěte klávesnici, myš a monitor tak, aby byla umožněná relaxovaná poloha 
hlavy a těla. 

 
 

Bezpečnost a normalizace v oblasti elektromagnetické 
kompatibility (EMC) 

 
Tato část obsahuje informace o: 

 

•   Bezpečnostních předpisech v USA a Kanadě 

•   Kanadských normách EMC  

•   Evropských bezpečnostních předpisech a normách EMC 
•   Australských normách EMC 

 
Bezpečnostní 

předpisy v USA 
a Kanadě 

Tento přístroj byl testován podle normy UL 3101-1 “Safety Requirements for Electrical 
Equipment for Laboratory Use, Part 1: General Requirements” a splňuje její požadavky. 
 

Tento přístroj byl testován podle normy CSA 1010.1 “Safety Requirements for Electrical 
Equipment for Measurement, Control, and Laboratory Use, Part 1: General 
Requirements” a splňuje její požadavky. 

 

 
Kanadské 

normy EMC 
Tento přístroj byl testován podle normy ICES-001, Issue 3: “Industrial, Scientific, and 
Medical Radio Frequency Generators“ a splňuje její požadavky. 

 

 
Evropské 

bezpečnostní 
předpisy a normy 

EMC 

Bezpečnost 
 

Tento přístroj splňuje bezpečnostní požadavky evropské Směrnice pro nízké napětí 
73/23/EEC. Tento přístroj byl testován podle norem EN 61010-1:2001 “Bezpečnostní 
požadavky na elektrické měřicí, řídící a laboratorní zařízení, část 1: Obecné požadavky” 
a EN 61010-2-010 “Zvláštní požadavky pro laboratorní zařízení pro ohřev materiálu” a 
splňuje jejich požadavky. 
 
EMC 
 

Tento přístroj splňuje požadavky směrnice Rady Evropské unie pro elektromagnetické 
rušení a odolnost vůči němu (EMC směrnice 89/336/EEC). Tento přístroj byl testován 
podle normy EN 61326 (Třída B) “Elektrická zařízení pro měření, kontrolu a laboratorní 
použití – požadavky EMC”. 

 

 
Australské normy 

EMC 
Tento přístroj byl testován podle normy AS/NZS 2064 “Limits and Methods 
Measurement of Electromagnetic Disturbance Characteristics of Industrial, Scientific, 
and Medical (ISM) Radio-frequency Equipment” a splňuje její požadavky. 
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Kapitola 1    Přehled 
 
 

Popis systému 
 
 

O přístroji 
7900HT  

Real-Time PCR systém ABI PRISM®  7900HT je Real-Time PCR přístroj druhé generace 
navržený pro provádění Real-Time PCR (PCR v reálném čase) v automatickém režimu 
provozu a pro snadné zpracovávání velkého počtu vzorků. Přístroj provádí eseje typu 
Real-Time, eseje detekované po skončení reakce (tzv. eseje typu end-point) a analýzu 
disociační křivky. Přístroj 7900HT je optimalizován pro používání reagencií společnosti 
Applied Biosystems pro kvantifikaci a detekci nukleových kyselin. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Obrázek 1-1 Real-Time PCR přístroj ABI PRISM 7900HT a jeho příslušenství 

 
 

Podporované 
eseje a 

chemizmy 

Přístroj ABI PRISM 7900HT podporuje provádění dvou typů esejí za použití reagencií 
společnosti Applied Biosystems a příbuzných společností. 
 
Eseje detekované po skončení reakce (End-Point) 
 

V esejích detekovaných po skončení reakce (end-point) se teplotní cyklování 
mikrodestiček s reagenciemi a templáty provádí v teplotním cykleru. Po skončení 
PCR se použije přístroj 7900HT pro provedení jediného měření fluorescence 
ukončených reakcí. Příkladem eseje tohoto typu je alelická diskriminace. 
 
Eseje detekované v reálném čase (Real-Time) 
 

V esejích detekovaných v reálném čase se teplotní cyklování mikrodestiček 
s reagenciemi a templáty provádí v přístroji 7900HT. Data jsou zaznamenávána 
v průběhu běhu při každém cyklu PCR. Výsledkem je chronologický záznam 
fluorescence jednotlivých reakcí. Příkladem eseje tohoto typu je absolutní 
kvantifikace, relativní kvantifikace a analýza disociační křivky. 
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Část 1.1  Poznáváme hardware    
 
 

Část 1.1 Poznáváme hardware 
 
 
 

     V této části Přístroj 7900HT................................................................................................... 1-4 
Počítač ................................................................................................................ 1-7 
Čtečky čárových kódů......................................................................................... 1-8 
Podavač mikrodestiček Zymark Twister............................................................. 1-9 
Spotřební materiál ............................................................................................. 1-10 
Zapojení přístroje .............................................................................................. 1-11 

 
Součásti 
přístroje 

Real-Time PCR systém ABI PRISM 7900HT se skládá z následujících součástí, 
zobrazených na obrázku 1-2. 

 
 

Přístroj 7900HT 
(viz strana 1-4) 

Počítač se systémem 
Microsoft®  Windows® 

(viz strana 1-7) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Čtečka čárových 
kódů 

(viz strana 1-8) 

Podavač 
mikrodestiček 

Zymark Twister® 

(viz strana 1-9) 

Dodatečné 
držáky mikro-

destiček 
(viz strana 1-8) 

Ruční čtečka  
čárových kódů 
  (viz strana 1-8) 

 
 

Obrázek 1-2 Součásti Real-Time PCR systému ABI PRISM 7900HT  
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Kapitola 1    Popis systému 
 
 

Přístroj 7900HT 
 
 

Popis 
přístroje 

Součástí přístroje 7900HT je zařízení pro provádění teplotního cyklování a detekci 
fluorescence (viz strana 1-2). Na obrázku 1-3 jsou vyobrazeny hlavní součásti 
přístroje podrobněji popsané níže. 

  Neodstraňujte kryty přístroje ABI PRISM 7900HT. Vnitřní součásti 
přístroje může opravovat či měnit jejich nastavení pouze kvalifikovaný technik 
společnosti Applied Biosystems. Nedodržení této výstrahy může vést k vážnému 
zranění a/nebo poškození přístroje. 

 
 

Laser 
 

CCD 
kamera 

 

Snímač 

 
 
Optický 
systém 

 
 
 
 

Nosítka 
 

Dvířka 

Vyhřívané víko 
 
Systém automatické 
manipulace s mikrodestičkou 
 
Blok na vzorky 

 
 

Obrázek 1-3   Součásti přístroje7900HT  
 
 

Automatický 
podavač 

mikrodestiček 

RIZIKO PORANĚNÍ. Dbejte, aby se při práci s přístrojem vaše 
ruce a volné součásti oblečení nedostaly k nosítkům a dvířkům přístroje. Vnitřní 
součásti systému 7900HT mohou způsobit vážné zranění. 
 

Přístroj 7900HT je vybaven automatickým podavačem mikrodestiček, který 
umožňuje snadné vkládání a vyjímání destiček z přístroje. Přístroj v automatickém 
režimu provozu tak umožňuje bezobslužnou práci. 

 
Vyhřívané víko  RIZIKO PORANĚNÍ. Horký povrch. Při práci v těsné blízkosti 

vyhřívaného víka dbejte, aby nedošlo k popálení. 
 

Přístroj 7900HT má vyhřívané víko pro optimální přenos tepla a rovnoměrný ohřev 
během teplotního cyklování. Po vložení mikrodestičky do přístroje na ni tlačí víko 
vahou 31,8 kg. V průběhu běhu má víko konstantní teplotu 105°C (±3°C), aby 
nedocházelo ke kondenzaci v jamkách mikrodestičky. 
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Přístroj 7900HT    
 
 

Vyměnitelné bloky 
na vzorky 

Přístroj 7900HT je vybaven vyměnitelnými bloky na ohřev vzorků na bázi 
peltierových článků (technologie odvozená od přístroje GeneAmp®  PCR System 
9700). Součástí bloku na vzorky jsou peltierovy články pro ohřev/chlazení vzorků 
(obrázek 1-4). Blok na vzorky je vyroben z hliníku, aby byl zajištěn optimální přenos 
tepla mezi blokem a mikrodestičkou nebo mikrofluidní kartou. 

  RIZIKO PORANĚNÍ. Horký povrch. Při práci dbejte, aby 
nedošlo k popálení. 

 
        Připojení k přístroji 

(nedotýkat se) 
 

 
 
 
 

Blok uvnitř 
přístroje 

 
 
 

Warning 

 

 
 
 
 
 
 
 
 
Blok na vzorky 
  (nedotýkat se) 
 
Pohled shora 

 

 
 
 
 
 
 
 
 
 
 
 

  Vyhřívané pláty 
(nedotýkat se) 
 
Pohled zdola 

 

 
 
 
Obvod 
(nedotýkat se) 

 
Obrázek 1-4   Součásti vyměnitelného teplotního bloku 

 
 

Vlastnosti vyměnitelného bloku na vzorky: 
 

•   Široký rozsah teplot: 4–99.9 °C 
•   Přesnost: ±0.25 °C v rozsahu 35–99.9 °C 
•   Rychlost ohřevu/chlazení: 1.5 °C za vteřinu 
•   Teplotní uniformita: ±0.5 °C (měřeno 30 sec po spuštění časovače) 
•   Dlouhodobá stabilita a vysoká spolehlivost 
•   Možnost používání různých druhů spotřebního materiálu (viz strana 1-10) 

•   Několik různých režimů provozu včetně režimu simulace běhu přístroje 9600 a 
programovatelné rychlosti změny teplot (ramping) (viz strana 3-19) 

•   Zkrácená doba mimo provoz díky možnosti okamžité výměny bloku (viz strana 
    7-6) 
•   Snadný přístup k bloku na vzorky (řešení problémů a údržba – viz strana 7-6) 
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Kapitola 1    Popis systému 
 
 

Optický systém  DŮLEŽITÉ!  Neodstraňujte kryt přístroje 7900HT. Vnitřní součásti přístroje může 
opravovat či měnit jejich nastavení pouze kvalifikovaný technik společnosti Applied 
Biosystems.  

 

Optický systém přístroje 7900HT je odvozen od optického systému Real-Time PCR 
ABI PRISM®  7700. Na obrázku 1-5 je vyobrazen optický systém přístroje 7900HT. 

 

Poznámka:  Více informací o optickém systému přístroje 7900HT naleznete 
v příloze A “Princip fungování.” 
 

 
 
 

 
      CCD 

 
 

     Čočky  
    kamery 

 
Mřížka 

   Emisní filtr 
 
 
 

    Laser Rozklad  
paprsku 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fresnelova čočka 

 
 

Čočky (uvnitř destičky) 
 
 
 

 
Boční pohled 

s čočkami) 
 

 
384/96-jamková 

optická mikrodestička 

 
 
 
 
Čelní pohled 

 
Obrázek 1-5   Optický systém přístroje 7900HT 
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    Počítač 
 
 

Počítač 
 

 
     Funkce  Pro správné fungování systému 7900HT a podavače mikrodestiček Zymark Twister 

je zapotřebí počítač s operačním systémem Microsoft Windows. Pomocí programů  
SDS a Automation Controller počítač umožňuje: 

 

•   Programovat a ovládat přístroj 

•   Koordinovat fungování přístroje 7900HT, systému automatického režimu 
provozu a čteček čárových kódů 

•   Uchovávání a správu dat vzniklých činností systému 7900HT 
•   Propojení místní sítě (LAN) a databáze SDS Enterprise (je-li instalována) 

 
Systémové 
požadavky 

Požadavky na konfiguraci operačního systému počítače sloužícího k ovládání 
přístroje 7900HT se liší podle verze programu SDS. Chcete-li znát nároky na systém 
vašeho počítače, naleznete je v dokumentu Release notes pro vaši verzi programu 
SDS. 
 

Tento soubor je umístěn: 
 

D:\AppliedBiosystems\SDS2.2\ReleaseNotes.txt 
 

Poznámka:  Pro čtení souboru je možno použít programy Microsoft Notepad, 
Wordpad nebo Word. 

 
Rozdělení 

pevného 
disku 

Během instalace přístroje 7900HT provede servisní technik společnosti Applied 
Biosystems rozdělení pevného disku tak, jak je uvedeno v následující tabulce. 

 
Pevný disk Disk Vel. 

(GB) 
Obsahuje 

 
C 2 Soubory operačního systému* 

 
D ≥25 •  Program SDS 2.2  

 •  Program Automation Controller  

 •  Program pro Zymark Twister  
 •  Program LAVA† 

 •  Programy třetích stran 

 •  Datové soubory sds 
 • (Volitelné) Klient databáze SDS 
    Enterprise 

 
 

*Společnost Applied Biosystems doporučuje, abyste na disk C neinstalovali programy. Počítač 
se spouští rychleji, je-li na disku C pouze operační systém. 

†Program pro ovládání čtečky čárových kódů.. 

 
Poznámka:  Rozdělení pevného disku podle tabulky viz výše je pouze základním 
rozdělením požadovaným programem SDS. Konkrétní konfigurace rozdělení 
pevného disku (pevných disků) je závislá na konkrétním modelu ovládacího 
počítače, dodaného k přístroji. 
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 Kapitola 1    Popis systému 
 
 

Čtečky čárových kódů 
 

 
         Popis  Součástí systému ABI PRISM 7900HT jsou i dvě čtečky čárových kódů pro načítání 

dat a rozeznání mikrodestiček: 
 

•   Ruční čtečka čárových kódů slouží k manuálnímu načítání kódů 
•   Pevně umístěná čtečka čárových kódů je používána pro automatické snímání 

kódu mikrodestičky umísťované do přístroje (je používána pouze v součinnosti 
s automatickým podavačem vzorků) 

 

Obě čtečky čárových kódů pracují s laserovým paprskem třídy II o vlnové délce 
670 nm a podporují formát 128 ASCII znakového čárového kódu. 

 
Umístění čteček 
čárových kódů 

 
 
 
 
 
 
 
 
 
 
 
 
 

Pevně umístěná čtečka čárových kódů Ruční čtečka čárových kódů 
 
 
 
 

Rozdělovač 
 
 

~ 

Ke zdířce PC  
pro klávesnici 
 
 
 
Ke klávesnici 

 
 

(Vyobrazeno bez krytu) 
 

 
 

Obrázek 1-6 Čtečky čárových kódů přístroje 7900HT  
 
 

Používání 
čteček 

čárových 
kódů 

NEBEZPEČÍ LASEROVÉHO ZÁŘENÍ. Přímé nebo odražené 
laserové paprsky mohou poškodit sítnici, což může vést k trvalém poškození zraku. 
Nikdy se nedívejte přímo do laserového paprsku. Odstraňte šperky a další předměty, 
které mohou odrážet paprsek do vašich očí. Chraňte ostatní před laserovými paprsky. 
 
Více informací o čtečkách čárových kódů naleznete v : 
 

Používání ruční čtečky čárových kódů................................................................... 2-26 
Seřízení pevně umístěné čtečky čárových kódů ..................................................... 7-49 
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Podavač mikrodestiček Zymark Twister    
 
 

Podavač mikrodestiček Zymark Twister 
 
 

         Popis Podavač mikrodestiček Zymark Twister®  slouží k manipulacím s mikrodestičkami, a 
tak umožňuje bezobslužný provoz přístroje 7900HT. Rameno podavače se pohybuje 
v rozsahu 310 stupňů, čímž je umožněn přístup k zásuvce přístroje 7900HT, až k pěti 
úložným věžím na mikrodestičky a k pevně umístěné čtečce čárových kódů. 

 
Součásti 

podavače 
mikrodestiček 

Zymark Twister 
 

Podavač mikrodestiček 
Zymark Twister 

 

 
(zobrazení v řezu) 

 

 
 
 
 

     Senzor 
 

Úchop Regulátor 
nastavení 

 
 
 
 
 
 

Pevně umístěná 
čtečka čárových kódů 

Rozšíření 
podavače 

Úložná věž (držák destiček) 

 
Obrázek 1-7 Součásti podavače mikrodestiček Zymark Twister 

Úložné věže  
X 

4 
 

3 
 

2 
1 

 
 

 
Podavač mikrodestiček Zymark 

Twister (pohled shora) 

Čárový kód 
 

Jamka A1 

 
Obrázek 1-8   Úložné věže podavače mikrodestiček Zymark Twister 

 
 

Používání 
podavače 

mikrodestiček 
Zymark Twister  

NEBEZPEČÍ LASEROVÉHO ZÁŘENÍ. Přímé nebo 
odražené laserové paprsky mohou poškodit sítnici, což může vést k trvalému 
poškození zraku. Nikdy se nedívejte přímo do laserového paprsku. Odstraňte šperky 
a další předměty, které mohou odrážet paprsek do vašich očí. Chraňte ostatní před 
laserovými paprsky. 
 
Více informací o podavači mikrodestiček Zymark Twister naleznete v: 
 

Zapnutí přístroje 7900HT ......................................................................................2-4 
Zapnutí a nastavení programu Automation Controller ........................................4-37 
Údržba podavače mikrodestiček .........................................................................7-35
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Kapitola 1    Popis systému 
 
 

Spotřební materiál 
 
 

Spotřební 
materiál 

k přístroji 
7900HT 

Díky vyměnitelným blokům umožňuje přístroj 7900HT používání různých typů 
spotřebního materiálu tak je popsáno v následující tabulce. 
 
Tabulka 1-1 Spotřební materiál 
 

Spotřební plastik 
 

Uzavření (víčka) 

ABI PRISM™  optické 384-jamkové 
mikrodestičky 
 

ABI PRISM™  optická adhezívní fólie 

ABI PRISM™  optické 96-jamkové 
mikrodestičky 

•   Kompresní podložky (Compression Pads): 
–   Standardní podložka pro ruční ovládání 

–   Zacvakávací podložka 

•   96-ti jamkové destičky: 
–   ABI PRISM optická adhezívní fólie 

–   ABI PRISM optická víčka (pouze plochá) 

Mikrofluidní karty Žádné (samozatavitelné) 
 

 
Kompresní 

podložky 
Společnost Applied Biosystems doporučuje pro dosažení optimálního přenosu tepla 
používat kompresní podložky. Standardní kompresní podložky jsou dodávány 
s optickými 96-ti jamkovými mikrodestičkami a lze je použít při ručním ovládání 
přístroje. Pro provoz v automatickém režimu s podavačem mikrodestiček Zymark 
Twister dodává společnost Applied Biosystems opakovaně použitelné zacvakávací 
podložky. 

 
Více informací 
o spotřebním 

materiálu 

Více informací o spotřebním materiálu a údaje pro jeho objednání naleznete 
v příloze C “Kity, reagencie a spotřební materiál”. 
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           Zapojení přístroje 
 
 

Zapojení přístroje 
 
 

Elektrické 
propojení 

Na obrázku 1-9 a v tabulce 1-2 je znázorněno propojení jednotlivých součástí 
přístroje ABI PRISM 7900HT. 

 
 
 
 
 
 
 

Napájení 
 
 

A H 
 
 

 Napájení 
 
Napájení 

HI-POT 

A                    B C                 D 

 
 
 
 
 

HI-
POT 

A B C D 

 
 Napájení   Napájení  

 Komunikační kabel 

  Kabel napájení 
 

Obrázek 1-9  Propojení součástí přístroje ABI PRISM 7900HT 
 
 

Tabulka 1-2 Propojení přístroje ABI PRISM 7900HT 
 

 

Kabel 
 

Typ 
 

Propojení z … 
 

do… 

A Komunikace Počítač (port pro monitor) Monitor 

B Komunikace/ 
Napájení 

Počítač (port myši) Myš – není zobrazena 

C Sériová 
komunikace 

Počítač (sériový port 1) Přístroj 7900HT 

D Komunikace/ 
Napájení 

Počítač (port klávesnice) Ruční čtečka čárových kódů 

E Komunikace Počítač (sériový port 2) Automatický podavač 
mikrodestiček (port C) 

F Ethernet Místní počítačová síť Počítač (ethernetový port) nebo 
HUB 

G* Komunikace/ 
Napájení 

Počítač (ISA karta 1) Pevně umístěná čtečka čárových 
kódů 

H Komunikace/ 
Napájení 

Kabel čtečky čárového 
kódu 

Klávesnice (není zobrazena) 

*Viz obrázek 1-10 na straně 1-12. 

B       C          E      A    F       G               E      G                           C 

 D 
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Kapitola 1    Popis systému 
 
 

Pevně umístěná 
čtečka čárových 

kódů 

 
 
Kabel čtečky 
čárových kódů 

 

Do karty 
Lava (ISA 
karta 1) 

 
 
Napájecí zdroj 
 
Napájecí kabel 

 
 

G 
 
 

Obrázek 1-10   Připojení pevně umístěné čtečky čárových kódů 
 
 

Univerzální 
napájecí sada 

(kat.č. 4334482) 

IEC 320 4-místný 
univerzální panel 
připojení (KAT. Č. 
4333969) 

 
 
 
 
 
 

IEC 320 Sev. Amerika × (1) 
 
 

IEC 320 Evropa 

 
Souprava kabelů × (4) 

 

 
 
Souprava kabelů pro Japonsko 

× (4) (viz níže) 
 
 

IEC 320 U.K./Irsko × (1) 
 
 

IEC 320 Austrálie/ 
Nový Zéland × (1) 

 
K počítači, monitoru, ruční čtečce 
čárových kódů a podavači mikrodestiček 

Poznámka:  Pořadí není důležité. 

 
IEC 320 Japonsko × (1) 

      označeno “JAPAN ONLY” 

 

Severní Amerika: 250V@15A MAX 
Evropa a ostatní země: 250V@10A MAX 

 
 

Obrázek 1-11  Univerzální panel připojení 
 
 

Při instalaci univerzální napájecí sady kabelů (všechny země mimo Japonska):  
 

1.   Propojte jeden konec speciálních propojovacích kabelů s jednotlivými spotřebiči. 
 

2.   Druhý konec propojovacích kabelů zapojte do panelu. 
 

3.   Zvolte správnou koncovku pro napájecí kabel podle dané země (pro ČR platí 
norma IEC320) a kabel propojte do panelu. 

 
4.   Vypněte všechny komponenty (monitor, počítač a automatický podavač). 

 
5.   Napájecí kabel propojte do napájecí zásuvky. 

 
6.   Zapněte komponenty. 

 
7.   Nepoužité propojovací kabely nenechávejte zapojené do panelu. 
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Část 1.2  Poznáváme software 
 
 

Část 1.2 Poznáváme software 
 
 
 

     V této části Jednotlivé součásti softwaru .............................................................................. 1-14 
Program SDS - soubory a jejich formáty........................................................... 1-15 
Správa dat .......................................................................................................... 1-17 
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Kapitola 1    Popis systému 
 
 

Jednotlivé součásti softwaru 
 
 

Programové 
vybavení 

Pro práci s přístrojem ABI PRISM 7900HT se používá soubor programů, které slouží 
k nastavení a spuštění a k analýze výsledků vytvářených přístrojem 7900HT. 
 
Tabulka 1-3 Standardní program SDS 

 
 

Program 
 

Funkce 

Program SDS  •   Vytváření a editace souborů destiček 

•   Provádění vstupní a finální analýzy dat alelické 
  diskriminace, relativní a absolutní kvantifikace 

•   Ukládání, tisk a export výsledků 

Java™  Runtime Environment Přídavný software používaný při běhu programu SDS  
 

DŮLEŽITÉ!  Nemažte součásti Java Runtime 
Environment. Jsou nutné pro správnou funkci programu 
SDS. 

Firmware přístroje 7900HT  •   Provádí řízení základních funkcí a operací přístroje 
7900HT 

•  Je ovládán příkazy z počítače 

•  Spojuje příkazy vydávané programem SDS s operacemi 
prováděnými přístrojem 7900HT 

 
Tabulka 1-4 Programy pro práci v automatickém režimu nebo s databází Enterprise  

 
 

Program 
 

Funkce 

Program Automation 
Controller 
 

•   Řídí a koordinuje operace přístroje 7900HT v režimu 
automatického provozu 

•   Spouští a řídí provádění jednotlivých běhů 

•   Provádí odečítání dat v průběhu běhu 

Program Zymark Twister  Program pro kalibraci automatického podavače 
mikrodestiček. 

Program LAVA  Program pro nastavení polohy pevně instalované čtečky 
čárových kódů. 

Klient databáze SDS  
Enterprise  
 

Zabezpečuje propojení programu SDS a databáze 
Enterprise pomocí síťového propojení. 

 

Poznámka:  Více informací viz strana 1-21. 
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Program SDS – soubory a jejich formáty    
 
 

Program SDS – soubory a jejich formáty 
 
 

Soubory 
používané a 

vytvářené 
programem SDS  

DŮLEŽITÉ!  Nikdy nemažte nebo nepřemisťujte programové soubory nebo adresáře 
programu SDS a souvisejících programů vyjma případů, kdy jste k tomu vyzváni 
zástupcem nebo dokumentací společnosti Applied Biosystems. 
 

Program SDS používá různé soubory a adresáře (Tabulka 1-5). Některé z těchto 
souborů obsahují výsledky nebo kalibrační data, jiné jsou zapotřebí pro provoz 
přístroje 7900HT. 
 
Tabulka 1-5 Běžné soubory programu SDS 
 

Typ souboru  Přípona Ikona Popis/Komentář 
 

 
Soubory dokumentů destiček 

 
ABI PRISM SDS 
dokument 

*.sds •   Virtuální záznam mikrodestičky (nebo jiného typu 
spotř. materiálu) se vzorky 

•   Obsahuje údaje o vzorcích a esejích (názvy, 
umístění, reportérová barva) v destičce 

•   Obsahuje údaje o teplotním profilu a nastavení pro 
  odečítání dat 

•   Ukládá data zaznamenaná v průběhu běhu
 
 
 

ABI PRISM SDS 
soubor typu sdm 

*.sdm •   Pro analýzu výsledků relativní kvantifikace 
(malé soubory dat) 

 
ABI PRISM SDS 
templát* 

*.sdt •   Pro vytváření dokumentů destiček (sds) 

•   Může obsahovat informace o jednotlivých esejích, 
teplotní profil a nastavení pro odečítání dat 

 
Importované/Exportované soubory 

 
Nastavení 
dokumentu 
destičky 

*.txt Pro vytváření dokumentu destičky 

 
Exportovaný 
datový soubor 

*.txt •   Obsahuje exportovaná hrubá nebo analyzovaná 
data pro všechny nebo zvolenou skupinu jamek  

•   Používá formát *.txt (tabelátorem oddělená data 
kompatibilní s většinou tabulkových editorů) 

 
Grafický 
soubor JPEG†   

*.jpg ‡ •   Pro export grafů nebo panelů dokumentu destičky 
•   Kompatibilní s většinou textových nebo 

  tabulkových editorů 
•   Může být začleněn přímo do souborů typu HTML 

  nebo XML 
 

 
*Používání templátů není nutné, ale je doporučeno kvůli úspoře času v případech, kdy jsou 
opakovaně používány destičky s identickým nastavením jednotlivých esejí. 
†Joint Photographic Experts Group 
‡Ikona se mění podle toho, kterému programu je přiřazen soubor typu jpeg 
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Velikost 
souborů  

Činností programu SDS vznikají soubory o různé velikosti v závislosti na typu běhu. 
V tabulce 1-6 jsou uvedeny průměrné velikosti typických souborů vzniklých činností 
programu SDS. 
 
Tabulka 1-6 Průměrná velikost dokumentů destičky  

 
 

Velikost souboru* 
 
 

Typ běhu 

 
 

Aplikace 
 

 Nekomprimovaný 
 

Komprimovaný 

Jedno čtení Alelická diskriminace 150 až 180 KB 70 až 90 KB 

Absolutní kvantifikace Čtení v 
reálném čase 
(Real-Time)† Relativní kvantifikace 

 
15 až 25 MB‡ 

 

 
10 až 15 MB 

*Velikost komprimovaných souborů je pouze odhad na základě komprese programem 
WinZip®. Více informací viz “Archivace souborů programu SDS” na straně 7-54. 

† Maximální velikost souborů při čtení v reálném čase (absolutní nebo relativní kvantifikace) je 
jen přibližná. Velikost může být větší v závislosti na nastavení režimu záznamu dat. 

‡Velikost souborů při čtení v reálném čase závisí na délce běhu a nastavení záznamu dat 
v dokumentu destičky. Delší běhy a běhy v nichž jsou data snímána ve více krocích mohou 
vést ke vzniku souborů výrazně větších než 15 až 25 MB. 

 
DŮLEŽITÉ!  Z důvodu omezení paměti nemůže databáze SDS Enterprise ukládat 
soubory, jejichž velikost přesahuje 40 MB. 
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Správa dat 
 
 

Fungování 
systému a tok dat 

Správa dat je klíčovým prvkem úspěšné integrace přístroje ABI PRISM 7900HT do 
procesu ostatních činností v laboratoři. Během 24 hodin provozu v režimu čtení 
v reálném čase (Real-Time) může přístroj 7900HT vytvořit více než 200 MB dat. 
K úspěšné správě dat je nutné pochopit základní principy jejich záznamu, ukládání a 
zpracovávání. 

 
Standardní režimy 

provozu 
Přístroj ABI PRISM 7900HT má tři standardní režimy provozu v závislosti na 
příslušenství, které bylo zakoupeno spolu s přístrojem 
 

•   Provoz samostatného přístroje (Stand-Alone – viz níže) 
•   Provoz v automatickém režimu (viz strana 1-18) 
•   Provoz s databází (viz strana 1-18) 

 
Provoz samostatného přístroje 
 

V tomto režimu provozu se používá pouze přístroj ABI PRISM 7900HT (Obrázek 1-
12) bez jakéhokoliv příslušenství. Jednotlivé běhy spouští laborant/ka za použití 
programu SDS, který ukládá data na pevné disky počítače. 

 

Počítač 
 

Program SDS  
 
 
 

 

ABI PRISM 7900HT  
 

Firmware 
 

3 
Teplotní cyklování a 

detekce 
 

4 
 

Záznam dat 

 
 
 
 
 
 
 
 
 
 
 
 
 

Sériový 
kabel 

1 
Vytvoření dokumentu 

destičky 
 

2 
Spuštění destičky 

pomocí dokumentu 
 
5 

Uložení hrubých dat 
do dokumentu 

 
6 

Otevření a analýza 
dokumentu destičky 

 
 
 
Pevný disk 
 

 
 
 

*.sds 
soubor 

 
 
 
 
 
 
 
 
*.sdt 

  soubor 

 
 
 
 
 

Obrázek 1-12   Samostatný provoz přístroje 7900HT 
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Provoz v automatickém režimu 
 

V tomto režimu provozu používá přístroj ABI PRISM 7900HT příslušenství – 
podavač mikrodestiček Zymark Twister a pevně umístěnou čtečku čárových kódů, 
což umožňuje zpracovávání velkého počtu vzorků. Pomocí programu Automation 
Controller tak může laborant/ka zpracovat větší počet destiček aniž je jejich 
zpracování osobně přítomen/přítomna. Obdobně jako v režimu samostatného 
provozu ukládá počítač veškerá data a umožňuje jejich analýzu. 

 
Počítač  

 
Program SDS 

 
 

Program Automation 
Controller 

1 
Vytvoření dokumentů  

destiček 

 
 
 
 

ABI PRISM 7900HT 
 

 
Firmware 

 

3 

2 

Zařazení destiček 
k analýze a jejich 

postupné spuštění 
 
5 

Uložení hrubých dat 
    do dokumentů 

Pevný disk 
 
 
 
 

*.sds 
soubor *.sdt 

 soubor 

Teplotní cyklování a  
          detekce 

 
4 

 
   Záznam dat 

 
Sériový 
kabel 

6 
Otevření a analýza 
dokumentu destičky 

 
 
 
 

Obrázek 1-13   Automatický režim provozu přístroje 7900HT  
 
 

Provoz s databází Enterprise 
 

V tomto provozním režimu používá přístroj ABI PRISM® 7900 HT databázi SDS 
Enterprise a automatický podavač mikrodestiček tak, aby bylo možné zpracování co 
nejvyššího počtu vzorků. V této konfiguraci (viz obrázek 1-14 na straně 1-19) má 
přístroj 7900HT dostatečnou kapacitu pro uložení a dostatečné možnosti pro analýzu 
velkého množství vzorků, ať již pro kvantifikaci genové exprese nebo genotypování. 
Kromě toho slouží databáze SDS Enterprise i pro úschovu výsledků souvisejících 
analýz, vzniklých na počítačích, které jsou připojeny prostřednictvím místní sítě. 
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ABI PRISM 7900HT 

 
Firmware 

 

 
3 

Teplotní cyklování a 
          detekce 

 
Stolní počítač (desktop) 
 

Program Automation  
Controller 

 

2 
Spuštění dokumentů  
destiček z databáze 

 
4 5 

  Sériový 
   kabel 

 
Uložení hrubých a analy- 
zovaných dat do databáze

 
 
 
 
 

Databázový server 
 

Databáze SDS 
Enterprise 

  
 
 
 
 

Ethernet 

 
 
 
 
 
 
 
 

Dokumenty 
destiček 

Analytické Výsledky 
 parametry 

 
 
 
 

Stolní počítač pro analýzy (desktop) 
 

Firmware 
 

6 
Otevření a analýza 
dokumentu destičky 

Ethernet 
 
 
 
1 

Vytvoření dokumentů  
destiček

 
 

Program RQ Manager  Pevný disk 
 

6 
Analýza výsledků 

(tzv. studie) 
 
 

Program SNP Manager  
 

6 

  Soubory nas- 
   tavení esejí 

Analýza výsledků 
(tzv. studie) 

 
 
 
 

Obrázek 1-14  Automatický režim provozu přístroje 7900HT s databází SDS 
Enterprise  

Záznam dat 
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Část 1.3  Databáze SDS Enterprise    
 
 

Část 1.3 Databáze SDS Enterprise 
 
 
 

     V této části O databázi SDS Enterprise....................................................................................1-22 
O softwaru databáze SDS Enterprise....................................................................1-25 
Koncepce databáze a správa dat ...........................................................................1-27 
Podpora dokumentace API ...................................................................................1-28 
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Kapitola 1    Popis systému 
 
 

O databázi SDS Enterprise 
 
 

O databázi Program SDS verze 2.2 je vybaven rozhraním pro komunikaci s databází SDS 
Enterprise společnosti Applied Biosystems jako součástí laboratorního informačního 
a řídícího systému (LIMS). Databáze SDS Enterprise je relační databáze založená na 
databázovém systému Oracle, navržená speciálně pro ukládání dat, která jsou 
generována přístrojem ABI PRISM® 7900HT. Mezi další funkce databáze patří 
autentizace uživatelů, výkonný a nastavitelný systém správy dat a nastavitelné 
možnosti archivování. Databáze dále obsahuje programové nástroje pro začlenění 
přístroje 7900HT do procesů správy dat v laboratorním provozu. 

 
Řízení přístupu Databáze SDS Enterprise umožňuje víceúrovňové řízení přístupu uživatelů a díky 

tomuto systému je možné různým uživatelům zamezit v přístupu k funkcím nejen 
samotné SDS databáze, ale i k programu SDS a k ovládání přístroje 7900HT. 
Součástí databáze je také modul pro nastavení práv jednotlivých uživatelů (SDS 
User Account Manager). Tento modul dovoluje nastavení práv a hesel jednotlivým 
uživatelům, přidávání a mazání uživatelů, to vše pouze uživateli s oprávněními 
administrátora. Práva přístupu k jednotlivým úkonům jsou uvedena v této příručce 
ve formě krátkých poznámek u popisu daného úkonu. 

 

Poznámka:  Úplný popis uživatelských účtů v databázi SDS Enterprise naleznete 
v příručce SDS Enterprise Database Administration Guide (kat. č. 4346513). 

 
Struktura 

sítě 
Databáze SDS Enterprise je koncipována jako dvoupásmová databáze 
s architekturou klient-server v prostředí sítě Ethernet (10Base-T) nebo Fast Ethernet 
(100Base-T). Databázi je možno provozovat jako součást izolované hvězdicové sítě 
s využitím routeru SMC dodávaného spolu s databází (obr. 1-15) nebo jako jeden 
uzel větší síťové sběrnice (obr. 1-16). Server databáze používá statickou IP adresu a 
je schopen obsluhovat až 5 klientských stanic najednou. Stanice mohou fungovat 
buď v režimu DHCP nebo mohou mít přiděleny statickou TCP/IP adresu. 
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O databázi SDS Enterprise    
 
 

Příklad architektury místní sítě (LAN) 
 

V základní konfiguraci je databáze SDS Enterprise schopna obsluhovat až čtyři DHCP 
nebo TCP/IP klientské stanice v topologii hvězdicové sítě. V této konfiguraci je server 
propojen s klientskými stanicemi přes router, dodávaný spolu s databází, se statickou 
IP adresou. 

 

Poznámka:  Router umožňuje propojení i do vzdálené sítě (WAN). 
 
 

Záznam dat 
• Záznamy běhů 
• Parametry analýzy 

 
• Dokumenty destiček 
• Templáty 

 
 
 
 
Databáze 

Analýza 
• Výsledky analýzy 
• Výsledky běhů 
 
• Studie 
• Nové dokumenty destiček 
• Templáty 

 
 

Operační systém 
Windows® 2000 

 
   Síťový protokol 

TCP/IP 
 

   Software 
Program SDS nebo 

program Automation 
Controller  

ABI PRISM 7900HT 
 

Databázový server 
 

Windows® 2000 
TCP/IP (Port 1521) 
Program databáze 
SDS Enterprise 
 

Stolní PC  
Operační systém 
Windows® 2000 
 
Síťový protokol 
TCP/IP 
 
Software 
Programy SDS, RQ 
Manager, nebo 
SNP Manager  

 
 
 
 
 

Router 
 
 
 
 
 
 

Obrázek 1-15   Základní architektura lokální sítě (LAN) pro databázi SDS Enterprise 
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Kapitola 1    Popis systému 
 
 

Příklad architektury vzdálené sítě (WAN) 
 

V konfiguraci WAN je databáze SDS Enterprise schopna obsluhovat až 5 klientských 
stanic jako jednotlivých síťových uzlů. Stejně jako v předchozí konfiguraci musí být 
server pro identifikaci v síti konfigurován s pevnou IP adresou a klientské stanice pak 
mohou být konfigurovány buď DHCP nebo pevnou TCP/IP adresou. 

 

 
Záznam dat 

• Záznamy běhů 
• Parametry analýzy 

 
• Dokumenty destiček 
• Templáty 
 

 
 
 
 
Databáze 

Analýza 
• Výsledky analýzy 
• Výsledky běhů 
 
• Studie 
• Nové dokumenty destiček 
• Templáty 

 
Operační systém 

Windows® 2000 
 

Síťový protokol  
TCP/IP 

 
 Software 

Program SDS nebo 
program Automation 

Controller 

ABI PRISM 7900HT 
 
 

Databázový server 
 

Windows® 2000 
TCP/IP (Port 1521) 
Program databáze 
SDS Enterprise 
 

 
 

Router 

Stolní PC Operační systém 
Windows® 2000 
 
Síťový protokol 
TCP/IP 
 
Software 
Programy SDS, RQ 
Manager, nebo 
SNP Manager 

 

 
 
 
 
 
 
 
 
 
 
 
 

Laboratoř Kancelář 
 
 

Obrázek 1-16   Základní architektura vzdálené sítě (WAN) pro databázi SDS 
Enterprise 
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O softwaru databáze SDS Enterprise    
 
 

O softwaru databáze SDS Enterprise  
 
 

Program 
správy 

databáze 

Databáze SDS Enterprise obsahuje nástroje, které umožňují uživateli začlenit ji do 
běžného provozu laboratoře tak, jak je popsáno v části: 
 

Databázové moduly pro velkokapacitní analýzu ......................................... 1-25 
Nástroje pro správu databáze ....................................................................... 1-26 

 
 
Databázové moduly pro velkokapacitní analýzu 

 
 

O modulech Společnost Applied Biosystems nabízí pro provádění středně- a velkokapacitních 
analýz genotypizace a genové exprese v databázi SDS Enterprise dva moduly (SNP 
Manager a RQ Manager) (Obrázek 1-17). 

 
 
 
 
 
 
 
 
 
 
 
 

Databáze SDS 
     Enterprise 

 
 
Studie/Výsledky běhů 
 
 
Analýza 

SNP Manager 
 

 

SNP/Genotypizace 
 

  
 
 
 
 
 
 

RQ Manager 
 

 
Relativní kvantifikace 

 
Obrázek 1-17  Databáze SDS Enterprise – Velkokapacitní analýza 

 
 

O programu 
SNP Manager 

 

Program SNP Manager slouží k provádění analýzy SNP (genotypové analýzy) pro 
středně velké a velké objemy dat uložené v databázi SDS Enterprise. Program je 
schopen najednou zpracovat až 5000 destiček, což znamená až 1,9 milionu 
5´nukleázových reakcí zpracovaných na přístroji ABI PRISM® 7900 HT. Více 
informací naleznete v příručce SDS SNP Manager User Guide (kat. č. 4338776). 

 
O programu 

RQ Manager 
 

Program RQ Manager slouží k provádění analýzy relativní kvantifikace (genové 
exprese) pro středně velké a velké objemy dat uložené v databázi SDS Enterprise. 
Program dokáže provést srovnávací analýzy pro až 97 detektorů (96 cílových genů a 
1 endogenní kontrola) pro až 200 destiček nebo přibližně 153600 multiplexních 
reakcí zpracovaných přístrojem ABI PRISM® 7900HT. Více informací naleznete 
v příručce SDS RQ Manager User Guide (kat. č. 4339753). 
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Kapitola 1    Popis systému 
 
 
Nástroje pro správu databáze 

 
 

Přehled 
 

Databáze SDS Enterprise obsahuje soubor nástrojů, které provádějí správu 
používání a obsahu databáze. Na obrázku 1-18 jsou shrnuty základní funkce 
každého z těchto nástrojů a typ dat, s kterými pracuje. 

 
 
 
 

Dokumenty 
destiček 

SDS 
Document 

Loader 

SDS 
Template 
Loader 

   Templáty 
 

 
 
 

SDS 
Document 

Creator 

 
 
Dokumenty 

destiček 

 

Databáze SDS 
Enterprise 
 

SDS User 
Account 
Manager 

 
SDS 

Document 
Extractor 

SDS 
Database 
Archiver 

 

 
Dokumenty 

destiček 
Archivy (.arc) 

 
Obrázek 1-18  Přehled nástrojů pro správu databáze 

 
 

Nástroje pro práci 
s dokumenty SDS 

Součástí programového vybavení databáze SDS Enterprise jsou čtyři nástroje, 
spustitelné z příkazové řádky, které zabezpečují správu dokumentů destiček, 
templátů a výsledků, které jsou generovány přístrojem 7900HT. 
 

•   SDS Document Creator (nástroj pro tvorbu dokumentů destiček) – Vytváří 
v databázi pomocí templátu a souboru nastavení eseje dokumenty destiček 
(assay plate setup file) (viz “Vytvoření dokumentu pomocí templátu” na straně 
A-51). 

•   SDS Document Loader (nástroj pro zavádění dokumentů destiček) – Zavádí do 
databáze obsah již existujících dokumentů destiček (viz “Zavádění dokumentů” 
na straně A-54). 

•   SDS Document Extractor (nástroj pro extrakci dokumentů z databáze) – 
Vytváří dokumenty destiček z dat v databázi (viz “Extrahování dokumentů” na 
straně A-55). 

•  SDS Template Loader (nástroj pro zavádění templátů) – Zavádí do databáze 
obsah již existujících templátů (viz “Zavádění do templátů” na straně A-50). 

 
Nástroj pro 

archivaci dat 
Program SDS Archiver se instaluje spolu s programem SDS, jehož součástí je Klient 
databáze SDS Enterprise. Tento program umožňuje administrátorovi databáze 
vytvářet archivy dat z databáze a následně data z archivních souborů opět do 
databáze nahrát. Viz “Archivace a zpětné nahrání dat do databáze” na straně A-56. 

 
Správce 

uživatelských účtů 
Program SDS User Account Manager se instaluje spolu s programem SDS, jehož 
součástí je Klient databáze SDS Enterprise. Tento program umožňuje 
administrátorům databáze přidělovat ostatním uživatelům práva a hesla, přidávat a 
odstraňovat je. Viz “Správa uživatelských účtů” na straně A-16. 
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Koncepce databáze a správa dat    
 
 

Koncepce databáze a správa dat 
 
 

Koncepce 
databáze 

Součástí databáze SDS Enterprise jsou tři primární typy datových souborů, 
používaných pro ovládání přístroje 7900HT a analýzu výsledků: 
 

•   Dokumenty destiček 
•   Analýza 
•   Studie 

 

Na obrázku 1-19 je vyobrazeno, odkud jsou získávány různé datové soubory a jejich 
použití při provozu přístroje ABI PRISM 7900HT. 

 

 
 
 
 

1 
Pomocí programu SDS se 

na počítači vytvářejí 
dokumenty destiček a jsou 

ukládány do databáze 
SDS Enterprise 

 
 
 
 
 
Dokumenty 

destiček 

 
 
 
 
 
 
Databázový 

server 

 
 
 
 
 
Dokumenty 

destiček 

 

2 
Destičky jsou překryty fólií a narovnány 

do úložných věží podavače. Před 
spuštěním každého běhu jsou vloženy 
do přístroje a je přečten jejich čárový 
kód. Program následně v databázi 

vyhledá dokument destičky 
s odpovídajícím čárovým kódem. 

 
 
 
 
 
 
 
 

5 
RQ Manager, SNP 

Manager nebo program 
SDS slouží k analýze 

výsledků 

 
 
Stolní PC 
 
 
 
 
 
 
 
•   Studie 
•   Výsledky 

 
7900HT  

 
 
 
 
 
 
 

Databáze 
•   Analýza 

 
3 

Každá destička je 
zpracována podle parametrů 

daných dokumentem 
destičky. V průběhu běhu 

jsou naměřená data 
ukládána do dokumentu 

destičky v databázi. 
 
                       4 

Ihned po skončení každého běhu 
provede program primární analýzu 

výsledků (multikomponentní algoritmus a 
normalizace). Analyzovaná data jsou 
následně uložena do databáze a jsou 

součástí příslušné studie. 
 

Obrázek 1-19  Tok dat v databázi SDS Enterprise 
 
 

Typy znovu 
použitelných dat 

Trvalé dokumenty destiček 
 

Trvalé dokumenty destiček obsahují stejné informace jaké jsou uloženy 
v dokumentech destiček (SDS). Dokumenty destiček pak odpovídají mikrodestičkám 
nebo mikrofluidním kartám. Každý trvalý dokument destičky zahrnuje údaje nezbytné 
pro provedení běhu s danou destičkou na přístroji 7900HT: 
 

•   Údaje o vzorku/jamce, 
•   Definice markerů/detektorů a jejich přiřazení k destičkám, 
•   Definice úlohy (task) pro každý marker/detektor a množství, 
•   Čárový kód destičky 
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 Kapitola 1    Popis systému 
 
 

Analýza 
 

Analýzou se rozumí soubor výsledků, které vznikly z hrubých dat určitého 
dokumentu destičky. Pro každý dokument destičky lze vytvořit více analýz. Každá 
analýza má unikátní název, který ji odliší od ostatních. 

 

Tento typ dat existuje v databázi ve dvou stavech: propojený nebo nepropojený. 
Data jsou propojena v okamžiku, kdy byla přiřazena ke specifické studii buď 
pomocí programu Automation Controller nebo RQ Manager / SNP Manager. 

 

DŮLEŽITÉ!  Po propojení dat a studie není možné tato data propojit s jinou studií, 
dokud je znovu neodpojíte. Více informací viz příručka SDS RQ Manager Software 

User Guide nebo SDS SNP Manager Software User Guide. 
 

RQ a SNP studie 
 

Program databáze SDS Enterprise používá pro organizaci sekundární analýzy dat 
vytvářených přístrojem ABI PRISM 7900HT systém tzv. studií. Hlavním cílem 
těchto studií je seskupit data pro analýzu za použití programů SNP Manager nebo 
RQ Manager. 

 
 

Podpora dokumentace API 
 
 

Technická 
podpora 

Součástí databáze SDS Enterprise je i kopie příručky SDS Enterprise Database 
Administrators Guide, která poskytuje informace pro integraci databáze do provozu 
laboratoře. 
 

V této příručce naleznete: 
 

•   Detailní informace o databázi SDS Enterprise API 
•   Podpůrné informace jako jsou kódy vzorků, reference javadoc, a 

požadavky pro připojení do databáze. 
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Kapitola 2    Začínáme 
 
 

Začínáme 
 
 

Dříve než začnete Pokud budete používat přístroj ABI PRISM®  7900HT poprvé, doporučujeme, abyste si 
prošli “Basic Software Skills Tutorial” (Základní dovednosti při ovládání programu  - 
cvičení) na straně 2-9. V tomto cvičení se seznámíte se základními znalostmi 
potřebnými pro ovládání programu SDS a naučíte se jej rychle a efektivně využívat. 

 
Odkazy V následujícím přehledu naleznete odkazy na základní kroky popsané v této příručce. 

 
Zadávání a spouštění experimentů 
 

Vytvoření dokumentu destičky.............................................................................. 3-8 
Spuštění jednoho dokumentu destičky ................................................................ 4-21 
Spuštění několika dokumentů destiček (várka dokumentů) ................................ 4-29 
Zastavení běhu z programu SDS ......................................................................... 4-26 
Zastavení běhu z programu Automation Controller ............................................ 4-39 
Vysunutí destičky z programu SDS .................................................................... 4-27 
Vysunutí destičky z programu Automation Controller ....................................... 4-39 
 
Analýza výsledků 
 

Analýza výsledků alelické diskriminace ............................................................... 5-5  
Analýza výsledků absolutní kvantifikace.............................................................. 6-5 
Analýza výsledků relativní kvantifikace ............................................................. 6-15 
Analýza disociační křivky ................................................................................... 6-37 
 
Údržba přístroje 7900HT 
 

Výměna adaptéru na destičky.............................................................................. 7-12 
Výměna bloku na vzorky ...................................................................................... 7-6 
Dekontaminace bloku na vzorky ......................................................................... 7-14 
Provedení kalibrace pozadí ................................................................................. 7-16 
Provedení kalibrace barev ................................................................................... 7-20 
Přidání vlastní barvy do sady barev..................................................................... 7-27 
Ověření funkčnosti přístroje pomocí destičky TaqMan RNáza P ....................... 7-30 
 
Údržba příslušenství přístroje 
 

Nastavení citlivosti senzoru destiček................................................................... 7-37 
Seřízení ramene podavače ................................................................................... 7-41 
Seřízení pevně umístěné čtečky čárových kódů .................................................. 7-49 
Čistění a výměna podložek ramene..................................................................... 7-52 
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Začínáme     
 
 

Používání 
nápovědy 

programu SDS 

Součástí programu SDS je nápověda pro všechny kroky zadávání, spouštění a 
analýzy experimentů. Nápověda je přístupná kliknutím na klávesu  (Help - 
Pomoc) umístěné v okně, v kterém zrovna pracujete. 
 

Nápovědu je možné otevřít dvěma možnými způsoby: 
 

 

Chcete-li… 
 

pak… 

otevřít nápovědu obecně, zvolte Help > SDS Online Help (Nápověda). 

otevřít nápovědu pro specifický úkon, 
který zrovna provádíte, 

klikněte na ikonu   v dialogovém okně, ve 
kterém právě pracujete. 

 
Další 

informace 
Další informace o používání přístroje ABI PRISM 7900HT nebo programu SDS 
naleznete v příručkách: 
 

•   ABI PRISM 7900HT Sequence Detection System Site Preparation and Safety 
Guide (Kat. č. 4317595) – Příprava místa 

•   ABI PRISM 7900HT Sequence Detection System Quick Reference Cards for: 
–  Allelic Discrimination (Kat. č. 4342506) – Alelická diskriminace 
–  Absolute Quantification (Kat. č. 4342507) – Absolutní kvantifikace 
–  Relative Quantification (Kat. č. 4342505) – Relativní kvantifikace 

•   ABI PRISM 7900HT Sequence Detection System Software Online Help – 

    Nápověda programu SDS 
•   Microsoft Windows Operating System Online Help – Nápověda operačního 

    systému Windows 
•   SDS Enterprise Database Administration Guide – Správa databáze SDS 

    Enterprise 
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Kapitola 2    Začínáme 
 
 

Zapnutí přístroje 7900HT 
 
 

Zapnutí 
přístroje 

Přístroj ABI PRISM 7900HT se zapíná postupně. Každá část systému musí být zapnuta 
v určitém pořadí tak, aby byl celý systém uveden do chodu správně. Pokud je toto 
pořadí narušeno, jednotlivé součásti přístroje mezi sebou nemusí navázat kontakt, 
nezbytný pro jejich správné fungování. 

 
 
 
 
 

 
Stavové diody 

Vypínač počítače 

 

 
 

    Vypínač 7900HT 
 
 
Podavač mikrodestiček Zymark 
Twister (vypínač vzadu) 

Vypínač monitoru 

 
Obrázek 2-1    Vypínače systému ABI PRISM 7900HT 

 
 

DŮLEŽITÉ!  Přístroj a podavač mikrodestiček zapněte alespoň 10 min před použitím. 
Po zapnutí dochází k zahřátí vyhřívaného víka bloku na vzorky na 105 °C. Pokud 
spustíte běh dříve než teplota víka dosáhne 105 °C, přístroj nespustí běh a vyčká na 
dosažení této teploty. 

 

1.   Zapněte monitor a počítač. 
 

2.   Zapněte podavač mikrodestiček Zymark Twister (vypínač je umístěn na zadní 
straně podavače, viz níže). 

   RIZIKO PORANĚNÍ. Při zapínání dbejte, abyste 
neblokovali pohyb ramene. Rameno se po zapnutí automaticky přesune do výchozí 
pozice. 

 
 
 
 

HI-POT 

A B C D 

Vypínač 
 

Zadní panel podavače 
 

Rameno se po zapnutí automaticky přesune do výchozí pozice (nad úložnou věž 
na zpracované destičky). 

 

3.   Stiskem hlavního spínače na předním panelu pod stavovými diodami zapněte 
přístroj 7900HT (viz obrázek 2-1). 

Po zapnutí provede přístroj 7900HT následující kroky: 
•   Vydá vysoký signální tón, což označuje správné zapnutí. 

•   Stavové diody (červená, oranžová, zelená) zablikají, což je známka aktivace 
přístroje (podrobněji viz “Stavové diody přístroje” na straně 2-5). 

 

DŮLEŽITÉ!  Nezapínejte přístroj 7900HT, pokud jste odstranili boční spodní kryt. 
Pokud to učiníte, nebude do přístroje z počítače nahrán firmware a objeví se chybová 
hláška. 
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Zapnutí přístroje 7900HT     
 
 

Stavové 
diody 

přístroje 

Přístroj 7900HT je vybaven třemi stavovými diodami, umístěnými v levé dolní části 
předního panelu (viz obrázek 2-2). 

 
 
 

Červená 
Oranžová 
Zelená 

 
Stavové diody 

 

 
 

Hlavní vypínač 
 
 
 
 
 
 

Obrázek 2-2 Stavové diody přístroje 7900HT  
 
 

Tabulka 2-1 Stavové diody přístroje 
 

 

Dioda - stav 
 

Přístroj - stav 
 

Požadovaný krok 

Svítí Přístroj je zapnut a připraven 
k provozu 

 

 
 
 
 

(Zelená) 
   Bliká •   Bezpečnostní spínače jsou 

rozpojeny a/nebo čtecí 
hlava není ve své pozici. 

•   Otevřená dvířka přístroje. 

Žádný 
 

Indikuje normální stav 
přístroje. 

   Bliká Přístroj přijímá/odesílá data 
z/do počítače (většinou 
během běhu). 

Žádný 
 

Indikuje normální stav 
přístroje. 

 

 
 
 
 
(Oranžová)

Svítí Svítí-li po zapnutí déle než 
dvě minuty: 

 

•   Nebyla správně provedena 
inicializace přístroje 

•   Systémová chyba 

1. Zkontrolujte, že ovládací 
počítač je zapnutý a 
připojený k přístroji (více 
informací na straně 1-11) 

2. Pokud ano, vypněte přístroj, 
vyčkejte 30 sec a znovu 
zapněte podle pokynů na 
straně 2-4. 

 
 
 
 
 
(Červená) 

Svítí Systémová chyba. Vypněte přístroj, vyčkejte 30 
sec a znovu zapněte. 

Poznámka:  Pokud se situace 
opakuje, kontaktujte Technickou 
podporu společnosti Applied 
Biosystems. 
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Používání programu SDS 
 
 

Spuštění 
programu 

1.   Spusťte program: 
•   Zvolte  > Programs > Applied Biosystems > SDS 2.2 > 

SDS 2.2., nebo 

•   Dvakrát klikněte na ikonu  (SDS 2.2) na ploše počítače. 
Používáte-li ve vaší místní síti databázi SDS Enterprise, budete automaticky 
vyzváni k přihlášení. 

 

2.   (pouze pro databázi) V okně Login (Přihlášení) zadejte vaše uživatelské jméno 
a heslo a potvrďte . 

 

Poznámka:  Používáte-li databázi, program SDS požaduje, aby každý uživatel 
měl uživatelské jméno a heslo (viz “Správa uživatelských účtů” na straně A-16). 

 

Počítač spustí program SDS a pokusí se navázat komunikaci s přístrojem 7900HT. 
Pokud je komunikace navázána, zobrazí se po otevření dokumentu destičky ve stavové 
liště ikona Připojeno ( ). 
Více informací viz “O stavové diodě” na straně 2-8. 

 
O rozhraní 
programu 

Informace o veškerých krocích programu jsou zobrazovány v okně programu SDS. 
Program umožňuje rychlý přístup k funkcím pomocí rozbalovacích nabídek a ikon. 
Na obrázku 2-3 jsou vlastnosti programového rozhraní zevrubně shrnuty. 

 
     Menu 

Nabídky příkazů pro 
ovládání programu 

 
 

 
 
 
 
 
 

Základní lišta 
Ikony pro ovládání základních 

funkcí programu (viz 
strana 2-7) 

 
 
 
 
 
 
 

 
Stavová lišta 

Zobrazuje zprávy o stavu 
přístroje a programu SDS (viz 

strana 2-8) 

Ikony Windows  
Minimalizovat ( ), maximali-
zovat ( ), zavřít ( ) okno 
 

 
 
 
 
 
 
 
Lišta Zobrazení 
Ikony pro zobrazování 
různých informací v rozhraní 
programu (viz strana 2-7) 
 
 
 
 
 
 
 
 
Ikona signalizující připojení 
přístroje Indikuje stav 
připojení k přístroji 7900HT 
(viz strana 2-8) 

 

 
            Obrázek 2-3 Součásti rozhraní programu SDS  

 Uživatelská příručka pro Real-Time PCR systém ABI PRISM 7900HT 2-6 



  

  

Používání programu SDS     
 
 

Základní lišta 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Lišta zobrazení 

Součástí základní lišty jsou ikony odkazující na hlavní funkce programu, týkající se 
správy a analýzy dat. V následujícím seznamu jsou tyto ikony popsány včetně odkazů 
na úkony, při nichž jsou ikonami odkazované příkazy využívány. 
 

 – Vytvoření nového dokumentu destičky (viz strana 2-12) 

 – Otevření dokumentu destičky z disku (viz strana 2-18)  

 – Uložení dokumentu destičky na disk (viz strana 2-16) 

 – Otevření dokumentu destičky z databáze (viz strana 2-18)  

 – Uložení dokumentu destičky do databáze (viz strana 2-16) 

DŮLEŽITÉ!  Ikony  a  jsou na liště zobrazeny pouze je-li program SDS 
připojen k databázi SDS Enterprise. 

 

 – Import dat z textového souboru (viz strana 2-15)  

 – Export dat do textového souboru (viz strana 2-13) 

 – Tisk (viz strana 2-12)  

 – Hledání (viz strana 2-12) 

 – Vyjmout (viz strana 2-12)  

 – Kopírovat (viz strana 2-12) 

 – Vložit (viz strana 2-12)  

 – Analýza dokumentu destičky (viz strana 2-12) 

 – Nastavení parametrů analýzy (viz strana 2-12) 
 
Součástí lišty zobrazení jsou ikony používané pro zobrazování dat v programu SDS. 
V následujícím seznamu jsou tyto ikony popsány včetně odkazů na úkony, při nichž 
jsou ikonami odkazované příkazy využívány. 
 

 – Skrýt/Zobrazit panel Well Inspector (Prohlížeč jamek) (viz strana 2-11) 

 – Skrýt/Zobrazit panel Plate List (Seznam destiček) (viz strana 2-11) 

 – Skrýt/Zobrazit destičku (viz strana 2-11)  

 – Skrýt/Zobrazit tabulku (viz strana 2-11) 

 – Skrýt/Zobrazit panel hrubých dat (viz strana 2-11)  

 – Skrýt/Zobrazit multikomponentní graf (viz strana 2-11) 

 – Skrýt/Zobrazit amplifikační graf (viz strana 2-11)  

 – Skrýt/Zobrazit standardní křivku (viz strana 2-11)  

 – Skrýt/Zobrazit graf genové exprese (viz strana 2-11) 

 – Skrýt/Zobrazit záznam disociační křivky (viz strana 2-11) 

 – Zvětšení destičky (viz strana 2-11) 

     – Nastavení zobrazení (Display Settings) (viz strana 2-11) 
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Stavová lišta Ve stavové liště jsou zobrazovány zprávy o stavu přístroje a programu. V následující 
tabulce jsou uvedeny všechny zprávy, které se mohou zobrazit. 

 
Tabulka 2-2 Stavové zprávy 

 
 

Zpráva 
 

Program SDS … 

Ready (Připraven) je připraven a čeká na příkazy. 

Collecting Data (Čtení dat) čte data z aktuálního běhu.. 

Reanalyze data (Znovu 
analyzovat data) 

vyžaduje analýzu dokumentu destičky. 

Změnilo se nastavení parametrů analýzy a je nutné 
provést analýzu znovu za použití těchto změn 

Analyzing data...  

(Analýza dat… + Ukazatel 
postupu) 

provádí analýzu. 
 

Ukazatel postupu vpravo od zprávy znázorňuje postup 
analýzy.  

Saving data...  

(Ukládání dat… + Ukazatel 
postupu) 

ukládá dokument destičky nebo templát. 
 

Ukazatel postupu vpravo od zprávy znázorňuje postup 
ukládání. 

Importing data... ¨ 

(Import dat + Ukazatel postupu) 
importuje soubor. 

 

Ukazatel postupu vpravo od zprávy znázorňuje postup 
importu. 

Exporting data...  

(Export dat… + Ukazatel postupu)

exportuje data z dokumentu destičky do souboru. 
 

Ukazatel postupu vpravo od zprávy znázorňuje postup 
exportu. 

 
Ikona 

připojení 
přístroje 

Ikona připojení přístroje znázorňuje stav připojení programu k přístroji 7900HT. 
 

 – Počítač je připojen k přístroji a očekává příkazy 
 

  – Počítač se nemůže připojit k přístroji (přístroj není připojen 
nebo zapnut) 
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Základní dovednosti při ovládání programu - cvičení 
 
 

Přístup Používáte-li počítač připojený k databázi SDS Enterprise, musíte mít pro dokončení 
tohoto cvičení práva uživatele třídy Scientist (Vědec) nebo Administrator (Správce). 

 
O tomto 
cvičení 

V tomto cvičení se: 
 

•   Naučíte, jak vytvářet, ukládat, tisknout, exportovat a importovat dokumenty 
     destiček 
•   Seznámíte, se základními součástmi rozhraní programu SDS 
•   Dozvíte, jak nastavit uživatelské rozhraní tak, aby vyhovovalo vašim potřebám 
•   Naučíte, jak používat ruční čtečku čárových kódů 

•   Dozvíte, jak ušetřit čas při práci s programem SDS 
 

Jak spustit 
cvičení 

Součástí nápovědy programu SDS je i toto cvičení. Pokud dáváte přednost této on-
line verzi, otevřete Nápovědu: 
 

1.   Pokud není ještě spuštěn, spusťte program SDS podle návodu na straně 2-6. 
 

2.   Zvolte Help > SDS Online Help (Nápověda > Nápověda programu SDS). 
 

3.   V Nápovědě klikněte na Basic Skills Tutorial (Základní dovednosti při ovládání 
programu – cvičení). 

 

4.   Postupujte podle pokynů na obrazovce. 
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Poznámky pro uživatele databáze 

 
 

Databáze a 
cvičení 

Používáte-li databázi SDS Enterprise pro ukládání dokumentů SDS, studií a dat, je 
možné, že v průběhu tohoto cvičení budete muset provést nějaké dodatečné úkony. 
Níže jsou tyto úkony popsány (nutnost jejich provedení závisí na tom, jak správce 
provedl nastavení databáze). 

 

 
Dialogové okno 
Reason(s) For 

Change 

Dialogové okno Reason(s) for Change (Důvod/y změny) se objevuje pouze v případě, 
je-li databáze SDS Enterprise nastavena tak, že vyžaduje zdůvodnění prováděných 
kroků (tzv. audit). Systém auditu sleduje vytváření, změny a mazání dat v databázi. 
 

Objeví-li se dialogové okno Reasons for Change, proveďte jeden z následujících 
kroků: 

• Zvolte důvod změny z rozbalovací nabídky a poté klikněte na ikonu .
• Zadejte důvod změny do příslušného pole a poté klikněte na ikonu  .

 
 

Rozbalovací nabídka 
důvodů změny 

 
Přednastavené důvody 

 
 
 
 

Popis vlastního důvodu 
 
 

Obrázek 2-4 Dialogové okno Reasons for Change (Důvod/y změny) 
 
 

Dialogové 
okno 

Electronic 
Signature 

 

Dialogové okno Electronic Signature (Elektronický podpis) se objevuje pouze 
v případě, je-li databáze SDS Enterprise nastavena tak, že vyžaduje elektronický 
podpis. Systém elektronického podpisu omezuje a sleduje přístup uživatelů k datům 
v databázi. 
 

Objeví-li se toto dialogové okno: 
 

1.   Do pole User ID (Jméno) a Password (Heslo) zadejte vaše uživatelské jméno a 
heslo a potvrďte . 

 

2.   Program následně zobrazí zprávu o úspěšném či neúspěšném použití 
elektronického podpisu. Pro pokračování klikněte . 

 
 
 

 Popis kroku, který 
 vyžaduje elektronický 
 podpis. 

 
 Uživatelské jméno 

 
 Heslo 

 
 
 

Obrázek 2-5 Dialogové okno Elektronický podpis 
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Lekce 1: Používání dokumentů destiček 

 
 

O dokumentu 
destičky 

Každá destička analyzovaná na přístroji ABI PRISM 7900HT vyžaduje vytvoření 
dokumentu destičky v programu SDS. Dokument destičky je virtuální záznam 
mikrodestičky nebo jiného typu spotřebního materiálu se vzorky. Program používá 
dokument destičky pro řízení činnosti přístroje (teplotní cyklování a čtení dat), pro 
organizaci a ukládání dat získaných během PCR a pro analýzu dat. 

 
Tabulka 2-3 Typy dokumentů destičky  

 
Typ souboru  Přípona Ikona Popis/Komentář 

 
ABI PRISM SDS 
dokument 

*.sds Dokumenty destiček jsou základní používané 
soubory. Jsou vytvářeny pro každý experiment. 

 
ABI PRISM SDS 
templát 

*.sdt Templáty jsou volitelné dokumenty používané 
v experimentech, v kterých se používá identická 
konfigurace esejí v destičce. Jejich používání vede 
k úspoře času. 

 
ABI PRISM SDS 
soubor typu 
sdm (multiplate) 

*.sdm Dokumenty typu sdm se používají pro analýzu 
výsledků relativní kvantifikace. Více informací viz 
Kapitola 6 “Analýza výsledků.” 

 
 

 
Cvičení v této lekci vás naučí pracovat s těmito typy dokumentů . 
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Cvičení 1: 
Vytvoření 

dokumentu 
destičky 

Pro každou destičku, kterou budete chtít analyzovat na přístroji 7900HT, musíte 
vytvořit dokument destičky. 
 

DŮLEŽITÉ!  Program SDS umožňuje pracovat s několika dokumenty destiček 
najednou. S každým dalším otevřeným dokumentem destičky však klesá rychlost 
práce. Z tohoto důvodu doporučuje společnost Applied Biosystems, abyste neotvírali 
více než deset dokumentů destiček. 
 

1.   Pokud není ještě spuštěn, spusťte program SDS: 
 

a.  Zvolte  > Programs > Applied Biosystems > SDS 2.2 > 
SDS 2.2). 

b.  (pouze pro databázi) V okně Login (Přihlášení) zadejte vaše uživatelské 
jméno a heslo a potvrďte . 

 

 

 
 

2.   Klikněte  nebo zvolte File > New (Soubor > Nový). 

3.   V dialogovém okně New Document (Nový dokument) zvolte: 
•   Rozbalovací nabídka Assay (Esej) – Zvolte Absolute Quantification 
     (Absolutní kvantifikace). 
•   Rozbalovací nabídka Container (Destička) – Zvolte 96 Wells Clear Plate 
     (96-ti jamková destička). 
•   Rozbalovací nabídka Template (Templát) – Zvolte Blank Template 
    (Žádný templát). 
•   V poli Barcode (Čárový kód) – Zadejte Practice (Nácvik). 

 

Poznámka:  Za normální situace byste zadali název souboru nebo čárový kód 
(max. 128 znaků).  

 

 

 
 

4.   Klikněte . 

Program zobrazí nový dokument destičky. 
 

5.   Otevřete templát 96-ti jamkové ověřovací destičky RNázyP a exportujte 
jej podle návodu na straně 2-13. 
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Cvičení 2: 
Export 

dokumentu 
destičky 

Další možností jak vytvořit dokument destičky (kromě manuálního vytvoření podle 
kapitoly 4 Ovládání přístroje) je import dokumentu destičky do programu SDS ze 
souboru nastavení eseje (Assay Plate Setup File). Tento soubor lze z programu SDS 
exportovat nebo vytvořit např. pomocí tabulkového procesoru či v systému LIMS (viz 
Příloha A “Související programy”). V následujícím cvičení exportujete soubor 
nastavení eseje (Assay Plate Setup File) jako templát, který následně v cvičení 3 
importujete (viz strana 2-15). 
 

Poznámka:  Kromě souboru nastavení eseje může program SDS též exportovat 
většinu grafů a tabulek. Viz Příloha A, “Související programy”. 
 
Otevření templátu 
 

Níže je popsán postup jak otevřít templát pro ověřovací destičku RNáza P. Program 
SDS instaluje templáty do adresáře: \AppliedBiosystems\SDS2.2\Templates. 
Kromě templátu pro destičku RNázaP jsou v tomto adresáři přednastaveny i 
templáty pro destičky, které jsou na přístroji 7900HT pravidelně analyzovány. 
 

1.   Klikněte  nebo zvolte File > Open (Soubor > Otevřít). 

2.   V poli Look In (Vyhledat) dialogového okna Open (Otevřít) vyhledejte adresář: 

\AppliedBiosystems\SDS2.2\Templates. 
 

3.   Zvolte File of type > ABI PRISM SDS Template Document (*.sdt) (Typ 
 souboru > Templát). 

 

4.   V poli Look In (Vyhledat) zvolte soubor 96 Well RNaseP Install Plate.sdt. 
 
 
 
 
 
 
 

Zvolte 
 
 
 
 
 
 

5.   Klikněte  (Otevřít). 

Program otevře templát. 
 

6.   Exportujte dokument podle návodu na straně 2-14. 
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Export dokumentu destičky 
 

1.   Klikněte  nebo zvolte File > Export (Soubor > Exportovat). 

2.   V poli Look In (Vyhledat) dialogového okna Export vyhledejte adresář: 

Applied Biosystems/SDS Documents. 
 

3.   V dialogovém okně Export zvolte Export > Setup Table (Export > Zadání). 
 

4.   Zvolte All Wells (Všechny jamky). 
 

5.   Zvolte SDS 2.2. 
 

6.   V poli File name (Název souboru) zadejte Practice (Nácvik). 
 

 

 
 

7.   Klikněte . 
 

Program uloží zadání dokumentu destičky ve formě textového souboru, v němž 
jsou data oddělena tabelátorem, pod názvem ‘Practice.txt’. 

 

Poznámka:  Soubor ‘Practice.txt’ můžete otevřít pomocí programů Microsoft 
Notepad, Wordpad nebo Word. 

 

8.   Zvolte File > Close (Soubor > Zavřít), čímž templát zavřete. 
 

DŮLEŽITÉ!  Dokument destičky, vytvořený v “Cvičení 1: Vytvoření dokumentu 
destičky” na straně 2-12 nezavírejte. 

 

9.   Importujte exportovaný dokument do dokumentu destičky podle postupu na 
straně 2-15. 
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Cvičení 3: 
Import zadání do 

dokumentu 
destičky 

Program SDS vám umožňuje importovat zadání do dokumentu destičky 
z exportovaného nebo připraveného souboru nastavení eseje (Assay Plate Setup File). 
Tím ušetříte čas. Importujte zadání dokumentu ze souboru Practice.txt (viz “Cvičení 
2: Export dat z dokumentu destičky” na straně 2-13) do prázdného dokumentu 
destičky vytvořeného v “Cvičení 1: Vytvoření dokumentu destičky” na straně 2-12. 
 

1.   Je-li dokument destičky z Cvičení 1 stále otevřen, postupte na krok 2. Jinak 
vytvořte nový dokument destičky: 

a.  Klikněte  nebo zvolte File > New (Soubor > Nový). 

b.  V dialogovém okně New Document (Nový dokument) zvolte totéž 
nastavení jako v templátu: 
Rozbalovací nabídka Assay (Esej) – Zvolte Absolute Quantification 
(Absolutní kvantifikace).  
Rozbalovací nabídka Container (Destička) – Zvolte 96 Wells Clear Plate 
(96-ti jamková destička).  
Rozbalovací nabídka Template (Templát) – Zvolte Blank Template 
(Žádný templát).  
Pole Barcode (Čárový kód) – nechte prázdné. 

c.  Klikněte . 

Program zobrazí nový dokument destičky. 
 

2.   Klikněte  nebo zvolte File > Import (Soubor > Import). 

3.   V poli Look In (Vyhledat) dialogového okna Import vyhledejte adresář: 

Applied Biosystems/SDS Documents. 
 

4.   Zvolte soubor Practice.txt vytvořený v cvičení 5. 
 

 

 
 

5.   Klikněte . 

Program importuje zadání z dokumentu Practice.txt do nového dokumentu 
destičky. 

 

Poznámka:  Více informací o importování a exportování zadání pomocí 
programu SDS naleznete v příloze A “Související programy.” 

 

6.   Uložte dokument podle postupu na straně 2-16. 
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Cvičení 4: 
Uložení 

dokumentu 
destičky 

Příkazem Save (Uložit) uložíte všechny změny dokumentu destičky (zadání a 
zobrazení). Používáte-li verzi programu SDS s databází SDS Enterprise, máte 
rovněž možnost uložit dokument destičky do databáze. 
 

Zvolte jednu z následujících možností: 
 

•   Používáte-li databázi, uložte dokument do databáze podle postupu na straně 
2-17. 

•   Nepoužíváte-li databázi, uložte dokument destičky na disk vašeho počítače 
podle postupu uvedeného níže. 

 
Uložení dokumentu destičky na disk 
 

1.   Klikněte  nebo zvolte File > Save As (Soubor > Uložit jako). 

2.   Zvolte File of type (Typ souboru) > ABI PRISM SDS Document (*.sds). 
 

3.   V poli File name (Název souboru) zadejte Practice  (Nácvik). 
 

 

 
 

4.   Klikněte  (Uložit). 
 

5.   V okně Document not properly set up (Dokument není správně zadán), klikněte 
       . 

 

 
 

Program uloží dokument destičky jako soubor Practice.sds. 
 

6.   Uzavřete uložený dokument destičky podle postupu na straně 2-17. 
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Uložení dokumentu destičky do databáze SDS Enterprise 
 

1.   Klikněte  nebo zvolte File > Save Document to Database (Soubor > Uložit 
      dokument do databáze). 

2.   V okně Document not properly set up (Dokument není správně zadán), klikněte 
       . 

 

 
 

3.   V dialogovém okně Save Document to database (Uložit dokument do databáze) 
nechte pole Comment (Komentář) prázdné nebo zadejte stručný popis souboru. 

 

Poznámka:  Popis v tomto poli může mít max. 256 znaků. 
 

 

 
 

4.   Klikněte   čímž soubor uložíte. 
 

5.   V okně Document not properly set up (Dokument není správně zadán), klikněte 
       . 

 

 
 

6.   V okně Saved Document (Dokument uložen) klikněte  . 
 

 
 

7.   Zvolte File > Close (Soubor > Zavřít). 
 

8.   Jste-li vyzváni k uložení dokumentu destičky, klikněte  (Ne). 

Program SDS soubor zavře, aniž jej uloží. 
 

9.   Otevřete dokument destičky podle postupu na straně 2-18. 
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Cvičení 5: 
Otevření 

dokumentu 
destičky 

V tomto cvičení otevřete dva dokumenty destičky (dokument z cvičení 3 a 
templát) a následně je použijete v následujících cvičeních. Účelem tohoto cvičení 
je seznámit se s kroky, které je nutné provést, pokud chcete otevřít dokument 
destičky předešle uložený na disk nebo do databáze SDS Enterprise. 
 

Zvolte jednu z následujících možností:: 
 

•   Používáte-li databázi, otevřete dokument z databáze podle postupu na straně 
2-17. 

•   Nepoužíváte-li databázi, otevřete dokument destičky z disku vašeho počítače 
podle postupu uvedeného níže. 

 
Otevření dokumentu destičky z disku 
 

1.   Klikněte  nebo zvolte File > Open (Soubor > Otevřít). 

2.   V poli Look In (Vyhledat) vyhledejte adresář: 

Applied Biosystems/SDS Documents 
 

3.   V poli Look In (Vyhledat) zvolte soubor Practice.sds. 
 
 
 
 
 

Zvolte 
 
 
 
 
 
 
 
 
 

4.   Klikněte  (Otevřít). 

Program otevře soubor Practice.sds. 
 

5.   Zvolte File > Close (Soubor > Zavřít). 
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Otevření dokumentu destičky z databáze SDS Enterprise 
 

1.   Klikněte  nebo zvolte File > Open Document from Database (Soubor > 
      Otevřít dokument z databáze). 

 

2.   V dialogovém okně Plate Query (Vyhledání destičky) nastavte parametry 
vyhledávání (Find Plates Matching These Criteria) takto: 

a.  Klikněte do první buňky ve sloupci Variable (Volitelný) a zvolte Barcode 
     (Čárový kód). 

b.  Klikněte do první buňky ve sloupci Conditions (Parametr) a zvolte 
     Contains (obsahuje). 

c.  Klikněte do první buňky ve sloupci Value1 (Hodnota1) a zadejte Practice 
     (Nácvik). 

 

d. Klikněte  (Vyhledat). 
 

Zvolte 
Barcode 

Zvolte 
Contains 

Zvolte 
Practice 

 

 
 
 
 
 
 
 

Kliknutím zahájíte vyhledávání 
 

4.   V seznamu výsledků zvolte dokument Practice (Nácvik) a klikněte  
      (Otevřít). 

 
 
 
 

Kliknutím zvolte 
dokument 

 
 
 
 

Kliknutím otevřete dokument 
 

5.   Klikněte  (Hotovo). 
 

6.   Pokračujte v části “Lekce 2: Zobrazování a změna velikosti panelů” na straně 
      2-20. 
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Lekce 2: Zobrazování a změna velikosti panelů 

 
 

Přehled V dokumentech destiček je možné zobrazit zadání a výsledky naráz v několika 
různých zobrazeních. V této lekci se seznámíte s různými možnostmi jak 
optimalizovat zobrazení dat na obrazovce a efektivně program využívat. 

 
Cvičení 1: 

Změna velikosti 
panelů a grafů 

Velikost panelů a grafů v dokumentu destičky můžete změnit posunutím šedé čáry, 
která je horizontálně i vertikálně odděluje.

 
 
 
 
 
 
 
 

Oddělovací čára 
(klikněte a táhněte) 

 
 
 
 
 

 Oddělovací čára (klikněte a táhněte) 
 

 
1.   Klikněte na šedou čáru, která odděluje destičku a prohlížeč jamek (well 
      inspector), a táhněte za ni doprava. 

Program rozšíří destičku a tabulku. 
 

2.   Procvičte si používání tohoto nástroje, dokud jej dokonale neovládáte. 
 

Cvičení 2: 
Skrytí a 

zobrazení 
panelů a grafů 

Zobrazení panelů a grafů můžete rovněž zapnout pomocí ikon v liště Zobrazení 
(Display).  
 

1.   V liště Zobrazení klikněte  (Skrýt/Zobrazit tabulku). 

Tabulka bude skryta. 
 

2.   Klikněte znovu  , čímž tabulku opět zobrazíte. 
 
Lišta Zobrazení je obzvláště výhodná pro změnu zobrazení údajů v dokumentu 
destičky. Více informací viz “Lišta zobrazení” na straně 2-7. 

 

3.   Vyzkoušejte si skrývání a zobrazování dalších součástí dokumentu destičky 
klikáním na další ikony v liště Zobrazení, abyste se s touto možností dokonale 
seznámili. 
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( 

 

 

 
 

Cvičení 3: 
Maximální/ 
Minimální 

velikost panelů 
a grafů 

Velikost panelů a grafů můžete změnit na maximum či minimum kliknutím na 
tlačítka změny velikosti v šedé oddělovací čáře. 
 

Poznámka:  Těmito tlačítky jsou černé šipky ) mezi sousedícími částmi 
dokumentu destičky. Kliknete-li na ně, skryje se ta část dokumentu na níž šipka 
ukazuje. 
 

1.   Šipka (ukazuje směrem dolů) v šedé čáře mezi destičkou a tabulkou slouží 
k maximálnímu zvětšení destičky ve vertikálním směru. 

Program zvětší destičku a odstraní (minimalizuje) tabulku. 
 
 
 
 
 
 
 

Změna velikosti 
 

 
 
 
 
 
 
 
 

2.   Kliknutím na šedou lištu ve spodní části dokumentu destičky a potažením 
      obnovíte původní velikost tabulky (viz postup v cvičení 1). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.   Vyzkoušejte si práci s tlačítky změny velikosti, dokud se s jejich funkcí 
dokonale neseznámíte. 
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Lekce 3: Zobrazení destičky 

 

 
   Přehled Zobrazení destičky (viz obrázek 2-6) je důležitou součástí programu SDS. Program 

používá toto zobrazení pro práci s  informacemi týkajícími se destičky a umožňuje 
vám zvolit určité jamky a zobrazit jich se týkající informace. V následujících 
cvičeních se seznámíte s používáním a úpravou údajů v zobrazení destičky. 

 
 
 
 
 
 

Zobrazení destičky 
 
 
 

Obrázek 2-6   Zobrazení destičky dokumentu SDS 
 
 

Cvičení 1: 
Zobrazení 
informací 

o jamce 

Zobrazení informací o jamce/jamkách je v programu SDS možné dvěma způsoby. 
Proveďte jeden z následujících kroků, chcete-li zobrazit informace o nějaké jamce 
dokumentu destičky: 
 

•   Kliknutím zvolte jakoukoliv jamku v destičce. 

Zvolená destičky je zvýrazněna černě a v panelu well inspector (prohlížeč 
jamek) se v záložce Setup (Zadání) zobrazí související informace. 

 
 
 
 
 
 
 
 

Záložka Setup zobrazí informace o 
zvolené jamce 

 
 
 
 
 
 

•   Přesuňte myš nad kteroukoliv jamku v zobrazení destičky. 
Ve žlutém vyskakovacím okně se zobrazí informace o dané jamce. 

 
 
 
 
 
 
 
 
 

Vyskakovací okno zobrazuje 
informace o jamce, nad níž je 
kurzor 
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Cvičení 2: 
Označení 

několika jamek 

V programu SDS je možné použít několik různých způsobů pro označení několika 
jamek. V následujícím cvičení si většinu z nich osvojíte. 
 

1.   Zvolte skupinu jamek pomocí některé z následujících akcí: 
•   Kliknutím a tažením myší okolo skupiny jamek, nebo 

•   Kliknutím na jamku vlevo nahoře ve skupině jamek a následně kliknutím na 
jamku vpravo dole ve skupině jamek za současného stisku klávesy Shift. 

Zvolené jamky jsou ohraničeny černě. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.   Zvolte několik izolovaných jamek pomocí některé z následujících akcí: 

a.  Stiskněte klávesu Ctrl a klikejte na jednotlivé jamky, které chcete zvolit. 
Zvolené jamky jsou ohraničeny černě. 

b.  Stiskněte klávesu Ctrl a klikejte na jamky, které nechcete zvolit. 
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3.   Zvolte celý sloupec nebo řádek jamek pomocí záhlaví: 

a.  Klikněte do záhlaví řádku B, čímž zvolíte všechny jamky v řádku. 
Zvolené jamky v řádku B jsou ohraničeny černě. 

 

b.  Přidržte klávesu Shift nebo Ctrl, poté klikněte do záhlaví dalších řádků či 
sloupců, čímž je zvolíte. 

 

 
 
 
 

Záhlaví řádku B 

 

 
 
 
 

 
 

nebo 
 

 
 
 
 
 
4.   Všechny jamky destičky zvolíte kliknutím do levého horního rohu ve schématu 
      destičky. 

Všechny jamky destičky jsou ohraničeny černě. 
 

 
 

Zde 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.   Pomocí postupu popsaného v krocích 1 až 4 si procvičte zvolení různých oblastí 
     destičky, abyste si tento postup dokonale osvojili. 
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Cvičení 3: 
Zvětšení 

zobrazení 
destičky 

Kliknutím na ikonu  můžete zobrazení destičky zvětšit a tím zobrazit informace o 
jednotlivých jamkách. 

1.   Klikněte na ikonu  a sledujte, jak se jamky zvětší. 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.   Klikněte na ikonu  znovu čímž obnovíte zobrazení destičky v původní 
      velikosti. 

 

3.   Procvičte si tuto funkci programu, abyste si ji osvojili. 
 

Cvičení 4: 
Změna velikosti 

jamek pomocí 
oddělovací linky 

Velikost zobrazených jamek lze rovněž změnit posunutím linek v záhlaví řádků nebo 
sloupců. 
 

1.   Umístěte myš nad linku v záhlaví oddělující sloupce nebo řádky. 

Z kurzoru myši se tímto stane dvojitá šipka ( ). 
 

2.   Kliknutím a tažením myší upravte šířku jamky. 

Program upraví šířku všech jamek podle vámi nastavené šířky. 
 

Kurzor myši 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.   Procvičte si tuto funkci programu, abyste si ji osvojili. 
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Lekce 4: Používání ruční čtečky čárových kódů 

 

 
  Přehled Ruční čtečka čárových kódů funguje jako přídatné zařízení ke klávesnici a slouží 

k automatickému zadání čárových kódů do programu SDS. Čtečka naskenuje čárový 
kód a : 

 

•   Předá informaci o čárovém kódu v abecedněčíslicové formě do programu 
SDS. Program vloží čárový kód do místa v němž je umístěn kurzor. 

•   Předá signál k potvrzení zadaného údaje (obdoba stisku klávesy Enter). 
 

Cvičení: 
Zadávání 
čárových 

kódů pomocí 
ruční čtečky 

Postup níže vysvětluje jak zadat čárové kódy pomocí ruční čtečky čárových kódů. 
Běžné je zadat čárový kód do dialogového okna při vytváření dokumentu destičky. 
 

1.   Zvolte Tools > Document Information (Nástroje > Informace o dokumentu). 
 

2.   V dialogovém okně Document Information klikněte do pole Comments 
      (Komentář). 

 
 
 
 
 

 
Zde klikněte 

 

 
 
 
 
 
 
 
 

3.    Podržte ruční čtečku čárových kódů 20 až 30 cm od destičky zacílenou na střed 
čárového kódu a stiskněte spoušť. Ze čtečky vyjde laserový paprsek, který se na 
destičce projeví jako červená čára. Pomalu posouvejte tento paprsek přes čárový 
kód dokud čtečka nevydá vysoký tón signalizující přečtení kódu. 

  NEBEZPEČÍ LASEROVÉHO ZÁŘENÍ. Přímé nebo 
odražené laserové paprsky mohou poškodit sítnici, což může vést k trvalému 
poškození zraku. Nikdy se nedívejte přímo do laserového paprsku. Odstraňte 
šperky a další předměty, které mohou odrážet paprsek do vašich očí. Chraňte 
ostatní před laserovými paprsky. 

 
 
 

PECY001DL3 

 
20-30 cm 

 
 
 
 
 
 

Po odečtení čárového kódu je tento kód automaticky vložen v abecedněčíslicové 
formě do zvoleného pole programu. 

 

4.   Klikněte  , čímž uzavřete dialogové okno Document Information. 
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Lekce 5: Používání kontextových nabídek 

 
 

   Přehled V programu SDS je možné používat kontextové nabídky, které umožňují rychlý 
přístup k příkazům dostupným v daném zobrazení nebo panelu. 

 

Chcete-li otevřít kontextovou nabídku, přesuňte kurzor nad panel nebo zvolené 
zobrazení a klikněte pravým tlačítkem myši. V místě kurzoru se zobrazí kontextová 
nabídka. 

 
 
 
 
 
 
 
 

Kontextová nabídka 
 
 
 
 
 
 
 

Obrázek 2-7   Kontextová nabídka programu SDS 
 
 

Následující příkazy jsou součástí všech kontextových nabídek: 
 

Tabulka 2-4 Standardní příkazy kontextových nabídek 
 

 
Příkaz 

 
Výsledek 

 
Viz strana 

Hide (Skrýt)  
<panel nebo graf> 

Skryje panel nebo zobrazení. 2-20 

Save <panel nebo graf> 
to Image File 
(Uložit jako obrázek) 

Otevře dialogové okno Export Graphic (Uložit jako obrázek) 
pro export zvoleného zobrazení nebo panelu ve formátu 
JPEG. 

A-16 

Display Settings 
(Nastavení zobrazení) 

Otevře dialogové okno Display Settings (Nastavení 
zobrazení), v němž je možné upravit vzhled panelů nebo 
grafů. 

3-22 

 
 
Lekce 6: Používání klávesových zkratek 

 
 

Cvičení: 
Zavření 

dokumentu 
destičky 

Ovládání hlavních funkcí programu SDS je možné pomocí klávesových zkratek. 
Klávesová zkratka je kombinace dvou kláves (Ctrl a další klávesy), které, jsou-li 
stisknuty současně, vedou k provedení určité akce. Seznam klávesových zkratek je 
součástí každé nabídky v hlavní liště. 
 

Zavřete otevřený dokument destičky pomocí klávesové zkratky podle následujícího 
postupu: 
 

1.   Stiskněte současně klávesy Ctrl a W (Ctrl+W). 
 

2.   Až se program zeptá, chcete-li uložit dokument destičky, klikněte  (Ne). 
 

Poznámka:  Součástí nápovědy programu SDS je úplný výčet klávesových zkratek 
používaných v programu. Chcete-li tento výčet zobrazit, otevřete nápovědu podle 
postupu “Používání nápovědy programu SDS” na straně 2-3. 
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Používání dokumentů destiček 
 
 

Používání 
několika 

dokumentů 
destiček 

Ačkoliv program SDS umožňuje pracovat s několika dokumenty destiček najednou, 
s každým dalším otevřeným dokumentem destičky klesá rychlost práce. Z tohoto 
důvodu doporučuje společnost Applied Biosystems, abyste neotvírali více než deset 
dokumentů destiček. 

 
Součásti 

dokumentu 
destičky 

Obrázek 2-8 znázorňuje typický dokument destičky a jeho součásti, popsané na 
následujících stránkách.

 
Zobrazení destičky 

(viz níže) 
 

 
Záložky 
(strana 2-29) 

 
 
 
 
 
 
 
 
 
 
 

Prohlížeč jamek 
(Well inspector - 
strana 2-30) 

 
 
 
 
 
 
 
 
 

Tabulka 
(strana 2-28) 

 
Obrázek 2-8  Součásti dokumentu destičky 

 
 

Zobrazení destičky Buňky zobrazené destičky odpovídají jamkám mikrodestičky. Informace v buňkách 
jsou zobrazeny podle typu dokumentu destičky. V Nastavení zobrazení (Display 
settings) je možné upravit obsah a vzhled údajů v buňkách. 

 

Poznámka:  Více informací o změně parametrů zobrazení destičky získáte po 
kliknutí na ikonu  (nápověda). 

 
      Tabulka V tabulce je zobrazováno zadání a výsledky analýzy dokumentu destičky. Tabulku je 

možné exportovat ve formě textového souboru (tabelátorem oddělená data 
kompatibilní s tabulkovým editorem – více informací viz Příloha A “Související 
programy”). 
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Používání dokumentů destiček 
 
 

Záložky V dokumentech destiček může být až šest záložek (v závislosti na jejich funkci) jak 
je popsáno níže: 

 
Tabulka 2-5 Záložky programu SDS 

 
Záložka Funkce Zobrazení/Grafy 

 
Setup Zobrazí informace o jamkách a 

       (Zadání)           umožňuje zadávat údaje. 
Prohlížeč jamek  
(Well Inspector)

 
 

Instrument Používá se k programování teplotního  
  (Přístroj)          profilu, ke spuštění běhu nebo k zařazení 

 běhu do řady. 

•   Method Editor (Nastavení 
  metody) 

–  Záložka Thermal Profile  

–  Záložka Auto Increment  

–  Záložka Ramp Rate  

–  Záložka Data Collection  

•   Záložka Real-Time  

•   Záložka Plate-Read  
 

Graf Raw 
Data Plot 
(Hrubá data) 

Zobrazí naměřenou fluorescenci (před 
analýzou). 
Data jsou zobrazena pouze v dokumen-
tech destičky, které byly spuštěny. 

Chcete-li je zobrazit, otevřete spuštěný do-
kument destičky, klikněte  a zvolte 
záložku Raw Data Plot. 

Hrubá data 

 
Calibration 
Data 
(Kalibrační 
data) 

Zobrazí výsledky kalibrace pozadí 
(Background) a barev (Pure Spectra), 
používaných pro normalizaci a 
multikomponentní analýzu hrubých dat. 
 

Data jsou zobrazena pouze v dokumen-
tech destičky, které byly spuštěny. 

Chcete-li je zobrazit, otevřete spuštěný do-
kument destičky, klikněte  a zvolte 
záložku Calibration Data. 

Kalibrační data 

•   Pozadí (Background Plot) 

•   Barvy (Pure Dyes Plot) 

 
Results Zobrazí výsledky běhu po analýze. 

       (Výsledky) 

Záložka Analysis (Analýza) je zobrazena 
pouze v dokumentech destičky, které byly 
analyzovány. 

Alelická diskriminace 

•   graf alelické diskriminace  

Absolutní kvantifikace 

•   amplifikační graf 

•   standardní křivka 

Relativní kvantifikace 

•   amplifikační graf 
 

Disociační 
křivka 

Zobrazí výsledky analýzy disociační křivky. 
Záložka je zobrazena pouze v dokumen-
tech destičky, které byly analyzovány a 
pochází z běhu monitorovaného v reál-
ném čase, v němž byla disociační křivka 
provedena. 

Disociační graf 
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Kapitola 2    Začínáme 
 
 

Prohlížeč jamek Prohlížeč jamek (Well Inspector – obrázek 2-9) slouží k zadání údajů (detektoru a 
údajů o vzorku) do jamek a k zobrazení informací ze zvolených jamek v zobrazení 
destičky. 

 
 
 

Název vzorku 
 

 
 

Seznam detektorů 
 
 
 

Rozbalovací menu Pasivní reference 
 
 

Okénko Omit Well (Vynechat jamku) 
 

Obrázek 2-9  Součásti prohlížeče jamek 
 
 

•   Sample Name (Název vzorku) – V tomto poli (lze jej upravit) se zobrazuje 
název vzorku ve zvolené jamce/jamkách 

 

Poznámka:  V poli se zobrazí *Mixed* (Smíšené) byly-li zvoleny jamky 
s rozdílnými názvy vzorků. 

 

•   Detector list (Seznam detektorů) – Seznam všech detektorů, které jsou součástí 
     dokumentu destičky. 

•   Omit Well (Vynechat jamku) – Je-li toto okénko zatrženo, data získaná měřením 
této jamky jsou vynechána při všech analýzách, které program provádí. 

•   Passive Reference (Pasivní reference) – Zobrazuje fluorescenční barvy 
používané jako pasivní reference. 
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Kapitola 3    Příprava běhu 
 
 

Poznámky pro uživatele databáze 
 
 

Dodatečné úkony Používáte-li databázi SDS Enterprise pro ukládání dokumentů SDS, studií a dat, je 
možné, že v průběhu tohoto cvičení budete muset provést nějaké dodatečné úkony. 
Níže jsou tyto úkony popsány (nutnost jejich provedení závisí na tom, jak správce 
provedl nastavení databáze). Více informací o úkonech popsaných níže naleznete 
v příručce SDS Enterprise Database Administration Guide. 

 

 
Dialogové okno 
Reason(s) For 

Change 

Dialogové okno Reason(s) for Change (Důvod/y změny) se objevuje pouze v případě, 
je-li databáze SDS Enterprise nastavena tak, že vyžaduje zdůvodnění prováděných 
kroků (tzv. Audit). Systém auditu sleduje vytváření, změny a mazání dat v databázi. 
 

Objeví-li se dialogové okno Reasons for Change, proveďte jeden z následujících 
kroků: 

• Zvolte důvod změny z rozbalovací nabídky a poté klikněte na ikonu .
• Zadejte důvod změny do příslušného pole a poté klikněte na ikonu .

 
 

Rozbalovací nabídka 
důvodů změny 

 
Přednastavené důvody 

 
 
 
 

Popis vlastního důvodu 
 
 

Obrázek 3-1   Dialogové okno Reasons for Change (Důvod/y změny) 
 
 

Dialogové 
okno 

Electronic 
Signature 

Dialogové okno Electronic Signature (Elektronický podpis) se objevuje pouze 
v případě, je-li databáze SDS Enterprise nastavena tak, že vyžaduje elektronický 
podpis. Systém elektronického podpisu omezuje a sleduje přístup uživatelů k datům 
v databázi. 
 

Objeví-li se toto dialogové okno: 
 

1.   Do pole User ID (Jméno) a Password (Heslo) zadejte vaše uživatelské jméno a 
heslo a potvrďte . 

 

2.   Program následně zobrazí zprávu o úspěšném či neúspěšném použití 
elektronického podpisu. Pro pokračování klikněte . 

 
 
 
 

 Popis kroku, který vyžaduje  
 elektronický podpis 

 
 Uživatelské jméno 

 
 Heslo 

 
 
 

Obrázek 3-2   Dialogové okno Elektronický podpis 
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Dříve než začnete 
 
 

Dříve než začnete 
 
 

Přehled V kapitolách 5 “Analýza esejí typu End-point” a 6 “Analýza výsledků Real-Time 
PCR” jsou stručně popsány experimenty, které můžete na přístroji 7900HT 
provádět. Před zahájením se můžete chtít seznámit s částmi těchto kapitol, které se 
týkají vámi prováděného experimentu: 
 

Alelická diskriminace ......................................................................................... 5-5 
Absolutní kvantifikace........................................................................................ 6-5 
Relativní kvantifikace ....................................................................................... 6-15 
Analýza disociační křivky................................................................................. 6-37 

 
Získání informací 

v nápovědě 
Součástí programu SDS je i nápověda, která vás provede přípravou, provedením a 
analýzou experimentu. Nápovědu získáte kliknutím na ikonu  v dialogovém okně, 
ve kterém pracujete. 

 
Zpracování 

velkého počtu 
vzorků s analýzou 

výsledků po 
skončení běhu 

Při provádění aplikací se sběrem dat po skončení běhu (jako je alelická 
diskriminace) je možné zvýšit počet zpracovávaných vzorků tak, že použijete 
přístroj ABI PRISM®  7900HT a několik teplotních cyklerů. Na rozdíl od 
experimentů se sběrem dat v reálném čase je sběr dat prováděn až po 
skončení běhu. Proto je možné provést běh s destičkou kdekoliv a analyzovat 
ji na přístroji 7900HT po jeho skončení. 
 

DŮLEŽITÉ!  Chcete-li provést teplotní cyklování a odečet dat na přístroji 7900HT, 
proveďte nejprve běh se sběrem dat v reálném čase a následně druhý běh – alelickou 
diskriminaci (více informací viz “Krok 5 – Programování běhu” na straně 3-17). 
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Kapitola 3    Příprava běhu 
 
 

Přehled 
 
 

Experimenty/ 
Běhy prováděné 

na přístroji 
7900HT 

 

Absolutní kvantifikace ............................................................................................. 3-4 
Alelická diskriminace............................................................................................... 3-6 
Pozadí ..................................................................................................................... 7-16 
Disociační křivka (Křivka tání) ................................................................................ 3-5 
Kalibrace barev (Spektrální kalibrace)................................................................... 7-20 
Relativní kvantifikace............................................................................................... 3-5 
Ověřovací běh s destičkou RNáza P....................................................................... 7-30 

 
Absolutní 

kvantifikace 
 
1.  Vytvořte dokument absolutní kvantifikace (viz strana 3-8). 
 
 
2.  Přidejte detektory do dokumentu destičky: 

a.  Vytvořte detektory pro sondy pro absolutní kvantifikaci (viz strana 3-9).  
b.  Kopírujte detektory do dokumentu destičky (viz strana 3-11). 

 
 
3.  Nastavte úlohu detektorů a množství: 

a.  Nastavte úlohu detektorů v dokumentu destičky (NTC, Standard a  
Neznámá) (viz strana 3-14). 

b.  Definujte množství pro všechny jamky destičky obsahující standardy 
(viz strana 3-15). 

 
 
4.  Nastavte teplotní profil absolutní kvantifikace (viz strana 3-17). 
 
 
5.  Provádíte-li experiment, jehož součástí je i disociační křivka, definujte teplotní 

parametry analýzy disociační křivky (viz strana 3-21). 
 
 
 
6.  Zvolte jednu z možností: 

–   Provádíte-li běh s jednou destičkou, pokračujte krokem 2. 
–   Provádíte-li běh první destičky série destiček o totožné konfiguraci, uložte 
     dokument destičky jako templát (viz strana 3-22). 

 
 
7.  Vytvořte dokument destičky z templátu vytvořeného v kroku 2 (viz strana 3-24). 
 
 
8.  Zadejte názvy vzorků a informace o destičce (viz strana 3-25). 
 
 
 
9.  Připravte destičku/y  a proveďte běh absolutní kvantifikace (viz strana 4-1). 
 
 
10.Analyzujte výsledky běhu (viz strana 6-5). 
 

 
*Kroky 2 a 2 lze vynechat tím, že importujete zadání dokumentu destičky ze souboru. 

Více informací viz “Import zadání dokumentu destičky” na straně A-2. 
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Přehled    
 
 

Relativní 
kvantifikace 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Disociační křivka 
(Křivka tání) 

 

 
1.  Vytvořte dokument relativní kvantifikace (viz strana 3-8). 

 
 
 

2.  Přidejte detektory do dokumentu destičky: 
a.  Vytvořte detektory pro sondy pro relativní kvantifikaci (viz strana 3-9).  
b.  Kopírujte detektory do dokumentu destičky (viz strana 3-11). 

 

 
 

  3.  * Nastavte úlohu detektorů v dokumentu destičky (NTC a Neznámá)  
         (viz strana 3-14). 

 
 
 

4.  * Nastavte teplotní profil relativní kvantifikace (viz strana 3-17). 
 
 
 

5.  Zvolte jednu z možností: 
–   Provádíte-li běh s jednou destičkou, pokračujte krokem 2. 
–   Provádíte-li běh první destičky série destiček o totožné konfiguraci, uložte 
     dokument destičky jako templát (viz strana 3-22). 

 
 
 

6.  Vytvořte dokument destičky z templátu vytvořeného v kroku 2 (viz strana 3-24). 
 
 
 

7.  Zadejte názvy vzorků a informace o destičce (viz strana 3-25). 
 
 
 
 

8.  Připravte destičku/y  a proveďte běh relativní kvantifikace (viz strana 4-1). 
 
 
 

9.  Analyzujte výsledky běhu (viz strana 6-15). 
 
 

* Kroky 2 a 2 lze vynechat tím, že importujete zadání dokumentu destičky ze souboru. 
Více informací viz “Import zadání dokumentu destičky” na straně A-2. 

 
 
V programu SDS je možné provést analýzu disociační křivky jako součást běhu 
absolutní kvantifikace. Proto chcete-li provést analýzu disociační křivky, definujte 
dokument destičky pro absolutní kvantifikaci podle postupu na straně 3-4 a zadejte 
provedení analýzy disociační křivky podle postupu na straně 3-21. 
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 Kapitola 3    Příprava běhu 
 
 

Alelická 
diskriminace 

 

 
1.  Vytvořte dokument alelické diskriminace (viz strana 3-8). 
 
 
 
2.  Přidejte markery do dokumentu destičky: 

a.  Vytvořte detektory pro sondy pro alelickou diskriminaci (viz strana 3-9). 

b.  Pro každý pár sond pro alelickou diskriminaci vytvořte marker (strana 3-12).  
c.  Kopírujte marker(y) do dokumentu destičky (viz strana 3-13). 

 

 
 
3.  Nastavte úlohu detektorů v dokumentu destičky (NTC a Neznámá) (viz strana 

3-14). 
 
 
 
4.  Chcete-li provést cyklování destičky alelické diskriminace na přístroji 7900HT, 

vytvořte dokument se sběrem dat v reálném čase a nastavte teplotní profil. 
Jinak pokračujte krokem 2 (viz strana 3-17). 

 
 
 
 
5.  Zvolte jednu z možností: 

–   Provádíte-li běh s jednou destičkou, pokračujte krokem 2. 
–   Provádíte-li běh první destičky série destiček o totožné konfiguraci, uložte 
     dokument destičky jako templát (viz strana 3-22). 

 
 
 
6.  Vytvořte dokument destičky z templátu vytvořeného v kroku 2 (viz strana 3-24). 
 
 
 
7.  Zadejte názvy vzorků a informace o destičce 

(viz strana 3-25). 

a.  Připravte destičku/y alelické diskriminace a proveďte jejich cyklování na 
teplotním cykleru (viz strana 4-1). 

b.  Spusťte destičku/y na přístroji 7900HT. 
 
 
 
8.  Analyzujte výsledky běhu (viz strana 5-5). 
 
 
 

* Kroky 2 a 2 lze vynechat tím, že importujete zadání dokumentu destičky ze souboru. 
   Více informací viz “Import zadání dokumentu destičky” na straně A-2. 
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Rychlé opakování: Zapnutí přístroje 7900HT    
 
 

Rychlé opakování: Zapnutí přístroje 7900HT 
 
 

Zapnutí 
přístroje 

Poznámka:  Níže je uveden zkrácený popis zapínání součástí přístroje ABI PRISM 

7900HT. Zevrubný popis naleznete v části “Zapnutí přístroje7900HT” na straně 2-4. 
 

DŮLEŽITÉ!  Nezapínejte přístroj 7900HT, pokud jste odstranili boční spodní kryt. 
Pokud to učiníte, nebude do přístroje z počítače nahrán firmware a objeví se chybová 
hláška. 
 

1.   Zapněte monitor a počítač. 
 

2.   Zapněte podavač mikrodestiček Zymark Twister®  , pokud je součástí vašeho 
      systému. 

 

 
 
 
 

HI-
POT 

A B C D 

Vypínač 

 
(Zadní panel podavače) 

 
3.   Zapněte přístroj 7900HT. 

 
 
 
 
 
 

Vypínač 
 
 
 
 

4.   Spusťte program SDS 2.2 (zvolte >  Programs > 
 Applied Biosystems >  SDS 2.2 > SDS 2.2) 

 

5.   (pouze pro databázi) V okně Login (Přihlášení) zadejte vaše uživatelské jméno a 
heslo a potvrďte  . 

 

 

 
 

Zobrazí se hlavní okno programu. 
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Krok 1 – Vytvoření dokumentu destičky 
 

Přístupová 
práva 

Používáte-li databázi SDS Enterprise, musíte mít pro vytváření dokumentu destičky 
práva uživatele třídy Scientist (Vědec) nebo Administrator (Správce). 

 
O dokumentu 

destičky 
Každá destička analyzovaná na přístroji ABI PRISM 7900HT vyžaduje vytvoření 
dokumentu destičky v programu SDS. Dokument destičky je virtuální záznam 
mikrodestičky nebo jiného typu spotřebního materiálu se vzorky (ABI PRISM®  384/96-ti 
jamková destička nebo AB Mikrofluidní karta). 
 

Dokumenty destiček obsahují tyto údaje: 
 

•   Informace o detektorech a jejich uspořádání v destičce 
•   Informace o markerech a jejich uspořádání v destičce (pouze alelická diskriminace) 
•   Informace o vzorcích a jejich uspořádání v destičce 
•   Teplotní profil experimentu (absolutní a relativní kvantifikace) 

 
Vytvoření 

dokumentu 
destičky 

1.   Pokud není ještě spuštěn, spusťte program SDS podle postupu na straně 3-7. 
 

2.   Klikněte  nebo zvolte File > New (Soubor > Nový). 

3.   V dialogovém okně New Document (Nový dokument) zvolte: 
•   Rozbalovací nabídka Assay (Esej) – Zvolte esej pro vaši destičku. 
•   Rozbalovací nabídka Container (Destička) – Zvolte typ spotřebního 
     materiálu, který zamýšlíte použít. 
•   Rozbalovací nabídka Template (Templát) – Zvolte Blank Template 
    (Žádný templát). 
•   V poli Barcode (Čárový kód) – proveďte jeden z kroků: 

Vytváříte-li: 
– Dokument destičky pro spuštění jedné destičky, naskenujte nebo zadejte 
   čárový kód destičky. 
– Templát pro zadání více destiček, ponechte toto pole prázdné. 

 

DŮLEŽITÉ!  V databázi SDS Enterprise není možné vytvořit dva dokumenty 
destiček pro různé typy běhů s týmž čárovým kódem. 

 

Poznámka:  Provádíte-li analýzu disociační křivky, zvolte v rozbalovací nabídce 
Assay (Esej) možnost Absolute Quantification (Absolutní kvantifikace). 

 

 
Rozbalovací nabídka Assay (Esej) 

 
Rozbalovací nabídka Container 
(Destička) 
Rozbalovací nabídka Template (Templát) 

 
 
 

Pole Barcode (Čárový kód) 
 

 
 
 

4.   Klikněte  . 
 

5.   Vytvořte a kopírujte detektory (a markery) do nového dokumentu destičky podle 
      popisu v kroku 2 “Přidání detektorů a markerů” na straně 3-9. 
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Krok 2 – Přidání detektorů a markerů 
 
. 
 

Vytváření 
detektorů 

Před tím než můžete použít dokument destičky ke spuštění běhu, musíte definovat 
jaké detektory (a případně markery, provádíte-li alelickou diskriminaci) budou 
v daném experimentu používány. Detektor je virtuálně vyjádřená genově specifická 
kombinace primerů a TaqMan® sondy, které jsou používány v dané eseji, nebo 
kombinace primerů za současného použití barviva SYBR®  Green 1 (používá se pro 
detekci dvouřetězcové DNA). Před použitím dokumentu destičky musíte vytvořit a 
přidat detektory pro všechny eseje na destičce. 
 

1.   Zvolte Tools > Detector Manager (Nástroje > Správce detektorů). 
 

2.   V dialogovém okně Detector Manager klikněte  (Nový).  
 

3.   V dialogovém okně Add Detector (Přidat detektor) zadejte: 
•   Name (Název) – Zadejte název detektoru. 

Název detektoru musí být jedinečný a měl by odkazovat na cílový lokus 
dané eseje (např. GAPDH nebo RNaza P). Nepoužívejte totéž jméno pro 
více než jeden detektor. Program SDS nerozlišuje mezi detektory stejného 
jména, i když používají odlišné barvy. 

•   Group (Skupina) – (nepovinné) Zadejte nebo zvolte skupinu, do které 
     detektor patří. 
•   Description (Popis) – (nepovinné) Zadejte stručný popis eseje 

(max. 32 znaků). 
•   Reporter/Quencher (Reportér a zhášeč)– Zvolte reportérovou barvu a 

zhášeč podle vaší sondy. 
Vytváříte-li detektor pro esej používající barvivo SYBR Green 1, zvolte 
zhášeč nefluorescenční (Quencher Dye - Non Fluorescent). 
Používáte-li vlastní barvu, která není dodávána společností Applied 
Biosystems, musíte před jejím použitím provést kalibraci přístroje pro tuto 
barvu (viz “Přidání vlastních barev” na straně 7-27). 

•   Color (Barva)  – (nepovinné) Kliknutím na čtvereček zvolte barvu 
     detektoru a potvrďte   . 
•   Notes (Poznámky) – (nepovinné) Zadejte libovolný komentář k detektoru 

(max. 200 znaků). 
 
 

Název 
Skupina 
Popis 

 

Reportér/Zhášeč 
 

Barva 
 

Poznámky 
 

 
Datum vytvoření (created) 
a poslední změny (last 
modified)  
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Detektor alelické diskriminace 

 
Detektor absolutní nebo 

relativní kvantifikace 
 

4.   Klikněte  . 

Program uloží nový detektor a zobrazí jej v seznamu detektorů. 
 

Poznámka:  Používáte-li databázi SDS Enterprise, nemůžete vytvořit 
detektor používající kombinaci téhož názvu, reportérové barvy a zhášeče jako 
existující detektor. 

 

 

 
 

5.   Opakujte kroky 2 až 4, až vytvoříte detektory pro všechny eseje na destičce. 
 

Poznámka:  Kliknutím na ikonu  otevřete nápovědu s informacemi o správci 
detektorů a s popisem postupů změny, mazání nebo vyhledávání detektorů. 

 

6.   Zvolte jednu z možností: 
 

 

Vytváříte-li dokument destičky  
pro … 

 
Pak… 

•   absolutní kvantifikaci 

•   relativní kvantifikaci 
•   analýzu disociační křivky  

kopírujte detektor(y) do dokumentu destičky 
podle postupu na straně 3-11. 

alelickou diskriminaci vytvořte a přidejte do dokumentu destičky 
markery podle popisu na straně 3-12. 
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Políčko Use (Použít) 

 
 

Kopírování a 
přidání detektorů 

do dokumentu 
destičky  

DŮLEŽITÉ!  Jakmile zkopírujete detektor do dokumentu destičky, není tento detektor 
nijak propojen se záznamem ve správci detektorů. Změníte-li tedy detektor ve správci 
detektorů poté, co jste jej kopírovali do dokumentu destičky, musíte jej z dokumentu 
destičky odstranit a kopírovat znovu, aby se tato změna v dokumentu destičky 
projevila. 
 

1.   V dialogovém okně Detector Manager (Správce detektorů) programu SDS 
kopírujte detektory do dokumentu destičky: 

a.  Přidržte klávesu Ctrl a zvolte detektory, které chcete přidat do dokumentu 
destičky. Zvolené detektory budou zvýrazněny.  

b.  Klikněte  (Kopírovat do dokumentu destičky). 

Program přidá detektory do Prohlížeče jamek (Well Inspector) dokumentu 
destičky. 

 

 
Dokument destičky 

 
Zkopírovaný 
detektor 

 
 
 

Správce detektorů 
 
 
 
 

Detektor vybraný 
ke kopírování 

 

 
2.   Klikněte  (Hotovo), čímž správce detektorů uzavřete. 

 

3.   Ve schématu destičky zvolte jamky obsahující esej pro první detektor. 
 

Poznámka:  Výběr jamek je snazší za pomoci kláves Ctrl a Shift, které 
umožňují vybrat jednotlivé jamky nebo jejich skupiny. Více informací viz 
strana 2-22. 

 

4.   Přidejte detektory do zvolených jamek tak, že zatrhnete políčko detektoru ve 
      sloupci Use (Použít) v prohlížeči jamek (well inspector). 

 
 
 

 
Detektory přidané  

do zvolených jamek 
dokumentu destičky 

 

 
 
 
 
 
 
 

5.   Opakujte kroky 3 až 4, až přidáte do schématu destičky i ostatní detektory. 
 

6.   Nastavte úlohy detektorů v dokumentu destičky podle postupu v části 
“Krok 3 – Nastavení úlohy detektorů” na straně 3-14. 
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Vytvoření 
markerů pro 

alelickou 
diskriminaci 

Součástí dokumentů destičky pro alelickou diskriminaci jsou tzv. ‘markery’, 
jejichž účelem je snazší organizace a používání detektorů. Marker je dvojice 
detektorů, představujících dvě eseje, zacílené na dvě různé alely téhož lokusu.  
 

DŮLEŽITÉ!  Dokumenty destiček pro alelickou diskriminaci musí obsahovat 
alespoň jeden marker. 
 

1.   Je-li otevřen Správce detektorů (Detector Manager), klikněte na  , čímž jej 
      zavřete. 

 

2.   Zvolte Tools > Marker Manager (Nástroje > Správce markerů). 
 

3.   V dialogovém okně Marker Manager klikněte  (Nový). 
 

4.   V poli Enter name of new Marker (Zadejte název nového markeru) zadejte 
název nového markeru a klikněte  . 

Nový marker se zobrazí v poli Markers (Markery). 
 

Poznámka:  Používáte-li databázi SDS Enterprise, nemůžete vytvořit 
marker, který používá kombinaci téhož názvu a detektorů jako existující 
marker. 

 

5.   Přidejte do nového markeru detektory: 

a.  V poli Markers (Markery) zvolte kliknutím nový marker. Zvolený marker 
     bude zvýrazněn. 

 

b.  V seznamu detektorů zatrhněte políčko Use (Použít) u detektorů, které 
mají být součástí markeru. Zvolený detektor bude zvýrazněn. 

 

DŮLEŽITÉ!  V jednom markeru není možné použít více než dva detektory a ty 
nesmí používat tutéž reportérovou barvu. 

 
 

Detektory v markeru 
‘CYP 2C9*2’ 

 
 
 
 
 
 
 
 
 
 

6.   Pracujete-li s více esejemi pro alelickou diskriminaci, opakujte kroky 3 až 5, až 
      vytvoříte všechny potřebné markery. 

 

DŮLEŽITÉ!  Před přidáním markeru do dokumentu destičky do něj musíte přidat 
dva detektory. 

 

Poznámka:  Kliknutím na ikonu  otevřete nápovědu s informacemi o správci 
markerů nebo o mazání markerů ze seznamu. 

 

7.   Přidejte marker(y) do dokumentu destičky pro alelickou diskriminaci podle 
      postupu v části “Kopírování a přidání markerů” na straně 3-13. 
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Kopírování a 
přidání markerů 

DŮLEŽITÉ!  Jakmile zkopírujete marker do dokumentu destičky, není tento marker 
nijak propojen se záznamem ve správci markerů. Změníte-li tedy marker ve správci 
markerů poté, co jste jej kopírovali do dokumentu destičky, musíte jej z dokumentu 
destičky odstranit a kopírovat znovu, aby se tato změna v dokumentu destičky 
projevila. 
 

1.   V dialogovém okně Marker Manager (Správce markerů) programu SDS 
kopírujte marker do dokumentu destičky: 

a.  Přidržte klávesu Ctrl a zvolte marker(y), které chcete přidat do dokumentu 
destičky.. 

b.  Klikněte  (Kopírovat do dokumentu destičky) 

c.  V dialogovém okně Copy Markers To Plate (Kopírovat markery do 
     destičky) klikněte . 

 
 
 

Markery kopírované do 
dokumentu destičky 

 
 
 

d.  Opakujte kroky a a c, čímž zkopírujete další markery do dokumentu 
     destičky alelické diskriminace. 

 

2.   Klikněte  (Hotovo), čímž správce markerů uzavřete. 
 

3.   Ve schématu destičky zvolte jamky obsahující esej pro marker, který jste 
předešle definovali. 

 

Poznámka:  Výběr jamek je snazší za pomoci kláves Ctrl a Shift, které 
umožňují vybrat jednotlivé jamky nebo jejich skupiny. Více informací viz 
strana 2-22. 

 

4.   Přidejte markery do zvolených jamek tak, že zatrhnete políčko markeru ve 
sloupci Use (Použít) v prohlížeči jamek (well inspector). 

 

Poznámka:  Detektory, které jsou součástí markeru, jsou přidány do jamek 
automaticky, jakmile je přidán marker. 

 
 
 

 
‘PDAR CYP 2C9*2’ 

přidán do zvolených 
jamek dokumentu 

destičky 

Detektory pro marker  
‘PDAR CYP 2C9*2’ 
 
 

 
 
Políčko Use (Použít) 
pro marker 
‘PDAR CYP 2C9*2’ 
(zvolen) 

 
 
 
 
 
 

5.   Opakujte kroky 3 a 4, až přidáte do schématu destičky i ostatní markery. 
 

6.   Nastavte úlohy detektorů v dokumentu destičky podle postupu v části 
“Krok 3 – Nastavení úlohy detektorů” na straně 3-14. 
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Krok 3 – Nastavení úlohy detektorů 
 
 

Přístupová 
práva 

Používáte-li databázi SDS Enterprise, musíte mít pro nastavení a změnu úlohy 
detektorů práva uživatele třídy Scientist (Vědec) nebo Administrator (Správce). 

 
O úlohách 
detektorů 

Pro každý detektor nebo marker použitý v jamkách dokumentu destičky musíte 
definovat jeho úlohu (‘task’). Úloha udává specifický účel nebo funkci daného 
detektoru nebo markeru v destičce. Program SDS používá úlohy detektorů k definici 
toho, jakým způsobem  zpracovávat data z jednotlivých jamek během analýzy. Úlohy 
detektorů se mění v závislosti na typu dokumentu destičky. 

 
Nastavení úlohy 

detektorů 
1.   Pomocí kláves Ctrl a Shift zvolte jamky ve schématu destičky, obsahující 
      vzorky s danou úlohou, jak je popsáno níže. 

 
Tabulka  3-1 Úlohy detektorů v programu SDS 

 
Experiment Úloha Použití pro… 

 
Alelická 

diskriminace 
Unknown všechny detektory jamek obsahujících PCR 

  (Neznámá)      reagencie a neznámé vzorky. 
 

NTC všechny detektory jamek s negativními kontrolami, 
které obsahují PCR reagencie ale ne templát. 

 
Absolutní 

   kvantifikace 
Unknown všechny detektory jamek obsahujících PCR  
(Neznámá)      reagencie a kvantifikované vzorky. 
 
Standard detektory jamek obsahujících PCR reagencie a 

vzorky o známém množství. (Více informací viz 
strana 3-15.) 

 
 NTC všechny detektory jamek s negativními kontrolami, 

které obsahují PCR reagencie ale ne templát. 
 

Relativní 
  kvantifikace 

Target všechny detektory jamek obsahujících PCR  
(Cíl)    reagencie pro amplifikaci cílových sekvencí. 

 
  Endogenní  

kontrola 
všechny detektory jamek obsahujících PCR  
reagencie pro amplifikaci endogenní kontroly. 

 
 

2.   V prohlížeči jamek klikněte u každého detektoru do pole ve sloupci Task 
(Úloha) a zvolte odpovídající úlohu z rozbalovací nabídky. Úloha se zobrazí ve 
všech vybraných jamkách. 

 
 
 

Zvolené jamky  Rozbalovací nabídka Task 
(Úloha) 
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3.   Opakujte kroky 1 a 2, až definujete všechny úlohy detektorů. 
 

4.   Zvolte jednu z možností: 
 

 

Vytváříte-li dokument 
destičky pro … 

 
Pak… 

absolutní kvantifikaci definujte množství jednotlivých standardů použitých 
v destičce podle postupu níže. 

•   alelickou diskriminaci 

•   relativní kvantifikaci 
•   analýzu disociační křivky 

•   Je-li to nezbytné, definujte pasivní referenci pro 
dokument destičky podle postupu na straně 3-16. 

•   Jinak nastavte teplotní profil podle postupu na 
straně 3-17. 

 
Definice 

standardů pro 
absolutní 

kvantifikaci 

Aby mohl program SDS vytvořit standardní křivku pro kvantifikaci neznámých 
vzorků, musíte definovat úlohu detektoru typu Standard a zadat množství jednotlivých 
standardů do dokumentu destičky absolutní kvantifikace. 
 

1.   Ve schématu destičky v programu SDS zvolte jamky obsahující první ředění 
standardu. 

 

2.   V prohlížeči jamek klikněte u příslušného detektoru do pole ve sloupci Task 
(Úloha) a z rozbalovací nabídky zvolte Standard. 

 

3.   V prohlížeči jamek klikněte u příslušného detektoru do pole ve sloupci Quantity 
(Množství) a zadejte množství nebo koncentraci standardu ve zvolených 
jednotkách (výchozí počet kopií, pikogramy, nanogramy, atd.) a stiskněte Enter. 

Zadané množství se zobrazí ve zvolených jamkách. 
 
 
 
 
 
 
 
 

Zvolené jamky 
 

 
Množství 

 

 
 
 
 

4.   Opakujte kroky 1 až 3 až zadáte množství i pro ostatní ředění standardu. 
 

Po skončení této činnosti by se ve schématu destičky ve všech replikátech 
standardu mělo zobrazovat označení Standard a definované množství, které 
program následně použije pro výpočet standardní křivky. 

 

5.   Proveďte jeden z následujících kroků: 
•   Je-li to nezbytné, definujte pasivní referenci pro dokument destičky podle 
     postupu v části 

“Krok 4 – Nastavení pasivní reference a vynechání jamek” na straně 3-16. 
•   Jinak nastavte teplotní profil podle postupu v části  

“Krok 5 – Programování běhu” na straně 3-17. 
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Krok 4 – Nastavení pasivní reference a vynechání jamek 
 
 

Přístupová 
práva 

Používáte-li databázi SDS Enterprise, musíte mít pro změnu pasivní reference nebo 
vynechání jamek práva uživatele třídy Scientist (Vědec) nebo Administrator (Správce). 

 
Nastavení 

pasivní 
reference 

Používáte-li kity a mixy společnosti Applied Biosystems, použijte přednastavenou 
pasivní referenci (společnost Applied Biosystems používá pasivní referenci ROX™ ). 
Používáte-li vlastní reagencie, zvolte pasivní referenci, kterou chcete použít. 
 

Poznámka:  Společnost Applied Biosystems doporučuje používat pasivní referenci 
k normalizaci signálu reportérové barvy (více informací viz strana D-6). 
 

1.   V rozbalovací nabídce Passive Reference (Pasivní reference) zvolte barvu. 
 

 
 
 
 
 
 

Rozbalovací nabídka pasivní 
reference 

 
Zvolte pasivní 
referenci 

 

 
 
 
 
 

2.   Je-li to nezbytné, vynechejte jamky podle postupu níže. Jinak nastavte teplotní 
      profil podle postupu na straně 3-17. 

 
Vynechání 

jamek 
Program SDS umožňuje vynechat (nepoužívat) určité jamky před nebo po provedení 
běhu. 
 

DŮLEŽITÉ!  Vynecháte-li určité jamky před provedením běhu, program SDS 
nebude během běhu odečítat data z těchto jamek. Pokud vynecháte jamky po 
provedení běhu, bude jamka vynechána z analýzy, ale data nebudou vymazána. 
 

1.   Stiskněte klávesu Ctrl a zvolte ve schématu destičky jamky, které chcete 
vynechat. 

 

2.   V prohlížeči jamek v záložce Setup (Zadání) klikněte do políčka Omit Well(s) 
      (Vynechat jamku/y). 

 
 

Zvolené jamky 
        (nepoužívané) 

 
Políčko Omit Well(s) (Vynechat jamku/y) 
(zatržené) 

 
 
 
 
 
 

3.   Nastavte teplotní profil podle postupu na straně 3-17. 
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Krok 5 – Programování běhu 
 
 

Přístupová 
práva 

Používáte-li databázi SDS Enterprise, musíte mít pro nastavení teplotního profilu 
práva uživatele třídy Scientist (Vědec) nebo Administrator (Správce). 

 
O programování 

běhu 
V průběhu běhu je činnost přístroje kontrolována z programu SDS prostřednictvím 
dokumentu destičky, v němž jsou naprogramovány pokyny k provedení běhu. 
Součástí každého nového běhu (vyjma alelické diskriminace) je přednastavený 
program běhu (teplotní profil), který je pro potřeby vašeho pokusu nutné upravit. 
 

Součástí programu je: 
 

•   Nastavení teplotního profilu 
•   Automatické změny nastavených parametrů (Auto Increment) 
•   Nastavení rychlostí, jakými jsou prováděny změny teplot (Ramp Rates) 
•   Nastavení sběru dat 
•   Nastavení reakčního objemu 

 
 

Programujete-li běh… 
 

Pak… 

•   absolutní kvantifikace 

•   relativní kvantifikace 
postupujte podle návodu na straně 3-19. 

 

DŮLEŽITÉ!  Používáte-li databázi SDS Enterprise, přečtěte 
si odstavec níže. 

alelické diskriminace viz strana 3-18. 

analýzy disociační křivky Chcete-li provést analýzu disociační křivky, proveďte: 
 

1.  Programujte běh absolutní kvantifikace podle 
postupu na straně 3-19. 

 

2.  Přidejte krok zvyšování teploty (pro analýzu disociační 
křivky) podle postupu na straně 3-21. 

 
O používání 

databáze 
 

Programujte běh takovým způsobem, aby sběr dat probíhal pouze v nezbytných 
krocích (stage). Kvůli omezené kapacitě paměti není možné do databáze SDS 
Enterprise ukládat dokumenty destiček větší než 40 MB. Velikost dokumentu se 
čtením v reálném čase závisí na délce běhu a nastavení sběru dat. Delší běhy a 
běhy, v nichž je sběr dat nastaven ve více krocích během cyklu, mohou vést ke 
vzniku dokumentů s velikostí výrazně větší než průměrných 15–25 MB. 
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Programování 
běhu alelické 
diskriminace 

Aby bylo možné na přístroji zpracovávat co nejvíce vzorků, není při provádění běhu 
alelické diskriminace k dispozici možnost programování běhu. Jelikož experimenty 
alelické diskriminace jsou experimenty se čtením po skončení reakce (end-point) a 
nevyžadují sběr dat v reálném čase, můžete teplotní cyklování provádět na jiném PCR 
cykleru a na přístroji 7900HT provést pouze sběr dat a analýzu. 
 
 

Chcete-li provést teplotní 
cyklování pokusu alelické 
diskriminace na… 

 
Pak… 

jiném PCR cykleru pokračujte krokem 8 “Zadání názvů vzorků a 
informací o destičce” na straně 3-25 

přístroji 7900HT  postupujte podle návodu níže. 

 
Provedení teplotního cyklování pokusu alelické diskriminace na přístroji 7900HT  
 

Chcete-li provést teplotní cyklování a sběr dat na přístroji 7900HT, proveďte nejprve 
běh se sběrem dat v reálném čase a následně další běh jako dokument alelické 
diskriminace. 
 

DŮLEŽITÉ!  Podle postupu uvedeného níže postupujte pouze provádíte-li PCR na 
přístroji 7900HT. Jinak proveďte PCR na jiném PCR cykleru a poté přeneste 
destičku do přístroje 7900HT pro sběr dat. 
 

1.   Spusťte program SDS. 
 

2.   Vytvořte dokument absolutní kvantifikace se sběrem dat v reálném čase podle 
postupu na straně 3-8. 

 

Poznámka:  Není nutné nastavovat v dokumentu destičky detektory. 
 

3.   V dokumentu destičky nastavte teplotní profil a inkubační doby podle 
vašeho protokolu, jak je popsáno v části “Nastavení běhu absolutní nebo 
relativní kvantifikace” na straně 3-19. 

 

4.   Uložte dokument destičky podle postupu na straně 4-22. 
 

DŮLEŽITÉ!  Neukládejte dokument se sběrem dat v reálném čase do databáze. 
V databázi nelze uložit dokumenty destiček pro různé typy běhů se stejným 
čárovým kódem. 

 

5.   Spusťte běh pomocí dokumentu se sběrem dat v reálném čase podle postupu na 
 straně 4-23. 

 

Poznámka:  Dokumenty se sběrem dat v reálném čase mohou být velmi 
užitečné při řešení problémů a neočekávaných výsledků, které se případně 
mohou vyskytnout v průběhu pokusu alelické diskriminace. 

 

6.   Po skončení běhu uzavřete dokument absolutní kvantifikace. 
 

7.   Pokračujte krokem 6 “Vytvoření templátu z dokumentu destičky” na straně 
      3-22. 
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Programování 
běhu absolutní 

nebo relativní 
kvantifikace 

Poznámka:  Níže jsou popsány pouze základní kroky nastavení běhu: teplotní profil, 
objem vzorku a sběr dat. Chcete-li získat více informací o nastavení běhu, kliknutím 
na ikonu  v záložce Instrument (Přístroj) otevřete nápovědu, kde získáte informace 
o nastavení automatické změny parametrů (auto increment) a nastavení rychlostí, 
jakými jsou prováděny změny teplot (Ramp Rates). 
 

1.   V programu SDS zvolte záložku Instrument (Přístroj) v dokumentu destičky. 
 

2.   Je-li zapotřebí, zatrhněte možnost 9600 Emulation. 
 

Poznámka:  Je-li zatržena možnost 9600 Emulation, program SDS sníží 
rychlost, s jakou jsou prováděny změny teplot při cyklování na přístroji 
7900HT tak, aby odpovídala rychlosti přístroje ABI PRISM®  7700. 

 

3.   Pozměňte přednastavený teplotní profil podle potřeby: 
 
 

Chcete-li… Pak… 

 
změnit 
nastavení 
času a 
teplot 

klikněte do příslušného pole, zadejte novou hodnotu a klikněte 
kdekoliv mimo toto pole. 

 
 
 
 

Teplota 
(4 až 99.9 °C) 

 
 

Čas 
(0:01 až 98:59 min) 

 
 

přidat krok 
inkubace (hold), 
cyklus nebo 
krok 

1.  Klikněte na krok vlevo od místa, kde chcete přidat nový krok. 
. 

2.  Klikněte  (Přidat cyklus) nebo  (Přidat krok 
inkubace). Program vloží nový krok do teplotního profilu.  

 

Poznámka:  Chcete-li přidat nový krok do cyklu, zvolte krok 

vlevo od místa, kde jej chcete přidat a klikněte . 
 
 

Zvolený krok 
 
 
 
 
 
 
 

Zde se vytvoří 
nový krok 

 
 
 

odstranit krok 1.  Klikněte na krok, který chcete odstranit. 
Zvolený krok bude zvýrazněn. 

2.  Klikněte na  (Odstranit krok), čímž krok odstraníte. 
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4.   Nastavte sběr dat v průběhu běhu: 

a.  Zvolte záložku Data Collection (Sběr dat). 
 

b.  Klikněte pod každý krok inkubace nebo změny teploty v teplotním 
profilu, chcete-li v něm provádět sběr dat. 

 
 
 
 
 
 
 

 Ikony označující sběr dat 
 

 
 
 
 
 
 
 
 

DŮLEŽITÉ!  Sběr dat v průběhu běhu nastavte pouze v nezbytných krocích PCR. 
Velikost dokumentu se čtením v reálném čase závisí na délce běhu a nastavení 
sběru dat. Delší běhy a běhy, v nichž je sběr dat nastaven ve více krocích během 
cyklu, mohou vést ke vzniku dokumentů s velikostí výrazně větší než 
průměrných 15–25 MB 

 

5.   Klikněte do pole Sample Volume (µL) (Objem vzorku) a zadejte objem 
vzorků v destičce. 

 

Poznámka:  Objemem vzorku se rozumí celkový objem jakékoliv jamky, včetně 
jamek neobsahujících templát, nebo jakékoliv kombinace mastermixu a 
templátu. 

 

DŮLEŽITÉ!  Všechny jamky destičky musí obsahovat vzorky o totožném 
objemu. 

 

6.   Zvolte jednu z následujících možností: 
 

 

Provádíte-li… 
 

Pak… 

pouze běh absolutní nebo 
relativní kvantifikace 

pokračujte krokem 6 “Vytvoření templátu 
z dokumentu destičky” ¨na straně 3-22. 

běh absolutní kvantifikace 
s analýzou disociační křivky 

definujte provedení analýzy disociační křivky 
podle postupu na straně 3-21. 
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Programování 
disociační křivky 

Abyste získali data pro analýzu disociační křivky, musíte na přístroji 7900HT 
naprogramovat postupné pomalé zvyšování teploty (‘temperature ramp’) vzorku za 
současného měření fluorescence každých 7-10 vteřin (detailní vysvětlení viz strana 
6-38). 
 

1.   V záložce Instrument (Přístroj) zvolte Thermal Profile (Teplotní profil). 
 

2.   Klikněte na krok vlevo od místa, kde chcete zadat krok disociační křivky. 
 

3.   V záložce Thermal Profile (Teplotní profil) klikněte  (Přidat krok 
      disociační křivky). 

 

Program SDS vloží krok postupného zvyšování teploty na konec 
naprogramovaného teplotního profilu. 

 

4.   Předvolené nastavení zvyšování teploty lze měnit, společnost Applied 
Biosystems však pro dosažení maximálního rozlišení (maximální oddělení 
píků při analýze) doporučuje postupovat následujícím způsobem. 

 
 

Doporučení Příklad 

 
Počáteční a konečná teplota 
musí být rozdílné o 
minimálně 35 °C. Každý krok 
trvá 15 vteřin (0:15). 

 
 
 
 
 
 
 

 
Nastavení rychlosti změny 
teploty (ramp rate) pro 
konečný krok musí být 2 %. 

DŮLEŽITÉ!  Volba 9600 
Emulation nesmí být 
zatržena, chcete-li toto 
nastavení provést. 

 
 
 
 

Zvyšování teploty musí být 
spojeno se sběrem dat 
(ikona). 

 
 
 
 
Konec 
 
 
Začátek 
 
 
 
 
 
 
 
 
 Rychlost 
změny 
teploty  
 
 
 
 
 
 
 
Ikona 
sběru dat 

 
 
 
 
 
 
 
 

5.   Pokračujte krokem 6 “Vytvoření templátu z dokumentu destičky” na straně 
      3-22. 
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Krok 6 – Vytvoření templátu z dokumentu destičky 
 
 

Přístupová 
práva 

Používáte-li databázi SDS Enterprise, musíte mít pro vytvoření templátu z dokumentu 
destičky práva uživatele třídy Scientist (Vědec) nebo Administrator (Správce). 

 
Nastavení 
zobrazení 
(volitelné) 

Dokumenty destiček vytvořené na základě templátu si podrží v templátu definované 
nastavení zobrazení, nastavte proto zobrazení templátu tak, aby se na jeho základě 
vytvořené dokumenty destiček zobrazovaly, jak si přejete. 
 

1.  Klikněte  nebo zvolte View > Display Settings (Zobrazit > Nastavení zobrazení). 
 

2.   V okně Display Settings (Nastavení zobrazení) nastavte zobrazení pro Results 
Grid (Schéma destičky) a Results Table (Tabulka výsledků). 

 

 

 
 

Více informací o dialogovém okně Display Settings (Nastavení zobrazení) 
získáte kliknutím na ikonu  , čímž otevřete nápovědu. 

 

3.   Nastavení potvrďte  . 

Nové nastavení zobrazení bude použito v dokumentu destičky. 
 

4.   Pokračujte částí “Vytvoření templátu z dokumentu destičky (volitelné)” na 
      straně 3-23. 
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Krok 6 – Vytvoření templátu z dokumentu destičky 
 
 

Vytvoření templátu 
z dokumentu 

destičky (volitelné) 

DŮLEŽITÉ!  Uložení dokumentu destičky jako templátu je nepovinný krok, který je 
doporučen, je-li možné dokument použít pro vytvoření více dokumentů destiček 
s totožnou konfigurací esejí. Nechcete-li vytvořit templát, pokračujte částí “Zadání 
názvů vzorků a informací o destičce (volitelné)” na straně 3-25. 
 
Chcete-li uložit templát: 
 

1.   Zvolte File > Save As (Soubor > Uložit jako). 
 

2.   V poli Save in (uložit v) v dialogovém okně Save As (Uložit jako) vyhledejte 
      adresář AppliedBiosystems > SDS2.2 > Templates. 

 

Poznámka:  Uložíte-li templát do adresáře Templates (Templáty), bude 
přístupný z rozbalovací nabídky Template v dialogovém okně New Document 
(Nový dokument). 

 

3.   Zvolte File of type (Typ souboru) > ABI PRISM SDS Template Document 
      (*.sdt). 

 

4.   Klikněte do pole File name (Název souboru) a zadejte název templátu. 
 

5.   Klikněte  (Uložit). 

Templát se uloží. 
 

6.   Zobrazí-li program jedno nebo více varování, přečtěte si je a potvrďte  . 
 

7.   Zvolte File > Close (Soubor > Zavřít). 

Vyzve-li vás program k uložení dokumentu destičky, klikněte  (Ne). 

Templát se zavře. 

8.   Vytvořte dokument destičky z templátu podle postupu na straně 3-24. 
 
Chcete-li uložit templát do databáze SDS Enterprise: 
 

1.   Zvolte File > Save Template to Database (Soubor > Uložit templát do 
      databáze). 

 

2.   V dialogovém okně Save Document as Template (Uložit dokument jako 
       templát) klikněte  (Ano). 

 

3.   Zobrazí-li program jedno nebo více varování, přečtěte si je a potvrďte  . 
 

4.   V poli Template Name (Název templátu) dialogového okna Save Template to 
      Database zadejte název templátu (max. 128 znaků) a klikněte  . 

 

5.   Zvolte File > Close (Soubor > Zavřít). 

Vyzve-li vás program k uložení dokumentu destičky, klikněte  (Ne). 

Templát se zavře. 

6.   Vytvořte dokument destičky z templátu podle postupu na straně 3-24. 
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 Možnost 

 
 Popis 

 
 Viz 

Vytvořit jeden dokument destičky 
z templátu 

Níže je popsáno jak vytvořit jeden 
dokument destičky z templátu. Opako-
váním tohoto postupu můžete vytvořit 
libovolný počet dokumentů destičky. 

 Níže. 

Vytvořit více dokumentů destičky 
z templátu pomocí nástroje 
Template Batch  

DŮLEŽITÉ!  Používáte-li databázi 
SDS Enterprise, musíte zvolit tuto 
možnost. 

Součástí programu je nástroj Template 
Batch, který umožňuje vytvořit naráz a 
rychleji více dokumentů destiček 
z templátu. 

 Strana 4-34 
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Krok 7 – Vytvoření dokumentu destičky z templátu 
 
 

Přístupová 
práva 

Používáte-li databázi SDS Enterprise, musíte mít pro vytváření dokumentu destičky 
z templátu práva uživatele třídy Scientist (Vědec) nebo Administrator (Správce). 

 
Možnosti vytváření 

dokumentu 
destičky 

z templátu 

Program SDS nabízí dvě možnosti jak vytvořit dokument destičky z templátu – 
jednotlivě a pro více dokumentů najednou. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vytvoření 
dokumentu 

destičky 
z templátu 

1.   V programu SDS klikněte  nebo zvolte File > New (Soubor > Nový). 

2.   V dialogovém okně New Document (Nový dokument) zvolte: 
•   Rozbalovací nabídka Assay (Esej) – Zvolte stejný typ jako templát. 
•   Rozbalovací nabídka Container (Destička) – Zvolte stejný typ jako 
     templát. 

•   Rozbalovací nabídka Template (Templát) – Zvolte příslušný templát 
(*.sdt) vytvořený na straně 3-22. 

 

Není-li soubor templátu v rozbalovací nabídce Template, vyhledejte jej takto: 

a.  Klikněte  (Vyhledat). 

b.  Vyhledejte na straně 3-22 vytvořený soubor templátu (*.sdt). 

c.  Klikněte  (Otevřít). 

V rozbalovací nabídce Template (Templáty) se zobrazí soubor templátu. 
 

Poznámka:  Rozbalovací nabídka Template obsahuje všechny soubory templátů 
z podadresáře Templates programu SDS. 

 

•   V poli Barcode (Čárový kód) – (volitelné) zvolte: 
– Zadejte čárový kód destičky, nebo 
– Naskenujte čárový kód pomocí ruční čtečky čárových kódů. 

 

3.   Klikněte  , čímž vytvoříte nový dokument destičky z templátu. 
 

4.   Pokračujte částí “Zadání názvů vzorků a informací o destičce (volitelné)” na 
straně 3-25. 
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Krok 8 – Zadání názvů vzorků a informací o destičce    
 
 

Krok 8 – Zadání názvů vzorků a informací o destičce 
 
 

Přístupová 
práva 

Používáte-li databázi SDS Enterprise, musíte mít pro zadání (změnu) názvů vzorků 
práva uživatele třídy Scientist (Vědec) nebo Administrator (Správce). 

 
Zadání názvů 

vzorků do 
dokumentu 

destičky 

V dokumentu destičky musí být zadány názvy vzorků, aby byla možná efektivní 
analýza výsledků. Program zobrazuje názvy vzorků ve schématu destičky a 
v tabulkách. 
 

Poznámka:  Názvy vzorků lze zadat až po skončení běhu, ale vždy před analýzou. 
 

Poznámka: Program SDS umožňuje importovat zadání (detektor, úloha detektoru 
a názvy vzorků) do dokumentu destičky ze souboru txt (tabelátorem oddělená 
data). Více informací viz “Import zadání do dokumentu destičky” na straně A-2. 
 

1.   Ve schématu destičky zvolte jamky obsahující první vzorek. 
 

2.   Klikněte do pole Sample Name (Název vzorku), zadejte název a potvrďte 
Enter. Ve zvolených jamkách se objeví nový název vzorku. 

 

3.   Opakujte kroky 1 a 2 pro všechny zbývající vzorky. 
 
 
 
 
 
 
 

Zde se objeví 
názvy vzorků 

 
 
Pole Název vzorku 

 
 
 
 
 
 

4.   Zadejte do dokumentu destičky informace o destičce podle popisu níže. 
 

Zadání 
informací o 

destičce 
(volitelné) 

1.  V programu SDS zvolte Tools > Document Information (Nástroje > Informace 
o dokumentu). 

 

2.  V dialogovém okně Document Information (Informace o dokumentu) upravte 
informace v polích Barcode (Čárový kód), Operator (Uživatel) nebo Plate 
Comments (Komentář). 

 

DŮLEŽITÉ!  Používáte-li databázi SDS Enterprise: 
 

•   Čárový kód zadaný do dokumentu destičky musí být jedinečný a nesmí být 
použit v jiném dokumentu destičky. 

•   Do pole Operator (Uživatel) je automaticky předvyplněno jméno uživatele, 
který se přihlásil do programu SDS a spustil běh (jméno je předvyplněno 
pouze po provedení běhu). 

•   Čárový kód dokumentu destičky, který byl již spuštěn, neměňte. 
 

3.   Po skončení klikněte  . 
 

4.   Spusťte běh podle popisu na straně 3-26. 
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Krok 9 – Spuštění běhu na přístroji 7900HT 
 
 

Přístupová 
práva 

Pro spuštění běhu destiček uložených v databázi SDS Enterprise neexistují žádná 
omezení z hlediska přístupových práv. 
 

DŮLEŽITÉ!  Dokument destičky musí být před spuštěním uložen do databáze. 
Spustit jej může uživatel ze skupiny Operator. 

 
Možnosti 
spuštění 
destiček 

Na přístroji 7900HT je možné spustit běh destičky jednotlivě nebo ve skupinách za 
použití podavače mikrodestiček Zymark Twister. 
 

DŮLEŽITÉ!  Nepoužíváte-li podavač mikrodestiček Zymark Twister, musíte spouštět 
destičky jednotlivě. 
 

Zvolte jednu z možností spuštění destičky: 
 

 

Spouštíte-li destičku… 
 

Popis 
 

Viz strana 

jednotlivě 1.  Připravte si destičku nebo mikrofluidní kartu  
Applied Biosystems 7900HT  

2.  Spusťte běh pomocí programu SDS. 

4-5 

 
4-21 

v rámci skupiny 
(automaticky) 

1.  Připravte si destičky nebo mikrofluidní karty  

2.  Spusťte skupinu destiček pomocí podavače 
mikrodestiček Zymark Twister. 

DŮLEŽITÉ!  Váš systém musí být vybaven 
podavačem mikrodestiček, chcete-li spouštět 
destičky automaticky. 
 

4-5 

 
4-29 
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Kapitola 4    Ovládání přístroje 
 
 

Poznámky pro uživatele databáze 
 
 

Dodatečné kroky Používáte-li databázi SDS Enterprise pro ukládání dokumentů SDS, studií a dat, je 
možné, že při vytváření a provádění změn dokumentů destiček budete muset provést 
dodatečné kroky jak je popsáno v této kapitole. Níže jsou tyto úkony popsány (nutnost 
jejich provedení závisí na tom, jak správce provedl nastavení databáze). Více 
informací naleznete v příručce SDS Enterprise Database Administration Guide. 

 

 
Dialogové okno 
Reason(s) For 

Change 

Dialogové okno Reason(s) for Change (Důvod/y změny) se objevuje pouze v případě, 
je-li databáze SDS Enterprise nastavena tak, že vyžaduje zdůvodnění prováděných 
kroků (tzv. Audit). Systém auditu sleduje vytváření, změny a mazání dat v databázi. 
 

Objeví-li se dialogové okno Reasons for Change, proveďte jeden z následujících 
kroků: 

• Zvolte důvod změny z rozbalovací nabídky a poté klikněte na ikonu .
• Zadejte důvod změny do příslušného pole a poté klikněte na ikonu .

 
 

Rozbalovací nabídka 
důvodů změny 

 
Přednastavené důvody 

 
 
 
 

Popis vlastního důvodu 
 
 

Obrázek 4-1 Dialogové okno Reasons for Change (Důvod/y změny) 
 
 

Dialogové 
okno 

Electronic 
Signature 

Dialogové okno Electronic Signature (Elektronický podpis) se objevuje pouze 
v případě, je-li databáze SDS Enterprise nastavena tak, že vyžaduje elektronický 
podpis. Systém elektronického podpisu omezuje a sleduje přístup uživatelů k datům 
v databázi. 
 

Objeví-li se toto dialogové okno: 
 

1.   Do pole User ID (Jméno) a Password (Heslo) zadejte vaše uživatelské jméno a 
heslo a potvrďte . 

 

2.   Program následně zobrazí zprávu o úspěšném či neúspěšném použití 
elektronického podpisu. Pro pokračování klikněte  . 

 
 
 

Popis kroku, který 
vyžaduje elektronický 
podpis. 

 
Uživatelské jméno 

 
Heslo 

 
 
 

Obrázek 4-2  Dialogové okno Elektronický podpis 
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Dříve než začnete 
 
 

Dříve než začnete 
 
 
Seznam kroků před 

spuštěním běhu 
Chcete-li spouštět destičky na přístroji 7900HT, musíte nejprve provést následující 
kroky. Více informací naleznete na příslušné straně. 

 
 

Prove
deno 

 

Úkol 
 

Viz strana 

 V posledním měsíci byla provedena kalibrace pozadí. 7-16 

 V posledním půlroce byla provedena kalibrace barev.  7-20 

 V přístroji není destička. 
 

DŮLEŽITÉ!  Chcete-li spustit běh, musí být přístroj prázdný. Je-li 
v něm destička, musíte ji vyjmout. 

4-42 

Pracujete-li v automatickém režimu, ověřte … 

 Zásobník na destičky, které již byly spuštěny, je prázdný. – 

 
 
 Přehled 

 
1.  Příprava pokusu na přístroji 7900HT: 

–   Příprava optické 96-ti jamkové destičky/ek ABI PRISM™  (viz strana 4-7). 
–   Příprava mikrofluidní karty/et Applied Biosystems 7900HT (viz strana 4-9). 

 
 
 
2.  Spusťte přístroj 7900HT: 

–   Samostatný provoz (viz strana 4-21). 
–   Provoz v automatickém režimu s databází SDS Enterprise (viz strana 4-30). 

–   Provoz v automatickém režimu bez databáze (viz strana 4-32). 
 
 
 
3.  Analýza výsledků. 

–   Alelická diskriminace (viz strana 5-5). 
–   Absolutní kvantifikace (viz strana 6-5). 
–   Relativní kvantifikace (viz strana 6-15). 
–   Analýza disociační křivky (viz strana 6-37). 
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Část 4.1  Příprava spotřebního materiálu    
 
 

Část 4.1 Příprava spotřebního materiálu 
 
 
 

    V této části Prevence kontaminace.............................................................................................4-6 
Spotřební materiál...................................................................................................4-6 
Příprava 96-ti a 384-jamkových mikrodestiček......................................................4-7 
Příprava mikrofluidních karet .................................................................................4-9 
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Uzavření (víčka) a kompresní podložky 
 
 

Typ 
 

Používejte… 
 

Nepoužívejte… 

Optické 384-jamkové 
destičky ABI PRISM™   
 

Optické adhezivní fólie ABI PRISM™   384-jamková septa 

 
Optické 96-ti jamkové 
destičky ABI PRISM™   

Kompresní podložky: 

•   Standardní podložka pro ruční ovládání  

•   Podložka ‘Snap-On’  

96-ti jamkové kryty: 

•   ABI PRISM optické adhezivní fólie  

•   ABI PRISM optická víčka (pouze plochá) 

Nepoužívejte: 

•   ABI PRISM optická 
víčka (kulatá) 

•   96-ti jamková septa 

Mikrofluidní karty Žádná (samozatavení) Žádná (samozatavení) 

 

Kapitola 4    Ovládání přístroje 
 
 

Prevence kontaminace 
 
 

Kontaminace a 
5´ nukleázová 

reakce 

Metodika PCR vyžaduje odpovídající postupy práce, aby nedocházelo ke vzniku 
falešně pozitivních výsledků (Kwok and Higuchi, 1989). Opakované provádění PCR 
reakcí a vysoký počet zpracovávaných vzorků může v principu vést k amplifikaci až 
jediné DNA molekuly (Saiki et al., 1985; Mullis and Faloona, 1987). 

 
PCR – Správná 

laboratorní praxe 
Při přípravě destiček nebo mikrofluidních karet dodržujte následující zásady: 
 

•   Při přípravě vzorků pro amplifikaci pomocí PCR používejte čistý laboratorní 
plášť (který nebyl předešle použit při manipulaci s PCR produkty nebo během 
přípravy vzorků) a čisté rukavice. 

•   Máte-li podezření, že rukavice jsou kontaminované, ihned je vyměňte. 
•   Používejte vyhrazené pracovní prostory a zařízení pro: 

–  Přípravu vzorků 
–  Sesazení PCR reakcí 
–  Amplifikaci pomocí PCR 
–  Analýzu PCR 

•   Nikdy nenoste PCR produkty do pracovních prostor vyhrazených pro přípravu 
     PCR. 
•   Otvírejte a zavírejte zkumavky a destičky se vzorky opatrně. Zabraňte rozlití 

vzorků a vytváření aerosolů. 
•   Uchovávejte reakce i reagencie vždy v dokonale uzavřených zkumavkách, 

destičkách apod. 
•   Používejte speciální pipety pro pipetování (tzv. positive displacement pipety) 

nebo špičky bránící šíření aerosolů (s filtrem). 
•   Pravidelně čistěte pracovní plochy a zařízení 10% roztokem chlornanu sodného. 

 

 

Spotřební materiál 
 

Spotřební materiál 
pro přístroj 

7900HT 
 

Tabulka 4-1 Spotřební materiál 
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 Příprava 96-ti a 384-jamkových mikrodestiček    
 
 

Příprava 96-ti a 384-jamkových mikrodestiček 
 
 

Příprava destiček 
pro spuštění na 
přístroji 7900HT  

1.   Připravte reakce v optické 96-ti nebo 384-jamkové destičce tak, že rozplníte do 
      jednotlivých jamek destičky reagencie, enzym a vzorky. 
 

DŮLEŽITÉ!  Uspořádání reakcí (vzorků a esejí) na destičce musí odpovídat 
zadání názvů vzorků a detektorů/markerů v odpovídajícím dokumentu 
destičky. 

 

2.   Uzavřete optickou reakční destičku způsobem kompatibilním s přístrojem 
      7900HT (obrázky 4-3 a 4-4 na straně 4-8). 
 

Poznámka:  Seznam nástrojů k uzavření použitelných na přístroji ABI PRISM 

7900HT naleznete na straně 4-6 v části “Spotřební materiál”. 
 

3.   Destičku krátce centrifugujte, abyste odstranili případné vzduchové bubliny.  
 

4.   Ověřte, že se všechny reakce nacházejí na dně jamky. 
 
 

     Správně          Špatně 
 
 
 
 
 
 
 
 
 
 

Reakce je na dně jamky. Reakce je na boku jamky, 
protože destička nebyla 
centrifugována. 

Na dně jamky je vzduchová 
bublina – reakce nebyla 
centrifugována dostatečně 
dlouho nebo při dostateč- 
ných otáčkách: 

 
 

 
 

5.   Používáte-li 96-ti jamkovou destičku, musíte použít i odpovídající kompresní 
      podložku. 

Spouštíte-li destičku: 

•   Jednotlivě pomocí programu SDS, použijte standardní kompresní 
podložku (obrázek 4-3). 

•   V rámci skupiny pomocí programu Automation Controller, použijte 
zacvakávací podložku (obrázek 4-3). 
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6.   Zvolte jednu z možností. Provádíte-li: 
–  Absolutní nebo Relativní kvantifikaci nebo Analýzu disociační křivky 

Spusťte destičku podle postupu v části “Spuštění destičky” na straně 4-23. 
–  Alelickou diskriminaci 

a.   Vložte destičku do PCR cykleru a proveďte PCR. 

b.  Krátce destičku centrifugujte. 

c.   Spusťte destičku podle postupu v části “Spuštění destičky” na straně 4-23. 
 

 
 
 
 

‘Zacvakávací’ 
kompresní 
podložka (pro  
automatický 
provoz) 

 
 

Optická 
adhezívní fólie 

Standardní 
kompresní podložka 
(pro jednotlivý běh) 

 
 
 
 

Optická víčka 
(pouze plochá) 

 NEBO 
 
 
 
 
 
 
 
 
 
 
 
 

Obrázek 4-3    96-ti jamková destička – příprava ke spuštění 
 
 
 
 

 Optická adhezívní 
fólie 

 
 
 
 

384-jamková 
  destička 

 
 
 
 

Obrázek 4-4   384-jamková destička – příprava ke spuštění 
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Příprava mikrofluidních karet  
 
 
O mikrofluidních kartách 

 
Mikrofluidní karty společnosti Applied Biosystems jsou nástroj pro studium 
genové exprese pomocí komparativní CT metody relativní kvantifikace. 
Mikrofluidní karty umožňují stanovit genovou expresi v jednom až osmi vzorcích 
cDNA syntetizované podle lidské RNA v dvoukrokovém pokusu RT-PCR. 

 
    Jak fungují Mikrofluidní karty fungují jako sada reakčních rezervoárů pro provedení kvantitativní 

Real-Time PCR. V běžném uspořádání obsahují jamky mikrofluidních karet 
reagencie TaqMan® (viz poznámka níže) detekující amplifikaci cílových sekvencí 
v reálném čase. Relativní hladina genové exprese je stanovena pomocí programu 
Relative Quantification na základě naměřených hodnot fluorescence během PCR 
reakce provedené na přístroji ABI PRISM®  7900HT. 

 

Poznámka:  V této příručce je termín reagencie TaqMan používán pro označení 
5´ exonukleázové  reakce používající TaqMan®  primery a sondy společnosti 
Applied Biosystems (včetně PDAR společnosti Applied Biosystems, esejí typu 
Assays-By-Design™  , Assays-On-Demand™ a jakýchkoliv esejí typu TaqMan 
vyráběných na zakázku.) 

 
Součásti 

mikrofluidních 
karet 

Mikrofluidní karty (obrázek 4-5) fungují jako rezervoáry pro provedení PCR 
v reálném čase. Sestávají z 384 propojených jamek rozdělených do osmi sad. 
Umožňují pracovat s uživatelem definovaným počtem replikátů. Každá jamka 
obsahuje lyofilizované TaqMan primery a sondy společnosti Applied Biosystems pro 
jednu cílovou mRNA. 

 
Rezervoár pro plnění (1z 8) 
Rezervoár pro vzorek cDNA, který je 
následně pomocí centrifugace 
rozplněn do jamek 

 

 
Sada rezervoárů 
Část mikrofluidní karty s osmi 
rezervoáry pro plnění. (Po centrifugaci 
a zatavení mikrofluidní karty se tato 
část odstřihne.) 

 
GR2156a 

 

 
Čárový kód 
 

 
Obrázek 4-5  Mikrofluidní karta 
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   Vnitřní struktura Na obrázku 4-6 je vyobrazena vnitřní struktura mikrofluidní karty. 
 

Plnící otvor Vzduchový otvor 
 
 
 
 

Rezervoár pro plnění 
 

 
Hlavní kanálek 

 
Boční kanálek 
Reakční jamka 

 
 

Obrázek 4-6   Vnitřní struktura mikrofluidní karty 
 
 

Detektory Mikrofluidní karta umožňuje amplifikaci cílové a kontrolní cDNA pomocí 5´ 
nukleázové reakce.  

 

Sondy používané v reakci fungují následujícím způsobem: 
 

•   Sondy značené barvou FAM™  detekují amplifikaci cílové cDNA. 
•   Sondy značené barvou FAM™  detekují amplifikaci externí endogenní 

kontroly. 
 

Kontaminace 
genomickou 

DNA 

TaqMan sondy a primery pro amplifikaci cDNA jsou navrhovány přes spojení 
exon-exon, čímž je minimalizováno riziko amplifikace kontaminující genomické 
DNA. Testy bylo prokázáno, že 5´ exonukleázové eseje lze provádět v přítomnosti 
až 10,000 kopií genomické DNA aniž je tato detekována, není-li v dokumentaci 
společnosti Applied Biosystems uvedeno jinak. 
 
Amplifikace externí endogenní kontroly 
 

Vezměte na vědomí, že běžně používaná esej pro amplifikaci externí endogenní 
kontroly není RNA-specifická, a proto má na ní vliv kontaminace genomickou 
DNA. Nicméně vzhledem k extrémně vysokým hladinám exprese rRNA je i 
v případě velké kontaminace genomickou DNA tento vliv na výsledky relativní 
kvantifikace získané pomocí mikrofluidní karty zanedbatelný. 

 
Singleplexní 

reakce 
 

V mikrofluidních kartách je doporučeno provádět singleplexní reakce s reagenciemi 
TaqMan (například barva FAM). Esej amplifikující externí endogenní kontrolu 
(například FAM-18S nebo FAM-GAPDH) se používá jako kalibrátor pro výpočet 
výsledků relativní kvantifikace. 
 

Poznámka:  Více informací o relativní kvantifikaci získáte v příručce ABI PRISM®  

7700 Sequence Detection System User Bulletin #2: Relative Quantitation of Gene 
Expression (Kat. č. 4303859). 

 
Kontrola jakosti V rámci kontroly jakosti společnosti Applied Biosystems je provedeno funkční  
  ověření sond a primerů plněných do mikrofluidních karet. 
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O centrifuze 

 
Po naplnění rezervoárů mikrofluidních karet vzorky cDNA je zapotřebí tyto karty 
centrifugovat, aby byl vzorek cDNA rozplněn do reakčních jamek. Centrifuga 
umožňuje stáčet až 12 mikrofluidních karet najednou. 

 
Potřebná 

centrifuga a 
příslušenství 

Pro správnou centrifugaci mikrofluidních karet budete potřebovat následující 
centrifugu a příslušenství: 
 

•   Centrifuga Sorvall®  Legend T 
 
 
 
 
 
 
 
 
 
 
 

GR2170 

 
Obrázek 4-7   Centrifuga Sorvall Legend T 

 
 

•   Výkyvný rotor Sorvall®/Heraeus “Tool-less” 750-mL  
•   Sadu čtyř speciálních závěsů Sorvall®/Heraeus, každý s držákem karet 

(Kontaktujte zástupce společnosti Applied Biosystems, chcete-li objednat tyto 
speciální závěsy.) 

•   Aktuální firmware 

Dokupujete-li vybavení k centrifuze Sorvall Legend T nebo Legend RT, 
kterou již vlastníte, může být zapotřebí provést aktualizaci firmwaru tak, aby 
bylo speciální závěsy na mikrofluidní karty možné používat. 

 
Součásti 

centrifugy 
 

Na obrázku 4-8 jsou vyobrazeny součásti centrifugy. 
 

 
Rotor 
Roztáčí sadu 4 závěsů 

 
 
 
 
Držák karet 
Podepírá sadu rezervoárů 
během centrifugace 

 
 
 
 

Závěs 
Nese mikrofluidní karty 
v držáku 

 
 
 
 
 

Obrázek 4-8  Součásti centrifugy 
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             Umístění Centrifuga se umístí na standardní laboratorní stůl. Více informací o provozu 
centrifugy naleznete v návodu. 

 
Nastavení typu 

závěsu 
1.   Zapněte centrifugu. 
 

2.   Podle pokynů v návodu pro centrifugu Sorvall Legend T použijte tlačítka 
 předního panelu centrifugy pro nastavení typu závěsů 15679 

 
Nastavení typu závěsů 

 
Volící klávesy 

 
 
 
 
 

DŮLEŽITÉ!   Ujistěte se, že jste nastavili správný typ závěsu. Pouze tak je 
zajištěno, že budou dodrženy maximální rychlosti centrifugace, povolené 
výrobcem pro daný typ závěsů. 

 

3.   Pomocí tlačítek předního panelu centrifugy nastavte následující parametry: 
 

 

Parametr 
 

Hodnota 

Up ramp rate (Zrychlování)  9 

Down ramp rate (Zpomalování) 9 

Rotational speed (Rychlost 
centrifugace) 

1200 rpm (331 × g) 

Centrifugation time (Doba 
centrifugace) 

1 min 

 
displej rpm  

 
Programovací  
tlačítka 1–4  

. 

 
Kontrola 

zrychlování 
Kontrola 
zpomalování 

Nastavení 
rpm 

 

Nastavení 
     času 

 
4.   Vypněte centrifugu. 
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O nástroji na 
zaslepení jamek 

Nástroj na zaslepení jamek mikrofluidních karet je nezbytný pro zaslepení 
jednotlivých jamek v kartě poté, co je tato naplněna vzorky cDNA a mastermixem. 
Nástrojem zaslepíte hlavní distribuční kanálky karty. 

 
Součásti 
nástroje 

 Madlo 
Pro pohyb zaslepovacích 

nožů 

Mikrofluidní karta 
Vyobrazena fólií nahoru s plnícími rezervoáry vpravo 
(zaslepovací nože se při zaslepování pohybují 
zleva doprava ve směru šipek vyznačených 
v základně) 

 
 

Vlis pro kartu 
Drží mikrofluidní kartu ve 
správné poloze   
 
Základna 
Drží mikrofluidní kartu ve 
správné poloze  a vede 
zaslepovací nože 

 
Obrázek 4-9  Součásti nástroje (vyobrazeno s odstraněným krytem) 

 
 

         Umístění Nástroj na zaslepení jamek mikrofluidních karet se umisťuje na běžný laboratorní 
stůl. Nevyžaduje připojení do elektrické sítě. 

 
 

Plnění mikrofluidních karet 
 
 

Potřebný materiál 
a vybavení 

Pro plnění reakčních mixů do rezervoárů mikrofluidních karet společnosti Applied 
Biosystems budete potřebovat následující materiál a vybavení: 
 

•   Mikropipetu Rainin F-100 (100-µL) 
•   Pipetovací špičky Rainin Fine Point (100-µL) 
•   Mikrofluidní kartu/y společnosti Applied Biosystems  
•   Reakční mixy PCR (návod na přípravu reakčních mixů naleznete v protokolu 

přiloženém k reagenciím pro vaše mikrofluidní karty) 
 

Doporučení pro 
plnění karet 

Pro správné plnění mikrofluidních karet je zapotřebí dodržet následující doporučení. 
 

•   Nevyjímejte mikrofluidní kartu z jejího obalu dokud se obal neohřál na 
pokojovou teplotu a vy jste připraveni kartu plnit reakčním mixem PCR. 

 

DŮLEŽITÉ!  Dlouhodobé vystavení fluorescenčních sond uvnitř mikrofluidních 
karet vnitřnímu osvětlení může vést k jejich fotodegradaci. Nevystavujte 
mikrofluidní karty slunečnímu světlu. 

 

•   Neohýbejte před plněním část karty se sadou rezervoárů (obrázek 4-5 na 
     straně 4-9). 

 

DŮLEŽITÉ!  Pro úspěšné plnění reakčních mixů je nezbytné, aby hlavní kanálky 
vedoucí od sady rezervoárů k jamkám zůstaly otevřené a nepoškozené. 
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  Plnění 
rezervoárů 

1.   Ohřál-li se obal karty na pokojovou teplotu a vy jste připraveni k plnění karty, 
 opatrně vyjměte kartu z obalu. 

 

2.   Umístěte mikrofluidní kartu na laboratorní stůl fólií dolů. 
 

3.   Pipetujte 100 µL reakčního mixu PCR do 100-µL mikropipety. 
 

4.   Podržte mikropipetu v úhlu a umístěte hrot špičky k plnícímu otvoru. 
 

Poznámka:  Plnící otvor je v levé části plnícího rezervoáru; je to ten větší 
z otvorů. 

 
 
 
 
 
 
 
 

 
GR2158 

 
Plnící otvor 
 
Vzduchový otvor 

 
DŮLEŽITÉ!  Nedotýkejte se špičkou fólie pod plnícím otvorem, mohlo by dojít 
k jejímu poškození. 

 

5.   Pipetujte reakční mix PCR tak, že zaplní plnící rezervoár ve směru ke 
vzduchovému otvoru. 

 

DŮLEŽITÉ!  Pipetujte do plnícího rezervoáru celých 100 µL. 
 

DŮLEŽITÉ!  Nedotýkejte se špičkou fólie pod plnícím otvorem, mohlo by dojít 
k jejímu poškození. 

 

DŮLEŽITÉ!  Buďte opatrní při vytlačování tekutiny ze špičky pipety kdy 
stlačujete píst pipety až do druhé dorazové polohy. Vytlačíte-li velký objem 
vzduchu, může dojít k vytlačení reakčního mixu z plnícího rezervoáru 
vzduchovým otvorem. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

GR2159 

 
6.   Plnění reakčního mixu z plnícího rezervoáru do reakčních jamek se provádí 

   centrifugačně. 

Pokračujte částí “Centrifugace mikrofluidních karet” na straně 4-15. 
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Centrifugace mikrofluidních karet 

 
 

Potřebný materiál 
a vybavení 

Pro správnou centrifugaci mikrofluidních karet budete potřebovat následující 
centrifugu a příslušenství: 
 

•   Mikrofluidní kartu/y s reakčním mixem PCR (strana 4-13) 
•   Centrifuga Sorvall®  Legend T 
•   Speciální závěsy Sorvall®/Heraeus (celkem čtyři), každý s držákem karet 
•   Prázdné karty na vyvážení 

 
Umístění karet 

do závěsů 

 
 

Poznámka:  Do centrifugy se vkládají čtyři závěsy Sorvall/Heraeus. Do každého 
závěsu lze vložit až tři mikrofluidní karty (naplněné a/nebo prázdné). 
 

1.   Připravte si prázdný závěs Sorvall/Heraeus a držák karet. 
 

DŮLEŽITÉ!  Závěsy Sorvall/Heraeus a držáky karet jsou speciálně vyráběny pro 
stáčení mikrofluidních karet. Nepoužívejte žádné jiné závěsy/držáky. 

 

2.   Umístěte závěs na laboratorní stůl označením směrem k vám. 
 

3.   Vložte mikrofluidní kartu do držáku a ujistěte se, že: 
•   Plnící rezervoáry směřují vzhůru z držáku 
•   Reakční jamky směřují stejně jako nápis “This Side Out” 

 

DŮLEŽITÉ!  Použijte prázdné karty na vyplnění všech zbývajících pozic 
v držáku. 

 

Poznámka:  Držák karet podepírá sadu rezervoárů během centrifugace. 
 

 
 

4.   Umístěte naplněný držák karet do závěsu tak, že nápis “This Side Out” směřuje 
k té části závěsu, na níž je emblém Sorvall. 

 
 
 
 
 

Emblém Sorvall 
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Umístění 
závěsů do 
centrifugy 

1.   Ujistěte se, že centrifuga je zapnuta a rotor se nepohybuje . 
 

2.   Otevřete víko centrifugy stiskem tlačítka OPEN (Otevřít). 

 
 

Tlačítko OTEVŘÍT  
 
 
 
 
 

3.   Umístěte naplněný závěs do volného ramena rotoru. 
 

Poznámka:  Ujistěte se, že závěs se v rotoru může volně vyklápět. 
 

4.   Umístěte do rotoru i ostatní závěsy podle kroku 3. 

  Výrobce doporučuje spouštět centrifugu vždy se čtyřmi závěsy, 
i když pouze dva z nich obsahují mikrofluidní karty. 

  Ujistěte se, že protilehlé závěsy mají shodnou hmotnost. 
Nejsou-li závěsy úplně naplněny mikrofluidními kartami s reakcemi, umístěte do 
závěsů prázdné karty a držáky karet. 

 
 
 
 
 
 
 
 
 
 
 
 
 

5.   Uzavřete víko centrifugy. 
 

Stáčení 
karet 

1.   Stiskněte tlačítko START. 

 

 
 
 

Tlačítko  
START 
 

 
 

Centrifuga se spustí a po jedné minutě automaticky vypne jak je 
naprogramováno. 

 

2.   Opakujte krok 1 takže se mikrofluidní karty budou stáčet celkem dvakrát 
jednu minutu, čímž je zajištěno úplné rozplnění reakčních mixů. 

 

3.   Otevřete víko centrifugy stiskem tlačítka OPEN. 
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4.   Jakmile se víko úplně otevře, vyjměte závěsy z centrifugy a držáky karet ze 
      závěsů. 

 

5.   Opatrně vyjměte mikrofluidní karty ze závěsů. 
 

6.   Ověřte, že v mikrofluidních kartách došlo k úplnému rozplnění reakčních mixů. 
 

Objem vzorků, který zůstane v rezervoárech, by měl být ve všech rezervoárech 
zhruba stejný. 

•   Pokud v některém z rezervoárů zůstal výrazně odlišný objem (viz obrázek 
níže), rozplnění se nezdařilo. Pokračujte následujícím krokem. 

 
 
 
 
 
 
 
 
 
 

•   Je-li některý z rezervoárů úplně prázdný (viz obrázek níže), je možné, že 
některé jamky nebyly správně naplněny. 
– S mikrofluidní kartou byste neměli dále pracovat. Použijte jinou kartu. 
– Druhou možností je pokračovat v práci s touto kartou, ale výsledky 
   z jamek plněných z problematického rezervoáru byste neměli brát 
   v potaz. 

 

 
 
 
 
 
 
 
 
 

7.   Ověřte naplnění rezervoárů: 
 

 

Jsou-li rezervoáry... 
 

Pak... 

po první centrifugaci 
naplněny nerovnoměrně 

centrifugujte mikrofluidní kartu znovu další minutu stejným 
způsobem. 

po druhé centrifugaci 
naplněny nerovnoměrně 

•   S mikrofluidní kartou byste neměli dále pracovat. 
Použijte jinou kartu. 

•   Druhou možností je pokračovat v práci s touto kartou, ale 
výsledky    z jamek plněných z problematického 
rezervoáru byste neměli brát v potaz. 

 
DŮLEŽITÉ!  Centrifugace nesmí probíhat při otáčkách vyšších než 1200 rpm 
nebo déle než 3 min, jinak by mohlo dojít k poškození mikrofluidní karty. 
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Zaslepení jamek mikrofluidních karet 

 
 

Potřebný materiál 
a vybavení 

Pro zaslepení jamek mikrofluidních karet společnosti Applied Biosystems potřebujete 
následující materiál a vybavení: 
 

•   Nástroj na zaslepení  
•   Pevný stůl 
•   Mikrofluidní kartu/y společnosti Applied Biosystems, která byla centrifugována 
     (strana 4-15) 
•   Nůžky 

 
Doporučení pro 

zaslepování 
Při zaslepování jamek mikrofluidních karet postupujte podle následujících pokynů. 
 

•   Zaslepte jamky v kartě co nejdříve po provedení centrifugace. Omezíte tím 
riziko kontaminace. 

•   Vždy umisťujte mikrofluidní kartu do nástroje tak, že aby se zaslepovací nože  
pohybovaly směrem k plnícím rezervoárům karty. 

•   Vždy zaslepujte jamky ve směru šipek zobrazených na nástroji, čímž zajistíte, že 
mixy jsou vytlačovány z kanálků karty do rezervoárů. 

 
Umístění 

nástroje pro 
zaslepování 

Nástroj pro zaslepování se nejlépe ovládá takovým způsobem, že tlačíte na držák 
ve směru od sebe (nikoliv horizontálně, ze strany na stranu). Při umisťování 
nástroje na zaslepování postupujte podle níže uvedených pokynů. 
 

1.   Umístěte nástroj  na zaslepování na pevný stůl zhruba ve výšce pasu. 
 

2.   Otočte nástroj tak, že jeho čelní strana (kde zaslepování začíná) je co nejblíže 
k vám a zadní strana co nejdál od vás. 

 

Poznámka:  Šipky na nástroji pro zaslepování směřují směrem od vás. 
 
 
 

Držák 
 
 
 
 
 
 
 
 
 
 

Výchozí 
pozice 

 
 
 

Vložení karty 1.   Posuňte madlo se zaslepovacími noži do výchozí pozice. 
 

DŮLEŽITÉ!  Nikdy nevkládejte mikrofluidní kartu do nástroje pro zaslepování 
není-li madlo ve své výchozí pozici. Posunete-li madlo přes mikrofluidní kartu 
do výchozí pozice, dojde k poškození karty. 
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2.   Vložte mikrofluidní kartu do nástroje na zaslepení: 
 

a.  Umístěte mikrofluidní kartu do nástroje na zaslepení ve správné orientaci 
tak, že rezervoáry pro plnění karty jsou co nejblíže šipkám vylisovaným do 
základny nástroje na zaslepení. 

b.  Orientujte mikrofluidní kartu do nástroje na zaslepení fólií nahoru. 
 
 
 
 
 
 
 
 
 
 
 

GR2177 

 

 
3.   Jemně na mikrofluidní kartu zatlačte, aby dosedla do nástroje na zaslepení. 

 

Poznámka:  Dva kovové hroty na základně nástroje pro zaslepení karty 
zapadají do odpovídajících otvorů mikrofluidní karty. Při správném umístění 
zapadne karta do nástroje tak, že její povrch splývá s povrchem nástroje. 

 

Poznámka:  Ve správné pozici drží mikrofluidní kartu i čtyři úchytky. 
 
 

Hrot 
 
 
 
 
 

Hrot 
 

GR2174 

 

 
Zaslepení karty 1.   Přesuňte madlo se zaslepovacími noži přes základnu nástroje na zaslepení ve 

směru šipek. Proveďte to jediným plynulým pohybem až na konec. 

  Na obou stranách nástroje jsou mechanické zábrany, které 
brání pohybu madla s noži tak, aby nedošlo k jeho vysunutí ze základny 
nástroje. Přesun neprovádějte nadměrnou silou nebo rychlostí. Nadměrná síla 
nemá vliv na kvalitu zaslepení karty, ale pouze zatěžuje nástroj na zaslepení. 

 
 
 
 
 

Konec pohybu 
 
 
 
 
 

GR2176 

 
Pohyb tímto 
směrem: 
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2.   Uchopte zaslepenou mikrofluidní kartu po stranách a vyjměte ji z nástroje. 
 

Poznámka:  Ve střední části základny nástroje na zaslepení je prohlubeň pro 
snazší přístup k boku karty. 

 
 
 
 

Prohlubeň 
 
 
 
 
 

GR2175 

 
3.   Ověřte, že karta byla dobře zaslepena. Zářezy vytvořené zaslepovacími noži by  

měly odpovídat hlavním kanálkům mikrofluidní karty. 
 

Pokud tomu tak není nebo je fólie jakkoliv poškozena, mikrofluidní kartu 
nepoužívejte. 

 

4.   Přesuňte madlo s noži do výchozí pozice na základně nástroje. 
 

DŮLEŽITÉ!  Nepřesouvejte madlo do výchozí pozice pokud jste mikrofluidní 
kartu z nástroje nevyjmuli. 

 

 
Oddělení 

rezervoárů pro 
plnění 

1.   Pomocí nůžek oddělte rezervoáry pro plnění od mikrofluidní karty. Odstřihněte 
      je na okraji karty. 

  RIZIKO PORANĚNÍ. Při oddělování rezervoárů od karty 
dbejte opatrnosti. Použijte nůžky spíše než nějaké nástroje s nechráněnými břity. 

 

 

 
 

Mikrofluidní karta je nyní připravena ke spuštění na přístroji 7900HT. 
 

2.   Zvolte jednu z následujících možností. Provádíte-li: 
–  Absolutní nebo relativní kvantifikaci nebo analýzu disociační křivky 

Spusťte běh podle postupu v části “Spuštění běhu” na straně 4-23. 
–  Alelickou diskriminaci 

a.  Vložte destičku do PCR cykleru a proveďte PCR. 

b.  Krátce destičku centrifugujte, abyste odstranili případné vzduchové bubliny.  

c.  Spusťte běh podle postupu v části “Spuštění běhu” na straně 4-23. 
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Část 4.2  Spuštění běhu – jedna destička  
 
 

Část 4.2 Spuštění běhu – jedna destička 
 
 
 

      V této části Uložení dokumentu destičky.................................................................................4-22 
Spuštění běhu – jedna destička (používání programu SDS) .................................4-23 
Po skončení běhu ..................................................................................................4-27 

 
Seznam kroků před 

spuštěním běhu 
Chcete-li spouštět destičky na přístroji 7900HT, musíte nejprve provést následující 
kroky. Více informací naleznete na příslušné straně. 

 
 

Prove
deno 

 

Úkol 
 

Viz strana 

 V posledním měsíci byla provedena kalibrace pozadí. 7-16 

 V posledním půlroce byla provedena kalibrace barev.  7-20 

 V přístroji není destička. 
 

DŮLEŽITÉ!  Chcete-li spustit běh, musí být přístroj prázdný. Je-li 
v něm destička, musíte ji vyjmout. 

4-42 

 
Přehled  

1.  Uložte dokument destičky (viz strana 4-22). 
 
 
 
2.  Vložte a spusťte připravenou destičku nebo mikrofluidní kartu (viz strana 4-23). 
 
 
 
3.  Analýza výsledků. 

–   Alelická diskriminace (viz strana 5-5). 
–   Absolutní kvantifikace (viz strana 6-5). 
–   Relativní kvantifikace (viz strana 6-15). 
–   Analýza disociační křivky (viz strana 6-37). 
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Kapitola 4    Ovládání přístroje   

  

 
 

Uložení dokumentu destičky 
 
 

Přístupová 
práva 

Používáte-li databázi SDS Enterprise, musíte mít pro uložení dokumentu destičky do 
databáze práva uživatele třídy Scientist (Vědec) nebo Administrator (Správce). 

 
Uložení 

dokumentu 
destičky při 

běhu s jednou 
destičkou 

Dokument destičky musí být před spuštěním uložen do databáze SDS Enterprise nebo 
jako dokument SDS (*.sds). 
 
Chcete-li uložit dokument SDS: 
 

1.   V programu SDS zvolte File > Save As (Soubor > Uložit jako). 
 

2.   V poli Look In (Vyhledat) dialogového okna Save As (Uložit jako) vyhledejte 
adresář pro uložení dokumentu. 

 

3.   V poli File name (Název souboru) buď: 
•   Zadejte název souboru (dokumentu destičky) nebo 
•   Zadejte nebo naskenujte čárový kód destičky. 

 

Poznámka:  Název souboru nemusí být čárový kód destičky. 
 

4.   Klikněte  (Uložit). 

Program uloží dokument destičky do zvoleného adresáře. 
 

5.   Spusťte běh podle postupu v části “Spuštění běhu” na straně 4-23. 
 
Chcete-li uložit dokument do databáze SDS Enterprise: 
 

1.   Zvolte File > Save Document to Database (Soubor > Uložit dokument do 
      databáze). 

 

2.   V dialogovém okně Save Document to database (Uložit dokument do databáze): 

a.  Zadejte stručný popis souboru do pole Comment (Komentář) (max. 255 
     znaků). 

Ukládáte-li dokument destičky do databáze, bude název souboru ztracen, 
nenapíšete-li jej do pole Comment. 

b.  Klikněte  . 
 

3.   V okně Saved Document (Dokument uložen) klikněte  . 
 

4.   Spusťte běh podle postupu v části “Spuštění běhu” na straně 4-23. 
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Spuštění běhu – jedna destička (používání programu SDS)      

  

 
 

Spuštění běhu – jedna destička (používání programu SDS) 
 
 

Přístupová 
práva 

Pro spuštění běhu destiček uložených v databázi SDS Enterprise neexistují žádná 
omezení z hlediska přístupových práv. 

 
       Spuštění běhu 1.   V programu SDS zvolte v dokumentu destičky záložku Instrument (Přístroj). 

 

2.   V záložce Real-Time nebo Plate-Read klikněte  (Otevřít/Zavřít). 

Nosítka přístroje se vysunou ven. 
 

3.   Umístěte připravenou destičku nebo mikrofluidní kartu do nosítek přístroje 
      podle vyobrazení níže. 

 

Před vložením destičky nebo mikrofluidní karty do nosítek se ujistěte, že: 
•   V programu SDS je otevřen odpovídající dokument destičky. 
•   Destička je uzavřena nebo mikrofluidní karta zaslepena. 

 
 
 

Jamka A1 
 
 
 

Šikmý roh 
 
 
 

Čárový kód 
 
 
 

Jamka A1 
 
 
 

Šikmý roh 
 
 
 

Čárový kód 
 

DŮLEŽITÉ!  Pozice A1 – viz vyobrazení. 
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4.   Proveďte jeden z následujících kroků: 

•   Provádíte-li běh v reálném čase, klikněte . 

•   Provádíte-li běh se čtením po skončení běhu, klikněte . 

Nosítka přístroje se zasunou zpět a přístroj spustí běh nebo čtení destičky. 
 

Poznámka:  Před spuštěním běhu může přístroj vyčkat až 15 minut na ohřátí 
vyhřívaného víka na požadovanou teplotu. 

 

Poznámka:  Více informací o záložkách Real-Time a Plate-Read získáte po 
kliknutí na ikonu  v nápovědě programu SDS. 

 

Během a po skončení běhu můžete: 
 

 

Činnost… 
 

Viz strana 

Sledování průběhu běhu 4-25 

Zastavení běhu 
 

DŮLEŽITÉ!  Musíte-li z jakéhokoliv důvodu běh zastavit, pečlivě si 
nejprve přečtěte pokyny na straně 4-26. 

4-26 

Otevření nosítek přístroje (po skončení běhu) 4-27 

Analýza výsledků po skončení běhu 4-27 
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Spuštění běhu – jedna destička (používání programu SDS)      

  

 

 
 

Sledování 
průběhu 

běhu 

Program SDS zobrazuje v záložce Real-Time nebo Plate Read informace o stavu 
přístroje a průběhu běhu. Na obrázku 4-10 jsou příklady údajů z těchto záložek 
během provozu přístroje 7900HT. 

 

 

 
     Záložka Real-Time 
(sběr dat v reálném čase) 

      Záložka Plate Read  
(sběr dat po skončení běhu) 

 
 

Obrázek 4-10   Záložky Real-Time a Plate Read 
 
 

•   Status – Zobrazuje stav přístroje 7900HT  
•   Time Remaining – Zobrazuje dobu do konce běhu 

 
Temperature - Teplota (pouze záložka Real-Time) 

 

•   Block – Zobrazuje aktuální teplotu bloku na vzorky 
•   Cover – Zobrazuje aktuální teplotu vyhřívaného víka 
•   Sample – Zobrazuje vypočítanou teplotu vzorků 

 
Cycle - Cyklus (pouze záložka Real-Time) 

 

•   Rep – Zobrazuje počet opakování cyklu 
•   Stage – Zobrazuje v kterém kroku se běh nachází 
•   State – Zobrazuje údaje o aktuálním kroku 
•   Step – Zobrazuje aktuální fázi cyklu 
•   Time – Zobrazuje dobu do konce kroku 

 
Data Collection Stamp – Sběr dat (pouze záložka Plate Read) 

 

•   Pre – Zobrazuje  datum provedení čtení před zahájením cyklování (pre-read). 
•   Post – Zobrazuje  datum provedení čtení po ukončení cyklování (post-read). 

 
 

Poznámka:  Více informací o záložkách Real-Time a Plate-Read získáte po kliknutí 
na ikonu  v nápovědě programu SDS. 
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Zastavení 
běhu 

DŮLEŽITÉ!  Před zastavením běhu si přečtěte následující pokyny. 
 
Zastavení běhu typu End-Point (Alelická diskriminace) 
 

V záložce Plate-Read dokumentu destičky klikněte . 
 
Zastavení běhu v režimu Real-Time (Absolutní nebo relativní kvantifikace) 
 

Dosáhla teplota víka (Cover) v záložce Real-Time 104 °C? 
 

•   No (teplota víka je nižší než 104 °C) 

V záložce Real-Time klikněte . 
•   Yes (teplota víka dosáhla 104 °C) 

Teplotní cyklování destičky již bylo zahájeno. Postupujte podle pokynů 
v následující tabulce: 

 
 

Důvod zastavení běhu 
 

Pak… 

Zapomněli jste definovat některé 
parametry dokumentu destičky jako 
např. přidání detektoru, úlohy 
detektoru, názvu vzorku 
(netýká se chyb v teplotním 
profilu) 

nezastavujte běh. 
 

Nechte přístroj dokončit běh a zadejte údaje 
před analýzou výsledků. Program nepoužívá 
informace o názvech vzorků nebo 
detektorech dříve než při analýze výsledků. 

•   Zapomněli jste něco pipetovat do 
    destičky (např. enzym nebo 
    mastermix) 

•   Špatně jste definovali teplotní 
profil. 

1.  V záložce Real-Time klikněte 

. 
2.  Zjistěte jak dlouho již běh trvá. 

 

3.  Rozhodněte, zda je možné destičku 
spustit znovu. 

 

4.  Je-li to nezbytné, vyjměte destičku a 
přidejte do ní co je potřeba. 

 

5.  Spusťte destičku znovu pomocí nově 
vytvořeného dokumentu destičky. 
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Po skončení běhu    
 
 

Po skončení běhu 
 
 

Přístupová 
práva 

Používáte-li databázi SDS Enterprise, musíte mít pro uložení dokumentu destičky do 
databáze práva uživatele třídy Scientist (Vědec) nebo Administrator (Správce). 

 
Vyjmutí destičky 

(Otevření a 
zavření nosítek) 

Podle stavové ikony poznáte, z jakého dokumentu destičky lze provést vyjmutí destičky. 
 
 

Stavová ikona Krok 
 

1.  V programu SDS zvolte Window (Okno) > (dokument 
destičky propojený s přístrojem). 

Connected to 
platename 
(Propojeno s 
název destičky) 

2.  V dokumentu destičky zvolte záložku Instrument (Přístroj) 

3.  Zvolte záložku Plate-Read nebo Real-Time podle typu běhu. 

4.  Zvolte  (Otevřít/Zavřít). 
 
 

 
Disconnected 
(Odpojeno) 

1.  V programu SDS klikněte nebo zvolte File > New (Soubor > 
     Nový). 
2.  Klikněte . . 
3.  Zvolte záložku Instrument (Přístroj). 

4.  Zvolte záložku Plate-Read nebo Real-Time. 

5.  Zvolte  (Otevřít/Zavřít). 
 
 

Uložení 
běhu 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Analýza 

výsledků běhu 

Po skončení běhu musíte uložit výsledky buď do databáze SDS Enterprise nebo ve 
formě souboru SDS (*.sds). 
 

Chcete-li uložit výsledky ve formě souboru SDS: 
 

1.   V programu SDS zvolte File > Save (Soubor > Uložit). 
 

Chcete-li uložit výsledky do databáze SDS Enterprise: 
 

DŮLEŽITÉ!  Pokud jste dokument destičky uložili do databáze již před spuštěním 
destičky, uložil program SDS výsledky běhu dočasně do adresáře /temp. Pokud po 
skončení běhu uzavřete dokument destičky aniž jej uložíte, otevřete adresář temp a 
přejmenujte dočasně uložený soubor na soubor typu *.sds, takže jej budete schopni jej 
znovu otevřít. 
 

1.   Zvolte File > Save Document to Database (Soubor > Uložit dokument do 
      databáze): 

 

2.   V poli Comment (Komentář) dialogového okna Save Document to Database 
zadejte stručný popis dokumentu destičky (max. 255 znaků). 

 

Poznámka:  Ukládáte-li dokument destičky do databáze, přijdete o jeho název 
pokud jej neuvedete v poli Comment (Komentář). 

 

3.   Klikněte  . 
 

4.   V dialogovém okně Saved Document (Uložený dokument) klikněte  . 
 
Část 5.1 Alelická diskriminace .........................................................................5-5 
Část 6.1 Absolutní kvantifikace........................................................................6-5 
Část 6.2 Relativní kvantifikace .......................................................................6-15 
Část 6.3 Analýza disociační křivky ................................................................6-37 
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Kapitola 4    Ovládání přístroje 
 
 

Odpojení 
programu a 

přístroje 

V programu SDS je možné zastavit všechnu komunikaci s přístrojem 7900HT. 
Přístroj ABI PRISM 7900HT je ovládán programem SDS nebo Automation Controller, 
chcete-li ovládat přístroj jedním z nich, musíte ovládání tím druhým ukončit. 
 
 

Chcete-li… Pak… 

 
odpojit program a 
přístroj 

1.  V programu SDS zvolte záložku Instrument (Přístroj) 
otevřeného dokumentu destičky. 

2.  Zvolte záložku Real-Time nebo Plate-Read. 

3.  Zvolte  (Odpojit). 
 

Poznámka:  Po odpojení program ani nemonitoruje ani 
nekontroluje činnost přístroje 7900HT. 

 
znovu propojit program 
a přístroj 

pro propojení otevřeného dokumentu destičky: 
1.  Zvolte File > Close (Soubor > Zavřít) čímž zavřete dokument 
     destičky. 

2.  Klikněte  nebo zvolte File > Open (Soubor > Otevřít). 
3.  V poli Look In (Vyhledat) vyhledejte požadovaný dokument 
     destičky. 

4.  Klikněte  (Otevřít). , 
Po otevření dokumentu destičky program znovu naváže 
spojení s přístrojem 7900HT. 

 
pro propojení nového dokumentu destičky klikněte   
nebo zvolte File > New (Soubor > Nový). 
Po vytvoření dokumentu destičky program znovu naváže 
spojení s přístrojem 7900HT. 
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Část 4.3  Automatický režim provozu   
 
 

Část 4.3 Automatický režim provozu 
 
 
 

      V této části Ovládání programu s databází SDS Enterprise ................................................. 4-30 
Ovládání programu bez databáze SDS Enterprise ............................................. 4-32 
Spuštění destiček pomocí programu Automation Controller............................. 4-37 
Po skončení běhu ............................................................................................... 4-42 

 
Seznam kroků před 

spuštěním běhu 
Chcete-li spouštět destičky na přístroji 7900HT, musíte nejprve provést následující 
kroky. Více informací naleznete na příslušné straně. 

 
 

Prove
deno 

 

Úkol 
 

Viz strana 

 V posledním měsíci byla provedena kalibrace pozadí. 7-16 

 V posledním půlroce byla provedena kalibrace barev.  7-20 

 V přístroji není destička. 
 

DŮLEŽITÉ!  Chcete-li spustit běh, musí být přístroj prázdný. Je-li 
v něm destička, musíte ji vyjmout. 

4-42 

 Zásobník na destičky, které již byly spuštěny, je prázdný. – 

 
  Přehled  Přístroj ABI PRISM 7900HT je možné používat v bezobslužném režimu provozu s 

ovládáním pomocí programu Automation Controller. Program Automation Controller 
umožňuje ovládání přístroje 7900HT, pevně umístěné čtečky čárových kódů a 
podavače mikrodestiček Zymark Twister a zpracovávat připravené destičky 
s potřebou minimálních uživatelských zásahů. Program Automation Controller může 
spouštět dokumenty destiček uložené na pevném disku počítače, připojeného k 
přístroji, nebo v databázi SDS Enterprise. 

 
Možnosti automatického provozu 

 

Obdobně jako program SDS i program Automation Controller vyžaduje vytvoření 
dokumentu destičky pro každou spouštěnou destičku. Program Automation Controller 
může spouštět dokumenty destiček uložené na pevném disku počítače, připojeného 
k přístroji, nebo v databázi SDS Enterprise. 

 

Postupujte podle odpovídajícího návodu: 
 

Ovládání programu s databází SDS Enterprise ................................................ 4-30 
Ovládání programu bez databáze SDS Enterprise ............................................ 4-32 
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 Část 4.3  Automatický režim provozu 
 
 

Ovládání programu s databází SDS Enterprise  
 
 

  Přehled Nejjednodušším způsobem ovládání přístroje ABI PRISM 7900HT je provoz pomocí 
programu Automation Controller s databází SDS Enterprise. Dokumenty destiček 
uložené v databázi SDS Enterprise jsou pro použití v programu Automation 
Controller automaticky řazeny. Po vytvoření dokumentu destičky mohou být 
připraveny samotné destičky a vloženy do podavače mikrodestiček Zymark Twister. 

 
    Postup 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Přihlášení do 
programu 

Automation 
Controller  

 
1.  Spusťte program Automation Controller a přihlaste se do databáze (viz 

strana 4-30). 
 
 
 

2.  Je-li to žádoucí, propojte běhy relativní kvantifikace nebo alelické diskriminace 
s příslušnou studií (study) (viz strana 4-31). 

 
 
 

3.  Vložte destičky a mikrofluidní karty do zásobníků podavače mikrodestiček 
    Zymark Twister (viz strana 4-39). 

 
 
 

4.  Spusťte běh (viz strana 4-41). 
 
 
 

5.  Analýza výsledků. 
–   Alelická diskriminace (viz strana 5-5). 

–   Absolutní kvantifikace (viz strana 6-5). 
–   Relativní kvantifikace (viz strana 6-15). 

–   Analýza disociační křivky (viz strana 6-37). 
 
 
 
1.   Máte-li spuštěn program SDS: 

•   Zvolte Instrument > Disconnect (Přístroj > Odpojit), čímž odpojíte 
přístroj a program, nebo 

•   Zvolte File > Exit (Soubor > Konec), čímž program SDS ukončíte. 
 

2.   Spusťte program Automation Controller  
(zvolte  > Programs > Applied Biosystems > SDS 2.2 > 

Automation Controller 2.2). 
 

3.   V dialogovém okně Login (Přihlášení) zadejte vaše uživatelské jméno a heslo a 
 klikněte  , čímž se přihlásíte do databáze. 

 

4.   Propojte běh se studií podle postupu v části “Propojení běhu a studie” na straně 
      4-31. 
 

5.   Vložte destičky do podavače destiček podle postupu v části “Vložení destiček 
 do podavače destiček” na straně 4-39. 
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Ovládání programu s databází SDS Enterprise    
 
 

Propojení 
běhu a 
studie 

Přístupová práva 
 

Používáte-li databázi SDS Enterprise, má každý uživatel právo propojit běh a studii. 
Novou studii ale mohou vytvořit pouze uživatelé s právy uživatele třídy Scientist 
(Vědec) nebo Administrator (Správce). 
 
O propojování studií 
 

Program Automation Controller může automaticky propojit výsledky běhů (tzv. 
seance - ‘sessions’) s určitou studií. Tento krok není povinný a lze je provést později 
prostřednictvím programu RQ nebo SNP Manager. Více informací o používání studií 
naleznete v části “Koncepce databáze a správa dat” na straně 1-27. 
 

DŮLEŽITÉ!  Pokud jste propojili běh a studii, nemůžete daný běh propojit s jinou 
studií dokud jej znovu neodpojíte v programu RQ nebo SNP Manager. 
 
Chcete-li provést propojení se studií: 
 

1.   V programu Automation Controller: 

•   Běhy relativní kvantifikace – Klikněte na  v poli Save Relative 
Quantification to Study (Uložit relativní kvantifikaci do studie) nebo 
zvolte Enterprise > Select RQ Study (Zvolte RQ studii). 

•   Běhy alelické diskriminace – Klikněte na  v poli Save Allelic 
Discrimination to Study (Uložit alelickou diskriminaci do studie) nebo 
zvolte Enterprise > Select AD Study (Zvolte AD studii). 

 
 

Kliknutím propojíte se 
studií při relativní 
kvantifikaci 

 

Kliknutím propojíte se 
studií při alelické 
diskriminaci 

 
2.   V dialogovém okně Select Study (Zvolte studii) buď: 

•   Zvolte již existující studii 

•   Klikněte  (Nový) a zadejte údaje do dialogového okna New Study 
(Nová studie), poté klikněte . 
– Name (Název) – Zadejte název studie (max. 128 znaků). 
– Creator (Vytvořil) – (Nelze změnit) Zobrazí vaše uživatelské jméno. 
– Description (Popis) – Zadejte stručný popis studie (max. 255 znaků). 

 

3.   Klikněte  . 
 

  4.   Vložte destičky do podavače destiček podle postupu v části “Vložení destiček 
 do podavače destiček” na straně 4-39. 

 

DŮLEŽITÉ!  V dialogovém okně Database Options (Možnosti databáze) musí být 
zvolena volba Save Analysis Results (Uložit výsledky analýzy), chcete-li propojit 
běhy řízené programem Automation Controller (možnost je předvolena). Je-li tato 
možnost zvolena, program automaticky provádí analýzu každého dokumentu destičky 
a ukládá analyzované výsledky do databáze. Okno otevřete zvolením Enterprise > 
Database Options (Možnosti databáze). 
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Ovládání programu bez databáze SDS Enterprise  
 
 

  Přehled Prvním krokem v režimu automatického provozu přístroje ABI PRISM 7900HT je 
přidání dokumentů destiček do řady destiček. Řada destiček je seznam dokumentů 
destiček, který používá program Automation Controller při identifikaci a provedení 
běhu připravených destiček. Tím, že přidáte dokument destičky do řady destiček, je 
tento dokument připraven k použití programem Automation Accessory. 

 

DŮLEŽITÉ!  Poté co jste přidali dokument destičky do řady destiček, program tento 
soubor uzamkne, čímž zabrání provedení dalších změn v souboru dokud nebude 
proveden běh nebo nebude tento dokument destičky vyjmut z řady destiček. 

 

Přístroj ABI PRISM 7900HT nabízí tři různé možnosti jak přidat dokument destičky 
do řady destiček. Seznamte se s těmito možnostmi uvedenými níže a zvolte možnost, 
která nejlépe odpovídá vašim potřebám. 

 

•   Přidejte dokument destičky do řady destiček pomocí programu SDS. (strana 4-33) 
•   Pomocí nástroje Template Batch vytvořte skupinu dokumentů destiček na 

základě templátu a přidejte je do řady destiček. (strana 4-34) 
•   Přidejte nebo odstraňte jednotlivé destičky nebo více destiček do řady destiček 

pomocí programu Automation Controller. (strana 4-37) 
 

   Postup  
 
1.  Přidejte dokumenty destiček do řady destiček. 

–   Přidejte dokument destičky do řady destiček pomocí programu SDS (viz 
strana 4-33) 

–   Vytvořte a přidejte dokumenty destiček do řady destiček pomocí nástroje 
     Template Batch (viz strana 4-34) 

 
 
 
2.  Spusťte a nastavte program Automation Controller a přidejte nebo odstraňte 

dokumenty destiček z řady destiček podle potřeby. (viz strana 4-37) 
 

 
 
3.  Vložte připravené destičky nebo mikrofluidní karty do úložných věží podavače  

mikrodestiček Zymark Twister. (viz strana 4-39) 
 
 
 
4.  Spusťte přístroj. (viz strana 4-41) 
 
 
 
5.  Analýza výsledků. 

–   Alelická diskriminace (viz strana 5-5). 
–   Absolutní kvantifikace (viz strana 6-5). 
–   Relativní kvantifikace (viz strana 6-15). 
–   Analýza disociační křivky (viz strana 6-37). 
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Přidání dokumentu destičky do řady destiček (pomocí programu SDS) 

 
DŮLEŽITÉ!  Součástí dokumentu destičky musí být čárový kód, teprve pak lze 
dokument přidat do řady destiček. Více informací o vložení čárového kódu do 
dokumentu destičky viz strana 3-25. 

 

1.   V programu SDS zvolte záložku Instrument (Přístroj). 
 

2.   V záložce Instrument (Přístroj) zvolte záložku Queue (Řada). 
 

3.   V záložce Queue (Řada) klikněte  (Poslat do řady). 

Uložili jste dokument destičky? 
–  Ano, program dokument destičky uloží automaticky. 
–  Ne, proveďte následující: 

 

a.  V poli Look in (Vyhledat) dialogového okna Save As (Uložit jako) 
vyhledejte adresář v němž chcete dokument destičky uložit. 

b.  Zvolte Files of type (Typ souboru) > ABI PRISM SDS Single Plate (*.sds). 

c.  Klikněte do pole File name (Název souboru) a proveďte: 
–    Zadejte název souboru dokumentu destičky, nebo 
– Zadejte nebo naskenujte čárový kód destičky.  

 d.  Klikněte  (Uložit). Program dokument uloží. 

4.   Jakmile jste vyzváni, klikněte  (Ano), čímž zařadíte dokument do řady 
      destiček. 

Poté co jste přidali dokument destičky do řady destiček, program tento soubor 
uzamkne, čímž zabrání provedení dalších změn v souboru dokud nebude 
proveden běh nebo nebude tento dokument destičky vyjmut z řady destiček. 

 

Poznámka:  Chcete-li dokument destičky vyjmout z řady, spusťte program 
Automation Controller a vyjměte dokument destičky z řady podle postupu 
na straně 4-38. 

 

5.   Klikněte  . 

6.   Zvolte File > Close (Soubor > Zavřít). Program SDS zavře dokument destičky. 
 

7.   Opakujte postup uvedený v této části tak dlouho dokud chcete vytvářet a přidávat 
      destičky do řady. 

 

8.   Po ukončení vytváření dokumentů destiček spusťte destičky seřazené v řadě 
podle postupu v části “Spuštění a nastavení programu Automation Controller” na 
straně 4-37. 
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Vytváření dokumentů destiček pomocí nástroje Template Batch  

 
 

O nástroji 
Template Batch 

 

Nástroj Template Batch umožňuje rychle vytvořit mnoho dokumentů destiček  
z jediného SDS templátu (*.sdt). Tento nástroj může být výhodné použít v situacích 
kdy jsou analyzovány vzorky v destičkách s totožným uspořádáním esejí. 
 

DŮLEŽITÉ!  Dokumenty destiček vytvořené nástrojem Template Batch neobsahují 
informace o vzorcích a destičce (čárový kód a pole komentář). Tyto informace musíte 
zadat ručně po skončení běhu. 

 
Vytvoření 

dokumentů 
destiček 

z templátu 

Poznámka:  Více informací o jednotlivých součástech dialogového okna Template 
Batch získáte v nápovědě programu SDS po kliknutí na ikonu . 
 

1.   V programu SDS otevřete soubor templátu z: 

pevného disku počítače 

a.  Klikněte  nebo zvolte File > Open (Soubor > Otevřít). 
b.  Zvolte File of type (Typ souboru) > ABI PRISM SDS Template Document 
     (*.sdt). 

c.  V poli Look in (Vyhledat) vyhledejte a zvolte templát.  

d.  Klikněte  (Otevřít). 

e.  Pokračujte krokem 2. 

databáze SDS Enterprise  

a.  Zvolte File > Open Template from Database (Soubor > Otevřít templát 
     z databáze. 

b.  V poli Template Names (Název templátu) dialogového okna Select 
     Template (Zvolte templát) vyhledejte a zvolte templát 

c. Klikněte .  

d. Klikněte  (Hotovo).  

e.  Uložte templát na pevný disk počítače podle postupu na straně 3-23. 

f.   Pokračujte krokem 2. 

Program SDS zobrazí soubor templátu. 
 

2.   Zařaďte soubor templátu do řady: 

a.  Zvolte záložku Instrument (Přístroj).  

b.  Zvolte záložku Queue (Řada). 

3.   Klikněte  (Poslat do řady). 

4.   V dialogovém okně Template Batch zadejte identifikační údaje destičky (Plate 
      ID): 

a. Klikněte  (Nový).  

 
 

 Uživatelská příručka pro Real-Time PCR systém ABI PRISM 7900HT 4-34 



Ovládání programu bez databáze SDS Enterprise     

  

 

 
 

b.   Do pole Plate ID (Identifikační údaje destičky) dialogového okna New 
Plate (Nová destička) naskenujte pomocí ruční čtečky čárových kódů 
čárový kód první destičky.  

  NEBEZPEČÍ LASEROVÉHO ZÁŘENÍ. Přímé nebo 
odražené laserové paprsky mohou poškodit sítnici, což může vést k trvalém 
poškození zraku. Nikdy se nedívejte přímo do laserového paprsku. Odstraňte 
šperky a další předměty, které mohou odrážet paprsek do vašich očí. Chraňte 
ostatní před laserovými paprsky. 

 

DŮLEŽITÉ!  Používáte-li databázi SDS Enterprise musí být čárové kódy unikátní 
a nesmí být použity již existujícím dokumentem destičky. 

 

c.  Opakujte krok b pro všechny destičky.  

d.  Po skončení klikněte . 

Čárové kódy destiček se zobrazí v poli Plate ID. 
 

5.   Zvolte cílový adresář pro uložení nových dokumentů destičky: 

a.  Klikněte  (Zvolit). 

b.  V poli Look in (Vyhledat) vyhledejte a zvolte adresář, do něhož chcete 
ukládat nové soubory. 

c.  Klikněte  (Zvolit adresář). 

V poli Plate Directory (Adresář destiček) dialogového okna Template Batch se 
zobrazí název cílového adresáře. 

 

 
 
 
 
 
 
 
 
 
 

Cílový adresář 
 
 
 
 
 

6.   Klikněte  (Vytvořit). 

Program vytvoří dokumenty destiček pro všechny položky v seznamu Plate ID, 
uloží je do cílového adresáře, přidá je do řady destiček a zobrazí zprávu o 
počtu dokumentů destiček, které vytvořil a zařadil do řady destiček. 

 

7.   Klikněte  , čímž zprávu uzavřete. 
 

8.   Klikněte  (Hotovo), čímž uzavřete dialogové okno Template Batch. 
 

9.   Zvolte File > Close (Soubor > Zavřít), čímž zavřete templát. 
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10.   Opakujte kroky v kapitolách 3 “Příprava běhu” a 4 “Ovládání přístroje” tak, 
        abyste vytvořili a přidali do řady další destičky podle potřeby. 

 

Poznámka:  Poté co jste přidali dokument destičky do řady destiček, program 
tento soubor uzamkne, čímž zabrání provedení dalších změn v souboru dokud 
nebude proveden běh nebo nebude tento dokument destičky vyjmut z řady 
destiček. 

 

11.   Po ukončení vytváření a přidávání dokumentů destiček do řady spusťte destičky 
seřazené v řadě podle postupu v části “Spuštění a nastavení programu 
Automation Controller” na straně 4-37. 
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Spuštění a nastavení programu Automation Controller 

 
 

Spuštění a 
nastavení 
programu 

Přístroj ABI PRISM 7900HT je možné provozovat v automatickém režimu pomocí 
programu Automation Controller. Program koordinuje fungování přístroje 7900HT, 
čtečky čárových kódů a podavače mikrodestiček a snímá a ukládá data v průběhu 
běhu. 
 

1.   Používáte-li program SDS, proveďte: 
•   Zvolte Instrument > Disconnect (Přístroj > Odpojit), čímž ukončíte 

komunikaci mezi programem a přístrojem, nebo 
•   Zvolte File > Exit (Soubor > Konec), čímž uzavřete program SDS. 

 

2.   Spusťte program Automation Controller  
(zvolte  > Programs > Applied Biosystems > SDS 2.2 > 

Automation Controller 2.2). 
 

3.   Používáte-li databázi SDS Enterprise, zadejte do odpovídajících polí 
dialogového okna Log In (Přihlásit) programu Automation Controller vaše 
uživatelské jméno a heslo, poté klikněte  . 

 

4.   Používáte-li databázi SDS Enterprise, definujte propojení jednotlivých běhů a 
studií podle postupu v části “Propojení běhu a studie” na straně 4-31. 

 

5.   Používáte-li program Automation Controller ve spojení s řadou destiček, ověřte, 
že pole Plate Queue (Řada destiček) obsahuje všechny dokumenty destiček, 
které chcete spustit. 

•   Chcete-li přidat dokument destičky do řady destiček – viz “Přidání destiček 
do řady destiček” na straně 4-38. 

•   Chcete-li odebrat dokument destičky z řady destiček – viz “Odebrání 
destiček z řady destiček” na straně 4-38. 

 
 
 
 
 
 

 
Řada destiček 
(musí obsahovat 
dokumenty destiček 
pro všechny 
spouštěné destičky) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.   Připravte destičky do podavače podle postupu na straně  4-39. 
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Přidání destiček 
do řady destiček 

1.   V programu Automation Controller zvolte File > Add Plates (Soubor > Přidat 
      destičky). 
 

2.   V poli Look in (Vyhledat) dialogového okna Open (Otevřít) vyhledejte adresář 
obsahující hledaný soubor/y. 

 

3.   Za současného stisku klávesy Ctrl zvolte dokument(y) destičky/ek, které chcete 
      přidat do řady destiček. 

Vybrané soubory budou zvýrazněny. 
 

DŮLEŽITÉ!  Součástí dokumentu destičky musí být čárový kód, jinak jej nelze 
přidat do řady destiček. Více informací o zadávání čárových kódů do dokumentu 
destičky viz strana 3-25. 

 

4.   Klikněte  (Otevřít). 

Program Automation Controller přidá dokument/y destičky/ek do řady destiček. 
 

Poznámka:  Poté co jste přidali dokument destičky do řady destiček, program 
tento soubor uzamkne, čímž zabrání provedení dalších změn v souboru dokud 
nebude proveden běh nebo nebude tento dokument destičky vyjmut z řady 
destiček. 

 
Odebrání 

destiček z řady 
destiček 

Chcete-li odebrat dokument destičky z řady destiček: 
 

Odebíráte-li… Pak… 

 
určitý dokument 
destičky z řady 
destiček 

1.  Za současného stisku klávesy Ctrl zvolte dokumenty destiček, 
     které chcete odebrat. 

Vybrané soubory budou zvýrazněny. 

2.  Zvolte File > Clear Selected Plate(s) (Soubor > Odstranit 
     zvolené destičky). 

3.  Klikněte  (Ano). 

Program odstraní zvolené dokumenty z řady destiček. 
 

všechny dokumenty 
z řady destiček 

1.  V programu Automation Controller zvolte File > 
Clear All Plates (Soubor > Odstranit všechny destičky). 

2.  Klikněte  (Ano). 
  Program odstraní všechny dokumenty z řady destiček. 
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Spuštění destiček pomocí programu Automation Controller  
 
 

Přístupová 
práva 

Pro spuštění běhu destiček uložených v databázi SDS Enterprise neexistují žádná 
omezení z hlediska přístupových práv. 

 
 
Vložení destiček do podavače 

 

 
Doporučení Při vkládání destiček do podavače postupujte následujícím způsobem: 

 

•   Před vložením destiček do podavače se ujistěte, že: 

–  dokument destičky pro každou destičku byl přidán do řady destiček 
nebo je v databázi SDS Enterprise  

–  destička byla uzavřena pomocí optické adhezívní fólie. 

•   Vložte destičky do zásobníků podavače v libovolném pořadí. Program načte 
čárový kód každé destičky před jejím použitím a vyhledá odpovídající dokument 
destičky. Program Automation Controller umožňuje provést běh až 84 destiček 
(21 destiček v jednom zásobníku). 

•   Vložte destičky do zásobníků tak, že umístění jamky A1 každé destičky 
     odpovídá obrázku 4-11. 
•   Neumisťujte destičky do zásobníku na destičky, které již byly spuštěny (X). 

Tento zásobník slouží k umisťování již analyzovaných destiček po skončení 
běhu. 

•   Používáte-li v podavači mikrofluidní kartu/y Applied Biosystems: 
–  Nedávejte do zásobníku více než 20 karet. 

–  Karty na sebe dobře zarovnejte. (Podavač nemusí nalézt kartu, není-li balík 
karet dobře zarovnán.) 

 

 
 

X 
4 

 

3 Podavač mikrodestiček  
  Zymark Twister (pohled shora) 

2 
1 

 
Čárový kód 

 

Jamka A1 
 

Obrázek 4-11 Umístění destiček v podavači mikrodestiček Zymark Twister  
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Vložení destiček 1.   Vložte uzavřené destičky nebo karty do zásobníků podavače podle postupu na 
straně 4-39. 

 

2.   V programu Automation Controller zatrhněte, které zásobníky používáte. 
 

DŮLEŽITÉ!  Pokud nepoužíváte zásobník 1 nebo možnost Restack 
vysvětlenou níže, odstraňte všechny destičky ze zásobníku 1. Při takovémto 
nastavení bude podavač umisťovat destičky z podavače 2 (po provedení běhu) 
do podavače 1. Obsahuje-li podavač 1 destičky, běh bude ukončen. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Označení zásobníků 
 

 
 
 
 
 

3.   Pokud chcete, aby po skončení běhu byly destičky umístěny v témže zásobníku 
jako na začátku, zvolte možnost Restack when finished (Po skončení 
přeskládat). 

 

Restack when finished (Po skončení přeskládat) – Po skončení běhu všech 
destiček v jednom zásobníku budou tyto destičky umístěny zpět do téhož 
zásobníku a v tomtéž pořadí jako na začátku. Není-li tato možnost zvolena, 
budou destičky umístěny do nejbližšího volného zásobníku ve směru 
hodinových ručiček počínaje zásobníkem na destičky, které již byly spuštěny 
(X). 

 

Poznámka:  Zpracováváte-li více destiček, trvá jejich přeskládání dosti dlouho. 
Používejte tuto možnost pouze je-li to nezbytně nutné. 

 

4.   Spusťte řadu destiček podle postupu na straně 4-41. 
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Spuštění přístroje 

 
 

Spuštění 
řady destiček 

Poté co jste přidali všechny dokumenty destiček do řady destiček nebo je uložili do 
databáze SDS Enterprise, můžete řadu destiček spustit. 
 

Chcete-li spustit řadu destiček, klikněte na  (Spustit řadu) ze záložky 
Plate Queue (Řada destiček). Program Automation Controller provede 
následující kroky: 

1.   Podavač mikrodestiček Zymark Twister vyjme první destičku ze zásobní věže 1 
a vloží ji do nosítek přístroje 7900HT. 

 

2.   Pevně umístěná čtečka čárových kódů načte čárový kód destičky. 
 

3.   Program Automation Controller provede následující kroky: 

•   Je-li program propojen s databází SDS Enterprise, vyhledá v databázi 
dokument destičky s odpovídajícím čárovým kódem. Jakmile jej nalezne, 
stáhne jej z databáze. 
Pokud program nenalezne dokument destičky s odpovídajícím čárovým 
kódem, prohledá řadu destiček postupem uvedeným níže. 

•   Není-li program propojen s databází, vyhledá v řadě destiček dokument 
destičky s odpovídajícím čárovým kódem. Jakmile jej nalezne, použije 
informace o parametrech běhu v něm obsažené. 

 

4.   Přístroj 7900HT uzavře nosítka přístroje a spustí běh podle parametrů 
 v dokumentu destičky. 

 

Poznámka:  Před spuštěním běhu může přístroj vyčkat až 15 minut na ohřátí 
vyhřívaného víka na požadovanou teplotu. 

 

Používáte-li databázi SDS Enterprise, program Automation Controller 
automaticky provádí počáteční analýzu každého ukončeného běhu a ukládá 
výsledky do databáze. Pokud jste definovali studii nebo studie podle postupu 
“Propojení běhu a studie” na straně 4-31, program automaticky propojí 
analyzované výsledky s příslušnou studií. 

Během a po skončení běhu jsou k dispozici následující možnosti: 
 

 

Chcete-li… 
 

Viz strana 

Sledovat průběh běhu 4-42 

Zastavit běh 
 

DŮLEŽITÉ!  Musíte-li z jakéhokoliv důvodu zastavit nedokončený 
běh, pečlivě si přečtěte pokyny na straně 4-26. 

4-42 

Otevřít nosítka přístroje (po skončení běhu) 4-42 

Analyzovat výsledky běhu po jeho skončení  4-42 
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Spuštění destiček pomocí programu Automation Controller            

  

 
 

Sledování 
průběhu 

běhu 

Program Automation Controller zobrazuje informace o průběhu běhu v záložce  
Real-Time nebo Plate Read. Více informací viz strana 4-25. 

 
Zastavení 

přístroje 
Chcete-li zastavit přístroj, klikněte kdykoliv na ikonu  v programu Automation 
Controller. 

 

Kliknete-li ... 
 

Přístroj... 

pokud podavač destiček 
manipuluje s destičkou 

ukončí běh a přesune rameno podavače do výchozí 
pozice. 

po vložení destičky do 
přístroje ale před spuštěním 
běhu 

ukončí běh, vysune destičku a přesune rameno 
podavače do výchozí pozice. 

po zahájení běhu ukončí běh, vysune destičku a přesune rameno 
podavače do výchozí pozice. 

DŮLEŽITÉ!  Zastavení běhu v jeho průběhu může mít vliv 
na průběh reakce. Před zastavením běhu si pečlivě 
přečtěte pokyny na straně 4-26. 

 
Vysunutí destičky Chcete-li po zastavení běhu vysunout destičku (nebo otevřít/zavřít nosítka přístroje), 

klikněte na ikonu  (Otevřít/Zavřít) v okně programu Automation 
Controller. 

 
 

Po skončení běhu 
 
 

Analýza 
výsledků 

Výsledky můžete analyzovat ihned po skončení běhu. 
 

Pokračujte podle typu vaší aplikace: 
 

Část 5.1 Alelická diskriminace.............................................................................. 5-5 
Část 6.1 Absolutní kvantifikace ............................................................................ 6-5 
Část 6.2 Relativní kvantifikace............................................................................ 6-15 
Část 6.3 Analýza disociační křivky ..................................................................... 6-37 
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Analýza esejí typu End-Point 5 
 
 
 
 

V této kapitole Eseje typu End-Point na přístroji 7900HT........................................................... 5-2 
Poznámky pro uživatele databáze........................................................................ 5-3 
Část 5.1 Alelická diskriminace.......................................................................... 5-5 
Přehled ................................................................................................................. 5-6 
Dříve než začnete................................................................................................. 5-9 
Seznam kroků .................................................................................................... 5-10 
Otevření výsledků běhu ..................................................................................... 5-11 
Analýza výsledků alelické diskriminace............................................................ 5-12 
Odečítání a kontrola výsledků alelické diskriminace ........................................ 5-13 
Po skončení analýzy........................................................................................... 5-18 
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Kapitola 5    Analýza esejí typu End-Point 
 
 

Běhy typu End-Point na přístroji 7900HT  
 
 

Běhy End-Point Běhy typu End-point jsou takové běhy, jejichž výsledky jsou detekované - tzn. 
fluorescence vzorků měřena - přístrojem ABI PRISM®  7900HT až po skončení reakce 
(cyklování). Narozdíl od běhů monitorovaných v reálném čase, které poskytují 
kvantitativní údaje, umožňují běhy typu end-point získání kvalitativních výsledků. 
Tento typ analýzy se běžně používá v kombinaci s chemizmem TaqMan®  pro 
potvrzení přítomnosti či nepřítomnosti určité specifické cílové nukleové kyseliny. 

 

Program SDS podporuje jeden typ analýzy typu end-point: Alelickou diskriminaci. 
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 Poznámky pro uživatele databáze    
 
 

Poznámky pro uživatele databáze 
 
 

Databáze a 
alelická 

diskriminace 

Používáte-li databázi SDS Enterprise pro ukládání dokumentů SDS, studií a dat, je 
možné, že během analýzy výsledků alelické diskriminace budete muset provést nějaké 
dodatečné úkony. Níže jsou tyto úkony popsány (nutnost jejich provedení závisí na 
tom, jak správce provedl nastavení databáze). Více informací naleznete v případě 
potřeby v příručce SDS Enterprise Database Administration Guide. 

 
Dialogové okno 
Reason(s) For 

Change 

Dialogové okno Reason(s) for Change (Důvod/y změny) se objevuje pouze v případě, 
je-li databáze SDS Enterprise nastavena tak, že vyžaduje zdůvodnění prováděných 
kroků (tzv. audit). Systém auditu sleduje vytváření, změny a mazání dat v databázi. 
 

Objeví-li se dialogové okno Reasons for Change, proveďte jeden z následujících 
kroků: 

• Zvolte důvod změny z rozbalovací nabídky a poté klikněte na ikonu  .  
• Zadejte důvod změny do příslušného pole a poté klikněte na ikonu  .  

 
 Rozbalovací nabídka 
 důvodů změny 

 
 Přednastavené důvody 

 
 
 
 

 Popis vlastního důvodu 
 

 
 

Obrázek 5-1 Dialogové okno Reasons for Change (Důvod/y změny) 
 

Dialogové 
okno 

Electronic 
Signature 

Dialogové okno Electronic Signature (Elektronický podpis) se objevuje pouze 
v případě, je-li databáze SDS Enterprise nastavena tak, že vyžaduje elektronický 
podpis. Systém elektronického podpisu omezuje a sleduje přístup uživatelů k datům 
v databázi. 
 

Objeví-li se toto dialogové okno: 
 

1.   Do pole User ID (Jméno) a Password (Heslo) zadejte vaše uživatelské jméno a 
heslo a potvrďte . 

 

2.   Program následně zobrazí zprávu o úspěšném či neúspěšném použití 
elektronického podpisu. Pro pokračování klikněte . 

 
 
 

 Popis kroku, který 
 vyžaduje elektronický 
 podpis 

 
 Uživatelské jméno 

 
 Heslo 

 
 
 

Obrázek 5-2  Dialogové okno Elektronický podpis 
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Část 5.1  Alelická diskriminace    
 
 

Část 5.1 Alelická diskriminace 
 
 
 

V této části Přehled ................................................................................................................. 5-6 
Dříve než začnete................................................................................................. 5-9 
Seznam kroků .................................................................................................... 5-10 
Otevření výsledků běhu ..................................................................................... 5-11 
Analýza výsledků alelické diskriminace............................................................ 5-12 
Odečítání a kontrola výsledků alelické diskriminace ........................................ 5-13 
Po skončení analýzy........................................................................................... 5-18 
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Match Mismatch 

Match Mismatch 

Kapitola 5    Analýza esejí typu End-Point 
 
 

Přehled 
 
 

Alelická 
diskriminace na 
přístroji 7900HT 

 

Přístroj ABI PRISM 7900HT umožňuje provádění alelické diskriminace pomocí sond 
typu TaqMan® . Alelická diskriminace je esej, při níž jsou v připraveném vzorku 
detekovány dvě varianty jedné nukleové kyseliny. Lze ji použít pro detekci 
jednonukleotidových polymorfismů (single-nucleotide polymorphism - SNP).

 
5´ nukleázová 
esej v alelické 

diskriminaci 

Alelická diskriminace prováděná na přístroji 7900HT využívá fluorogenní 5´ 
nukleázovou esej (viz strana D-2). V průběhu PCR nasedají fluorogenní sondy 
specificky na komplementární sekvence DNA templátu v oblasti mezi primery. 
Následně při prodlužování primerů DNA polymeráza AmpliTaq Gold® rozštěpí 
sondy, které nasedly na alelu s odpovídající sekvencí. Tímto štěpením dochází k 
oddělení reportérové barvy a zhášeče což vede k nárůstu fluorescenčního signálu 
vyzařovaného reportérem. Po skončení PCR je destička analyzována na přístroji 
7900HT a je odečtena fluorescence. Kvantifikováním a porovnáním 
fluorescenčních signálů pomocí programu SDS je možné stanovit, jaké alelické 
varianty se nacházejí v daném vzorku. 
 

Nedokonalé párování mezi sondou a cílovou sekvencí snižuje efektivitu 
hybridizace sondy. Navíc je mnohem pravděpodobnější, že DNA polymeráza 
AmpliTaq Gold nedokonale nasednutou sondu vytěsní aniž ji degraduje, a nedojde 
tak k uvolnění reportérové barvy. Je-li polymerační fáze PCR prováděna při 
optimální teplotě z hlediska nasednutí sond, nižší teploty tání (Tm) nedokonale 
spárovaných sond snižují stupeň jejich degradace a následně i fluorescenci. Na 
obrázku 5-3 je popsaná situace vyobrazena (Livak et al., 1995; Livak et al., 1999). 

 
 

Alela 
X V 

Q 

 
Dokonalé párování Nedokonalé párování 

(vyšší Tm) 

 
Legenda 

 
V     VIC 

 
F     FAM 

 
Q     Zhášeč 

Alela F 
Y 

Q 
 
DNA 
polymeráza 
AmpliTaq 
Gold  

Dokonalé párování Nedokonalé párování 
(vyšší Tm) 

 
GR1556 

 
 

Obrázek 5-3   Interakce sondy a cílové sekvence 
 
 

Tabulka 5-1 uvádí souvislosti mezi fluorescenčním signálem a sekvencemi ve vzorku. 
 

Tabulka 5-1 Souvislost signálu a sekvence 
 

 

Nárůst … 
 

znamená… 

jen fluorescence barvy VIC®   homozygozitu pro alelu X. 

jen fluorescence barvy FAM™   homozygozitu pro alelu Y. 

fluorescence obou barev heterozygozitu. 
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Přehled    
 
 

Algoritmické 
zpracování 

hrubých dat 
alelické 

diskriminace 

Program SDS může zpracovávat hrubá data okamžitě po skončení běhu alelické 
diskriminace. Pojmem ‘hrubá data’ je míněn spektrální signál v rozsahu vlnových 
délek 500 až 660 nm zaznamenaný programem SDS pro jednotlivé jamky destičky. 
V průběhu analýzy používá program několik matematických algoritmů tak, aby na 
základě hrubých dat odvodil přímý vztah mezi změnami spekter v neznámých 
vzorcích. 
 

Prvním z těchto matematických algoritmů je přepočet hrubých dat, vyjádřených jako 
závislost intenzity fluorescenčního signálu na vlnové délce, na signál jednotlivých 
čistých barev, který se provádí pomocí údajů získaných během kalibrace barev 
(použijí se extrahovaná spektra čistých barev). Jakmile program zjistí jednotlivé barvy, 
vypočítá jejich příspěvek do celkového naměřeného signálu (hrubá data) pomocí 
multikomponentního algoritmu. Úplný popis těchto výpočtů naleznete v části 
“Multikomponentní algoritmus” na straně D-5. 

 
O systému 

odečítání 
Po provedení normalizace program následně využívá unikátní algoritmus společnosti 
Applied Biosystems, tzv. algoritmus maximální pravděpodobnosti (Maximum 
Likelihood Algorithm), a to pro zpracování všech vzorků, s nimiž jsou spojeny nějaké 
markery, které mají být automaticky odečítány (angl. autocalling). Tento algoritmus 
provádí klastrovou analýzu dat na základě poměru normalizovaného signálu 
reportérových barev (např. poměr barvy FAM™  vůči VIC® ). Typickým výsledkem 
analýzy jsou tři hlavní klastry (shluky) odpovídající třem různým genotypům: 
homozygot pro alelu X, homozygot pro alelu Y a heterozygot. 
 

Po provedení této klastrové analýzy program následně využije řadu dalších 
pravděpodobnostních testů, aby výsledky analýzy upřesnil a identifikoval odlehlé 
body. Pro každý vzorek následně vypočítá tzv. ukazatel kvality (“quality value”), jenž 
vyjadřuje míru pravděpodobnosti, že vzorek patří do určitého klastru. Na základě 
prahové hodnoty ukazatele kvality pro určitý marker (definované v nastavení 
parametrů analýzy – dialogovém okně Analysis Settings) jsou potom analyzovány 
vzorky. Jsou-li hodnoty ukazatele kvality pro danou kombinaci vzorek – klastr vyšší 
než definovaná prahová hodnota, je daný vzorek řazen do tohoto klastru a je mu 
přiřazen příslušný genotyp. 
 

Poznámka:  Jakýkoliv SNP, který se významně liší od předpokládaných frekvencí 
podle Hardy-Weinberga, je zapotřebí analyzovat manuálně. 
 
O dvouklastrové analýze 
 

Jsou-li v dané studii přítomny pouze dva klastry, používá algoritmus automatického 
odečítání pro přiřazení genotypů předpokládané frekvence genotypů těchto klastrů. 
Obsahuje-li studie dva velké klastry a jeden vzorek mezi nimi, bude tento vzorek 
považován spíše za odlehlý bod než za klastr a data budou zpracována jako 
dvouklastrová. 
 

Poznámka:  Algoritmus maximální pravděpodobnosti využívá netemplátovou 
kontrolu a odečítání je nejefektivnější, jsou-li netemplátové kontroly součástí 
experimentu. 
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Kapitola 5    Analýza esejí typu End-Point 
 
 

         O klastrech  Program SDS znázorňuje výsledky alelické diskriminace v grafu zobrazujícím 
fluorescence obou reportérových barev (Rn alely X vůči Rn alely Y). Program 
znázorní každou jamku 384-jamkové destičky jako jediný bod v grafu. Poloha 
klastrů těchto bodů se může měnit – podél horizontální osy (alela X), vertikální osy 
(alela Y) nebo diagonálně (alela X/alela Y). Tyto změny vyplývají z rozdílů v PCR 
amplifikaci, která může být důsledkem různých vstupních koncentrací DNA. 

 

Na obrázku níže je znázorněna variace klastrů kvůli rozdílné PCR amplifikaci. 
 

 
 
 

Homozygoti pro alelu Y  
 
 
 

Heterozygoti  
alela X/alela Y 

 
 
 
 
 

Odlehlé body 
 

Homozygoti pro alelu X  
 

 
Žádná amplifikace 

 
 
 

Obrázek 5-4   Variace klastrů  
 
 

Genotypická segregace klastrů 
 

Obrázek 5-4 znázorňuje koncept genotypické segregace vzorků v grafu. V grafu se 
nacházejí čtyři oddělené samostatné klastry, představující netemplátové kontroly a 
tři možné genotypy (homozygot pro alelu X, homozygot pro alelu Y a 
heterozygot). Homozygotní vzorky mají zvýšenou intenzitu fluorescence v jedné 
ose grafu (v závislosti na alele, kterou obsahují). Naopak heterozygotní vzorky se 
nacházejí ve střední části grafu, neboť obsahují obě alely a mají proto zvýšenou 
intenzitu fluorescence obou reportérových barev. 

 
O odlehlých bodech 

 

Vzorky, které nejsou součástí žádného klastru, mohou: 
 

•   Obsahovat řídce se vyskytující sekvenční varianty 
•   Obsahovat sekvenční duplikace 
•   Být výsledkem chybné přípravy (pipetovací chyba) 
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Dříve než začnete 
 
 

Dříve než začnete 
 
 

Používání 
nápovědy 

Bližší informace o krocích popsaných v této části naleznete v nápovědě programu 
SDS. Chcete-li otevřít nápovědu, klikněte na ikonu  , která je součástí každého 
(dialogového) okna, v němž pracujete. 

 
Použité 
příklady 

Vyobrazení a náhledy, které jsou součástí této kapitoly, byly vytvořeny za použití 
destičky obsahující reagencie TaqMan pro alelickou diskriminaci dvou cílů (CYP 
2C9*2 a CYP 2C19*2) za použití šesti vzorků lidské genomové DNA (HD 1, 2, 3, 4, 
7, 8). Každá jamka destičky obsahuje 1 µL DNA, 1X TaqMan®  Universal PCR Master 
Mix, primery a sondy TaqMan značené barvami FAM a VIC. 
 

Na obrázku 5-5 je znázorněno uspořádání esejí, testovaných vzorků a 
netemplátových kontrol (NTC) na destičce. 

 
 
 
 

HD-1 HD-1  HD-1  HD-1  HD-1 HD-1  HD-1 HD-1  HD-1  HD-1 
 
 

HD-2 HD-2  HD-2  HD-2  HD-2 HD-2  HD-2 HD-2  HD-2  HD-2 
 

 
HD-3 HD-3  HD-3  HD-3  HD-3 

 

 
HD-4 HD-4  HD-4  HD-4  HD-4 

HD-3  HD-3 HD-3  HD-3  HD-3 
 

 
HD-4  HD-4 HD-4  HD-4  HD-4 

 
NTC 

 

 
HD-7 HD-7  HD-7  HD-7  HD-7 HD-7  HD-7 HD-7  HD-7  HD-7 

 
 

HD-8 HD-8  HD-8  HD-8  HD-8 HD-8  HD-8 HD-8  HD-9  HD-8 
 
 
 

Nepoužito 
 
 
 
 
 

PDAR CYP 2C9*2 
 

PDAR CYP 2C19*2 
 

Obrázek 5-5   Uspořádání vzorků a detektorů na destičce 
 
 

Poznámka:  Sondy používané v tomto pokusu byly navrženy pomocí programu 
Primer Express®  a při dodržení pravidel popsaných v části “Pravidla pro návrh esejí” 
na straně B-2. 

 

DŮLEŽITÉ!  Program SDS nevyžaduje, aby součástí experimentu absolutní 
kvantifikace byly pozitivní kontroly. 
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 Kapitola 5    Analýza esejí typu End-Point 
 
 

Průběh analýzy 
 

 
Postupné kroky 
 1.  Analýza výsledků běhu (viz strana 5-11). 

 
 

2.  Zobrazení výsledků alelické diskriminace (viz strana 5-13). 
 
 
 

3.  Odečtení alel pro každý marker (viz strana 5-14). 
 
 
 

4.  Kontrola odečtených alel (viz strana 5-16). 
 
 
 

5.  Volba dalších kroků (viz strana 5-18): 
–   Opakovaná analýza výsledků. 
–   Úprava zobrazení výsledků. 
–   Tisk částí dokumentu destičky. 
–   Export výsledků (tabulka nebo grafy). 
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Otevření výsledků běhu    
 
 

Otevření výsledků běhu 
 
 

Přístupová 
práva 

Pro otevření výsledků běhu alelické diskriminace uložených v databázi SDS 
Enterprise neexistují žádná omezení z hlediska přístupových práv. 

 
Otevření 
výsledků 

Otevření dokumentu destičky 
 

1.   Klikněte  nebo zvolte File > Open (Soubor > Otevřít). 

2.   V poli Look in (Vyhledat) vyhledejte a zvolte příslušný dokument destičky. 
 

3.   Klikněte  (Otevřít). 

Program SDS zobrazí soubor s dokumentem destičky. 
 

4.   Nastavte pro každý marker parametry analýzy (Analysis Settings) podle 
      postupu níže. 

 
Otevření neanalyzovaných výsledků z databáze SDS Enterprise  
 

1.   Klikněte  nebo zvolte File > Open Document from Database (Soubor > 
      Otevřít dokument z databáze). 

2.   V dialogovém okně Plate Query (Volba destičky) upravte parametry 
vyhledávání destičky (Find Plates Matching These Criteria) dle potřeby. 

 

3.   Klikněte  (Vyhledat). 
 

 
 
 
 

Vyhledávací 
kritéria 

 
 

Kliknutím zahájíte 
hledání 

 
 

Vyhledané 
dokumenty  

 
 
 
 
 

4.   V seznamu Search Results (Výsledky vyhledávání) zvolte dokument, s nímž 
      chcete pracovat. 

 5.    Klikněte  (Otevřít). 

 6.    Klikněte  (Hotovo). 

7.   Nastavte pro každý marker parametry analýzy (Analysis Settings) podle 
      postupu níže. 
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Analýza výsledků alelické diskriminace 
 
 

Přístupová 
práva 

Pro analýzu výsledků běhu alelické diskriminace neexistují žádná omezení z hlediska 
přístupových práv. 

 
O analýze Součástí analýzy SNP (neboli genotypování) je automatické nebo manuální 

“odečítání” výsledků pro každý vzorek a marker. “Odečítáním” se rozumí určení 
alelických variant přítomných v každém vzorku.  
 

Program SDS umožňuje odečítání: 
 

•   Manuální. 
•   Automatické, pomocí systému automatického odečítání (“AutoCalling”) – viz 

“O systému automatického odečítání” na straně 5-7. 
 

Nastavení 
parametrů analýzy 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Analýza 

výsledků 

Před zahájením analýzy je zapotřebí nastavit její parametry, a to pro každý marker, který 
chcete pomocí algoritmu automatického odečítání analyzovat. Parametry analýzy jsou 
specifické pro daný marker a musí být tudíž i nastaveny zvlášť pro každý marker. 
 

DŮLEŽITÉ!  Parametry analýzy je zapotřebí nastavit pouze hodláte-li používat 
systém automatického odečítání. 
 
Nastavení parametrů analýzy: 
 

1.   Klikněte na ikonu  nebo zvolte Analysis > Analysis Settings (Analýza > 
      Parametry analýzy). 

 

2.   Chcete-li nastavit parametry analýzy: 
•   Pro jediný marker, zvolte tento marker z rozbalovací nabídky. 
•   Pro všechny markery, zvolte v rozbalovací nabídce All markers (Všechny 
     markery). 

 

3.   V dialogovém okně Analysis Settings (Parametry analýzy): 
 

a.  Zvolte možnost Autocaller enabled (Zapnutí automatického odečítání), čímž 
tento systém pro daný marker aktivujete. 

b.  Předpokládáte-li, že data budou pouze ve dvou klastrech, zvolte možnost 
2-Cluster Calling (Dvouklastrové odečítání). 

 

c.  Do pole Quality (Kvalitativní ukazatel) zadejte procentuálně vyjádřenou 
hodnotu ukazatele kvality pro automatické odečítání vzorků. 

 

4.   Opakujte kroky 2 a 3 i pro zbývající markery v dokumentu destičky. 
 

5.   Po ukončení klikněte na ikonu  . 
 
Během analýzy program používá různé algoritmy tak, aby na základě hrubých dat 
odvodil vztah mezi změnami spektrálních signálů v jednotlivých vzorcích. 
 
Chcete-li analyzovat výsledky: 
 

1.   Klikněte na ikonu  nebo zvolte Analysis > Analyze (Analýza > Analyzovat). 

Program SDS provede analýzu dat a zobrazí výsledky v záložce Results. 
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Odečítání a kontrola výsledků alelické diskriminace 
 
 

O zobrazení 
výsledků 

Program SDS zobrazuje výsledky běhů alelické diskriminace v grafu podle intenzity 
signálu reportérových barev. Po provedení normalizace signálu a multikomponentní 
analýzy jsou normalizované výsledky zobrazeny tak, že každé jamce odpovídá jediný 
bod v grafu. Na obrázku 5-6 jsou znázorněny součásti tohoto grafu. 

 
Seznam 
markerů 

Seznam 
možností 
odečítání 

 

 
 
Nástroje 

 
 
 
 

Graf 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Obrázek 5-6  Součásti grafu alelické diskriminace 
 
 

•   Seznam markerů – Určuje, kterého markeru se graf týká. 
•   Seznam možností odečítání – Pomocí tohoto seznamu můžete zvolenému 

bodu v grafu přiřadit příslušnou alelickou variantu. 
•   Nástroje – Umožňují upravovat graf následujícím způsobem: 

 
 

Ikona Popis 
 

Kliknutím nebo potažením okolo skupiny bodů zvolíte body v grafu. 
 

 
Zakroužkováním skupiny bodů zvolíte body v grafu. 

Posun zobrazení (kliknutím a tažením myší).  
 
 

Zvětšení části grafu (kliknutím nebo označením výseku grafu). 
 

Zobrazení celého grafu (kliknutím do grafu). 
 
 

•   Graf – Graf výsledků běhu. 
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Manuální 
odečítání alel 

1.   Zvolte záložku Results (Výsledky). 
 

2.   Upravte zobrazení grafu alelické diskriminace tak, abyste viděli všechny 
výsledky (křížky v grafu). 

a.  Klikněte na ikonu .  

b.  Klikněte na graf. 

c.  Klikněte na ikonu . 

d.  Zvolte všechny křížky v grafu (kliknutím a tažením kurzoru přes všechny 
body v grafu). 
Všechny zvolené jamky budou v zobrazení destičky zvýrazněny. 

 

e.  Ověřte, že jsou zvoleny všechny jamky. Pokud ne, opakujte kroky a až d, 
dokud nezvolíte všechny jamky. 

 
 
 
 

Černá čára 
(ohraničuje zvolené jamky) 

 

 
 
 
 
 
 
 
 
 
 
 

3.   Zvolte klastr vzorků odpovídající první alele. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Homozygoti pro alelu X 
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4.   Zvolte Call (Odečítání) > Allele X (Alela X). 
 
 
 

Zvolte Allele X (Alela X) 
 
 
 
 

Program automaticky označí vybrané vzorky a jamky jako alelu X. 
 
 
 

Homozygoti pro alelu X 
 

 
 

5.   Opakujte kroky 3 a 4 dokud neodečtete o jaké alely se jedná i ve všech 
      zbývajících vzorcích v grafu. 

 
 

Odečet 
 

Symbol 
 

Definice 

Alela X ● 

Alela Y ● 

 

Homozygot pro alelu v příslušné ose grafu. 

Obě (Both) ● Heterozygot (alely X a Y) 

NTC ■ Netemplátová kontrola 

Undetermined 
(neznámé) 

✕ Neznámý genotyp (neoznačeno) 

 
Poznámka:  Způsob zobrazení grafu výsledků alelické diskriminace můžete 
upravit v dialogovém okně Display Settings (Možnosti zobrazení). Více 
informací naleznete v nápovědě. 

 
 
 
 
 

Homozygoti pro alelu Y 
 

Heterozygoti (alely X a Y) 
 

 
 
 
 
 
Homozygoti pro alelu X 
 
Žádná amplifikace 

 
 
 

6.   Provádíte-li analýzu více markerů: 

a.  V rozbalovací nabídce Marker zvolte další marker.  

b.  Opakujte pro tento marker kroky 2 až 5. 

c.  Opakujte kroky a a b dokud neodečtete alely pro všechny markery. 
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Ověření 

odečtených 
alel 

1.   Ověřte správné odečtení alel v kontrolních vzorcích. 

a.  V zobrazení destičky označte všechny netemplátové kontroly. 
Program označí odpovídající body v grafu. 

b.  Ověřte, že body jsou v klastru v očekávaném místě grafu. 

c.  Používáte-li pozitivní kontroly, opakujte kroky a a b i pro jamky 
     s pozitivními kontrolami pro alelu X a alelu Y. 

 
 
 

Klastr alely Y  
 

 
 
 
 
 
 
 

Klastr alely X 
 

 
Klastr netemplátových 
kontrol 
 

 
2.   Vzorky, které nejsou součástí klastrů, označte jako Undetermined (neznámé). 

Vzorky, které nejsou součástí klastrů, mohou: 
•   Obsahovat málo se vyskytující sekvenční varianty 
•   Obsahovat duplikované sekvence 
•   Obsahovat kontaminace 
•   Být výsledkem chybné přípravy reakce nebo vzorku 

 
 
 
 
 
 
 
 
 
 
 
 
 

neznámé vzorky 
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3.   Vyhledejte vzorky, které se nepodařilo amplifikovat: 

a.  V grafu zvolte klastr netemplátových kontrol. 

Program SDS zvýrazní body v grafu a jamky v zobrazení destičky. 
 

b.  V zobrazení destičky zkontrolujte jamky, které jsou součástí klastru 
netemplátových kontrol a přitom jsou označeny jako neznámé. 

Vzorky, které jsou součástí klastru netemplátových kontrol (NTC): 
•   Neobsahují DNA 
•   Obsahují inhibitory PCR  
•   Mají homozygotní deleci cílové oblasti  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Klastr NTC  
(zvolený) 

 

 
 
 

Jamky NTC 
 

 
 
 
 
 
 
 
 
 
 

Neznámé vzorky 
v klastru NTC 

 
4.   Proveďte znovu PCR se vzorky, které nejsou součástí klastru nebo jsou součástí 
      klastru NTC. 

 

5.   Provádíte-li analýzu více markerů: 

a.  V rozbalovací nabídce Marker zvolte další marker.  

b.  Opakujte pro tento marker kroky 1 až 4. 

c.  Opakujte kroky a a b dokud neověříte odečet alel pro všechny markery. 
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Po skončení analýzy 
 
 

Přístupová 
práva 

Používáte-li databázi SDS Enterprise, musíte mít pro ukládání výsledků analýzy do 
databáze práva uživatele třídy Scientist (Vědec) nebo Administrator (Správce). 

 
Volba dalších 

kroků 
 

Po ukončení analýzy jsou k dispozici následující možnosti: 

Úprava zobrazení výsledků ...........................................................................  (viz níže)  

Tisk zprávy ..................................................................................................... (viz níže)  

Export dokumentu destičky............................................................................ (viz níže)  

Uložení výsledků .................................................................................................... 5-19 
 

Úprava 
zobrazení 
výsledků 

Před vytištěním nebo exportem výsledků analýzy můžete pozměnit vzhled některých 
součástí dokumentu destičky včetně tabulky výsledků, zobrazení destičky a většiny 
grafů (alelická diskriminace, hrubá data a pozadí). 
 

1.   Klikněte na ikonu  nebo zvolte View > Display Settings (Zobrazit > 
Nastavení zobrazení). 

 

2.   V dialogovém okně Display Settings (Nastavení zobrazení) klikněte na 
ikonu  , čímž získáte více informací o možnostech změny zobrazení. 

 
           Tisk zprávy Program SDS umožňuje vytisknout zprávu s výsledky analýzy. Zpráva může 

obsahovat vybrané součásti dokumentu destičky. 
 

1.   Klikněte  nebo zvolte File > Print Report (Soubor > Tisk zprávy). 
 

2.   V dialogovém okně Print Report (Tisk zprávy) klikněte na ikonu  , čímž 
získáte více informací o nastavení a tisku zprávy. 

 
Export 

dokumentu 
destičky  

Export dokumentu destičky ve formě souboru *.txt 
 

Program SDS umožňuje exportovat hrubá data nebo analyzované výsledky ve formě 
souboru *.txt (tabelátorem oddělená data), a to pro všechny nebo zvolené jamky 
dokumentu destičky. Exportovaný soubor je kompatibilní s většinou tabulkových 
editorů. 
 

Chcete-li exportovat dokument destičky, zvolte jednu z následujících možností: 
 

•   Pokračujte částí “Export dokumentu destičky” na straně A-16. 
•   Klikněte na ikonu  v zobrazení tabulky 

 
Nápověda 

 
 
 

Export grafů jako obrázků 
 

Program SDS umožňuje export většiny grafů z dokumentu destičky ve formě 
grafických souborů formátu JPEG (Joint Photographic Experts Group). Formát 
JPEG je kompatibilní s většinou textových a tabulkových editorů a lze jej použít 
přímo též v dokumentech typu HTML. 

 

Chcete-li exportovat graf ve formátu JPEG, získáte více informací v části “Export 
obrázků” na straně A-16 nebo kliknutím na ikonu  v příslušném grafu. 
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Po skončení analýzy    
 
 

Uložení výsledků Program SDS ukládá výsledky analýzy různými způsoby v závislosti na tom, zda je 
analýza ukládána do databáze SDS Enterprise (viz níže) nebo do dokumentu destičky 
(viz strana 5-20). 
 

Uložení výsledků do databáze SDS Enterprise  
 

Používáte-li databázi SDS Enterprise, lze výsledky analýzy uložit jako tzv. seance 
(session). 
 

DŮLEŽITÉ!  Při ukládání do databáze dodržujte následující pokyny: 
 

•   Pokud jste jakkoliv upravili informace v dokumentu destičky (vypuštění jamek, 
změna způsobu zobrazení), musíte uložit dokument destičky do databáze, chcete-
li tyto změny zachovat (zvolte File > Save Plate Document to Database – 
Soubor > Uložit dokument do databáze). 

•   Databáze SDS Enterprise umožňuje dvěma nebo více uživatelům otevírat a 
upravovat data najednou. Pokud jiný uživatel otevřel, upravil a uložil táž data, 
která jste právě analyzovali, program tyto úpravy po uložení v databázi přepíše. 

•   Výsledky analýzy uložené v databázi jsou přímo propojeny s dokumentem 
destičky, na jehož základě byly vytvořeny. Pokud poté, co jste výsledky 
analýzy uložili do databáze, upravíte propojený dokument destičky (vypustíte 
jamky, pozměníte názvy vzorků atp.), výsledky vaší analýzy nemusí být s 
tímto dokumentem více propojeny. Následně může dojít ke změně výsledků 
vaší analýzy, pokud tuto analýzu zopakujete, poněvadž jste změnili obsah 
propojeného dokumentu destičky, v němž jsou uložena hrubá data. 
Společnost Applied Biosystems doporučuje dodržovat při práci s výsledky 
analýzy následující doporučení: 
–  Ukládejte dokument destičky jako nový dokument kdykoliv v jeho zadání 

provedete nějaké změny (vypuštění jamek, pozměnění názvů vzorků, úprava 
detektorů nebo markerů atp.) 

–  Pro každý uložený dokument ukládejte pouze jedny výsledky analýzy 

–  Vezměte na vědomí, že pouze výsledky analýzy uložené po provedení 
posledních změn v dokumentu destičky odpovídají obsahu tohoto 
dokumentu. 

 

Chcete-li uložit výsledky do databáze: 
 

1.   Zvolte File > Save Results to Database (Soubor > Uložit výsledky do 
      databáze). 

 

2.   V poli Description (Popis) dialogového okna Save Results to Database (Uložit 
výsledky do databáze) zadejte popis dokumentu destičky (max. 255 znaků). 

 

Poznámka:  Program vám automaticky nabízí možnost uložit výsledky 
analýzy pod názvem propojeného dokumentu destičky. 

 

3.   (Volitelné) V poli Add to Study (Přidat ke studii) klikněte na ikonu  a 
 zvolte studii nebo vytvořte novou studii pomocí ikony  (Nová) a 
 provedením následujících kroků: 

a.  V poli Name (Název) dialogového okna Create New Study (Vytvořit novou 
studii) zadejte název studie (max. 128 znaků).  

b.  V poli Description (Popis) zadejte stručný popis studie (max. 255 znaků). 

c. Klikněte .  

d. Klikněte . 
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4.   V dialogovém okně Save Results to Database (Uložit výsledky do databáze) 
      klikněte  . 

 

5.   Potvrďte ještě jednou kliknutím  . 
 

Uložení dokumentu typu *.sds 
 

Ačkoliv program ukládá změny provedené v zobrazení dokumentu destičky a 
nastavení parametrů analýzy, neukládá odečtené alely. 

 

1.   Zvolte File > Save As (Soubor > Uložit jako). 
 

2.   V poli Look in (Vyhledat) dialogového okna Save As (Uložit jako) vyhledejte a 
zvolte adresář, do něhož chcete uložit nový soubor. 

 

3.   V poli File name (Název souboru): 
•   Zadejte název souboru dokumentu destičky, nebo 
•   Zadejte nebo naskenujte čárový kód destičky. 

 

Poznámka:  Program SDS nepožaduje, aby název souboru odpovídal čárovému 
kódu destičky. 

 

4.   Klikněte  (Uložit). 

Program uloží dokument destičky do zvoleného adresáře. 
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Kapitola 6    Analýza výsledků Real-Time PCR 
 
 

Poznámky pro uživatele databáze 
 
 

Databáze a 
výsledky Real-

Time PCR 

Používáte-li databázi SDS Enterprise pro ukládání dokumentů SDS, studií a dat, je 
možné, že během analýzy výsledků budete muset provést nějaké dodatečné úkony. 
Níže jsou tyto úkony popsány (nutnost jejich provedení závisí na tom, jak správce 
provedl nastavení databáze). Více informací naleznete v případě potřeby v příručce 
SDS Enterprise Database Administration Guide. 

 

 
Dialogové okno 
Reason(s) For 

Change 

Dialogové okno Reason(s) for Change (Důvod/y změny) se objevuje pouze v případě, 
je-li databáze SDS Enterprise nastavena tak, že vyžaduje zdůvodnění prováděných 
kroků (tzv. audit). Systém auditu sleduje vytváření, změny a mazání dat v databázi. 
 

Objeví-li se dialogové okno Reasons for Change, proveďte jeden z následujících 
kroků: 

• Zvolte důvod změny z rozbalovací nabídky a poté klikněte na ikonu .  
• Zadejte důvod změny do příslušného pole a poté klikněte na ikonu .  

 
 

 Rozbalovací nabídka 
 důvodů změny 

 
Přednastavené důvody 

 
 
 
 

Popis vlastního důvodu  
 

 
 

Obrázek 6-1  Dialogové okno Reasons for Change (Důvod/y změny) 
 

Dialogové 
okno 

Electronic 
Signature 

Dialogové okno Electronic Signature (Elektronický podpis) se objevuje pouze 
v případě, je-li databáze SDS Enterprise nastavena tak, že vyžaduje elektronický 
podpis. Systém elektronického podpisu omezuje a sleduje přístup uživatelů k datům 
v databázi. 
 

Objeví-li se toto dialogové okno: 
 

1.   Do pole User ID (Jméno) a Password (Heslo) zadejte vaše uživatelské jméno a 
heslo a potvrďte . 

 

2.   Program následně zobrazí zprávu o úspěšném či neúspěšném použití 
elektronického podpisu. Pro pokračování klikněte . 

 
 
 

 Popis kroku, který 
 vyžaduje elektronický 
 podpis 

 
 Uživatelské jméno 

 
 Heslo 

 
 
 

Obrázek 6-2   Dialogové okno Elektronický podpis 
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Real-Time PCR experimenty na přístroji 7900HT    
 
 

Real-Time PCR experimenty na přístroji 7900HT 
 
 

 Real-Time PCR Termín Real-Time PCR (PCR v reálném čase) se používá v případě těch 
amplifikačních experimentů, při nichž se na přístroji ABI PRISM® 7900HT provádí 
měření fluorescence biologického vzorku během teplotního cyklování. Na rozdíl od 
experimentů typu end-point (s vyhodnocením po skončení běhu) je v experimentech 
typu Real-Time možné vyhodnocovat výsledky kvalitativně a kvantitativně. Analýzu 
v reálném čase je možné provádět v kombinaci s reagenciemi typu TaqMan® 

nebo SYBR® Green 1 za různým účelem včetně kvantitativní PCR a analýzy 
disociační křivky. 

 
Kvantitativní 

RT-PCR 
Kvantitativní RT-PCR je metoda kvantifikace sekvencí ribonukleové kyseliny 
izolované ze vzorku biologického původu. V typickém případě se jedná o buňky, 
tkáně a tělní tekutiny. V průběhu kroku reverzní transkripce (RT) se provede přepis 
cílové RNA do sekvence komplementární DNA (cDNA). Následuje provedení PCR v 
níž je počáteční množství cílové cDNA kvantifikováno zmnožením (amplifikací) až 
na detekovatelnou úroveň. Dva typy kvantitativní RT-PCR, které je možné provádět 
na přístroji 7900HT, absolutní a relativní kvantifikace, jsou popsány níže. 

 
Absolutní 

kvantifikace 
Cílem absolutní kvantifikace je přesně stanovit absolutní množství cílové nukleové 
kyseliny v neznámém vzorku. Výsledky absolutní kvantifikace jsou udávány ve 
stejných jednotkách jako standardy použité pro jejich kvantifikace. 

 
Relativní 

kvantifikace 
Cílem relativní kvantifikace je stanovit množství cílové nukleové kyseliny 
v neznámém vzorku v poměru k téže sekvenci v kalibrátoru. Relativní kvantifikace 
exprese cílového genu je vypočítána pomocí dat získaných přístrojem ABI PRISM 

7900HT jednou ze dvou níže uvedených metod: 
 
Metoda relativní standardní křivky 
 

Metoda relativní standardní křivky je obdobou standardní křivky v absolutní 
kvantifikaci. Ale protože cílem metody relativní kvantifikace je poměrná kvantifikace, 
jsou výsledky vytvořené touto metodou používány odlišně. Pro všechny 
experimentální vzorky se stanoví množství cílové sekvence na základě standardní 
křivky a vydělí se množstvím cílové sekvence v kalibrátoru. Jelikož výsledkem je 
bezjednotkové číslo, není nutné pro stanovení relativního množství cílové nukleové 
kyseliny znát absolutní množství používaných standardů. 
 
O komparativní CT metodě 
 

Program SDS počítá relativní hladinu genové exprese pomocí komparativní CT 

metody. Tato metoda je podobná metodě standardní křivky s tím rozdílem, že pro 
dosažení výsledků relativní kvantifikace používá aritmetický vzorec. Nepoužívá 
standardní křivku, ale počítá relativní genovou expresi pomocí vzorce: 

Relativní množství = 2–∆∆CT 
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Přehled 
 
 

O absolutní 
kvantifikaci 

Přístroj ABI PRISM 7900HT umožňuje provádění absolutní kvantifikace nukleových 
kyselin v reálném čase pomocí metody standardní křivky. Cílem absolutní 
kvantifikace je přesně stanovit absolutní množství cílové nukleové kyseliny 
v neznámém vzorku. Výsledky absolutní kvantifikace jsou udávány ve stejných 
jednotkách jako standardy použité pro kvantifikaci. 

 
5´ nukleázová 

esej v absolutní 
kvantifikaci 

Provádění absolutní kvantifikace na přístroji 7900HT je umožněno díky fluorogenní 
5´ nukleázové eseji (viz strana D-2). Nejprve jsou připraveny standardy, ředěné 
v rozpětí několika řádů, a neznámé vzorky. Následně jsou standardy i neznámé 
vzorky pipetovány do optické destičky s mastermixem a reagenciemi TaqMan pro 
detekci specifické cílové sekvence nukleové kyseliny. Destička se vloží do přístroje 
7900HT a provede se běh s měřením fluorescence v reálném čase. Během teplotního 
cyklování přístroj zaznamenává fluorescenční signál emitovaný v důsledku štěpení 
sondy TaqMan® v přítomnosti cílové sekvence. Po skončení běhu program SDS 
zpracuje hrubá data (naměřený fluorescenční signál) a vypočítá prahový cyklus (CT) 
pro každý vzorek (viz strana D-9). Následně program propočítá standardní křivku na 
základě hodnot CT pro ředěné standardy a na základě této křivky a hodnot CT 

neznámých vzorků vypočítá jejich absolutní množství (viz níže). 
 

Poznámka:  Více informací o fluorogenní 5´ nukleázové eseji, snímání dat v reálném 
čase a souvisejících matematických výpočtech naleznete v příloze D “Principy 
fungování”. 
 

Na obrázku 6-3 je vyobrazena standardní křivka vytvořená pomocí instalační 
destičky s RNázou P. Uspořádání vzorků a standardů na destičce je vyobrazeno 
v části “Příklady v této části” na straně 6-8. 

 
Graf standardní křivky 
 
 

 
 

28 
 
 

26 
 

 
 

CT 24 Neznámé vzorky 
 

 
 

22 
 
 
 

20 
1.0 E+2 1.0 E+3 1.0 E+4 1.0 E+5 

 
Množství 

(LogN počáteční koncentrace) 

 
Obrázek 6-3  Standardní křivka vytvořená na základě instalační destičky s RNázou P  
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Matematické 
zpracování 

hrubých dat 

Program SDS může provést analýzu hrubých dat ihned po ukončení běhu absolutní 
kvantifikace. Pojmem ‘hrubá data’ je míněn spektrální signál v rozsahu vlnových 
délek 500 až 660 nm zaznamenaný programem SDS pro jednotlivé jamky destičky. 
V průběhu analýzy používá program několik matematických algoritmů tak, aby na 
základě hrubých dat odvodil přímý vztah mezi změnami spekter v neznámých 
vzorcích. 
 
Multikomponentní algoritmus 
 

Prvním z těchto matematických algoritmů je přepočet hrubých dat, vyjádřených 
jako závislost intenzity fluorescenčního signálu na vlnové délce, na signál 
jednotlivých čistých barev, který se provádí pomocí údajů získaných během 
kalibrace barev (použijí se extrahovaná spektra čistých barev). Jakmile program 
zjistí jednotlivé barvy, vypočítá jejich příspěvek do celkového naměřeného 
signálu (hrubá data) pomocí multikomponentního algoritmu. 
 
Nastavení prahu a odečtení hodnot CT 
 

Po provedení normalizace musí být pro každý běh stanoveny hodnoty pozadí a 
prahu (více informací viz “Kinetická analýza / Kvantitativní PCR” na straně 
D-7). Výsledky pokusu lze znázornit pomocí grafu standardní křivky v záložce 
Results (Výsledky). V grafu jsou znázorněny hodnoty prahového cyklu (CT) 
standardů a neznámých vzorků v závislosti na množství. 
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Kapitola 6    Analýza výsledků Real-Time PCR 
 
 

Dříve než začnete 
 
 

Používání 
nápovědy 

Bližší informace o krocích popsaných v této části naleznete v nápovědě programu 
SDS. Chcete-li otevřít nápovědu, klikněte na ikonu  , která je součástí každého 
(dialogového) okna, v němž pracujete. 

 
Příklady v této 

části 
Vyobrazení a náhledy, které jsou součástí této kapitoly, byly vytvořeny za použití 
ověřovací destičky TaqMan® RNáza P, což je destička používaná při instalaci 
přístroje 7900HT z důvodu ověření jeho funkčnosti. V destičce jsou předpřipraveny 
reagencie pro detekci a kvantifikaci genomických kopií lidského genu kódujícího 
RNázu P (gen se vyskytuje v genomu v jediné kopii a kóduje RNA podjednotku 
enzymu RNáza P). Každá jamka obsahuje reakční směs (1X TaqMan® Universal PCR 
Master Mix, primery pro RNázu P a sondu značenou barvou FAM™) a templát. 
 

Na obrázku 6-4 je znázorněno uspořádání standardů a vzorků na destičce RNáza P. 
Jedná se o pět sloupců standardů (1250, 2500, 5000, 10000 a 20000 kopií) a dvě 
skupiny vzorků (5000 a  10000 kopií). 

 
 
 
 
 
 
 
 
 
 

Populace  1 
5000 

Populace  2 
10000 

 
 
 
 
 
 
 
 
 
 
 

Obrázek 6-4   Uspořádání vzorků na destičce 
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Seznam kroků    
 
 

Seznam kroků  
 

 
  Postupné kroky 
 1.  Otevření dokumentu destičky (viz strana 6-10). 

 

 
 

2.  Nastavení parametrů analýzy (viz strana 6-11). 
 
 
 

3.  Analýza výsledků běhu (viz strana 6-12). 
 
 
 

4.  Pro každý detektor, pro který jste stanovili pozadí a práh (viz strana 6-46): 

–   Automaticky – Ověřte, že hodnoty pozadí a prahu byly programem nastaveny 
správně. 

–   Manuálně – Nastavte hodnoty pozadí a prahu pro detektor. 
 

 
 
 

5.  Zobrazení odlehlých bodů a jejich vypuštění z analýzy výsledků 
(viz strana 6-49). 

 
 
 

6.  Zobrazení výsledků absolutní kvantifikace (viz strana 6-14). 
 
 
 

7.  Volba dalších kroků (viz strana 6-51): 
–   Opakovaná analýza výsledků. 
–   Úprava zobrazení výsledků (tabulka výsledků, vyobrazení destičky, 

grafy). 
–   Tisk částí dokumentu destičky. 
–   Export výsledků (tabulka nebo grafy). 
–   Uložení analýzy. 
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Otevření výsledků běhu 
 
 

Přístupová 
práva 

Pro otevření výsledků běhu z databáze SDS Enterprise neexistují žádná omezení 
z hlediska přístupových práv. 

 
Otevření 

dokumentu 
destičky 

Otevření dokumentu destičky 
 

1.   Klikněte na ikonu  nebo zvolte File > Open (Soubor > Otevřít). 

2.   V poli Look in (Vyhledat) vyhledejte a zvolte příslušný dokument destičky. 
 

3.   Klikněte  (Otevřít). 

Program SDS zobrazí soubor s dokumentem destičky. 
 

4.   Nastavte parametry analýzy (Analysis Settings) pro každý detektor podle 
postupu v části “Nastavení parametrů analýzy” na straně 6-11. 

 
Otevření dokumentu destičky z databáze SDS Enterprise  
 

5.   Klikněte  nebo zvolte File > Open Document from Database (Soubor > 
      Otevřít dokument z databáze). 
 
6.   V dialogovém okně Plate Query (Volba destičky) upravte parametry 

vyhledávání destičky (Find Plates Matching These Criteria) dle potřeby. 
 

7.   Klikněte  (Vyhledat). 
 
 
 
 

Vyhledávací 
kritéria 

 
 

Kliknutím zahájíte 
hledání 

 
 

Vyhledané 
dokumenty  

 
 
 
 

8.   V seznamu Search Results (Výsledky vyhledávání) zvolte dokument, s nímž 
chcete pracovat. 

 

9.   Klikněte  (Otevřít). 
 

10.   Klikněte  (Hotovo). 
 

11.   Nastavte parametry analýzy (Analysis Settings) pro každý detektor podle 
postupu v části “Nastavení parametrů analýzy” na straně 6-11. 
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Analýza výsledků 
 
 

Přístupová 
práva 

Pro analýzu výsledků absolutní kvantifikace uložených v databázi SDS Enterprise 
neexistují žádná omezení z hlediska přístupových práv.

 
Nastavení 

parametrů analýzy 
Před zahájením analýzy je zapotřebí nastavit její parametry, a to pro každý detektor, 
který chcete analyzovat. Parametry analýzy jsou specifické pro daný detektor a musí 
být tudíž i nastaveny zvlášť pro každý detektor. Program SDS počítá pro každý 
detektor pozadí a práh automaticky pomocí algoritmu AutoCT nebo je možné toto 
nastavení provést ručně. 
 

Poznámka:  Analýzu je možné provést aniž nastavíte její parametry, v takovém 
případě budou použity přednastavené hodnoty – pozadí bude kalkulováno v rozsahu 
od 3. do 15. cyklu a práh bude mít hodnotu 0.2. 
 

1.   Klikněte na ikonu  nebo zvolte Analysis > Analysis Settings (Analýza > 
      Parametry analýzy). 

2.   V rozbalovací nabídce Detektor (Detektor) zvolte detektor. 
 

3.  V okně Analysis Settings (Parametry analýzy) zvolte metodu analýzy 
(automatická nebo manuální), která má být použita pro stanovení pozadí  a 
prahu pro zvolený detektor: 

 

 

 
 

Chcete-li stanovit pozadí a práh: 

Automaticky – Zvolte možnost Automatic CT. 

DŮLEŽITÉ!  Zvolíte-li použití algoritmu AutoCT, ověřte po skončení 
analýzy, že hodnoty pozadí a prahu byly vypočítány správně (podle 
postupu na straně 6-46). 

 

Poznámka:  Více informací o algoritmu AutoCT naleznete v části “Automatické 
stanovení prahu a pozadí” na straně 6-18. 

 

Manuálně – Proveďte: 

a.  Zvolte možnost Manual CT. 
 

b.  V poli Threshold (Práh) zadejte prahovou hodnotu platnou pro zvolený 
detektor(y) nebo ponechte toto pole prázdné a nastavte práh ručně podle 
postupu na straně 6-46. 
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c.  Zvolte jednu z možností: 
Automatic Baseline (Automatické stanovení pozadí) – program vypočítá 
pozadí pro zvolený detektor(y) automaticky. 
Manual Baseline (Ruční stanovení pozadí) a zadejte do polí Start 
(Začátek) a End (Konec) hodnoty pro daný detektor(y). 
Manual Baseline (Ruční stanovení pozadí) ponechte pole Start a End 
prázdná. (Nastavíte tyto hodnoty ručně podle postupu na straně 6-46.) 

 

4.   Je-li toho zapotřebí, opakujte kroky 2 a 3 pro další detektory. 
 

DŮLEŽITÉ!  Parametry analýzy (práh a pozadí) nastavované v kroku 3 na straně 
6-11 jsou specifické pro daný detektor a musí být tudíž i nastaveny zvlášť pro 
každý detektor v dokumentu destičky. 

 

5.   Po ukončení klikněte na ikonu . 
 

6.   Analyzujte výsledky podle postupu níže. 
 

Analýza 
výsledků 

Poté co jste nastavili parametry analýzy můžete analyzovat výsledky běhu. Během 
analýzy program používá různé matematické algoritmy tak, aby na základě hrubých 
dat odvodil vztah mezi změnami spektrálních signálů pasivní reference a 
reportérových barev v jednotlivých vzorcích. Na základě těchto přepočtů pak 
vypočítá prahový cyklus (CT) pro každou reakci (standardy a neznámé vzorky). 
Následně program vynesením hodnot standardních vzorků do grafu závislosti 
hodnoty CT na počátečním počtu kopií vytvoří standardní křivku. 

Poznámka:  Více informací o souvisejících matematických výpočtech naleznete 
v příloze D “Principy fungování”. 
 

1.   Klikněte na ikonu  nebo zvolte Analysis > Analyze (Analýza > Analyzovat). 
Program SDS provede analýzu dat a zobrazí výsledky v záložce Results. 

 

2.   Zvolte jednu z možností: 

•   Používáte-li pro nastavení pozadí a prahu pro detektory v destičce 
algoritmus AutoCT, ověřte, že nastavení bylo pro každý detektor 
provedeno správně – viz postup na straně 6-46, 

•   Nastavujete-li pozadí a práh manuálně, nastavte je pro každý detektor 
podle postupu na straně 6-46. 

 

3.   Pokud manuálně odstraňujete odlehlé body, postupujte podle pokynů na straně 
6-46. 
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Zobrazení výsledků 
 
 

Zobrazení 
standardní 

křivky 

Program zobrazí vytvořenou standardní křivku v záložce Results (Výsledky) 
dokumentu destičky. Jedná se o graf závislosti hodnot CT (prahový cyklus) na 
množství (LogN). Na obrázku 6-5 jsou znázorněny součásti tohoto grafu. 

 

 
Nápověda 
 
Nabídka Detektory 
 

Legenda 

Hide Unknowns  
(Skrýt neznámé vzorky) 
 
Parametry standardní 
křivky 
 

Graf 
 
 
 
 
 
 
 

Obrázek 6-5   Součásti grafu standardní křivky 
 
 

•    – Nápověda programu SDS. 
•   Nabídka Detektory – Přepínání údajů zobrazených v grafu podle zvoleného 

detektoru. 
•   Legenda – Vysvětlení symbolů v grafu. 
•   Hide Unknowns (Skrýt neznámé vzorky) – Vypíná a zapíná zobrazení 
     neznámých vzorku v grafu. 
•   Parametry standardní křivky: 

–  Slope (Sklon) – Sklon standardní křivky. Ze sklonu standardní křivky se 
odvozuje efektivita eseje. Má-li reakce 100% efektivitu, bude mít standardní 
křivka sklon −3.33, jelikož 10-tinásobný rozdíl v koncentracích vede k rozdílu 
3.33 v hodnotách CT. 

–   Y-Inter – Průsečík standardní křivky a osy Y. 

–  R2 – Tento parametr popisuje korelaci mezi hodnotami CT a logaritmicky 
vyjádřeným množstvím templátu ve standardních vzorcích. Nabývá hodnot 
v rozsahu od 1 do 0, přičemž hodnoty blízké 1 vyjadřují lepší korelaci mezi 
hodnotami CT a logaritmicky vyjádřeným množstvím templátu. 

 

Poznámka:  Program počítá druhou mocninu parametru R umocněním tzv. 
Pearsonova korelačního koeficientu (též známého jako parametr r). K výpočtu 
používá pouze standardní vzorky, které tvoří křivku. 

 

•   Graf – Grafické znázornění výsledků absolutní kvantifikace. 
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Zobrazení 
tabulky výsledků 

Výsledky absolutní kvantifikace se zobrazují v tabulce v dokumentu destičky. Na 
obrázku 6-6 je příklad takové tabulky s výsledky běhu s ověřovací destičkou 
RNáza P. 

 

 
Nápověda 

 
 

 
Obrázek 6-6   Tabulka výsledků běhu absolutní kvantifikace 

 
 

Sloupce v tabulce: 
 

•   Position (Pozice) – Označení jamky v destičce. 
•   Sample (Vzorek) – Název vzorku v dané jamce. 
•   Detector (Detektor) – Název detektoru použitého v dané jamce. 
•   Task (Úloha detektoru) – Úloha detektoru (NTC, Standard nebo Unknown – 
    Neznámý vzorek) v dané jamce. 

 

Poznámka:  Více informací o úlohách detektorů viz strana 3-14. 
 

•   CT – Prahový cyklus naměřený v dané jamce v průběhu PCR. 

Poznámka:  V tomto sloupci se zobrazí ‘Undetermined’ (Nestanoveno), pokud 
v dané jamce nedojde k zaznamenatelnému nárůstu fluorescenčního signálu 
během PCR (fluorescenční signál v dané jamce nikdy nepřekročí práh pro daný 
detektor). 

 

•   Quantity (Množství) – V jamkách obsahujících: 
–  Neznámé vzorky udává tento sloupec vypočítané množství cílové nukleové 

kyseliny (templátu) ve stejných jednotkách v jakých jsou definovány 
standardy. 

–  Standardy udává tento sloupec jejich množství. 
 

Poznámka:  Více informací o zadávání množství jednotlivých standardů viz 
strana 3-15. 

 

Následující dva sloupce obsahují data pouze v případě, byla-li daná jamka 
analyzována v rámci replikátu. 

 

•   Qty Mean (Průměrné množství) – Aritmetický průměr množství templátu 
v dané skupině replikátů. 

•   Qty stddev (Standardní odchylka) – Standardní odchylka množství 
templátu pro danou jamku. 

•   Status (Stav) – Stav analýzy. 
 

Po skončení analýzy 
 

Přístupová 
práva 

Používáte-li databázi SDS Enterprise, musíte mít pro ukládání výsledků analýzy do 
databáze práva uživatele třídy Scientist (Vědec) nebo Administrator (Správce). 

 
Volba dalších 

kroků 
Úprava zobrazení výsledků ................................................................................. 6-51 
Tisk zprávy .......................................................................................................... 6-51 
Export dokumentu destičky................................................................................. 6-51 
Uložení výsledků ................................................................................................. 6-52 
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Přehled 
 
 

Relativní 
kvantifikace na 

přístroji 7900HT 
 

Přístroj ABI PRISM 7900HT umožňuje provádění relativní kvantifikace nukleových 
kyselin v reálném čase pomocí komparativní CT metody. Tato metoda používá  pro 
výpočet výsledků relativní kvantifikace následující vzorec: 
 

2–∆∆CT
 

 
kde: 

 
 

∆∆CT = Normalizovaný signál vzorku vyjádřený v poměru k normalizovanému signálu 
kalibrátoru. 

 
 

Poznámka:  Odvození shora uvedeného vzorce je popsáno v příručce ABI PRISM 7700 

Sequence Detection System User Bulletin #2: Relative Quantification of Gene 

Expression (kat. č. 4303859). 
 

Poznámka:  Shora zmíněnou normalizací signálu se rozumí signál vytvořený 
amplifikací cílové sekvence v neznámém vzorku a v kalibrátoru normalizovaný na 
signál vytvořený amplifikací endogenní kontroly. 

 

Poznámka:  Program SDS nepodporuje používání metody relativní standardní 
křivky. 

 
5´ nukleázová 
esej v relativní 

kvantifikaci 

Provádění relativní kvantifikace na přístroji 7900HT je umožněno díky fluorogenní 
5´ nukleázové eseji. Po pečlivém zvolení endogenní kontroly jsou navrženy sondy a 
primery pro cílové i kontrolní sekvence. Jakmile je ověřeno fungování esejí, jsou 
neznámé vzorky pipetovány do optické destičky s mastermixem a reagenciemi 
TaqMan pro detekci specifické cílové sekvence nukleové kyseliny. Destička se vloží 
do přístroje 7900HT a provede se běh s měřením fluorescence v reálném čase. 
 

Během teplotního cyklování přístroj zaznamenává fluorescenční signál emitovaný 
v důsledku štěpení sondy TaqMan® v přítomnosti cílové sekvence. Po skončení běhu 
program SDS zpracuje hrubá data (naměřený fluorescenční signál) a vypočítá 
prahový cyklus (CT) pro každý vzorek. Program SDS následně vypočítá relativní 
kvantitu genové exprese na základě hodnot CT kalibrátoru a neznámého vzorku. 
 

Poznámka:  Více informací o fluorogenní 5´ nukleázové eseji, snímání dat v reálném 
čase a souvisejících matematických výpočtech naleznete v příloze D “Principy 
fungování”. 
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Matematické zpracování hrubých dat 

 
Program SDS může provést analýzu hrubých dat ihned po ukončení běhu relativní 
kvantifikace. Pojmem ‘hrubá data’ je míněn spektrální signál v rozsahu vlnových 
délek 500 až 660 nm zaznamenaný programem SDS pro jednotlivé jamky destičky. 
V průběhu analýzy používá program několik matematických algoritmů tak, aby na 
základě hrubých dat odvodil přímý vztah mezi změnami spekter v neznámých 
vzorcích. 

 
Multikomponentní Prvním z těchto matematických algoritmů je přepočet hrubých dat, vyjádřených jako 
            algoritmus závislost intenzity fluorescenčního signálu na vlnové délce, na signál jednotlivých 

čistých barev, který se provádí pomocí údajů získaných během kalibrace barev 
(použijí se extrahovaná spektra čistých barev). Jakmile program zjistí jednotlivé 
barvy, vypočítá jejich příspěvek do celkového naměřeného signálu (hrubá data) 
pomocí multikomponentního algoritmu. 

 
Nastavení prahu 

a odečtení 
hodnot CT 

Po provedení normalizace musí být pro každý detektor v rámci studie stanoveny 
hodnoty pozadí a prahu. Program umožňuje nastavit pozadí a práh manuálně (viz 
strana 6-49) nebo automaticky (viz strana 6-19). Hodnoty CT vypočítané na základě 
pozadí a prahu jsou základem pro výpočet relativní genové exprese. 

 
      Odlehlé body  Při každé PCR může dojít k tomu, že v důsledku experimentální chyby dochází 

v některých  jamkách k nedostatečné nebo vůbec žádné amplifikaci. Výsledkem jsou 
hodnoty CT, které se výrazně liší od průměru ostatních jamek v rámci skupiny 
replikátů. Budou-li tyto výsledky zahrnuty do výpočtů, mohou vést k chybným 
závěrům. Před zahájením analýzy proto musí být každá skupina replikátů pečlivě 
zkontrolována z hlediska možného výskytu odlehlých bodů. Program umožňuje 
automatické (viz strana 6-19) nebo manuální (viz strana 6-49) odstranění odlehlých 
bodů. 

 
Výpočet relativní 
genové exprese 

Konečným krokem analýzy je výpočet relativní genové exprese na základě hodnot 
CT. Algoritmus výpočtu výsledků relativní kvantifikace je stručně popsán na straně 
D-11. Zevrubný popis odvození vzorce ∆∆CT, matematických operací s výsledky 
relativní kvantifikace a dalších souvisejících informací o chemizmu 5´ nukleázové 
reakce naleznete v následujících příručkách: 
 

 •   Informace o provádění relativní kvantifikace na přístroji 7900HT: 
–  ABI PRISM 7700 Sequence Detection System User Bulletin #2: Relative 

Quantification Of Gene Expression (kat. č. 4303859) 
–  RQ Manager Software User Guide(kat. č. 4339753) 
–  Bibliografické odkazy v této příručce. 

•   Informace o odvození vzorce ∆∆CT: 
–  ABI PRISM 7700 Sequence Detection System User Bulletin #2: Relative 

Quantification Of Gene Expression (kat. č. 4303859) 
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Automatické 
nastavení 

pozadí a prahu 

Součástí programu SDS je algoritmus AutoCT, který umožňuje automatické 
nastavení pozadí a prahu pro každý detektor. Algoritmus vypočítává pozadí a práh 
pro každý detektor na základě předpokladu, že výsledkem amplifikace je “typický” 
průběh křivek – viz obrázek 6-7. 

 

 
 

Fáze plató (Plateau) 
Lineární fáze 

Exponenciální fáze 
 

∆Rn 
 
 

Pozadí (Background) 
 

 
 
 
 
 

Cyklus 
Pozadí (Baseline) 

 
 

Obrázek 6-7   Typická amplifikační křivka 
 
 

Experimentální chyby (jako např. kontaminace, chyby při pipetování apod.) mohou 
vést k výsledkům, které se od typického průběhu amplifikačních křivek výrazně liší. 
Takové výsledky pak vedou k tomu, že softwarový algoritmus nastaví pozadí a práh 
pro daný detektor nesprávně. Společnost Applied Biosystems proto doporučuje, 
abyste po provedení analýzy studie pomocí algoritmu AutoCT provedli kontrolu 
nastavení pozadí a prahu pro všechny detektory. 
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Automatické odstranění odlehlých bodů 

 
 

O odlehlých 
bodech 

Při každé PCR může dojít k tomu, že v důsledku experimentální chyby dochází 
v některých  jamkách k nedostatečné nebo vůbec žádné amplifikaci. Výsledkem jsou 
hodnoty CT, které se výrazně liší od průměru ostatních jamek v rámci skupiny 
replikátů. Budou-li tyto výsledky zahrnuty do výpočtů, mohou vést k chybným 
závěrům, neboť změní průměrné hodnoty pro skupinu replikátů. 

 
O automatickém 

odstranění 
odlehlých bodů  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Reproducibilita 

amplifikace 

Program SDS je pro studie sestávající ze skupin alespoň tří a více replikátů vybaven 
algoritmem pro identifikaci a odstranění odlehlých bodů. Program používá 
statistickou metodu založenou na Grubbsově postupu odstraňování odlehlých bodů 
(též známém jako Maximum Normalized Residual Test), která umožňuje vyřazení 
jednoho odlehlého bodu ve skupině nejméně tří replikátů. 
 

Program využívá tento postup podle Grubbse v různých fázích kalkulace ∆∆CT 

v závislosti na typu endogenní kontroly používané v rámci studie. Ve studiích typu 
singleplex dochází k odstranění odlehlých bodů ze skupiny replikátů ihned po 
výpočtu prahového cyklu (CT). Ve studiích typu multiplex po výpočtu ∆CT. Přitom 
má-li zřejmý odlehlý bod hodnotu CT lišící se o ne více než 0.25 od průměru dané 
skupiny replikátů, program jej neodstraní. 

Poznámka:  Odstranění odlehlých bodů je volitelná možnost, kterou lze aktivovat 
v dialogovém okně Analysis Settings (Parametry analýzy - viz strana 6-29). Odlehlé 
body lze rovněž identifikovat a odstranit ručně podle postupu na straně 6-49. 
 

Kromě Grubbsova testu používá program i další algoritmy pro zpracování 
výsledků. Mají-li vzorky hodnoty CT rovné nebo vyšší než je maximální počet 
cyklů, jsou ignorovány (s výjimkou, že těchto hodnot nabývá většina vzorků 
v rámci dané skupiny replikátů). 
 
Experimentální reproducibilita hodnot CT při relativní kvantifikaci klesá, tak jak se 
snižuje výchozí počet kopií templátu k extrémně nízkým hodnotám (méně než 100 
kopií). Výsledky PCR amplifikace nízkého počtu kopií a následné vysoké hodnoty 
CT mohou mít výrazně sníženou statistickou reproducibilitu. Chcete-li se vyhnout 
problémům s reproducibilitou kvantifikace nízce se exprimujících genů, musíte 
experimentálně stanovit, při jaké koncentraci templátu jsou výsledky ještě 
reproducibilní, a to pro každou esej (všechny cílové sekvence a endogenní 
kontrola). 
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Koncepce experimentu 
 
 

Endogenní 
kontrola 

Předpokladem provedení všech experimentů typu relativní kvantifikace je vždy 
amplifikace sekvence endogenní kontroly. V typickém případě je endogenní kontrola 
cílová sekvence RNA nebo DNA, která má ve všech vzorcích v rámci daného 
experimentu hladinu genové exprese na statisticky srovnatelné úrovni. Endogenní 
kontrola je používána pro normalizaci rozdílů v množství celkové RNA přidávané do 
každé reakce. Příkladem běžně používaných endogenních kontrol jsou GAPDH, 18S 
rRNA a β-Actin. 
Endogenní kontrolu je možné amplifikovat nezávisle na cílové sekvenci 
v samostatných jamkách destičky (singleplex), nebo v téže jamce jako cílovou 
kvantifikovanou sekvenci (multiplex). 
 
 

DŮLEŽITÉ!  Pro výpočet standardní odchylky relativního množství cílové sekvence 
musí každá destička obsahovat minimálně dva replikáty cílové sekvence a endogenní 
kontroly. 

 
 Kalibrátor 

 
Předpokladem provedení všech experimentů typu relativní kvantifikace je vždy 
definice kalibrátoru. Během analýzy výsledků počítá program SDS genovou expresi 
ve vzorcích ve vztahu ke genové expresi v kalibrátoru. Kalibrátor je tedy nezbytnou 
součástí výpočtů, neboť jsou k němu vztahovány výsledky kvantifikace genové 
exprese. 
 

Kalibrátorem může být: 
 

•   Vzorek odebraný v bodě nula nějakého experimentu prováděného v čase 
•   Vzorek, který nebyl vystaven působení experimentálního zásahu (ve srovnání se 
     vzorkem, který takovému působení vystaven byl) 

 

Poznámka:  Program SDS vždy bere v úvahu všechny výsledky kalibrátoru v rámci 
skupiny replikátů, ať již jsou replikáty umístěny na jedné nebo více destičkách. 

 
           Replikáty Při provádění relativní kvantifikace doporučuje společnost Applied Biosystems  

používání tří nebo více replikátů pro každý vzorek, aby výsledky byly statisticky 
signifikantní. 

 

Replikáty vám umožňují: 
 

•   Získat výsledky i v případě selhání amplifikace v některé jamce – Nedojde-li 
v některé z jamek k amplifikaci, je možné získat výsledky, byla-li tato jamka 
součástí skupiny replikátů. Zejména v případě endogenních kontrol je to zvlášť 
důležité, neboť při selhání jejich amplifikace mohou být k nepoužití všechny 
výsledky v dané destičce. 

•   Odstranit odlehlé body – Používání replikátů umožňuje zobrazení a odstranění 
odlehlých bodů. 

•   Zajistit reproducibilitu výsledků – V obecném slova smyslu umožňuje 
používání replikátů dosáhnout vyšší stupeň reproducibility prováděného 
pokusu, neboť umožňuje identifikovat a odstranit výsledky vzniklé v důsledku 
experimentální chyby (jako je kontaminace, pipetovací chyby apod.). 

 Uživatelská příručka pro Real-Time PCR systém ABI PRISM 7900HT 6-20 



  

  

 
 
GR2
108 

 

 

 

G
R

2
1
0
8

 
G

R
2
1
0
8

 
G

R
2
1
0
8

 
G

R
2
1
0
8

 

Začínáme    
 
 

Začínáme 
 
 

Používání 
nápovědy 

Bližší informace o krocích popsaných v této části naleznete v nápovědě programu 
SDS. Chcete-li otevřít nápovědu, klikněte na ikonu  , která je součástí každého 
(dialogového) okna, v němž pracujete. 

 
Příklady v této části Vyobrazení a náhledy, které jsou součástí této kapitoly, byly vytvořeny za použití 

destiček TaqMan® Cytokine Gene Expression Plates (kat.č. 4304671), které slouží 
k in vitro kvantifikaci (v reálném čase) genové exprese lidských genů pro cytokiny. 
Jedna destička umožňuje kvantifikovat expresi 24 genů pro cytokiny a endogenní 
kontrolu za použití vzorků komplementární DNA (cDNA). Destička TaqMan 
Cytokine Gene Expression Plate I je vlastně optická 96-ti jamková destička v níž je 
24 skupin replikátů, v každé skupině sondy TaqMan a primery pro kvantifikaci 
mRNA jednoho lidského cytokinového genu a endogenní kontroly. Na obrázku 6-8 
je vyobrazeno uspořádání jednotlivých esejí v destičce. 
 

Studie použitá pro vytvoření náhledů, které jsou v této části, sestávala ze čtyř 
destiček, které byly použity ke kvantifikaci genové exprese 24 cílových genů během 
36-tihodinového intervalu. 

 
 
 

IL-2 

 
 
IL-1α IL-1β 

 
 Destička 1 

36 hod 

 
IL-3 IL-4 IL-5 

 
IL-6 IL-7 IL-8 

 
IL-10 IL-12p35 IL-12p40 

 
 

 Destička 2 

 

24 hod 

 
IL-13 

 
IL-15 IL-17 

 
 

 Destička 3 

12 hod 

IL-18 G-CSF GM-CSF 
 

M-CSF IFNγ LTβ 
 

TGFβ TNFα TNFΒ 

 
 
 
 

 Destička 4 

 
 
0 hod 

 

 
 
 

Obrázek 6-8   Uspořádání vzorků na destičkách 
 
 

Poznámka:  Více informací o použité destičce naleznete v příručce TaqMan 
Cytokine Gene Expression Plate I Protocol (kat. č. 4306744). 
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Kapitola 6    Analýza výsledků Real-Time PCR 
 
 

Seznam kroků  
 

 
Postupné kroky 
 1.  Vytvoření dokumentu obsahujícího více destiček (viz strana 6-23). 

 
 

2.  Přidání destiček relativní kvantifikace do analýzy (viz strana 6-24). 
 
 
 

3.  Nastavení parametrů analýzy (viz strana 6-26). 
 
 
 

4.  Analýza výsledků běhu (viz strana 6-30). 
 
 
 

5.  Pro každý detektor, pro který jste stanovili pozadí a práh (viz strana 6-46): 
–   Automaticky – Ověřte, že hodnoty pozadí a prahu byly programem nastaveny 

správně. 
–   Manuálně – Nastavte hodnoty pozadí a prahu pro detektor. 

 
 
 

 
6.  Pro každý detektor, pro který mají být odlehlé body odstraněny ručně - Zobrazení 

odlehlých bodů a jejich vypuštění z analýzy výsledků (viz strana 6-49). 
 
 
 

7.  Zobrazení výsledků relativní kvantifikace (viz strana 6-31). 
 
 
 

8.  Volba dalších kroků (viz strana 6-35): 

–   Opakovaná analýza výsledků. 
–   Úprava zobrazení výsledků (tabulka výsledků, vyobrazení destičky, 

grafy). 
–   Tisk částí dokumentu destičky. 
–   Export výsledků (tabulka nebo grafy). 
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 Možnosti analýzy výsledků relativní kvantifikace    
 
 

Možnosti analýzy výsledků relativní kvantifikace 
 
 

Společnost Applied Biosystems nabízí dva způsoby jak analyzovat výsledky 
relativní kvantifikace. 

 
Dokumenty 

obsahující více 
destiček (pro nízký 

počet vzorků) 

Pro analýzu výsledků relativní kvantifikace používá program SDS odlišný typ 
dokumentu destičky, tzv. násobný dokument (ABI PRISM SDS Multiplate Document, 
*.sdm). Tento dokument umožňuje analýzu výsledků získaných použitím ne více než 
10 destiček. Narozdíl od jednotlivých dokumentů destičky umožňuje tento typ 
dokumentu ukládat nastavení a výsledky analýzy. Bez ohledu na to zda analyzujete 
výsledky získané za použití jedné nebo více destiček, musíte pro provedení analýzy 
vytvořit tento násobný typ dokumentu. 
 

Poznámka:  Program SDS umožňuje otevřít jednotlivé dokumenty destičky pro 
relativní kvantifikaci, ale nelze je jako takové použít pro výpočet relativní genové 
exprese. 

 
Program RQ 

Manager (pro 
střední až vysoký 

počet vzorků) 

Program RQ Manager je samostatný software pro provádění analýzy relativní 
kvantifikace se středním až vysokým počtem vzorků na základě výsledků uložených 
v databázi SDS Enterprise. Umožňuje srovnávací analýzu až 97 detektorů (96 
cílových sekvencí a 1 endogenní kontrola) na 200 destičkách, nebo přibližně 153600 
multiplexních reakcí provedených na přístroji ABI PRISM 7900HT. Více informací 
naleznete v příručce SDS RQ Manager User Guide (kat. č. 4339753). 

 

 
 

Vytvoření studie 
 
 

Vytvoření 
dokumentu 

obsahujícího více 
destiček 

Chcete-li provést srovnávací analýzu několika destiček v rámci studie, musíte nejprve 
vytvořit dokument (studii relativní kvantifikace) obsahující více destiček. 
 

1.   V programu SDS klikněte na ikonu  nebo zvolte File > New (Soubor > Nový). 

2.   V dialogovém okně New Document (Nový dokument) nastavte: 
•   Assay (Esej) – Relative Quantification (∆∆CT) Study (Studie relativní 
     kvantifikace)  
•   Container (Destička) – zvolte typ používané destičky. 

 

DŮLEŽITÉ!  V rámci studie relativní kvantifikace nemůžete porovnávat výsledky 
z běhů provedených za použití různých typů destiček (např. vzorky analyzované 
na 96-ti jamkové destičce nelze porovnávat se vzorky analyzovanými na 384-
jamkové destičce). 

 

3.   Klikněte . Program zobrazí nový dokument. 
 

4.   Přidejte do studie relativní kvantifikace dokumenty destiček podle postupu 
 na straně 6-24. 
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Přidání 
dokumentů 
destiček do 

studie 

Chcete-li provést srovnávací analýzu několika destiček v rámci studie, musíte nejprve 
přidat destičky do násobného dokumentu destiček. 
 

Dokumenty destiček přidané do studie musí: 
 

 •   Mít tentýž formát (nemůžete porovnávat výsledky z běhů provedených za 
použití různých typů destiček) 

•   Být připraveny za týchž podmínek (stejný teplotní profil, objem vzorku a 
nastavení sběru dat) 

•   Mít pojmenované vzorky ve všech používaných jamkách. (Pokud dokument 
destičky neobsahuje názvy vzorků, můžete je zadat pomocí programu SDS.) 

 

DŮLEŽITÉ!  V průběhu analýzy nebudou analyzovány nepojmenované vzorky. 
 

DŮLEŽITÉ!  V rámci studie relativní kvantifikace nemůžete porovnávat výsledky 
z běhů provedených za použití různých typů destiček (např. vzorky analyzované na 
96-ti jamkové destičce nelze porovnávat se vzorky analyzovanými na 384-jamkové 
destičce). 
 
Chcete-li přidat destičky do násobného dokumentu relativní kvantifikace: 
 

1.   V násobném dokumentu klikněte  (Přidat destičku/y). 
 

2.   V dialogovém okně Add (Přidat) proveďte: 
 

Víte-li, kde jsou dokumenty destiček uloženy: 

a.  Zvolte záložku File (Soubor). 
 

b.  Vyhledejte adresář obsahující dokumenty destiček. 

c.  Za současného stisku klávesy Ctrl zvolte vybrané soubory, 
poté klikněte  (Přidat). 

 
 
 
 

 Přidané 
 dokumenty 

 
  Zvolené 
  dokumenty 

 

 
 
 
 
 
 
 

Nevíte-li, kde jsou dokumenty destiček uloženy nebo chcete vyhledat specifický 
dokument/y destičky: 

a.  Zvolte záložku Search (Hledat). 

b.  V poli Search in (Hledat v) zadejte adresář, který chcete prohledávat nebo 
     klikněte a zvolte umístění (adresář nebo pevný disk), které chcete 
     prohledávat. 

 

c.  Chcete-li prohledat všechny podadresáře, zvolte Include Subdirectories 
(Včetně podadresářů). 
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    Vytvoření studie 
 
 

  d.  V dialogovém okně Plate Query (Vyhledání destičky) nastavte parametry 
vyhledávání (Find Plates Matching These Criteria). 

e.  Klikněte  (Hledat). 
 

f.   V seznamu Search Results (Výsledky vyhledávání) zvolte za současného 
stisku klávesy Ctrl dokumenty, které chcete použít, a poté klikněte 

 (Přidat). 
 
 
 
 

 Přidané 
 dokumenty  
 
 

 
 

Vyhledávání dokumentů  
destiček majících  
v názvu “RQ“ 

 
Nalezené dokumenty 
 

 
 
 
 
 
 
 

Poznámka:  Více informací o vyhledávání dokumentů destiček naleznete 
v části  “Vyhledávání destiček” na straně A-20. 

 

3.   Chcete-li přidat do studie další destičky, opakujte krok 2 (můžete přidat max. 10 
      destiček). 

 

Poznámka:  Destičky můžete ze studie odstranit tak, že zvolíte příslušný 
dokument a kliknete   (Odstranit). 

 

4.   Po skončení přidávání destiček klikněte . 
 

5.   Nastavte parametry analýzy pro danou studii podle postupu na straně 6-26. 
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Analýza studie 
 
 

Přístupová 
práva 

Pro analýzu výsledků relativní kvantifikace uložených v databázi SDS Enterprise 
neexistují žádná omezení z hlediska přístupových práv. 

 
Nastavení 
parametrů 

analýzy 

Před zahájením analýzy studie je zapotřebí nastavit její parametry, a to pro každý 
detektor, který chcete analyzovat. Parametry analýzy jsou specifické pro daný 
detektor a musí být tudíž i nastaveny zvlášť pro každý detektor. Níže jsou stručně 
popsány možnosti nastavení parametrů analýzy: 
 

•   O parametrech analýzy (viz níže) 
•   Nastavení parametrů analýzy (viz strana 6-29) 

 

Poznámka:  Analýzu je možné provést aniž nastavíte její parametry, v takovém 
případě budou použity přednastavené hodnoty – pozadí bude kalkulováno v rozsahu 
od 3. do 15. cyklu a práh bude mít hodnotu 0.2. 

 
 
O parametrech analýzy 

 
 

Nastavení pro 
zvolený 
detektor 

Tato nastavení definují, jakým způsobem program SDS počítá hodnoty CT skupin 
replikátů pro zvolený detektor z rozbalovací nabídky Detector. Jak je znázorněno na 
obrázku 6-9, je možné zvolit jak automatický tak manuální způsob stanovení pozadí a 
prahu. 

 
 
 
 
 

Automatický výpočet Ct 
 
Manuální výpočet Ct  

 

 
 
 
 
 

 
Obrázek 6-9   Nastavení pro zvolený detektor 

 
 

•   Automatic CT (Automatický výpočet CT) – Program stanoví rozsah cyklů pro 
výpočet pozadí a práh (pro zvolený detektor) pomocí algoritmu AutoCT  (viz 
strana 6-18). 

 

DŮLEŽITÉ!  Zvolíte-li použití algoritmu AutoCT, ověřte po skončení analýzy, že 
hodnoty pozadí a prahu byly vypočítány správně (podle postupu na straně 6-46). 
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•    Manual CT (Manuální výpočet CT) – Program použije pro výpočet hodnot CT 

pozadí a práh (pro zvolený detektor) specifikované v dialogovém okně Analysis 
Settings (Parametry analýzy). 
Program nabízí dvě možnosti jak manuálně nastavit pozadí a práh pro 
daný detektor: 

–  Znáte-li hodnoty, které chcete použít, zadejte je do odpovídajících polí 
v dialogovém okně Analysis Settings (Parametry analýzy). 

–  Chcete-li nastavit pozadí a práh pomocí nástrojů v záložce Amplification 
Plot (Amplifikační graf), ponechte tato pole prázdná a nastavte tyto 
hodnoty ručně podle postupu na straně 6-46. 

 
Odstranění 
vybraných 
replikátů a 
odlehlých 

bodů ze studie 

Tato nastavení definují, jakým způsobem program identifikuje a odstraní odlehlé 
body pro všechny detektory ve studii. 

 
 
 
 

Automatické odstranění  
odlehlých bodů 

 
Odstranění replikátů jejichž ∆CT  <=… 
 

 
 
 
 

Obrázek 6-10    Odstranění vybraných replikátů a odlehlých bodů ze studie 
 

•   Automatic Outlier Removal (Automatické odstranění odlehlých bodů) – 
Program pomocí speciálního algoritmu automaticky odstraní ze studie odlehlé 
body. Více informací o tomto algoritmu viz “Automatické odstranění odlehlých 
bodů” na straně 6-19. 

•   Omit replicates whose (Odstranění replikátů jejichž) ∆CT <=… – Program 
automaticky odstraní ze studie všechny jamky, jejichž hodnota ∆CT je menší 
nebo rovna zadané hodnotě. Tato možnost je k dispozici pouze u experimentů 
typu multiplex, kde obdobné hodnoty CT pro cílový gen a endogenní kontrolu 
mohou znamenat vzájemnou kompetici v rámci eseje a její vliv na amplifikaci. 

 

Poznámka:  Identifikaci a odstranění odlehlých bodů je možné provést i manuálně 
podle postupu na straně 6-49. 
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Nastavení 
dalších  

parametrů 
studie 

Tato nastavení definují níže uvedené parametry. Jejich nastavení má pro vyhodnocení 
výsledků zásadní význam a používá se v rámci celé studie. 

 
 
 

Volba kalibrátoru 
 

Volba detektoru endogenní kontroly 
 

 
Volba typu kontroly  

 
Volba RQ Min/Max Confidence  

 
 
 

Obrázek 6-11   Nastavení parametrů pro vyhodnocení genové exprese v rámci studie 
 
 

•   Calibrator Sample (Kalibrátor) – Zobrazí název vzorku používaného v rámci 
studie jako kalibrátor. 

•   Endogenous Control Detector (Detektor endogenní kontroly) – Zobrazí 
název detektoru, který program používá jako endogenní kontrolu v rámci 
studie. 

•   Control Type (Typ kontroly) – Možnosti Multiplexed/Non-Multiplexed 
(multiplexní / singleplexní reakce) – udává, jak program zpracuje výsledky 
z jamek označených jako endogenní kontrola. 

•   RQ Min/Max Confidence – Definuje hladinu významnosti, kterou program 
použije pro výpočet standardní chyby průměru hladiny genové exprese 
(hodnoty RQMax a RQMin) pro vzorky v rámci studie. 

•   Export Individual ∆CTs (Export jednotlivých hodnot ∆CT) – Je-li tato 
možnost zvolena, program bude exportovat hodnoty ∆CT jednotlivých vzorků 
(namísto průměrných hodnot ∆CT pro skupinu replikátů). 
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Nastavení parametrů analýzy 

 
 

Nastavení 
parametrů analýzy 

1.   Klikněte na ikonu  nebo zvolte Analysis > Analysis Settings (Analýza > 
      Parametry analýzy). 
 

2.   V rozbalovací nabídce Detector (Detektor) zvolte: 
•   detector name (název detektoru) –  Abyste nastavili parametry analýzy pro 
     tento detektor. 
•   All Detectors (všechny detektory) – Abyste nastavili parametry 

analýzy pro všechny detektory najednou. 
 

3.   V dialogovém okně Analysis Settings (Parametry analýzy) definujte způsob 
(automatický nebo manuální) výpočtu pozadí a prahu pro zvolené detektory: 
  
Chcete-li stanovit pozadí a práh: 

Automaticky – Zvolte možnost Automatic CT. (Více informací o algoritmu 
Automatic Ct viz strana.) 

 

DŮLEŽITÉ!  Zvolíte-li použití algoritmu AutoCT, ověřte po skončení 
analýzy, že hodnoty pozadí a prahu byly vypočítány správně (podle postupu 
na straně 6-46). 

Manuálně – Proveďte: 

a.  Zvolte možnost Manual CT. 
 

b.  V poli Threshold (Práh) zadejte prahovou hodnotu platnou pro zvolený 
detektor(y) nebo ponechte toto pole prázdné a nastavte práh ručně podle 
postupu na straně 6-46. 

c.  Zvolte jednu z možností: 
Automatic Baseline (Automatické stanovení pozadí) – program vypočítá 
pozadí pro zvolený detektor(y) automaticky. 
Manual Baseline (Ruční stanovení pozadí) a zadejte do polí Start 
(Začátek) a End (Konec) hodnoty pro daný detektor(y). 
Manual Baseline (Ruční stanovení pozadí) ponechte pole Start a End 
prázdná. (Nastavíte tyto hodnoty ručně podle postupu na straně 6-46.) 

 

4.   Je-li toho zapotřebí, opakujte kroky 2 a 3 pro další detektory. 
 

DŮLEŽITÉ!  Parametry analýzy (práh a pozadí) nastavované v kroku 3 jsou 
specifické pro daný detektor a musí být tudíž i nastaveny zvlášť pro každý 
detektor v dokumentu destičky. 

 

5.    Počítáte-li výsledky pro dva nebo více replikátů pro vzorek, zvolte nebo naopak 
 neoznačujte možnost Automatic Outlier Removal (Automatické odstranění 
 odlehlých bodů). 

 

6.   Pokud chcete, zvolte možnost Omit Samples Whose (Odstranění replikátů 
 jejichž) ∆CT <=, následně zadejte příslušnou hodnotu. Více informací 
 naleznete v části “Odstranění vybraných replikátů a odlehlých bodů ze studie” 
na straně 6-27. 

 

7.   V rozbalovací nabídce Calibrator Sample (Kalibrátor) zvolte vzorek, který 
      chcete používat jako kalibrátor. 
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8.   V rozbalovací nabídce Endogenous Control Detector (Detektor endogenní 
kontroly) zvolte detektor, který reprezentuje endogenní kontrolu používanou 
v rámci vaší studie. 

 

DŮLEŽITÉ!  Detektor používaný jako endogenní kontrola musí být součástí 
všech dokumentů v rámci studie. 

 

9.    Zvolte možnost Multiplexed nebo Non-Multiplexed (multiplexní / singleplexní 
reakce), abyste definovali typ používané endogenní kontroly. 

 

Poznámka:  Možnosti Multiplexed nebo Non-Multiplexed jsou k dispozici pouze 
pokud analyzované dokumenty obsahují jak multiplexní tak singleplexní reakce. 

 

10.   V rozbalovací nabídce RQ Min\Max Confidence zvolte hladinu významnosti, 
kterou má program použít pro výpočet standardní chyby průměrné genové 
exprese (pro zobrazení přesnosti odhadu populačního průměru). 

 

  11.   Pokud chcete, zvolte možnost Export Individual ∆CT (Export jednotlivých 
hodnot ∆CT). Je-li tato možnost zvolena, program SDS zobrazí hodnoty to 
display the ∆CT pro jednotlivé vzorky z příslušné skupiny replikátů. Není-li tato 
možnost zvolena, program zobrazí průměrné hodnoty ∆CT skupiny replikátů. 

 

12.   Klikněte  , čímž potvrdíte nastavení parametrů analýzy. 
 

13.   Analyzujte výsledky podle postupu na straně 6-30. 
 
 

Analýza studie 
 
 

Analýza 
výsledků 

Během analýzy program používá různé matematické algoritmy tak, aby na základě 
hrubých dat odvodil vztah mezi změnami spektrálních signálů pasivní reference a 
reportérových barev v jednotlivých vzorcích. Na základě těchto přepočtů pak vypočítá 
prahový cyklus (CT) pro každou reakci (endogenní kontrola a neznámé vzorky). 
 

Poznámka:  Více informací o souvisejících matematických výpočtech naleznete 
v příloze D “Principy fungování”. 
 

1.   Klikněte na ikonu  nebo zvolte Analysis > Analyze (Analýza > Analyzovat). 
Program SDS provede analýzu dat a zobrazí výsledky v záložce Results. 

 

2.   Zvolte jednu z možností: 

•   Nastavujete-li pozadí a práh manuálně, nastavte je pro každý detektor podle 
postupu na straně 6-46. 

•   Používáte-li pro nastavení pozadí a prahu pro detektory v destičce algoritmus 
AutoCT, ověřte, že nastavení bylo pro každý detektor provedeno správně – 
viz postup na straně 6-46. 

 

3.   Pokud manuálně odstraňujete odlehlé body, postupujte podle pokynů na straně 
6-46. 

 

 Uživatelská příručka pro Real-Time PCR systém ABI PRISM 7900HT 6-30 



       Kapitola 6    Analýza výsledků Real-Time PCR   

  

 
 

Zobrazení výsledků 
 
 

Zobrazení 
analyzovaných 

dat 

Graf genové exprese zobrazuje výsledky pro detektor(y) zvolený z rozbalovací 
nabídky Detectors. Program SDS vám umožňuje v grafu genové exprese omezit 
zobrazení detektoru a destičky pomocí tabulek Plates (Destičky) a Targets (Cílové 
geny) v panelu Plate List (Seznam destiček). Program zobrazí výsledky pouze pro 
zvolené cílové geny a destičky. 

 
O grafu genové 

exprese 
Program SDS zobrazuje v grafu genové exprese výsledky relativní kvantifikace 
(∆∆CT). Graf je v horní části násobného dokumentu. Na obrázku 6-12 jsou 
znázorněny důležité součásti grafu. 

 
 

Ukazatele standardní chyby (viz níže) 
 
 

Šipka (viz strana 6-33) 
 
 

Legenda 
 

 
Graf 

 
 
 

Detektory 
 
 

Obrázek 6-12   Součásti grafu genové exprese 
 

•   Osa X – Seznam všech kvantifikovaných genů. Program pro každý cílový gen 
zobrazí relativní expresi genu v konkrétním vzorku. 

 
•   Osa Y – Výsledky výpočtu relativní kvantifikace jsou seskupeny podle cílového 

kvantifikovaného genu a vyjádřeny v logaritmické škále. Hladina genové exprese 
je vypočítána a znázorněna relativně vůči hladině exprese v kalibrátoru a každý 
přírůstek odpovídá 10-tinásobné změně genové exprese. 

 
O hladině genové 

exprese 
Program SDS zobrazuje výsledky relativní kvantifikace v logaritmické škále, kde 
každý přírůstek odpovídá 10-tinásobné změně genové exprese. Hladina genové 
exprese je vypočítána a znázorněna relativně vůči hladině exprese v kalibrátoru 
(zvoleném v rozbalovací nabídce Calibrator). 
 

Poznámka:  Jelikož kalibrátor je porovnáván sám se sebou, je jeho hladina genové 
exprese vždy 1 (1E+00). 
 

V tabulce 6-1 na straně 6-32 jsou uvedeny různé možnosti vyjádření hladiny genové 
exprese pro skupinu replikátů, které mohou nastat. Stínované řádky tabulky označují 
kombinace výsledků, pro které program není schopen vypočítat přesnou úroveň 
genové exprese. 
 

Poznámka:  Minimální ( ↑) a maximální ( ↓ ) možná hladina genové exprese jsou 
detailně popsány na straně 6-33. 
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Tabulka 6-1 Hladina genové exprese 

 

∆CT vzorku Příklad (40 cyklů amplifikace)  
Detektor 

Kalibrátor Neznámý vzorek 

 
Hladina exprese je 

Kalib. ∆CT Nezn. ∆CT Výsledek 

Target 

Endo 
<a 

< 
< 

< 
Zobrazena 25 

33 
32 

35 
•   RQ se zobrazí 
•   USC se zobrazí 

Target 

Endo 
Maxb 

< 
< 

< 
Minimum možného 

(zobrazí se ↑) 
—b 

35 
34 

30 
•   RQ se zobrazí 
•   USC zobrazí ↑ 

Target 

Endo 
< 

< 
Max 

< 
Maximum možného 

(zobrazí se ↓ ) 
33 

33 
— 

33 
•   RQ se zobrazí 
•   USC zobrazí ↓ 

Target 

Endo 
Max 

Max 
Max 

Max 
Nestanoveno 

(nezobrazí se) 
— 

— 
— 

— 
Target 

Endo 
< 

Max 
Max 

Max 
Nestanoveno 

(nezobrazí se) 
30 

— 
— 

— 
Target 

Endo 
Max 

Max 
< 

Max 
Nestanoveno 

(nezobrazí se) 
— 

— 
30 

— 
Target 

Endo 
Max 

Max 
Max 

< 
Nestanoveno 

(nezobrazí se) 
— 

— 
— 

30 
Target 

Endo 
Max 

< 
Max 

Max 
Nestanoveno 

(nezobrazí se) 
— 

30 
— 

— 
Target 

Endo 
< 

Max 
< 

Max 
Nestanoveno 

(nezobrazí se) 
30 

— 
20 

— 
Target 

Endo 
< 

Max 
Max 

< 
Nestanoveno 

(nezobrazí se) 
35 

— 
— 

33 
Target 

Endo 
< 

< 
Max 

Max 
Nestanoveno 

(nezobrazí se) 
30 

20 
— 

— 
Target 

Endo 
Max 

Max 
< 

< 
Nestanoveno 

(nezobrazí se) 
— 

— 
30 

20 
Target 

Endo 
Max 

< 
Max 

< 
Nestanoveno 

(nezobrazí se) 
— 

20 
— 

20 
Target 

Endo 
Max 

< 
< 

Max 
Nestanoveno 

(nezobrazí se) 
— 

33 
35 

— 
Target 

Endo 
< 

< 
< 

Max 
Nestanoveno 

(nezobrazí se) 
30 

35 
33 

— 
Target 

Endo 
< 

Max 
< 

< 
Nestanoveno 

(nezobrazí se) 
33 

— 
30 

35 

•   RQ se 
nevypočítá 

•   USC se nezobrazí  

Target – cílový gen, Endo – Endogenní kontrola, RQ – relativní hladina genové exprese, USC – Ukazatel standardní chyby 

a < : Označuje případ, kdy je hodnota CT nižší než maximální cyklus PCR daného běhu (platná hodnota CT). 
b Max (nebo —): Označuje případ, kdy amplifikační křivky dané skupiny replikátů nepřekročí práh (hodnota ‘nestanoveno’). 
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O šipkách směrem 

dolů 
 
 

Šipka dolů 

Program zobrazí šipku směrem dolů, aby indikoval, že udávaná hladina genové 
exprese představuje pro daný gen maximum možného. Šipka dolů se zobrazí pokud: 
 

•   Kalibrátor má platné hodnoty CT pro cílový gen i endogenní kontrolu (CT 
je nižší než počet cyklů PCR) a 

•   Hodnota CT pro cílový detektor neznámého vzorku není stanovena 
(hodnota CT endogenní kontroly je platná). 

 

Za shora zmíněné situace neobsahuje neznámý vzorek dostatečné množství cílové 
cDNA, tak aby mohl být porovnán s kalibrátorem. Proto program udává maximálně 
možnou hladinu genové exprese pro daný neznámý vzorek. 

 
O šipkách směrem Program zobrazí šipku směrem nahoru, aby indikoval, že udávaná hladina genové  
                   nahoru  exprese představuje pro daný gen minimum možného. Šipka nahoru se zobrazí pokud:

 
 
Šipka 
nahoru 

 

•   Neznámý vzorek má platné hodnoty CT pro cílový gen a endogenní kontrolu 
(CT je nižší než počet cyklů PCR) a 

•   Hodnota CT pro cílový detektor kalibrátoru není stanovena (hodnota CT 
endogenní kontroly je platná). 

 

Za shora zmíněné situace neobsahuje kalibrátor dostatečné množství cílové cDNA, 
tak aby mohl být porovnán s neznámým vzorkem. Proto program udává minimálně 
možnou hladinu genové exprese pro daný neznámý vzorek. 

 
O ukazatelích 

standardní chyby 
Pokud byla hladina genové exprese vypočítána pro skupinu dvou nebo více replikátů, 
program zobrazuje pro každý sloupec v grafu ukazatele standardní chyby. Tím je 
vyjádřena vypočítaná maximální (RQMax) a minimální (RQMin) hladina exprese, 
vyjadřující standardní chybu průměrné hladiny genové exprese (hodnota RQ). 
Společně tyto dva limity definují rozsah hladiny genové exprese, v němž se skutečná 
hladina genové exprese pravděpodobně nachází. Pro výpočet program používá 
nastavení parametru RQMin/RQMax confidence (Hladina významnosti) 
v dialogovém okně Analysis Settings (Parametry analýzy). 
 

Poznámka:  Jelikož standardní odchylku lze vypočítat pouze při použití dvou a více 
replikátů, program SDS nezobrazuje ukazatele standardní chyby, hodnoty RQMin a 
RQMax nebo standardní odchylku je-li cílový gen nebo endogenní kontrola 
kvantifikována v jediném vzorku. 
 

Poznámka:  Ukazatele standardní chyby jsou vyjádřením pravděpodobnosti, že 
náhodně zvolený vzorek splňuje kritéria definovaná na základě standardní populace, 
stupňů volnosti a hladiny významnosti RQ Min/Max. Program nezobrazuje 
ukazatele standardní chyby pro kalibrátor, poněvadž ten je porovnáván sám se 
sebou. 

 
Vzorky 

s nestanovenou 
hodnotou CT a 

odstranění 
odlehlých bodů 

Program nestanoví hodnotu CT pokud amplifikační křivky replikátů v průběhu běhu 
nepřekročí nastavený práh pro daný detektor. 
 

•   Není-li zapnuta funkce odstranění odlehlých bodů, program ignoruje všechny 
jamky s nestanovenou hodnotou CT a udává průměr CT zbývajících jamek. 

•   Je-li zapnuta funkce odstranění odlehlých bodů a současně většina jamek v rámci 
skupiny replikátů nemá stanovenu hodnotu CT, program nestanoví průměrnou 
hodnotu CT. Má-li polovina nebo více jamek stanovenu hodnotu CT, program 
ignoruje všechny jamky s nestanovenou hodnotou CT, ze zbylých jamek odstraní 
odlehlé body a znázorní průměrnou hodnotu CT zbylých jamek. 
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Zobrazení 
tabulky výsledků 

Program zobrazuje výsledky výpočtu relativní kvantifikace v tabulce v dokumentu 
destičky. Na obrázku 6-13 je příklad takové tabulky výsledků, obsahující údaje 
získané za použití TaqMan Human Cytokine Plate I. 
 
 
 
 
 
 
 
 
 
 
 
 
 
s 

 
Obrázek 6-13   Tabulka výsledků relativní kvantifikace 
 
 
Sloupce v tabulce:: 
 

•   Position (Pozice) – Označení destičky a jamky v destičce 

•   Sample (Vzorek) – Název vzorku v dané jamce 

•   Detector (Detektor) – Název detektoru použitého v dané jamce 

•   Task (Úloha detektoru) – Úloha detektoru použitého v dané jamce. 

•   CT – Průměrný vypočítaný prahový cyklus skupiny replikátů, do níž daný 
vzorek patří. 

 

Poznámka:  V tomto sloupci se zobrazí ‘Undetermined’ (Nestanoveno), pokud 
v dané jamce nedojde k zaznamenatelnému nárůstu fluorescenčního signálu 
během PCR (fluorescenční signál v dané jamce nikdy nepřekročí práh pro 
daný detektor). 

 

•   ∆CT – Normalizovaný prahový cyklus daného vzorku 
•   Avg∆CT – Průměrná vypočítaná hodnota prahového cyklu pro skupinu 

replikátů, do níž daný vzorek patří 

•   ∆CT SD – Standardní odchylka od průměrné hodnoty ∆CT skupiny replikátů, do 
níž daný vzorek patří 

•   ∆∆CT – Vypočítaná hodnota ∆∆CT pro skupinu replikátů, do níž daný vzorek 
patří. 

•   RQ – Vypočítaná relativní hladina genové exprese pro skupinu replikátů, do níž 
daný vzorek patří  

•   RQ min – Minimální možná hladina genové exprese daných vzorků 
•   RQ max – Maximální možná hladina genové exprese daných vzorků 

•   Status (Stav) – Probíhá-li vyhodnocení vzorku automaticky a algoritmus 
vyřadí vzorek z další analýzy, zobrazí se zde důvod vyřazení. 

•   Rejected (Vyřazen) – Probíhá-li vyhodnocení vzorku automaticky, zobrazí se 
     zde, zda byl vzorek vyřazen z analýzy. 
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 Po skončení analýzy    
 
 

Po skončení analýzy 
 
 

Přístupová 
práva 

Používáte-li databázi SDS Enterprise, musíte mít pro ukládání výsledků analýzy do 
databáze práva uživatele třídy Scientist (Vědec) nebo Administrator (Správce). 

 
Volba dalších 

kroků 
Úprava zobrazení výsledků............................................................................... 6-51 
Tisk zprávy ....................................................................................................... 6-51 
Export dokumentu destičky .............................................................................. 6-51 
Uložení výsledků ...................................................................................... (viz níže) 

 
Uložení studie  Po ukončení analýzy je možné její výsledky uložit v programu SDS ve formátu  

Multiplate Document File (*.sdm). 
 
Chcete-li uložit analýzu ve formátu Multiplate Document File (*.sdm): 
 

1.   V programu SDS zvolte File > Save As (Soubor > Uložit jako). 
 

2.   V poli Look in (Vyhledat) dialogového okna Save As (Uložit jako) vyhledejte a 
zvolte adresář, do nějž chcete výsledky uložit. 

 

3.   V poli File name (Název souboru) zadejte název souboru. 
 

4.   Klikněte  (Uložit). Program uloží dokument destičky do zvoleného 
      adresáře. 

 
Uložení studie do databáze SDS Enterprise  
 

Databáze SDS Enterprise neumožňuje ukládání studií relativní kvantifikace 
(ABI PRISM Multiplate Document File). 
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Část 6.3  Analýza disociační křivky   
 
 

Část 6.3 Analýza disociační křivky 
 
 
 

  V této části Přehled ..................................................................................................................6-38 
Dříve než začnete .................................................................................................6-39 
Seznam kroků .......................................................................................................6-40 
Otevření výsledků běhu ........................................................................................6-41 
Analýza výsledků..................................................................................................6-41 
Odečtení hodnoty Tm ............................................................................................6-42 
Po skončení analýzy..............................................................................................6-44 
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Kapitola 6    Analýza výsledků Real-Time PCR 
 
 

Přehled 
 
 

O analýzy 
disociační křivky 

Na přístroji ABI PRISM 7900HT je možné provádět analýzu disociační křivky 
nukleových kyselin pomocí barviva SYBR® Green 1, které se váže na 
dvouřetězcovou DNA. Cílem analýzy disociační křivky je přesné stanovení teploty 
tání (melting temperature - Tm) cílové nukleové kyseliny v neznámém vzorku. 
Typickým příkladem použití disociační křivky je detekce přítomnosti nespecifických 
produktů a stanovení optimální koncentrace primerů. 

 
Barvivo 

SYBR Green 1 
 

Analýza disociační křivky na přístroji 7900HT je proveditelná pomocí fluorogenního 
barviva SYBR Green 1, které se váže na dvouřetězcovou DNA (viz strana D-3). 
Běžně se provádí po skončení PCR reakce, v níž bylo toto barvivo použito, s cílem 
detekovat přítomnost nespecifických produktů. Po skončení PCR se provede 
dodatečný krok – pomalé postupné zvyšování teploty. Vazebné vlastnosti barviva 
SYBR Green 1 umožňují monitorovat hybridizaci nukleových kyselin ve vzorku. 
Přístroj během tohoto kroku zaznamenává pokles fluorescence barviva SYBR Green, 
který je důsledkem disociace dsDNA. 

 
Matematické 

zpracování 
výsledků 

Po skončení běhu provádí program SDS pomocí různých algoritmů zpracování 
naměřeného fluorescenčního signálu barviva SYBR Green 1. Výstupem tohoto 
zpracování je graf závislosti změny fluorescenčního signálu na teplotě. 
 
Multikomponentní algoritmus a normalizace 
 

Prvním z těchto matematických algoritmů je přepočet hrubých dat, vyjádřených jako 
závislost intenzity fluorescenčního signálu na vlnové délce, na signál jednotlivých 
čistých barev, který se provádí pomocí údajů získaných během kalibrace barev 
(použijí se extrahovaná spektra čistých barev). Jakmile program zjistí jednotlivé barvy, 
vypočítá jejich příspěvek do celkového naměřeného signálu (hrubá data) pomocí 
multikomponentního algoritmu (více informací o multikomponentním algoritmu 
naleznete na straně D-5). Následně program provede normalizaci signálu pomocí 
signálu pasivní reference podle postupu níže. 

 
 R(SYBR) 

Rn    =   
 R(Passive Reference) 
 

 
Derivace 

 

Program SDS poté vypočítá první derivaci normalizovaného signálu (Rn), a to pro 
každé přístrojem 7900HT zaznamenané měření během kroku zvyšování teploty. 
Výsledkem (Rn´) je rychlost změny fluorescence v závislosti na teplotě (viz níže). 
 
 dRn 
Rn’    =   
 dT 
 
Jako poslední krok program vynese do grafu závislost negativní hodnoty 
derivovaných dat -Rn´ na teplotě (T), čímž zobrazí změnu fluorescence při každé 
změně teploty. Tm cílové nukleové kyseliny lze pak odvodit z grafu – jedná se o 
teplotu, při níž dochází k maximální rychlosti poklesu fluorescenčního signálu 
(zobrazí se jako pík) pro danou amplifikační křivku. 
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Dříve než začnete    
 
 

               Příklad   Na obrázku 6-14 je vyobrazena disociační křivka detekující nespecifický produkt 
              amplifikace ve vzorku cDNA. Jsou zde vyobrazeny dva píky, což je typický signál 

tvory dimerů primerů. Amplifikace specifického produktu vede ke vzniku píku s Tm 

80.5 °C, pík vzniklý v důsledku tvorby dimerů primerů má nižší Tm 74.9 °C. 
 
 

-6.0 
 

-5.0 

 
Dimer 

primerů 

 
Hlavní produkt 
Tm  = 80.5 °C 

 

 
-4.0 

 

 
-3.0 

 
-2.0 

 
-1.0 

 
0.0  

60 65 70 75 80 85 90 95 

Teplota (°C) 

 
Obrázek 6-14   Příklad výsledku analýzy disociační křivky 

 
 

Dříve než začnete 
 
 

Používání 
nápovědy 

Bližší informace o krocích popsaných v této části naleznete v nápovědě programu 
SDS. Chcete-li otevřít nápovědu, klikněte na ikonu  , která je součástí každého 
(dialogového) okna, v němž pracujete. 

 
Příklady v této části Vyobrazení a náhledy, které jsou součástí této kapitoly, byly vytvořeny za použití 

běhu ověřujícího specifický průběh amplifikace fragmentu genu kódujícího β-aktin 
v neznámých vzorcích. Každá z jamek destičky obsahovala barvivo SYBR Green 1, 
primery a genomickou DNA jako templát. 
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Kapitola 6    Analýza výsledků Real-Time PCR 
 
 

Seznam kroků 
 

 
Postupné kroky  
 1.  Analýza výsledků běhu (viz strana 6-41). 

 

 
 

2.  Zobrazení výsledků analýzy disociační křivky (viz strana 6-42). 
 
 
 

3.  Stanovení teploty tání (Tm) pro jednotlivé píky (viz strana 6-44). 
 
 
 

4.  Volba dalších kroků (viz strana 6-44): 

–   Opakovaná analýza výsledků. 
–   Úprava zobrazení výsledků (tabulka výsledků, vyobrazení destičky, 

grafy). 
–   Tisk částí dokumentu destičky. 
–   Export výsledků (tabulka nebo grafy). 
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Otevření výsledků běhu    
 
 

Otevření výsledků běhu 
 
 

Přístupová 
práva 

Pro otevření výsledků běhu z databáze SDS Enterprise neexistují žádná omezení 
z hlediska přístupových práv. 

 
Otevření 

neanalyzovaného 
dokumentu destičky 

Otevření dokumentu destičky 
 

1.   Klikněte na ikonu  nebo zvolte File > Open (Soubor > Otevřít). 

2.   V poli Look in (Vyhledat) vyhledejte a zvolte příslušný dokument destičky. 
 

3.   Klikněte  (Otevřít). 

Program SDS zobrazí soubor s dokumentem destičky. 
 

4.   Nastavte parametry analýzy (Analysis Settings) pro každý detektor podle 
      postupu níže. 

 
Otevření neanalyzovaného dokumentu destičky z databáze SDS Enterprise 
 

5. Klikněte  nebo zvolte File > Open Document from Database (Soubor > 
Otevřít dokument z databáze). 

 

6. V dialogovém okně Plate Query (Volba destičky) upravte parametry 
vyhledávání destičky (Find Plates Matching These Criteria) dle potřeby. 

 

7. Klikněte  (Vyhledat). 
 

8. V seznamu Search Results (Výsledky vyhledávání) zvolte dokument, s nímž 
chcete pracovat. 

 

9. Klikněte  (Otevřít). 
 

10. Klikněte  (Hotovo). 
 

  
 

Analýza výsledků 
 
 

Přístupová 
práva 

Pro analýzu výsledků disociační křivky uložených v databázi SDS Enterprise 
neexistují žádná omezení z hlediska přístupových práv. 

 
Analýza výsledků Analýzu výsledků lze provést ihned po skončení běhu. Vysvětlení postupu analýzy 

naleznete v části “Matematické zpracování hrubých dat” na straně 6-7. 
 

1.   Vyberte všechny jamky destičky. 

Program ohraničí vybrané jamky černou čárou. 
 

2.   Klikněte na ikonu  nebo zvolte Analysis > Analyze (Analýza > Analyzovat). 

Program SDS provede analýzu dat a zobrazí výsledky v záložce Dissociation 
Curve (Disociační křivka). 

 

3.   Stanovte Tm pro disociační křivky zobrazené v grafu podle postupu na straně 
      6-44. 
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Kapitola 6    Analýza výsledků Real-Time PCR 
 
 

Stanovení hodnot Tm  
 

 
Zobrazení 

výsledků analýzy 
disociační křivky  

Program SDS zobrazuje výsledky analýzy disociační křivky v záložce Dissociation 
Curve dokumentu destičky. Zobrazí se graf závislosti negativní hodnoty 
derivovaných dat -Rn´ na teplotě (T), tedy změna fluorescence při každé změně 
teploty. 
 

Poznámka:  V grafu se zobrazují pouze údaje z vybraných jamek destičky. Pokud 
nevidíte žádné křivky, zvolte příslušné jamky ve vyobrazení destičky. 
 

Na obrázku 6-15 jsou znázorněny součásti tohoto grafu. 
 

Záložka Dissociation 
Curve (Disociační křivka) 

 
Graf 

 
 
 
 
 
 
 
 

Disociační křivky 
 
 
 
 
 
 

Hodnota Tm a posuvník 

Nabídka Step (Krok) 
Nabídka Plot (Graf) 
Nabídka Detector 
(Detektor) 

 

 
Obrázek 6-15    Součásti grafu disociační křivky 

 
 

•   Graf – Zobrazuje data ze zvolených jamek ve vyobrazení destičky. 
 

Poznámka:  Způsob zobrazení grafu lze změnit. Více informací o možnostech 
změny zobrazení získáte v nápovědě programu SDS po kliknutí na ikonu . 

 

•   Nabídka Step (Krok)  – Zvolte, z kterého kroku zvyšování teploty se mají data 
zobrazit. 
Je-li součástí dokumentu destičky více než jeden krok zvyšování teploty, je 
možné v nabídce Step (Krok) zvolit, z kterého z těchto kroků budou data 
zobrazena. 
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Stanovení hodnot Tm    
 
 

•   Hodnota Tm a posuvník – Program SDS zobrazuje hodnotu Tm pod zeleným 
     posuvníkem (viz níže). 

 
 
 
 

Tm 
 

 
Parametr Tm lze definovat dvěma způsoby: 

–  Z chemického hlediska se jedná o teplotu, při níž je 50% DNA 
v dvouřetězcové formě. 

–  Z matematického hlediska se jedná o maximální hodnotu první derivace 
křivky pro daný pík. 

•   Nabídka Plot (Graf) –  Zvolte, v jaké formě mají být data zobrazena. 
K dispozici jsou dvě možnosti: 

–  Raw (Hrubá data) – Při zvolení této možnosti se zobrazí normalizovaný 
fluorescenční signál reportérové barvy (Rn) v závislosti na teplotě (graf vlevo 
na obrázku 6-16). 

–  Derivative (Derivace) – Při zvolení této možnosti se zobrazí derivace signálu 
(Rn´) v závislosti na teplotě (graf vpravo na obrázku 6-16). Jedná se o graf 
závislosti negativní rychlosti změny fluorescence. 

Na obrázku 6-16 jsou vyobrazeny oba grafy. 

 

 
Hrubá data      Derivace 

 
Obrázek 6-16   Grafy v záložce Disociační křivka 

 
 

•   Nabídka Detector (Detektor) – Umožňuje zvolit detektor, pro nějž budou 
výsledky zobrazeny. 
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 Kapitola 6    Analýza výsledků Real-Time PCR     
 
 

Stanovení 
hodnot Tm  

1.    Umístěte kurzor nad zelenou linku Tm vedoucí ve směru osy Y. 
 

2.  Klikněte a táhněte za tuto linku tak, abyste ji umístili do maxima zvoleného 
píku. 

Program SDS zobrazí hodnotu Tm pro křivku pod linkou Tm. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Hodnota Tm a posuvník 

 
 
 

Poznámka:  Vrchol píku představuje maximální rychlost změny normalizované 
fluorescence. 

 
 

Po skončení analýzy
  

 
Přístupová 

práva 
Používáte-li databázi SDS Enterprise, musíte mít pro ukládání výsledků analýzy do 
databáze práva uživatele třídy Scientist (Vědec) nebo Administrator (Správce). 

 

 
Volba dalších 

kroků 
Úprava zobrazení výsledků ................................................................................. 6-51 
Tisk zprávy .......................................................................................................... 6-51 
Export dokumentu destičky................................................................................. 6-51 
Uložení výsledků ................................................................................................. 6-52 
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Část 6.4 Poznámky k analýze 
 
 
 

V této části Nastavení pozadí a prahu......................................................................................6-46 
Odstranění odlehlých bodů ...................................................................................6-49 
Po skončení analýzy..............................................................................................6-51 
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Kapitola 6    Analýza výsledků Real-Time PCR 
 
 

Nastavení pozadí a prahu 
 
 

Nastavení pozadí 
a prahu 

Rozhodnete-li se pro určitý detektor nastavit pozadí a práh ručně, postupujte 
následujícím způsobem: 
 

1.   Zvolte záložku Results (Výsledky). 
 

2.   Provádíte-li nastavení pozadí a prahu: 

Pro experiment absolutní kvantifikace 

Zvolte všechny jamky kliknutím do levého rohu ve vyobrazení destičky. 
 

 
   Zde klikněte 

 
 
 
 
 
 
 
 
 
 
 
 
 

Pro experiment relativní kvantifikace (v násobném dokumentu) 
 

a.  Zvolte destičku a zvolte všechny jamky v destičce kliknutím do levého rohu 
ve vyobrazení destičky. 

b.  Opakujte krok a, dokud nevyberete jamky všech destiček v rámci studie. 
 
 

Kliknutím zde zvolíte všechny 
jamky 

 
 
 
 
 
 
 
 
 

Zde zvolte destičku 
 

 
 
 

3.   V rozbalovací nabídce Detector (Detektor) v amplifikačním grafu zvolte 
detektor, pro který chcete nastavit pozadí a práh. 

Data vybraných jamek budou zobrazena v amplifikačním grafu. 
 

4.   V rozbalovací nabídce Plot (Graf) zvolte ∆Rn vs. Cycle (Graf závislosti ∆Rn na 
      cyklu). 

5.   Dvakrát klikněte na amplifikační graf nebo jednou na ikonu . 
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Nastavení pozadí a prahu    
 
 

6.   V dialogovém okně Display Settings (Nastavení zobrazení): 

a.  V poli Select Pane/View (Volba zobrazení) zvolte Amplification Plot 
     (Amplifikační graf). 

b.  V části Y Axis (Osa Y) zvolte Linear (Lineární). 

c.  Klikněte . 
 

7.   Nastavte pozadí (baseline) tak, aby se amplifikační křivky začínaly zvedat 
později, než je číslo cyklu v poli Stop. 

Pokud ověřujete nastavení pozadí pro předešle automaticky analyzovaný 
detektor, ověřte, že je nastaveno správně, a pokračujte krokem 8. Není-li pozadí 
nastaveno správně, otevřete okno Analysis Settings (Parametry analýzy), zadejte 
volbu manuální analýzy pro daný detektor a potvrďte . Poté co budou data 
zobrazena, nastavte pozadí a práh ručně. 

 
 

Vypadá-li graf amplifikace takto... Pak... 
 

Amplifikační křivka začíná později, než 
je přednastavená horní hranice pro 
výpočet pozadí (cyklus 15). 

 

Pozadí je nastaveno správně. 
 
 
 
 
 
 

Vysoký rozsah nastavení pozadí.  
Upravte horní hranici pro výpočet 
pozadí tažením značky      doleva (nižší 
cyklus). 

 
 
 
 
 
 

 

Nízký rozsah nastavení pozadí.  
Upravte horní hranici pro výpočet pozadí 
tažením značky      doprava (vyšší 
cyklus). 

 
 
 
 
 
 
 
 

8.   Dvakrát klikněte na amplifikační graf nebo jednou na ikonu . 
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Kapitola 6    Analýza výsledků Real-Time PCR 
 
 

9.   V dialogovém okně Display Settings (Nastavení zobrazení): 

a.  V poli Select Pane/View (Volba zobrazení) zvolte Amplification Plot 
     (Amplifikační graf). 

b.  V části Y Axis (Osa Y) zvolte Log (Logaritmické). 

c.  Klikněte . 
 

10.   Nastavte práh tak, aby byl: 
•   Vyšší než pozadí (background) 
•   Níž než je fáze plató a lineární fáze amplifikační křivky 
•   V exponenciální fázi amplifikační křivky 

 

Pokud ověřujete nastavení prahu pro předešle automaticky analyzovaný 
detektor, ověřte, že je nastaven správně, a pokračujte krokem 11. Není-li práh 
nastaven správně, otevřete okno Analysis Settings (Parametry analýzy), zadejte 
volbu manuální analýzy pro daný detektor a potvrďte . Poté co budou 
data zobrazena, nastavte pozadí a práh ručně. 

 
 
 

Fáze plató (Plateau) 
Lineární fáze 
 

Exponenciální fáze 
Nastavený práh 

Rn (klikněte a táhněte) 
 

 
Pozadí (Background) 

 

 
 
 
 
 

Cyklus 
Pozadí (Baseline) 

 

 
11.   Opakujte kroky 3 až 10, dokud nenastavíte pozadí a práh pro všechny zbývající 
        detektory. 

 

12.   Odstraňujete-li odlehlé body 
•   Automaticky – Zobrazte výsledky. 

•   Manuálně – Zobrazte a odstraňte odlehlé body podle postupu na straně 
6-49. 
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Odstranění odlehlých bodů    
 
 

Odstranění odlehlých bodů 
 

     Přehled Při každé PCR může dojít k tomu, že v důsledku experimentální chyby dochází 
v některých  jamkách k nedostatečné nebo vůbec žádné amplifikaci. Výsledkem jsou 
hodnoty CT, které se výrazně liší od průměru ostatních jamek v rámci skupiny 
replikátů. Budou-li tyto výsledky zahrnuty do výpočtů, mohou vést k chybným 
závěrům, neboť změní průměrné hodnoty pro skupinu replikátů. 

 
Zobrazení 

odlehlých bodů 
Abyste získali přesné výpočty výsledků relativní kvantifikace, musíte zjistit, zda se 
v některé ze skupin replikátů nenachází odlehlé body. K tomu použijete graf CT vs. 
Well Position (Hodnoty CT v závislosti na poloze jamky). 
 

1.   Zvolte záložku Results (Výsledky). 
 

2.   Analyzujete-li výsledky v rámci studie relativní kvantifikace, zvolte destičku a 
odznačte všechny jamky v zobrazení destičky. Opakujte tento postup pro 
všechny destičky v rámci studie. Po ukončení tohoto kroku bude amplifikační 
graf prázdný. 

 

3.   Odstraňujete-li odlehlé body v rámci experimentu: 

Absolutní kvantifikace 
Zvolte všechny jamky kliknutím do levého rohu ve vyobrazení destičky. 

Relativní kvantifikace (v násobném dokumentu) 

Zvolte destičku a zvolte všechny jamky v destičce kliknutím do levého rohu 
ve vyobrazení destičky. 

 

4.   V rozbalovací nabídce Plot (Graf) zvolte CT vs. Well Position (Graf závislosti 
hodnoty CT na poloze jamky). 

 

5.  V grafu ověřte uniformitu každé skupiny replikátů porovnáním hodnot CT 

všech vzorků patřících do dané skupiny. 
 

 

    Odlehlé body? 
 

Pak… 

Ano Poznamenejte si čísla jamek, které odpovídají odlehlým 
bodům, a pokračujte dalším krokem. 

Ne Pokračujte dalším krokem. 

 
6.   V rozbalovací nabídce Detector (Detektor) zvolte další detektor a opakujte 

kroky 3 až 5. Opakujte pro všechny detektory. 
 

7.   Analyzujete-li přítomnost odlehlých bodů v rámci studie relativní kvantifikace, 
opakujte kroky 3 až 6 pro všechny destičky v rámci studie. 

 

8.   Jsou na destičce odlehlé body? 
 

Ano – Odstraňte je z analýzy postupem uvedeným v části “Odstranění jamek 
z analýzy” na straně 6-50. 

Ne – Proveďte jeden z následujících kroků: 
•   Analyzujete-li výsledky absolutní kvantifikace, zobrazte výsledky běhu 

v grafu standardní křivky a v tabulce Results (Výsledky). 
•   Analyzujete-li výsledky relativní kvantifikace, zobrazte výsledky běhu 

v grafu genové exprese a v tabulce Results (Výsledky). 
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Odstranění jamek 
z analýzy 

Program SDS umožňuje odstranit zvolené jamky z analýzy. Pokud jste identifikovali 
odlehlé body nebo výsledky, které nechcete zahrnout do analýzy, můžete jim 
odpovídající jamky z analýzy odstranit postupem uvedeným níže. 
 

DŮLEŽITÉ!  Odstraníte-li jamku před provedením běhu, program SDS nebude měřit 
v dané jamce fluorescenci. Je-li jamka odstraněna až po provedení běhu, program ji 
vyřadí z analýzy, ale naměřená data zůstanou zachována. 
 

1.   Chcete-li odstranit jamku v rámci studie relativní kvantifikace, zvolte nejprve 
příslušnou destičku. 

 

2.   Za současného stisku klávesy Ctrl zvolte ve vyobrazení destičky jamku(y), 
kterou chcete odstranit. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.   Chcete-li odstraňovat jamky v rámci studie relativní kvantifikace, opakujte 
kroky 1 a 2 pro všechny destičky studie. 

 

4.   Zvolte záložku Setup (Zadání). 
 

5.   V okně Well inspector (Prohlížeč jamek), klikněte do pole Omit Well(s) 
(Odstranit jamku/y), čímž vybrané jamky odstraníte z analýzy. 

 
 

Zvolené jamky 
           (odstraněné) 

 
Pole Omit Well(s) (Odstranit jamku/y) 
 

 
 
 
 
 
 

Poznámka:  Chcete-li odstraněnou jamku opět použít, označte ji a klikněte do 
pole Omit Well(s) (Odstranit jamku/y). 

 

6.   Klikněte na ikonu  nebo zvolte Analysis > Analyze (Analýza > Analyzovat). 
 

7.   Opakujte postup v části “Odstranění odlehlých bodů” na straně 6-49, abyste 
ověřili, že všechny odlehlé body byly odstraněny. 
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Po skončení analýzy 
 
 

Přístupová 
práva 

Používáte-li databázi SDS Enterprise, mohou všichni uživatelé provádět níže uvedené 
kroky vyjma ukládání výsledků. Pro ukládání výsledků analýzy do databáze musíte 
mít práva uživatele třídy Scientist (Vědec) nebo Administrator (Správce) 

 
Volba dalších 

kroků 
Úprava zobrazení výsledků............................................................................ (viz níže)  

Tisk zprávy .....................................................................................................(viz níže)  

Export dokumentu destičky ............................................................................(viz níže)  

Uložení výsledků ....................................................................................................6-52 
 

Úprava 
zobrazení 
výsledků 

Před vytištěním nebo exportem výsledků můžete upravit jejich zobrazení (tabulku 
výsledků, zobrazení destičky a většinu grafů). 
 

1.   Klikněte na ikonu  nebo zvolte View > Display Settings (Zobrazit > 
Nastavení zobrazení). 

 

2.  V dialogovém okně Display Settings (Nastavení zobrazení) klikněte na 
ikonu  , čímž získáte více informací o možnostech změny zobrazení. 

 
          Tisk zprávy Program SDS umožňuje tisk zprávy o výsledcích analýzy. Tato zpráva může 

sestávat z různých částí dokumentu destičky. 
 

1.   Klikněte na ikonu  nebo zvolte File > Print Report (Soubor > Tisk zprávy). 
 

2.   V dialogovém okně Print Report (Tisk zprávy) klikněte na ikonu  , 
čímž získáte více informací o nastavení a tisku zprávy. 

 
Export 

dokumentu 
destičky 

Export dokumentu destičky ve formě souboru *.txt 
 

Program SDS umožňuje exportovat hrubá nebo analyzovaná data ve formě textového 
souboru (tabelátorem oddělená data - *.txt). Exportovat lze výsledky všech nebo 
zvolených jamek. Exportovaný soubor je kompatibilní s většinou tabulkových editorů. 
 

Chcete-li exportovat dokument destičky, zvolte jednu z následujících možností: 
 

•   Pokračujte částí “Export dokumentu destičky” na straně A-16. 
•   Klikněte na ikonu  v zobrazení tabulky. 

 
Export grafů jako obrázků 
 

Program SDS umožňuje export většiny grafů z dokumentu destičky ve formě 
grafických souborů formátu JPEG (Joint Photographic Experts Group). Formát 
JPEG je kompatibilní s většinou textových a tabulkových editorů a lze jej použít 
přímo též v dokumentech typu HTML. 
 

Chcete-li exportovat graf ve formátu JPEG, získáte více informací v části “Export 
obrázků” na straně A-16 nebo kliknutím na ikonu  v příslušném grafu. 
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Uložení výsledků Program SDS ukládá výsledky analýzy různými způsoby v závislosti na tom, 
zda je analýza ukládána do databáze SDS Enterprise (viz níže) nebo do 
dokumentu destičky (viz strana 6-53). 
 
Uložení výsledků do databáze SDS Enterprise 
 

Používáte-li databázi SDS Enterprise, lze výsledky analýzy uložit jako tzv. seance 
(session). 
 

DŮLEŽITÉ!  Při ukládání do databáze dodržujte následující pokyny: 
 

•   Pokud jste jakkoliv upravili informace v dokumentu destičky (vypuštění jamek, 
změna způsobu zobrazení), musíte uložit dokument destičky do databáze, chcete-
li tyto změny zachovat (zvolte File > Save Plate Document to Database – 
Soubor > Uložit dokument do databáze). 

•   Databáze SDS Enterprise umožňuje dvěma nebo více uživatelům otevírat a 
upravovat data najednou. Pokud jiný uživatel otevřel, upravil a uložil táž data, 
která jste právě analyzovali, program tyto úpravy po uložení v databázi přepíše. 

•   Výsledky analýzy uložené v databázi jsou přímo propojeny s dokumentem destičky, 
na jehož základě byly vytvořeny. Pokud poté, co jste výsledky analýzy uložili do 
databáze, upravíte propojený dokument destičky (vypustíte jamky, pozměníte názvy 
vzorků atp.), výsledky vaší analýzy nemusí být s tímto dokumentem více propojeny. 
Následně může dojít ke změně výsledků vaší analýzy, pokud tuto analýzu 
zopakujete, poněvadž jste změnili obsah propojeného dokumentu destičky, v němž 
jsou uložena hrubá data. 
Společnost Applied Biosystems doporučuje dodržovat při práci s výsledky 
analýzy následující doporučení: 
–  Ukládejte dokument destičky jako nový dokument kdykoliv v jeho zadání 

provedete nějaké změny (vypuštění jamek, pozměnění názvů vzorků, úprava 
detektorů nebo markerů atp.) 

–  Pro každý uložený dokument ukládejte pouze jedny výsledky analýzy 

–  Vezměte na vědomí, že pouze výsledky analýzy uložené po provedení 
posledních změn v dokumentu destičky odpovídají obsahu tohoto 
dokumentu. 

 
Chcete-li uložit výsledky do databáze: 
 

1.   Zvolte File > Save Results to Database (Soubor > Uložit výsledky do 
      databáze). 

 

2.   V poli Description (Popis) dialogového okna Save Results to Database (Uložit 
výsledky do databáze) zadejte popis dokumentu destičky (max. 255 znaků). 

 

Poznámka:  Program vám automaticky nabízí možnost uložit výsledky 
analýzy pod názvem propojeného dokumentu destičky. 

 

3.   (Volitelné) V poli Add to Study (Přidat ke studii) klikněte na ikonu  a 
 zvolte studii nebo vytvořte novou studii pomocí ikony  (Nová) a 
 provedením následujících kroků: 

a.  V poli Name (Název) dialogového okna Create New Study (Vytvořit novou 
studii) zadejte název studie (max. 128 znaků).  

b.  V poli Description (Popis) zadejte stručný popis studie (max. 255 znaků). 

c.  Klikněte  .  

d.  Klikněte . 
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4.   V dialogovém okně Save Results to Database (Uložit výsledky do databáze) 
      klikněte  . 

 

5.   Potvrďte ještě jednou kliknutím . 
 

Uložení dokumentu typu *.sds 
 

Ačkoliv program ukládá změny provedené v zobrazení dokumentu destičky a 
nastavení parametrů analýzy, neukládá výsledky analýzy.  

 

1.   Zvolte File > Save As (Soubor > Uložit jako). 
 

2.   V poli Look in (Vyhledat) dialogového okna Save As (Uložit jako) vyhledejte a 
zvolte adresář, do něhož chcete uložit nový soubor. 

 

3.   V poli File name (Název souboru): 
•   Zadejte název souboru dokumentu destičky, nebo 
•   Zadejte nebo naskenujte čárový kód destičky. 

 

Poznámka:  Program SDS nepožaduje, aby název souboru odpovídal čárovému 
kódu destičky. 

 

4. Klikněte  (Uložit). 
Program uloží dokument destičky do zvoleného adresáře. 
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Poznámky pro uživatele databáze 
 
 

Dodatečné úkony Používáte-li databázi SDS Enterprise pro ukládání dokumentů SDS, studií a dat, je 
možné, že v průběhu tohoto cvičení budete muset provést nějaké dodatečné úkony. 
Níže jsou tyto úkony popsány (nutnost jejich provedení závisí na tom, jak správce 
provedl nastavení databáze). Více informací o úkonech popsaných níže naleznete 
v příručce SDS Enterprise Database Administration Guide. 

 

 
Dialogové okno 
Reason(s) For 

Change 

Dialogové okno Reason(s) for Change (Důvod/y změny) se objevuje pouze v případě, 
je-li databáze SDS Enterprise nastavena tak, že vyžaduje zdůvodnění prováděných 
kroků (tzv. Audit). Systém auditu sleduje vytváření, změny a mazání dat v databázi. 
 

Objeví-li se dialogové okno Reasons for Change, proveďte jeden z následujících 
kroků: 

• Zvolte důvod změny z rozbalovací nabídky a poté klikněte na ikonu .
• Zadejte důvod změny do příslušného pole a poté klikněte na ikonu .

 
 

 Rozbalovací nabídka 
 důvodů změny 

 
 Přednastavené důvody 

 
 
 
 

Popis vlastního důvodu 
 

 
 

Obrázek 7-1   Dialogové okno Reasons for Change (Důvod/y změny) 
 

Dialogové 
okno 

Electronic 
Signature 

Dialogové okno Electronic Signature (Elektronický podpis) se objevuje pouze 
v případě, je-li databáze SDS Enterprise nastavena tak, že vyžaduje elektronický 
podpis. Systém elektronického podpisu omezuje a sleduje přístup uživatelů k datům 
v databázi. 
 

Objeví-li se toto dialogové okno: 
 

1.   Do pole User ID (Jméno) a Password (Heslo) zadejte vaše uživatelské jméno a 
heslo a potvrďte . 

 

2.   Program následně zobrazí zprávu o úspěšném či neúspěšném použití 
elektronického podpisu. Pro pokračování klikněte . 

 
 
 
 

 Popis kroku, který vyžaduje  
 elektronický podpis 

 
 Uživatelské jméno 

 
 Heslo 

 
 
 

Obrázek 7-2   Dialogové okno Elektronický podpis 
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 Doporučená frekvence kroků údržby    
 
 

Doporučená frekvence kroků údržby 
 
 

Frekvence 
údržby 

V následující tabulce jsou uvedeny kroky údržby přístroje ABI PRISM®  7900HT, které 
je doporučeno provádět pravidelně. 
 
Tabulka 7-1 Plán údržby přístroje 7900HT Instrument 

 
 

Interval 
 

Krok 
 

Viz strana 
 

  Po Út  St Čt Pá So Ne 
 
 
 
 
 

Týden (7 dní) 

Archivujte soubory SDS  7-54 

Proveďte kalibraci pozadí 7-16 

Zkontrolujte (a případně vyměňte) podložky 
ramene podavače 

7-52 

  Po Út  St Čt Pá So Ne 
 
 
 
 
 

  Měsíc (30 dní) Defragmentujte pevný disk počítače  7-54 

Proveďte kalibraci barev* 7-20  
 Leden Červenec 

Su M  T  W Th  F   S Su M  T  W Th  F   S 

 
 
 
 

Každý půlrok 
(6 měsíců) 

 
Ověřte, zda se na internetových stránkách 
společnosti Applied Biosystems nacházejí 
aktualizace softwaru. 

7-55 

*Kalibraci pozadí proveďte před každou kalibrací barev. 
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Část 7.1  Údržba přístroje 7900HT    
 
 

Část 7.1 Údržba přístroje 7900HT 
 
 
 

     V této části Výměna bloku na vzorky ..................................................................................... 7-6 
Výměna adaptéru na destičky ............................................................................ 7-12 
Dekontaminace bloku na vzorky ....................................................................... 7-14 
Provedení kalibrace pozadí ................................................................................ 7-16 
Provedení kalibrace barev.................................................................................. 7-20 
Přidání vlastní barvy do sady barev ................................................................... 7-27 
Ověření funkčnosti přístroje .............................................................................. 7-30 
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Výměna bloku na vzorky 
 

 
      Kdy provádět  DŮLEŽITÉ!  Před výměnou bloku na vzorky proveďte všechny požadované 

aktualizace programu SDS a firmwaru přístroje. Pokud tento krok neprovedete, může 
se stát, že přístroj nebude možné ovládat nebo dojde k poškození jeho součástí. 

 

Blok na vzorky musíte vyjmout, pokud: 
 

•   Chcete dekontaminovat jamky v bloku (viz strana 7-14) 
•   Chcete blok vyměnit za jiný 

 

DŮLEŽITÉ!  Po instalaci nového bloku vždy proveďte kalibraci pozadí. 
 

Postup 
instalace bloku 

na vzorky 

Pokud nedostanete jiné pokyny, postupujte podle níže uvedených pokynů pro 
výměnu bloku. 
 
Chcete-li instalovat blok na vzorky: 
 

1.   Proveďte všechny požadované aktualizace programu SDS a firmwaru přístroje 
ABI PRISM 7900HT (viz strana 7-55). 

 

2.   Vyjměte stávající blok na vzorky (viz strana 7-7). 
 

3.   Instalujte nový blok na vzorky (viz strana 7-10). 
 

4.   Vyměňte adapér na destičky (viz strana 7-12). 
 

5.   Proveďte běh s destičkou pro kalibraci pozadí, abyste ověřili případnou 
 přítomnost kontaminace v bloku (viz strana 7-16). 

 

Měníte-li typ bloku nebo budete používat nový blok, rovněž proveďte:  

DŮLEŽITÉ!  Po výměně bloku vždy proveďte kalibraci pozadí a kalibraci barev, i když  
měníte blok za jiný blok téhož formátu. 
 

6.   Proveďte kalibraci barev pro nový formát bloku (viz strana 7-20). 
 

7.   Proveďte ověřovací běh s destičkou TaqMan®  RNase P Instrument 
Verification Plate nebo s ověřovací mikrofluidní kartou TaqMan™  TGF-β 
Instrument Verification Micro Fluidic Card, čímž ověříte správné fungování 
bloku (viz strana 7-30). 

 
Používáte-li podavač mikrodestiček, rovněž proveďte: 
 

8.   Měníte-li formát destiček (např. blok pro 384-jamkovou destičku za blok pro 
96-ti jamkovou destičku nebo blok na mikrofluidní karty), nastavte citlivost 
senzoru destiček ramene podavače pro nový formát (viz strana 7-37). 

 

9.   Proveďte seřízení podavače mikrodestiček Zymark Twister® pro nový formát 
(viz strana 7-41). 

 

DŮLEŽITÉ!  Podavač mikrodestiček musíte seřídit pouze do pozice Instrument 
(Přístroj) (Zymark pozice 2) podle pokynů na straně 7-41 až 7-44. 

 

10.   Proveďte seřízení pevně umístěné čtečky čárových kódů pro nový formát 
(viz strana 7-49). 
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Potřebné 
pomůcky 

•   Blok na vzorky (pokud jej měníte) 
•   Imbus 5/32 (pouze pro určité přístroje) 
•   Imbus 5/16 (pro některé přístroje může být potřeba hasák) 

 
Manipulace 

s blokem na 
vzorky 

Výměnné bloky na vzorky jsou citlivá zařízení, jejichž některé součásti jsou křehké a 
mohou se při nesprávné manipulaci snadno rozbít. Na obrázku 7-3 je znázorněno jak 
s blokem manipulovat. 

 

 
 

Připojení k přístroji 
(nedotýkat se) 

 
 
 
 

Topné elementy 
 
 
 
 
 
 

(Spodní část bloku) 
Zde na bocích blok uchopte 
 

 
Obrázek 7-3   Manipulace s blokem na vzorky 

 
 

Vyjmutí bloku 
na vzorky 

1.   Spusťte program Automation Controller: 
 

a.  Zvolte záložku Thermal Status (Teplotní parametry) a ověřte, že blok 
funguje. Blok funguje, pokud program odečítá informace o teplotě. 

b.  Klikněte  (Otevřít/Zavřít) čímž vysunete nosítka přístroje. 

2.   Zvolte File > Exit (Soubor > Konec), čímž program Automation Controller 
 ukončíte. 

 

3.   Vypněte a vypojte přístroj 7900HT ze sítě. 

  RIZIKO PORANĚNÍ. Během následujících kroků musí být 
přístroj vypnut a vypojen ze zásuvky. Nedodržení těchto opatření může vést 
k vážnému zranění nebo poškození přístroje. 

 

4.   Vyčkejte 20 až 30 min, než se ochladí vyhřívané víko. 

  RIZIKO PORANĚNÍ. Je-li přístroj v provozu, může být 
teplota bloku na vzorky až 100 °C. Před provedením následujících kroků vyčkejte, 
než se blok na vzorky ochladí na pokojovou teplotu. 
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5.   Jsou-li nosítka vysunuta ven, zatlačte je dovnitř, abyste měli více místa. 
 
 
 
 
 
 
 
 
 
 
 

6.   Používáte-li podavač mikrodestiček Zymark Twister, odstraňte kryty 
pevně umístěné čtečky čárových kódů a podstavce. 

 
 
 
 
 
 

 
Kryty pevně umístěné čtečky  
čárových kódů a podstavce 

 
7.   Zasuňte nosítka zpět do přístroje, a pak odstraňte spodní kryt otvoru, abyste měli 

přístup k bloku na vzorky. 
 

DŮLEŽITÉ!  Spodní kryt je nasazen na dvou čepech a jeho odstranění může 
vyžadovat sílu (žádné nástroje nejsou zapotřebí). 

 
 
 
 

Spodní kryt 
 

 
 
 
 
 

8.   Pomocí imbusu 5/16 vyšroubujte šroub závory, držící blok, aby byl volný, ale 
nikoliv úplně povolený. 

 

DŮLEŽITÉ!  Pro uvolnění závory u některých přístrojů může být zapotřebí 
nastavitelný hasák. 

 
 

 
Závora            

 
 

Šroub závory  
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9.   Uvolněte šroub, jímž je závora připevněna ke kostře přístroje (na některých 
přístrojích pomocí imbusu 5/32). 

 
 
 
 
 
 

šroub 
 
 
 
 

10.   Vyjměte závoru nahoru a ven z přístroje. 
 
 
 
 
 
 
 
 
 
 

11.   Vyjměte blok z přístroje: 

a.  Otočte uvolňovací páku na spodní straně bloku o 90 stupňů. 
 
 
 
 
 
 
 
 
 

b.  Opatrně, abyste nepoškodili topné elementy na spodní straně bloku, 
vysuňte blok na vzorky z přístroje a umístěte jej na čistý a rovný povrch. 
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Výměna bloku 
na vzorky 

DŮLEŽITÉ!  Před výměnou bloku na vzorky proveďte všechny požadované 
aktualizace programu SDS a firmwaru přístroje. Pokud tento krok neprovedete, 
může se stát, že přístroj nebude možné ovládat nebo dojde k poškození jeho 
součástí. 
 

1.   Vložte blok na vzorky do přístroje: 
 

a.  Opatrně, abyste nepoškodili topné elementy na spodní straně bloku, 
položte blok na vzorky do vodicích kolejnic na stranách jeho úložiště 
v přístroji. 

b.  Opatrně zasuňte blok na vzorky do přístroje. 
 

c.  Po jeho zasunutí na blok pevně zatlačte, abyste zajistili propojení 
kontaktů s přístrojem. 

 
 
 
 
 
 
 
 
 
 

2.   Zajistěte blok na vzorky závorou. 
 
 
 
 
 
 
 
 
 
 

3.   Dotáhněte šroub (z kroku 9 na straně 7-9), kterým připevníte závoru bloku ke 
kostře přístroje (případně pomocí imbusu 5/32). 

 

4.   Pomocí imbusu 5/16 dotáhněte šroub závory. 
 

5.   Znovu zatlačte na pravé i levé čelní straně bloku, abyste se ujistili, že je správně 
 usazen v úložišti. 

 

6.   Nasaďte zpět spodní kryt: 

a.  Přiložte spodní kryt spodní stranou k otvoru v boku přístroje. 

b.  Zatlačte na kryt dokud čepy nezacvaknou. 
 

DŮLEŽITÉ!  Spodní kryt musíte nasadit zpět předtím než znovu zapnete přístroj. 
Pokud tak neučiníte, přístroj si nestáhne z počítače firmware a program SDS 
zobrazí chybovou hlášku. 
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7.   Používáte-li podavač mikrodestiček, nasaďte zpět kryty pevně umístěné čtečky 
čárových kódů a podstavce (odstraněné v kroku 6 na straně 7-8). 

 
 
 
 
 
 
 

Pevně umístěná 
čtečka čárových 

kódů a kryty 
 

8.   Zapojte přístroj 7900HT do sítě a zapněte jej. 
 

9.   Ověřte, že blok funguje: 

a.  Spusťte program Automation Controller.  

b.  Zvolte záložku Thermal Status (Teplotní parametry). 
 

 

Odečítá program 
informace o teplotě? 

 
Pak… 

Ano instalace proběhla úspěšně. 

Odečítané údaje o teplotě potvrzují, že přístroj 
7900HT je úspěšně propojen s blokem. 

Ne přístroj 7900HT nebyl úspěšně propojen s blokem. 

1.  Vypněte přístroj 7900HT a vypojte jej ze sítě. 

2.  Odstraňte spodní kryt. 
 

3.  Zatlačte na pravé i levé čelní straně bloku, abyste se 
ujistili, že je správně  usazen v úložišti. 

4.  Znovu zasaďte spodní kryt. 

5.  Opakujte krok 8 dokud neuslyšíte tón potvrzující 
navázanou komunikaci mezi přístrojem a blokem na 
vzorky. 

 
 

10.   Poté co je blok v přístroji: 

a.  Proveďte kalibraci pozadí (viz strana 7-16), abyste ověřili, že blok na 
     vzorky: 

– Správně funguje 
– Není kontaminován fluorescenčními kontaminacemi 

 

b.  Měníte-li formát bloku, pokračujte podle pokynů v části “Výměna bloku 
na vzorky” na straně 7-6. 

 

DŮLEŽITÉ!  Po výměně bloku proveďte kalibraci barev a pozadí, a to i když 
měníte jeden blok za druhý téhož formátu. 

 Uživatelská příručka pro Real-Time PCR systém ABI PRISM 7900HT 7-11 



Kapitola 7    Údržba přístroje   

  

 
 

Výměna adaptéru na destičky 
 
 

     Kdy provádět Vyjměte a vyměňte adaptér na destičky poté co vyměníte blok za blok jiného formátu 
(např. 384-jamkový blok na vzorky za 96-ti jamkovou verzi). 

 

Poznámka:  Blok určitého formátu lze používat pouze s adaptérem na tytéž 
destičky. 

 
Potřebné 
pomůcky 

•   Imbus 3/32 
•   Některý z adaptérů: 

–  Adaptér na 384-jamkové destičky 
–  Adaptér na 96-jamkové destičky 
–  Adaptér na mikrofluidní karty 

 
Výměna 

adaptéru 
na destičky 

1.   Jsou-li nosítka uvnitř přístroje 7900HT, vysuňte je ven: 

a.  Spusťte SDS. 

b.  Klikněte na ikonu  nebo zvolte File > New (Soubor > Nový). 

c.  V dialogovém okně New Document (Nový dokument) klikněte . 

d.  V okně nového dokumentu zvolte záložku Instrument (Přístroj). 

e.  V záložce Real-Time klikněte  (Otevřít/Zavřít). 
Nosítka přístroje se vysunou ven. 

f.   Zvolte File > Exit (Soubor > Konec), čímž program SDS ukončíte. 
 

2.   Vyšroubujte čtyři šrouby, jimiž je adaptér na destičky připevněn k ramenu. 
 
 
 

Vyšroubovat 
 
 
 
 
 
 
 
 
 
 
 

 Vyšroubovat 
 

 
3.   Vyjměte adaptér na destičky. 

 

Poznámka:  Měníte-li formát bloku na vzorky (např. 384-jamkový blok na 
vzorky za 96-ti jamkovou verzi), uložte adaptér na destičky spolu s vyjmutým 
blokem téhož formátu. 
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4.   Umístěte nový  adaptér na rameno tak, že je značka A1 v zadním levém rohu 
      (viz níže). 

 

DŮLEŽITÉ!  Ujistěte se, že instalujete adaptér správného formátu (384-jamková, 
96-jamková destička nebo mikrofluidní karta). Na adaptérech na destičky je 
vyznačeno, pro jaký spotřební materiál jsou určeny. 

 
 
 

Jamka A1 
 

 
 
 
 
 
 
 
 
 
 

Označení 
 

 
5.   Přišroubujte zpět čtyři vyjmuté šrouby v pořadí uvedeném níže: 

 

DŮLEŽITÉ!  Pořadí, v jakém jsou jednotlivé šrouby utahovány, je důležité pro 
dodržení správné pozice adaptéru na destičky v bloku na vzorky uvnitř 
přístroje 7900HT. 

 

 
 
 
 

3 1 
 
 
 
 
 
 
 
 
 

2 4 
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Dekontaminace bloku na vzorky 
 
 

      Kdy provádět Tento postup popisuje jak provádět dekontaminaci jamek bloku na vzorky. Tato 
procedura slouží k odstranění zbytkových kontaminujících produktů PCR a reagencií 
včetně fluorescenčních sond TaqMan®. Čistěte blok na vzorky tak často, jak je potřeba. 

 

DŮLEŽITÉ!  Plánujete-li používat jinou metodu čistění nebo dekontaminace, než je 
uvedena v této příručce, ověřte si nejprve u společnosti Applied Biosystems, že tato 
metoda nepoškodí blok na vzorky nebo přístroj 7900HT. 

 
Potřebné 
pomůcky 

•   10% roztok chlornanu sodného 
•   Izopropanol, 100 procentní 
•   Imbus 5/32 
•   Tyčinky s vatou 

 

  CHEMICKÉ RIZIKO. 10% roztok chlornanu sodného je 
tekutý dezinfekční prostředek, který může poškodit pokožku a vést k její 
depigmentaci. Přečtěte si bezpečnostní list a dodržujte pokyny při manipulaci. 
Používejte prostředky ochrany očí, ochranný oděv a rukavice. 

  CHEMICKÉ RIZIKO. Izopropanol je hořlavá kapalina a 
vytváří hořlavé výpary. Expozice vede k podráždění očí, kůže a dýchacího ústrojí. 
Delší nebo opakovaný kontakt může vysušit pokožku a způsobit podráždění. Může 
též způsobit ospalost, závratě, bolesti hlavy a apod. Přečtěte si bezpečnostní list a 
dodržujte pokyny při manipulaci. Používejte prostředky ochrany očí, ochranný oděv 
a rukavice. 

 
Čistění bloku na 

mikrofluidní karty 
1.   Otřete povrch bloku (šedý hliník) pomocí 10% roztoku chlornanu sodného. 
 

2.   Otřete blok třikrát pomocí destilované vody. 
 

3.   Otřete blok pomocí izopropanolu a nechte jej uschnout. 
 

 
 

Warning 

Připojení k přístroji 
(nedotýkat se) 

 
 
 
 
  

Jamka A-1 
 
 
 
 

4.   Vyměňte blok podle postupu v části “Výměna bloku na vzorky” na straně 7-10. 
 

5.   Proveďte kalibraci pozadí pomocí mikrofluidní karty, abyste ověřili, že se 
kontaminaci podařilo odstranit. 
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Čistění 384- nebo 

96-ti jamkového 
bloku na vzorky 

1.   Vyjměte blok na vzorky z přístroje 7900HT podle postupu v části “Výměna 
      bloku na vzorky” na straně 7-7. 
 

2.   Za pomoci následujícího obrázku vyhledejte kontaminovanou jamku/y 
v bloku na vzorky. 

 
 
 

 
Warning 

Připojení k přístroji 
(nedotýkat se) 

 
 
 
 
 
 
 
 

Jamka A-1 
 
 
 
 
 

3.   Pipetujte odpovídající objem 10% roztoku chlornanu sodného do každé 
      potenciálně kontaminované jamky. 

•   Pro 96-ti jamkový blok pipetujte 150 µL roztoku chlornanu sodného do 
     každé jamky. 
•   Pro 384 jamkový blok pipetujte 40 µL roztoku chlornanu sodného do 
     každé jamky. 

 

4.   Nechte roztok působit 3 až 5 min. 
 

5.   Pomocí pipety roztok z jamek odstraňte. 
 

6.   Třikrát opláchněte každou kontaminovanou jamku odpovídajícím objemem 
destilované vody (pipetujte do jamky a odsajte). 

•   Pro 96-ti jamkový blok použijte na oplach 150 µL deionizované vody. 

•   Pro 384 jamkový blok použijte na oplach 40 µL deionizované vody 
 

Poznámka:  V třetím kole oplachu můžete použít absolutní izopropanol namísto 
vody. 

 

7.   Odsajte zbytkový izopropanol nebo vodu z jamek bloku na vzorky. 
 

8.   Vyměňte blok podle postupu v části “Výměna bloku na vzorky” na straně 
7-10. 

 

9.   Proveďte kalibraci pozadí, abyste ověřili, že se kontaminaci podařilo odstranit. 
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Provedení kalibrace pozadí 
 
 

         Kdy provádět Společnost Applied Biosystems doporučuje provádět kalibraci pozadí měsíčně nebo 
podle potřeby v závislosti na využití přístroje. 

 
Účel kalibrace 

pozadí 
Kalibrace pozadí slouží ke změření úrovně fluorescence pozadí v přístroji – používá se 
destička nebo mikrofluidní karta s deionizovanou vodou. V průběhu kalibrace pozadí 
systém provádí po dobu 2 minut při 60°C kontinuální odečítání signálu z destičky pro 
kalibraci pozadí. Poté program SDS spočítá průměrnou hodnotu zaznamenaných 
spekter a na jejich základě generuje výsledný kalibrační soubor. Systém během 
následně prováděných běhů používá tento kalibrační soubor pro odečet fluorescence 
pozadí z naměřených hodnot. 
 

Jelikož signál pozadí se může měnit se stárnutím přístroje, společnost Applied 
Biosystems doporučuje provádět kalibraci pozadí každý měsíc. 
 

Poznámka:  Běhy kalibrace pozadí lze rovněž využít k detekci kontaminace 
v bloku na vzorky. 

 
O signálu 

pozadí 
V rámci měření fluorescence přístrojem ABI PRISM 7900HT  je zaznamenávána i 
fluorescence, která je systému vlastní a běžně se označuje jako fluorescence pozadí. 
Fluorescence pozadí je složený signál, který je detekován v celém spektru. Tento 
signál sestává z fluorescence, která pochází z různých zdrojů - elektronický šum 
pozadí, blok na vzorky, voda použitá ve spotřebním materiálu, spotřební plast 
(destičky a víčka). Jelikož signál pozadí může snižovat přesnost měření, přístroj 
7900HT byl konstruován tak, aby signál pozadí byl minimální. Kromě toho využívá 
program SDS rovněž algoritmus odpočtu signálu pozadí z každého vzorku, čímž se 
zvyšuje citlivost detekce (viz strana D-5). 

 
 Potřebné 
 pomůcky 

Jedna z následujících možností 
 

•   Destička pro kalibraci pozadí, která je součástí spektrálního kalibračního kitu,  
a centrifuga s adaptéry na destičky 

•   Věci pro přípravu destičky pro kalibraci pozadí: 
–  ABI PRISM™  optická 394- nebo 96-jamková destička 
–  ABI PRISM optická adhezívní fólie nebo ABI PRISM optická víčka 
–  Pipetman, 100-µL (a špičky) 
–  Centrifuga s adaptéry na destičky 

•   Mikrofluidní karta pro kalibraci pozadí vyžaduje: 
–  Reagencie pro kalibraci (Micro Fluidic Card Spectral Calibration Reagents) 
–  Centrifuga 
–  Nástroj pro zaslepení mikrofluidních karet 
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Provedení kalibrace pozadí     

  

 
 
Příprava destičky nebo mikrofluidní karty pro kalibraci pozadí 

 
 
     Příprava karty 1.   Vyjměte mikrofluidní kartu pro kalibraci pozadí z obalu a nechte ji ohřát na 

       pokojovou teplotu. 
 

2.   Vyjměte zkumavku s roztokem pro kalibraci pozadí z mrazáku a nechte ji 
roztát. Poté co roztaje ji promíchejte na vortexu. 

 

3.   Rozplňte roztok pro kalibraci pozadí do mikrofluidní karty, vždy 100 µL roztoku 
      do každého plnícího rezervoáru. 
 

4.   Centrifugujte mikrofluidní kartu podle postupu v části “Centrifugace 
mikrofluidních karet” na straně 4-15. 

 

5.   Zaslepte mikrofluidní kartu podle postupu v části “Zaslepení mikrofluidních 
      karet” na straně 4-18. 
 

6.   Pokračujte částí “Vytvoření dokumentu destičky pro kalibraci pozadí” níže. 
 
  Příprava destičky 1.   Zvolte jednu z možností: 

 
 

Pokud… 
 

pak… 

používáte destičku 
pro kalibraci pozadí 
ze spektrálního 
kalibračního kitu  

vyjměte destičku z mrazáku a nechte ji ohřát na 
pokojovou teplotu 

vytváříte vlastní 
destičku pro 
kalibraci pozadí 

1.  Pipetujte deionizovanou vodu do každé jamky. 

–   384-jamková destička: 20 µL do každé jamky. 

–   96-ti jamková destička: 50 µL do každé jamky. 
 

2.  Uzavřete destičku pomocí optické adhezívní fólie nebo 
optických plochých víček. 

 
2.   Krátce destičku centrifugujte. 
 

3.   Pokračujte částí “Vytvoření dokumentu destičky pro kalibraci pozadí” níže. 
 
 
Vytvoření dokumentu destičky pro kalibraci pozadí 

 
 

Příprava 
dokumentu 

destičky 

1.   Spusťte program SDS. 
 

2.   Klikněte na ikonu  nebo zvolte File > New (Soubor > Nový). 

3.   V dialogovém okně New Document (Nový dokument) zvolte: 
•   Assay (Esej) – Zvolte Background (Pozadí). 
•   Container (Destička) – Zvolte odpovídající formát destičky. 
•   Template (Templát) – Zvolte Blank Template (Žádný templát). 

 

4.   Má-li destička pro kalibraci pozadí nebo mikrofluidní karta čárový kód, klikněte 
do pole Barcode (Čárový kód) a pomocí ruční čtečky čárových kódů jej 
naskenujte. 
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5.   Klikněte . 

Program vytvoří dokument destičky pro kalibraci pozadí. 
 

DŮLEŽITÉ!  Dokument destičky pro kalibraci pozadí neměňte. Teplotní 
parametry běhu pro kalibraci pozadí jsou uloženy v programu SDS a zahrnují 
jedlinou inkubaci při 60 °C 2 min. Jelikož destička obsahuje pouze vodu, není 
nutné zadávat vzorky nebo detektory. 

 

6.   Uložte dokument destičky: 

a.  Klikněte na ikonu  nebo zvolte File > Save (Soubor > Uložit). 
b.  V poli File name (Název souboru) zadejte: 

Background_<datum ve formátu RRMMDD > 
Např. běh provedený 31. května 2001 bude pojmenován: 
Background_010531. 

c.  Klikněte  (Uložit). 
Program dokument destičky uloží a je připraven provést běh. 

 

7.   Pokračujte částí “Spuštění destičky pro kalibraci pozadí nebo mikrofluidní 
karty” níže. 

 
 

Spuštění destičky pro kalibraci pozadí nebo mikrofluidní karty 
 
 

Provedení běhu 
kalibrace 

pozadí 

1.   Vložte destičku pro kalibraci pozadí do přístroje 7900HT: 

a.  V programu SDS v dokumentu destičky zvolte záložku Instrument 
(Přístroj). 

b.  Zvolte záložku Real-Time. 

c.  Klikněte  (Otevřít/Zavřít). 
d.  Umístěte destičku pro kalibraci pozadí nebo mikrofluidní kartu do nosítek 

přístroje podle obrázku níže. 
 
 

Jamka A1 
 
 
 
 

Čárový kód destičky směřuje k čelní 
straně přístroje 

 
 

Jamka A1 
 
 
 
 

Čárový kód mikrofluidní karty směřuje k čelní 
straně přístroje 

 
 

Poznámka:  Pozice A1 je vlevo nahoře. 
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2.  Klikněte . 

Přístroj 7900HT spustí běh kalibrace pozadí. 
 

Poznámka:  Před spuštěním běhu může přístroj vyčkat až 15 minut na ohřátí 
vyhřívaného víka na požadovanou teplotu. 

 

3.   Po skončení běhu se objeví dialogové okno Run Complete (Běh ukončen): 

a.  Klikněte . 

b.  Klikněte  (Otevřít/Zavřít) a vyjměte destičku z nosítek. 

c.  Proveďte extrakci pozadí podle popisu na straně 7-19. 
 
 

Analýza výsledků kalibrace pozadí 
 
 

Extrakce 
pozadí 

Během této procedury vytvoří program SDS na základě běhu kalibrace pozadí 
kalibrační soubor a uloží jej v podadresáři Calibration (Kalibrace) adresáře SDS 2.2. 
 

1.   Zvolte Analysis > Extract Background (Analýza > Extrakce pozadí). 
Program se pokusí extrahovat signál pozadí a zobrazí hlášku o průběhu extrakce. 

Zobrazí-li: 
•   Dialogové okno Calibration Update Complete (Kalibrace ukončena), byl 

běh úspěšný. 
Pokračujte krokem 2. 
Signál odečtený z destičky pro kalibraci pozadí je v rámci povolených 
limitů. 

 

 

 
 

•   Dialogové okno Error (Chyba), je běh neúspěšný. Vyhledejte problémové 
jamky a dekontaminujte blok podle postupu v části “Běhy kalibrace 
pozadí” na straně 8-9. 
Program extrakci přerušil, protože jedna nebo více jamek dává signál vyšší 
než 2500 FSU. 

 

 

 
 

2.   Klikněte na ikonu  nebo zvolte File > Save (Soubor > Uložit). 

Program uloží dokument destičky. 
 

3.   Zvolte File > Close (Soubor > Zavřít). 

Program zavře dokument destičky. 
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Provedení kalibrace barev 
 

 
       Kdy provádět Společnost Applied Biosystems doporučuje provádět kalibraci barev: 

 

•   Každých 6 měsíců v závislosti na používání přístroje 
•   Po výměně bloku na vzorky za jiný typ (viz strana 7-6) 

 

DŮLEŽITÉ!  Před kalibrací barev musíte vždy provést kalibraci pozadí. 
 

Účel kalibrace 
barev 

V rámci kalibrace barev systém odečte během 2-minutové inkubace při 60 °C spektra 
sérií standardů jednotlivých barev a   uloží informace o spektrech jednotlivých barev 
v příslušném kalibračním souboru pro danou barvu v adresáři SDS. Po skončení běhu 
program provede extrakci příspěvku každé jednotlivé barvy do celkového signálu. 
 

DŮLEŽITÉ!  Jelikož stáří a používání přístroje mohou ovlivnit odečítání čistých 
spekter, doporučuje společnost Applied Biosystems aktualizovat kalibraci barev 
jedenkrát až dvakrát ročně v závislosti na využití přístroje. 

 
Soubory 

barev 
Přístroj ABI PRISM 7900HT monitoruje fluorescenční signály barev FAM™, NED™, 
ROX™, SYBR®, TAMRA™, TET™ a VIC®  pipetovaných v předpřipravených 384- nebo 
96-ti jamkových destičkách. 
 

V případě mikrofluidních karet jsou monitorovány tři barvy: FAM™, VIC® a ROX™. 
Vaše instalační souprava tyto tři barvy obsahuje a vy je pipetujete do tří 
mikrofluidních karet, abyste provedli kalibraci. 

 

 
1   2  3 4 5   6 7 Barva Max. (nm) 

 

1 FAM ~520 

2 SYBR ~520 

3 TET ~540 

4 VIC ~550 

 JOE ~550 

5 NED ~570 

6 TAMRA ~580 

7 ROX ~610 

 
Obrázek 7-4   Spektra čistých barev na přístroji 7900HT  

 
 

Poznámka:  Přístroj 7900HT umožňuje používání vlastních barev (jiných než těch, 
které nabízí společnost Applied Biosystems). Chcete-li používat vlastní barvy, 
postupujte podle části  “Přidání vlastní barvy do sady barev” na straně 7-27. 
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Provedení kalibrace barev  

  

 
 

Po ukončení běhu je každé snímání provedené v jeho průběhu uloženo v programu 
SDS ve formě nezpracovaných spektrálních dat. Příspěvek emise jedné každé 
fluorescenční barvy je v daném vzorku stanoven porovnáním nezpracovaných 
spektrálních dat a spektrálních dat této barvy uložených v kalibračním souboru (tzv. 
multikomponentní analýza, viz str. D-5). Ukládáte-li po ukončení analýzy dokument 
destičky, program uloží kalibrační soubor i fluorescenční data naměřená v průběhu 
daného experimentu.  

 
Potřebné 
pomůcky 

 

384-nebo 96-ti jamková destička 
 

•   Spektrální kalibrační kit 
–  verze pro 384-jamkovou destičku 
–  verze pro 96-ti jamkovou destičku 

•   Destička pro kalibraci barev 
•   Informační leták 
•   Centrifuga s adaptérem na destičky 

 

Poznámka:  Spektrální kalibrační kit obsahuje destičku/y pro kalibraci barev a 
informační leták. Verze pro 96-ti jamkovou destičku obsahuje dvě destičky pro 
kalibraci barev. 

 
Mikrofluidní karta 
 

•   Spektrální kalibrační reagencie pro mikrofluidní kartu 
•   Centrifuga 
•   Nástroj pro zaslepení mikrofluidní karty 
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Příprava destičky nebo mikrofluidní karty pro kalibraci barev  

 
 

Příprava 
destiček 

DŮLEŽITÉ!  Před kalibrací barev musíte vždy provést kalibraci pozadí. 
Viz “Provedení kalibrace pozadí” na straně 7-16. 
 

1.   Vyjměte 384- nebo 96-ti jamkovou destičku pro kalibraci barev z lednice a 
nechte ji ohřát na pokojovou teplotu. 

 

2.   Vyjměte destičku pro kalibraci barev z obalu. 
 

3.   Krátce destičku centrifugujte. 
 

Příprava 
mikrofluidních 

karet 

DŮLEŽITÉ!  Před kalibrací barev musíte vždy provést kalibraci pozadí. 
Viz “Provedení kalibrace pozadí” na straně 7-16. 
 

1.   Vyjměte tři prázdné mikrofluidní karty z lednice a nechte je ohřát na pokojovou 
teplotu. 

 

2.   Vyjměte tři mikrozkumavky (barvy FAM, VIC a ROX) z mrazáku a nechte 
je roztát. Po roztátí je vortexujte. 

 

3.   Naplňte jednu prázdnou mikrofluidní kartu barvou FAM (100 µL na jeden plnící 
rezervoár). 

 

4.  Centrifugujte mikrofluidní kartu podle postupu v části “Centrifugace 
mikrofluidních karet” na straně 4-15. 

 

5.   Zaslepte mikrofluidní kartu podle postupu v části “Zaslepení jamek 
mikrofluidních karet” na straně 4-18. 

 

6.   Opakujte kroky 3 až 5 pro barvy VIC a ROX. 
 
 
Příprava dokumentu destičky nebo mikrofluidní karty pro kalibraci barev 

 
 

Příprava 
dokumentu 

destičky pro 
kalibraci barev 

1.   Spusťte program SDS. 
 

2.   Klikněte na ikonu  nebo zvolte File > New (Soubor > Nový). 

3.   V dialogovém okně New Document (Nový dokument) zvolte:  

•   Assay (Esej) – Zvolte Pure Spectra (Barvy). 

•   Container (Destička) – Zvolte odpovídající formát destičky.  

•   Template (Templát) – Provádíte-li: 

•   Běh s 384-jamkovými destičkami: zvolte 384 Well Pure Dyes Plate.sdt. 
Nejsou-li k dispozici templáty, vytvořte dokument podle návodu 
v informačním letáku ze spektrálního kalibračního kitu a podle postupu na 
straně 7-28. 

•   Běh s 96-jamkovými destičkami: zvolte odpovídající templát. 
Spouštíte-li destičku 1 (obsahuje barvy FAM, JOE™, NED a ROX), zvolte 
96 Well Pure Dyes Plate 1.sdt. 
Spouštíte-li destičku 2 (obsahuje barvy SYBR, TAMRA, TET a VIC), 
zvolte 96 Well Pure Dyes Plate 2.sdt. 
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•   Běh s mikrofluidní kartou: ponechte toto pole prázdné. 
Pro mikrofluidní kartu FAM (obsahuje barvu FAM), zvolte MFC FAM 
Pure Dyes.sdt. 
Pro mikrofluidní kartu ROX (obsahuje barvu ROX), zvolte MFC ROX 
Pure Dyes.sdt. 
Pro mikrofluidní kartu VIC (obsahuje barvu VIC), zvolte MFC VIC 
Pure Dyes.sdt. 

 

4.   Do pole Barcode (Čárový kód) naskenujte pomocí ruční čtečky čárových 
kódů čárový kód. 

 

5.   Klikněte . Program vytvoří dokument destičky pro kalibraci barvy. 
 

6.   Uložte dokument destičky: 

a.  Klikněte na ikonu  nebo zvolte File > Save (Soubor > Uložit). 

b.  Zvolte Files of type (Typ souboru) > ABI PRISM SDS Document (*.sds). 

c.  V poli File name (Název souboru) zadejte: 
•   384-jamková destička: PureDye_< datum ve formátu RRMMDD > 

Např. běh provedený 31. května 2001 bude pojmenován: 
PureDye_053101. 

•   96-ti jamková destička, zadejte PureDye_Plate<plate #>_< datum ve 

formátu RRMMDD >. Např. běh s destičkou 1 provedený 31. května 2001 
bude pojmenován: PureDye_Plate1_053101. 

•   384-jamková karta: zadejte <Barva>< datum ve formátu RRMMDD 
>_MFC. Např. běh provedený 31. května 2001 bude pojmenován 

FAM_053101_MFC. 

d.  Klikněte  (Uložit). 

Program dokument destičky uloží. 
 

7.   Připravte a spusťte destičky pro kalibraci barev podle postupu níže. 
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Spuštění destiček nebo mikrofluidních karet pro kalibraci barev 

 
 

Spuštění 
destičky pro 

kalibraci barev 

1.   Vložte destičku pro kalibraci barev do přístroje 7900HT: 

a.  V programu SDS v dokumentu destičky zvolte záložku Instrument 
(Přístroj). 

b.  Zvolte záložku Real-Time a klikněte  (Otevřít/Zavřít). 
 

c.  Umístěte destičku pro kalibraci barev nebo mikrofluidní kartu do nosítek 
přístroje podle obrázku níže. 

 
Jamka A1 

 
 
 
 

Čárový kód destičky směřuje k čelní 
straně přístroje 

 
 

Jamka A1 
 
 
 
 

Čárový kód destičky směřuje k čelní straně 
přístroje 

 
 

Poznámka:  Pozice A1 je vlevo nahoře. 
 

2.   Klikněte . 

Přístroj 7900HT spustí běh kalibrace barev. Teplotní profil běhu je uložen 
v přístroji a sestává z jediné dvouminutové inkubace při 60 °C. 

 

Poznámka:  Před spuštěním běhu může přístroj vyčkat až 15 minut na ohřátí 
vyhřívaného víka na požadovanou teplotu. 

 

3.   Po skončení běhu se objeví dialogové okno Run Complete (Běh ukončen): 

a.  Klikněte . 

b.  Klikněte  (Otevřít/Zavřít) a vyjměte destičku z nosítek. 

c.  Proveďte extrakci barev podle popisu na straně 7-25. 
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Analýza výsledků kalibrace barev 

 
 

Extrakce barev Účelem zobrazení výsledků pomocí průvodce (Pure Dye Wizard) je vyhledat a 
odstranit nepravidelné barevné signály. Průvodce zobrazuje spektrální data vždy pro 
tři jamky najednou. Tyto jamky obsahují vždy tutéž barvu v identické koncentraci a 
zobrazené křivky by proto měly mít identický průběh. Nepřesnosti pipetování nebo 
kontaminace mohou způsobit mírné změny signálu v určité jamce. Signál z takové 
jamky musí být vyřazen. 
 

1.   Zvolte Analysis > Extract Pure Dye Wizard (Analýza > Průvodce extrakcí 
barev). 

 

2.   Postupujte podle pokynů v průvodci. 

Proveďte následující kroky: 

a.  Zkontrolujte zda nedochází k posunu vrcholků (píků) spekter. 
Příklad destičky: 

 

 
 
 
 
 
 
 

Posun 
 

 
 
 
 
 
 
 

Klikněte zde 
(vyřazení 
jamky) 

 
 

Příklad mikrofluidní karty: 
 

 
 
 
 
 
 
 

Posun 
 
 
 
 
 
 
 

Klikněte zde 
(vyřazení 
jamky) 
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b.   Pokud dojde k posunu píku (odlehlý bod), klikněte do políčka příslušné 
jamky, čímž tuto jamku odstraníte (nebude použita pro vytvoření 
kalibračního souboru). 

 

Poznámka:  Spektrální signály jsou obecně přijatelné, mají-li pík ve stejné pozici 
jako ostatní vzorky téže skupiny a mírný posun signálu při jiných vlnových 
délkách. 

 

c.  Klikněte  (Další). 
d.  Opakujte kroky a až c i pro všechny zbývající jamky dokud se nezobrazí 

hláška signalizující provedení extrakce spektrálního signálu. 

Program provede extrakci signálu jednotlivých barev a uloží tato data jako 
kalibrační soubor. 

 

3.   Klikněte na ikonu  nebo zvolte File > Save (Soubor > Uložit). 

Program uloží dokument destičky. 
 

 4.   Zvolte File > Close (Soubor > Zavřít). 

Program zavře dokument destičky. 
 

5.   Provádíte-li spektrální kalibraci pro: 
•   384-jamkový blok – Kalibrace barev je hotova. 

•   96-ti jamkový blok – Proveďte běh s druhou destičkou pro kalibraci barev. 
Opakujte kroky: 
– “Příprava destičky nebo mikrofluidní karty pro kalibraci barev” na straně 
7-22 
– “Spuštění destiček nebo mikrofluidních karet pro kalibraci barev” 
na straně 7-24 
– “Analýza výsledků kalibrace barev” na straně 7-25 

•   384-jamkovou mikrofluidní kartu – Proveďte běh s druhou a třetí 
mikrofluidní kartou pro kalibraci barev obsahující barvy VIC a ROX. 
Opakujte kroky: 
– “Příprava destičky nebo mikrofluidní karty pro kalibraci barev” 
na straně 7-22 
– “Spuštění destiček nebo mikrofluidních karet pro kalibraci barev” 
na straně 7-24 
– “Analýza výsledků kalibrace barev” na straně 7-25 
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Přidání vlastní barvy do sady barev 
 
 

      Kdy provádět Přístroj ABI PRISM 7900HT lze použít k provádění reakcí používajících vlastní 
barvy (nevyráběné společností Applied Biosystems). Před jejich použitím je 
nezbytně nutné vytvořit destičku a spustit běh s destičkou pro kalibraci této barvy. 

 
Potřebné 
pomůcky 

•   ABI PRISM optické 384- nebo 96-ti jamkové destičky 
•   ABI PRISM optická adhezívní fólie nebo ABI PRISM optická plochá víčka 
•   vlastní barva(y) 
•   pipeta, 100-µL (se špičkami) 
•   centrifuga s adaptérem na destičky 

 
Vytvoření destičky 

s vlastní barvou 
Poznámka:  Účel této destičky je totožný jako u destiček ABI PRISM pro kalibraci 
barev. Program SDS použije takovouto destičku jako standard, používaný následně při 
multikomponentní analýze každého běhu, kde je daná barva použita. 
 

1.   Připravte si destičku s ředící řadou vlastní barvy. 
 

2.   Spusťte program SDS. 
 

3.   Vytvořte dokument destičky pro alelickou diskriminaci a spusťte běh 
s připravenou destičkou. 

 

Poznámka:  Pro tento dokument destičky  není nutné definovat názvy vzorků, 
detektory apod. Účelem běhu je stanovit správnou pracovní koncentraci barvy. Toho 
je docíleno porovnáním intenzity spektrálních signálů jednotlivých ředění. 
 

4.   Zvolte Analysis > Analyze (Analýza > Analyzovat). 

Program analyzuje výsledky běhu. 
 

5.   Klikněte na ikonu  (Zobrazit graf hrubých dat). 
 

6.   Ze zobrazeného grafu odečtěte nejvyšší koncentraci barvy, která nedá vzniknout 
saturovanému signálu, a poznamenejte si ji. 

 

Poznámka:  Saturované signály mají píky přesahující detekční mez (> 65,000 
fluorescenčních jednotek) a v grafu hrubých dat vytvářejí plató. 

 

Koncentrace vlastní barvy, která vede ke vzniku nejsilnějšího možného signálu 
ale nikoliv k saturaci, je maximální použitelná koncentrace dané barvy na 
přístroji 7900HT. 

 

7.   Opakujte kroky 1 až 6 pro všechny vlastní barvy. 
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8.   Vytvořte si destičku pro kalibraci vlastní barvy (barev) tak, že pipetujete každou 
vlastní barvu do nejméně tří sloupců v optické destičce ABI PRISM™  

v koncentracích stanovených v kroku 7. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

DŮLEŽITÉ!  Optické parametry přístroje 7900HT vyžadují, aby byla každá 
vlastní barva pipetována do nejméně tří sloupců. 

 

9.   Uzavřete destičku pomocí adhezívní optické fólie nebo optických plochých 
víček. 

 

10.   Vytvořte templát pro běh s vlastní barvou podle postupu níže. 
 

Vytvoření 
templátu pro 

destičku s vlastní 
barvou 

1.   Spusťte program SDS. 
 

2.   Přidejte novou barvu do programu pomocí Dye Manager (Správce barev): 

a.  Zvolte Tools > Dye Manager (Nástroje > Správce barev). 

b.  V dialogovém okně Dye Manager (Správce barev) klikněte  (Nová). 
 

c.  V dialogovém okně Add Dye (Přidat barvu) zadejte název vlastní 
barvy a klikněte . 
Program přidá novou barvu do seznamu vlastních barev. 

d.  Opakujte kroky b a c pro další vlastní barvy, které chcete přidat do Správce 
barev. 

e.  Klikněte  (Hotovo). 
Program SDS vám následně umožní tyto barvy použít, budete-li chtít 
provést jejich kalibraci. 

 

3.   Vytvořte dokument destičky pro provedení kalibrace vlastní barvy: 

a.  Klikněte na ikonu  nebo zvolte File > New (Soubor > Nový). 

b.  V dialogovém okně New Document (Nový dokument) zvolte: 

Assay (Esej) – Zvolte Pure Spectra (Barvy). 
Container (Destička) – Zvolte odpovídající formát destičky. 
Template (Templát) – Zvolte Blank Template (Žádný templát). 

c.  Klikněte . Program vytvoří dokument destičky pro kalibraci barvy. 
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4.   Do dokumentu destičky přidejte vlastní barvy: 

a.  Zvolte jamky obsahující vlastní barvy. 

b.  V rozbalovací nabídce Dyes (Barvy) v záložce Setup (Zadání) zvolte 
příslušnou barvu. 
Program přiřadí zvolenou barvu vybraným jamkám. 

 

c.  Opakujte kroky a a b, chcete-li přiřadit další vlastní barvy. 
 
 

 
Rozbalovací nabídka Dyes (Barvy)  

 
 

Vlastní barva přiřazená zvolené jamce 
 

 
 
 
 

5.   Uložte takto vytvořený dokument jako templát: 

a.  Klikněte na ikonu  nebo zvolte File > Save (Soubor > Uložit). 
b.  V dialogovém okně Save (Uložit) vyhledejte adresář Program Files > 

Applied Biosystems > SDS 2.2 > Templates (Templáty). 

Adresář Templates se objeví v poli Look in (Vyhledat). Uložíte-li templát 
do adresáře Templáty, bude k dispozici v rozbalovací nabídce Template 
(Templáty) v dialogovém okně New Document (Nový dokument). 

c.   Zvolte Files of type (Typ souboru) > ABI PRISM SDS Template 
Document (*.sdt). 

d.  V poli File name (Název souboru) zadejte název templátu. 

e.  Klikněte  (Uložit). Program uloží dokument destičky jako templát. 
 

6.   Proveďte běh s destičkou pro kalibraci vlastní barvy podle postupu v části  
“Příprava destičky nebo mikrofluidní karty pro kalibraci barev” na straně 7-22. 
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Ověření funkčnosti přístroje 
 

      Kdy provádět  Společnost Applied Biosystems doporučuje ověřit funkčnost přístroje pomocí 
destičky TaqMan®  RNase P Instrument Verification Plate (TaqMan® RNáza P pro 
ověření funkčnosti přístroje) nebo mikrofluidní karty TaqMan™  TGF-β Instrument 
Verification Micro Fluidic Card (TaqMan™  TGF-β pro ověření funkčnosti přístroje): 

 

•   Při výměně bloku na vzorky za jiný typ (první výměna svého druhu) 
•   Je-li zapotřebí ověřit funkčnost přístroje 7900HT 

 
Účel běhů 

RNázy P 
Běh s destičkou TaqMan® RNáza P pro ověření funkčnosti přístroje ověřuje fungování 
přístroje 7900HT při použití optických destiček téhož formátu (384- nebo 96-ti 
jamkové). Destička s RNázou P obsahuje rozplněné reagencie potřebné pro detekci a 
kvantifikaci genomových kopií lidského genu pro RNázu P (jednokopiový gen 
kódující RNázovou podjednotku enzymu RNáza P). Každá jamka obsahuje reakční 
mix (1× TaqMan® univerzální PCR mastermix, primery na RNázu P a sonda značená 
FAM) a templát. 
 

Tabulka 7-2 znázorňuje uspořádání standardů a skupin neznámých vzorků na destičce 
RNáza P. Destička RNáza P obsahuje pět skupin standardů  (1250, 2500, 5000, 10000 
a 20000 kopií) a dvě skupiny neznámých vzorků (5000 a 10000 kopií). 
 
Tabulka 7-2 Organizace vzorků a standardů na 384- a 96-ti jamkové destičce RNáza P 
 

Destička RNáza P  
 

  Organizace vzorků a standardů 

384 jamek 

                        
G

R
21

07
 

96 jamek  
 
 

Neznámé vzorky 
5000 

 
 

NTC STD 1250 STD 2500 
 

STD 5000 STD 10000 STD 20000 
 
 

Neznámé vzorky 
10000 
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Účel běhů 
TGF-β  

Běh s mikrofluidní kartou TaqMan™  TGF-β pro ověření funkčnosti přístroje ověřuje 
fungování přístroje 7900HT při použití mikrofluidních karet. Mikrofluidní karta TGF-
β obsahuje rozplněné reagencie potřebné pro detekci a kvantifikaci genomových 
kopií lidského genu pro TGF-β. Každá jamka obsahuje primery na TGF-β a FAM 
značenou MGB sondu. 

 
Potřebné 
pomůcky 

Běhy RNáza P 
 

•   destička TaqMan® RNáza P pro ověření funkčnosti přístroje 
•   centrifuga s adaptéry na destičky 

 
Běhy TGF-β 
 

•   mikrofluidní karta TaqMan TGF-β pro ověření funkčnosti přístroje 
•   TaqMan® univerzální PCR mastermix 
•   voda, prostá DNáz/RNáz, deionizovaná 
•   2-mL mikrozkumavka, sterilní 
•   centrifuga 
•   nástroj pro zaslepení mikrofluidních karet 

 
Příprava ověřovací 

destičky nebo 
mikrofluidní karty 

Příprava destičky RNáza P  
 

1.   Vyjměte ověřovací destičku TaqMan RNáza P z mrazáku a nechte ji roztát při 
pokojové teplotě. 

 

2.   Krátce destičku centrifugujte. 
 

3.   Pokračujte částí “Příprava dokumentu destičky” na straně 7-32. 
 
Příprava mikrofluidní karty TGF-β 
 

4.   Vyjměte mikrofluidní kartu TGF-β z mrazáku a nechte ji ohřát na pokojovou 
teplotu. 

 

5.   Ve sterilní 2-mL mikrozkumavce připravte reakční směs: 
 

 

Reagencie 
 

Objem (µL) 

TaqMan univerzální PCR mastermix 500 

lidská cDNA 50 

voda prostá RNáz/DNáz 450 
 

Celkový objem 1000 

 
6.   Opatrně obsah zkumavky promíchejte poklepem. 

 

7.   Pipetujte 100 µL reakční směsi do každého z osmi plnících rezervoárů. 
 

8.   Pokračujte částí “Příprava dokumentu destičky” na straně 7-32. 
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Příprava 
dokumentu 

destičky 

1.   Spusťte program SDS. 
 

2.   Klikněte na ikonu  nebo zvolte File > New (Soubor > Nový). 

3.   V dialogovém okně New Document (Nový dokument) zvolte: 

Assay (Esej) – Absolute Quantification (Absolutní kvantifikace) 

Container (Destička) – Zvolte odpovídající formát destičky. 

Template (Templát) – Provádíte-li:  
 

•   Běh s 384-jamkovou destičkou RNáza P, zvolte 384 Well RNaseP Install 
Plate.sdt. 

•   Běh s 96-ti jamkovou destičkou RNáza P, zvolte 96 Well RNaseP Install 
Plate.sdt. 

•   Běh s mikrofluidní kartou TGF-β, zvolte rnase p card template.sdt. 
 

Poznámka:  Nejsou-li k dispozici templáty, vytvořte dokument pro kalibraci 
barev pomocí návodu v informačním letáku ze spektrálního kalibračního kitu a 
podle postupu na straně 7-28. 

 

4.  Do pole Barcode (Čárový kód) naskenujte pomocí ruční čtečky čárových kódů 
čárový kód: 

a.  Klikněte do pole Barcode (Čárový kód). 
 

b.  Vyjměte destičku RNáza P nebo mikrofluidní kartu TGF-β z obalu a 
naskenujte čárový kód. 

 

5.   Klikněte . Program vytvoří dokument destičky. 
 

Poznámka:  Dokument destičky neměňte. Součástí templátu je i přednastavený 
teplotní profil. 

 

6.   Uložte dokument destičky: 

a.  Klikněte na ikonu  nebo zvolte File > Save (Soubor > Uložit). 
b.  V poli Barcode (Čárový kód) dialogového okna Save (Uložit) proveďte: 

– Zadejte název nebo čárový kód a klikněte  (Uložit). 
– Pomocí ruční čtečky čárových kódů naskenujte čárový kód. 

c.  Zvolte Files of type (Typ souboru) > ABI PRISM SDS Document (*.sds).  

d.  Klikněte  (Uložit). 

Program dokument destičky uloží. Nyní je možné spustit běh RNázaP. 
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Spuštění destičky 
RNáza P nebo 

mikrofluidní karty 
TGF-β  

1.   V dokumentu destičky programu SDS zvolte záložku Instrument (Přístroj). 
 

2.   Zvolte záložku Real-Time. 
 

3.   Jsou-li nosítka zasunuta do přístroje 7900HT, klikněte  
(Otevřít/Zavřít). Nosítka se vysunou ven. 

 

4.  Umístěte destičku RNáza P nebo mikrofluidní kartu TGF-β do nosítek přístroje. 
 

Poznámka:  Pozice A1 je vlevo nahoře. 
 

5.   V záložce Real-Time klikněte . Spustí se běh. 
 

Poznámka:  Před spuštěním běhu může přístroj vyčkat až 15 minut na ohřátí 
vyhřívaného víka na požadovanou teplotu. 

 

6.   Po skončení běhu: 

a.  Proveďte analýzu výsledků podle postupu na straně 6-12. 
 

b.  Nastavte pozadí a práh podle postupu na straně 6-46. 

c.  Ověřte funkčnost přístroje 7900HT podle postupu níže. 
 

Ověření 
funkčnosti 

přístroje 

Analýza výsledků běhu RNáza P 
 

Ověření funkčnosti přístroje je úspěšné, pokud získaná data dokládají, že přístroj je 
schopen rozlišit 5000 a 10000 genomových ekvivalentů s 99.7% koeficientem 
spolehlivosti. 
 

Ověření funkčnosti přístroje 7900HT se provádí pomocí následujícího výpočtu: 
 

[ ( CopyUnk1 ) – 3( σCop y Un k 1 ) ] > [ ( CopyUnk2 ) + 3( σCopyUnk2 ) ] 

 
kde: 

 

•   CopyUnk1 - Průměrný počet kopií skupiny 1 (Obsahuje 10000 kopií) 
•   σCopyUnk1 - Standardní odchylka skupiny 1 (Obsahuje 10000 kopií) 
•   CopyUnk2 - Průměrný počet kopií skupiny 2 (Obsahuje 5000 kopií) 
•   σCopyUnk2 - Standardní odchylka skupiny 2 (Obsahuje 5000 kopií) 

Poznámka:  Údaje pro dosazení do vzorce lze získat ze zprávy o výsledcích. 
 

Poznámka:  Při analýze je z každé skupiny neznámých vzorků v 96-jamkové destičce 
TaqMan RNáza P pro ověření funkčnosti přístroje možné vyloučit maximálně šest 
odlehlých bodů. 
 

Poznámka:  Při analýze je z každé skupiny neznámých vzorků v 384 jamkové 
destičce TaqMan RNáza P pro ověření funkčnosti přístroje možné vyloučit 
maximálně deset odlehlých bodů. 
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Část 7.2  Údržba podavače mikrodestiček    
 
 

Část 7.2 Údržba podavače mikrodestiček 
 
 
 

         V této části Součásti podavače mikrodestiček a pozice úložných věží................................. 7-36 
Nastavení citlivosti senzoru destiček ................................................................. 7-37 
Seřízení podavače mikrodestiček....................................................................... 7-41 
Seřízení pevně umístěné čtečky čárových kódů ................................................ 7-49 
Čištění a výměna podložek ramene (pro úchop destiček).................................. 7-52 
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Součásti podavače mikrodestiček a pozice úložných věží 
 
 

Součásti 
podavače 

mikrodestiček 

Součásti zmíněné v textu níže jsou vyobrazeny na obrázku 7-5. 
 

(zobrazení v řezu) 
 
 
 
 
 
 
 
 

 Senzor 
 

Úchop Regulátor 
nastavení 

 
 

 Úložná věž (držák destiček) 
 
 
 

Rozšíření podavače 

Podavač mikrodestiček Zymark Twister  
Pevně umístěná čtečka čárových kódů 

 
Obrázek 7-5  Součásti podavače mikrodestiček 

 
 

Úložné věže Seřízení podavače mikrodestiček Zymark Twister se provádí pomocí programu 
Zymark Twister®  . Definice úložných věží je odlišná v tomto programu a v programu 
Automation Controller. Na obrázku 7-6 jsou vyjmenovány jednotlivé pozice tak jak 
jsou těmito dvěma programy označovány. 

 
 
 

0 
1 7 

 
2 6 

  
3 5 

4 
 

 
 

(čelo přístroje) Čárový kód 
 

Jamka A1 
 
 
 

Obrázek 7-6  Definice úložných věží v programech Automation Controller a Zymark 
Twister  
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Nastavení citlivosti senzoru destiček 
 

 
      Kdy provádět Senzor destiček, umístěný pod ramenem podavače mikrodestiček Zymark Twister 

vyžaduje seřízení v následujících situacích: 
 

•   Při výměně bloku na vzorky za blok jiného formátu 
•   Vyskytnou-li se problémy při detekci destiček 

 
Potřebné 
pomůcky 

•   Optické reakční destičky ABI PRISM (odpovídající aktuálnímu formátu bloku na 
     vzorky) 

 
Seřízení citlivosti 

senzoru 
Různé rozměry destiček vyžadují různý úchop ramenem podavače. Proto je senzor 
zapotřebí seřídit při každé změně formátu spotřebního materiálu. 
 

1.   Vypněte podavač mikrodestiček Zymark Twister. 

   RIZIKO PORANĚNÍ. Podavač mikrodestiček Zymark 
Twister musí být při provádění následujících kroků vždy vypnut, jinak může dojít 
k vážnému poranění uživatele nebo poškození podavače. 

 

2.   Otáčejte nastavovacím kolečkem až na doraz, aby se senzor dostal do 
pozice Up (nahoře – viz boční panel). 

 
 
 

Nastavovací kolečko 
 
 
 
 
 

Senzor 
 

3.   Seřiďte senzor: 
 

a.  Vezměte 96-ti nebo 384-jamkovou optickou destičku ABI PRISM za 
okraje a netlačte přitom na její střed, abyste ji nedeformovali. 

 

b.  Umístěte destičku mezi úchopy ramene přesně na střed. 

c.  Přidržujte destičku v této pozici a pomalu otáčejte nastavovacím kolečkem 
tak dlouho, než senzor klesne k destičce: 

–  Senzor se musí dotýkat svrchní strany destičky a 
–  Vydá měkké “kliknutí” 

 

DŮLEŽITÉ!  Kliknutí je velice tiché a může být obtížné je zaslechnout. Pro 
usnadnění přibližte při seřizování ucho k senzoru . 
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4.   Odstraňte destičku a poslouchejte, uslyšíte-li rozpojení senzoru. 
 

 

Slyšeli jste rozpo-  
jení senzoru? 

 
pak… 

Ne 1.  Posuňte senzor směrem dolů pootočením nastavovacího 
kolečka ve směru vyznačeném na rameni podavače. 

 

2.  Umístěte destičku do úchopu a poslouchejte sepnutí 
spínače senzoru: 

–   Neslyšíte-li sepnutí senzoru, vyjměte destičku a 
opakujte kroky 1 a 2 výše. 

–   Slyšíte-li sepnutí senzoru, vyjměte destičku a 
pokrakujte krokem viz níže 

Ano 1.  Posuňte senzor pomocí nastavovacího kolečka o jeden 
krok směrem nahoru, jak je vyznačeno na rameni 
podavače. 

2.  Umístěte destičku do úchopu a poslouchejte sepnutí 
 spínače senzoru: 

–   Slyšíte-li sepnutí senzoru, vyjměte destičku a 
opakujte kroky 1 a 2 výše. 

–   Neslyšíte-li sepnutí senzoru, úspěšně jste nalezli 
nulovou pozici senzoru. 

Poznámka:  V nulové pozici způsobí posun nastavovacího 
kolečka o jeden krok dolů sepnutí senzoru.  

 
5.   Jakmile naleznete nulovou pozici, opatrně otáčejte nastavovacím kolečkem 

ve směru dolů o potřebný počet kroků podle formátu destičky jak je 
specifikováno níže: 

 
 

Destička 
 

Otočení nastavovacího kolečka o… 

96-ti jamková optická destička 20 kroků 

384- jamková optická destička 15 kroků 

mikrofluidní karta 15 kroků 

 
Poznámka:  Pokud se spletete, začněte znovu krokem 4 a nalezněte nulovou 
pozici senzoru. 

 

6.   Zkontrolujte seřízení podle postupu na straně 7-39. 
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Kontrola 
seřízení 

1.   Umístěte destičku do úložné věže 1 podavače. 
 

2.   Zapněte přístroj 7900HT, podavač mikrodestiček a počítač. 
 

3.   Zvolte  > Programs > Zymark Twister Plate Handler > Twister. 

Spustí se program Zymark Twister. 
 

4.   Klikněte Manual Control (Ruční ovládání). 
 

5.   V dialogovém okně Manual Control (Ruční ovládání) klikněte na věž 4. 
 
 
 
 
 
 
 
 
 
 
 

Klikněte 
 

 
 
 
 

Rameno podavače se natočí nad vstupní věž. 
 

6.   Klikněte  (Najít destičku). 

Bylo-li seřízení provedeno správně, klesne rameno podavače až k destičce a 
sepne se spínač senzoru, signalizující nalezení destičky. 

Vydá-li rameno podavače skřípavý zvuk, upravte nastavení senzoru: 
 

a.  V programu Zymark Twister klikněte  (Výchozí vertikální 
pozice), čímž přesunete rameno podavače nahoru. 

b.  Otočte nastavovacím kolečkem ve směru dolů o 10 kroků. 

c.  Opakujte krok 6 dokud nebude destička nalezena. 
 

7.   Klikněte  (Sevřít úchop), pak klikněte  (Výchozí 
vertikální pozice). 

Bylo-li seřízení provedeno správně, rameno podavače uchopí destičku a vyjme ji 
z věže. 

Pokud se rameno podavače zastaví předtím, než může úchop uchopit destičku, a 
k jejímu uchopení nedojde, upravte nastavení senzoru: 

a.  Otočte nastavovacím kolečkem ve směru nahoru o 10 kroků. 

b.  Uchopte destičku rukou a v programu Zymark Twister klikněte 

 (Otevřít úchop), čímž ji uvolníte. 
c.  Umístěte destičku zpět do věže 1. 

 

8.   Opakujte kroky 6 a 7 dokud rameno správně neuchopí destičku. 
 

9.   Uchopte destičku rukou a v programu Zymark Twister klikněte  
(Otevřít úchop), čímž ji uvolníte. 
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10.   Ukončete program Zymark Twister. 

a.  Klikněte  (Hlavní nabídka). 
b.  Klikněte Quit Application (Ukončit program). 

 

Chyba programu Zymark Twister může způsobit, že program zůstane neukončený 
v paměti počítače i poté, co byl ukončen. Jelikož v takovém případě dojde ke 
konfliktu s programem SDS, použijte Správce úloh operačního systému Windows: 

 

1.     a.  Stiskněte najednou klávesy Crtl + Alt + Del. 

b.  V dialogovém okně Windows Security klikněte Task Manager (Správce 
     úloh). 

c.  V dialogovém okně Task Manager (Správce úloh) se ujistěte, že se program 
zavřel – nevidíte-li v seznamu úloh (Task) program Zymark Twister, je vše 
v pořádku. Pokud program stále běží, klikněte na jeho název a klikněte 
Close (Zavřít). 

d.  Zvolte File > Exit (Soubor > Konec). 
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Seřízení podavače mikrodestiček  
 

 
     Kdy provádět Následující proceduru proveďte, přemístíte-li přístroj ABI PRISM 7900HT, nebo 

potřebuje-li podavač mikrodestiček Zymark Twister seřídit. 
 

Potřeba seřízení vzniká zejména v následujících případech: 
 

•   Rameno podavače destiček se pohybuje příliš ve směru dolů (rameno skřípe při 
uchopení nebo uvolnění destičky) 

•   Rameno podavače naráží do úložných věží 
•   Rameno podavače uvolňuje destičky nade dnem úložných věží 
•   Destičky se při umístění do nosítek přístroje naklánějí 

 
Příprava 
přístroje 

k seřízení 

1.   Odstraňte kryty pevně umístěné čtečky čárových kódů a podstavce. 

 
 
 
 
 

 
Kryty pevně umístěné čtečky 
 čárových kódů a podstavce 

 
2.   Uvolněte tři černé šrouby připevňující přístroj 7900HT k podstavci podavače. 

 

  
 

3.   Vysuňte nosítka přístroje. 

a.  Spusťte program Automation Controller. 

Objeví-li se chybová hláška, ‘Machine calibration values are not valid. 
Please refer to documentation for calibration process,’ (Kalibrační 
hodnoty přístroje nejsou správně. Proveďte kalibraci podle návodu.) 
klikněte . 

b.  Klikněte  (Otevřít/Zavřít). 
Nosítka přístroje se vysunou ven. 

c.  Zvolte File > Exit (Soubor > Konec). 
Program Automation Controller se ukončí. 

 

4.   Zvolte  > Programs > Zymark Twister Plate Handler > Twister. 

Spustí se program Zymark Twister. 
 

5.   Klikněte Manual Control (Ruční ovládání). 

Černé šrouby 
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Seřízení věže 1 
(Zymark – 
pozice 4) 

Prvním krokem seřízení je seřízení věže 1 (pozice 4 v programu Zymark Twister). 
Toto seřízení je základem pro následné seřízení pozic dalších věží podavače. 
 

1.   Umístěte prázdnou destičku do úložné věže 1 podavače (Zymark - pozice 4). 
 

2.   V programu Zymark Twister klikněte na pozici 4. 
 
 
 
 
 
 
 
 
 
 
 

Klikněte 
 

 
 
 
 

Rameno podavače se natočí nad vstupní věž. 
 

3.   Pomocí příkazů Vertical Positioning (Seřízení ve vertikálním směru) posuňte 
rameno podavače dolů tak, aby bylo těsně nad věží. 

Seřízení ve vertikálním směru lze provádět čtyřmi různými způsoby: 
•   Výrazné posuny proveďte pomocí posuvníku.. 
•   Klikněte do lišty posuvníku – posun ramene o 250 kroků. 
•   Klikněte na spodní šipku – posun ramene o 50 kroků. 

•   Klikněte na šipky nahoru a dolů v okně Vertical Adjustment (Seřízení ve 
vertikálním směru) – posun ramene o 1 krok. 

•   Klikněte do okna Vertical Adjustment (Seřízení ve vertikálním směru), 
zadejte hodnotu a stiskněte klávesu Enter – posun do specifického místa. 

 

 
 
 
 

Posuvník 

Lišta posuvníku (kliknutí – 250 kroků) 

Šipka dolů (kliknutí - 50 kroků) 
 

 
 
Šipky (kliknutí - 1 krok) 

 
 

4.   Ověřte rotační pozici ramene podavače, abyste se ujistili, že úchop: 
•   je přímo nad věží 
•   při pohybu dolů se nedotkne stěn věže 
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5.   Pomocí šipek v okně Rotary Adjustment (Nastavení rotace) upravte pozici 
úchopu tak, že je přímo nad věží (vycentrován) a při pohybu dolů se nedotkne 
stěn věže. 

•   Chcete-li posunout rameno podavače ve směru hodinových ručiček, 
klikněte na šipku nahoru. 

•   Chcete-li posunout rameno podavače proti směru hodinových ručiček, 
klikněte na šipku dolů. 

 
 
 
 
 
 
 
 
 
 
 
 

Šipka nahoru (posun ramene ve směru hodinových ručiček) 

 
 Šipka dolů (posun ramene proti směru hodinových ručiček) 

 

6.   Pomocí nastavení Vertical Adjustment (Seřízení ve vertikálním směru) opatrně 
snižte rameno podavače do úložné věže. Upravte  (Nastavení rotace) (Rotary 
Adjustment) podle potřeby, aby byl úchop uprostřed věže. 

 

7.   Poté co je úchop uvnitř věže, klikněte  (Najít destičku). 
Rameno podavače se pohne směrem dolů k destičce. 

Ujistěte se, že: 

•   Destička je uprostřed úchopu. 
•   Senzor destičky je v kontaktu s destičkou. 
•   Ani úchop, ani destička se nedotýkají stěn věže. 

 

8.   Klikněte  (Sevřít úchop). 
Destička je uchopena. 

 

9.   Zvolte  (Výchozí vertikální pozice). 
Rameno podavače se přesune nahoru. Dotýká-li se destička stěn věže, upravte 
rotační nastavení ramene podavače tak, aby k tomu nedocházelo. 

 

Poznámka:  Může se stát, že je kontakt mezi destičkou a stěnou věže (věží) 
nevyhnutelný. Každopádně se jej snažte minimalizovat jak je to jen možné. 

 

10.   Pomocí příkazů Vertical Positioning (Seřízení ve vertikálním směru) přesuňte 
rameno podavače několikrát nahoru a dolů, abyste ověřili správnost seřízení. 

 

11.   Přesuňte rameno podavače směrem dolů na dno úložné věže, klikněte 

 (Definice rotační pozice) a klikněte  (Ano). 

Program zaznamená rotační pozici ramene pro věž 1 (Zymark – pozice 4). 
 

12.   Klikněte  (Otevřít úchop). 
Destička se uvolní. 
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R2012 
G 

 

 

 
 

Seřízení 
podavače 

mikrodestiček 
k přístroji 

Dalším krokem je seřízení ramene podavače mikrodestiček vůči nosítkům přístroje 
(Zymark – pozice 2). Tím zajistíte bezproblémový přenos destičky z ramene 
podavače do nosítek přístroje a zpět. 
 

Poznámka:  Během následující procedury nastavíte pozici podavače mikrodestiček 
vůči přístroji 7900HT. Musíte uvolnit tři černé šrouby na podstavci podavače 
mikrodestiček, které jej propojují s přístrojem 7900HT. 
 

1.   Pokud tam již není umístěte prázdnou destičku do úložné věže 1 (Zymark - 
pozice 4) a zvedněte ji pomocí ramene podavače: 

a.  V programu Zymark Twister klikněte na pozici 4.  

b.  Klikněte  (Najít destičku). 

c.  Klikněte  (Sevřít úchop). 
 

2.   Klikněte na pozici 2. 
 

 
 
 

Klikněte 
zde 

 
 
 
 
 
 

Rameno podavače se přesune nad nosítka přístroje. 
 

3.   Pomocí příkazů Vertical Positioning (Seřízení ve vertikálním směru) snižte 
rameno podavače tak, aby bylo přibližně 1 cm nad nosítky přístroje. 

 

4.   Pomocí šipek v nastavení Rotary Adjustment (Nastavení rotace) vycentrujte 
úchop a destičku podél osy Y nosítek přístroje. 

 
 
 
 

1      2      3      4      5      6      7      8      9    10  11  12  13  14  15  16  17  18  19  20  21  22  23   24 

A B 

C D 

E F 

G H 

I 

J K 

L M 

N O 

P 

 
Vycentrujte destičku 

 
 

5.   Posuňte podavač mikrodestiček a jeho základnu k nebo od přístroje 7900HT tak, 
abyste vycentrovali úchop a destičku podél osy X nosítek přístroje. 

 
 
 
 

1      2      3      4      5      6      7      8      9    10  11  12  13  14  15  16  17  18  19  20  21  22  23   24 

A B 

C D 

E F  

G H 

I 

J K 

L M  

N O 

P 

 
 

Vycentrujte destičku 
 

6.   Proveďte opět centrování úchopu a destičky podél osy Y nosítek přístroje 
pomocí příkazů programu tak jako v kroku 4. 
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7.   Pomocí příkazů Vertical Positioning (Seřízení ve vertikálním směru) opatrně  
snižte rameno podavače na nosítka přístroje a ověřte, že destička dosedá přesně 
do nosítek. 

 

8.   Dotáhněte tři černé šrouby na základně spojující přístroj 7900HT 
a podavač mikrodestiček. 

 

9.   Uvolněte destičku z ramene podavače.  

 a.  Klikněte  (Otevřít úchop). 

b.  Klikněte  (Výchozí vertikální pozice). 
 

10.   Klikněte  (Najít destičku). 
Rameno podavače se pohne směrem dolů k destičce. 

 

11.   Uložte rotační a vertikální nastavení: 

a.  Klikněte  (Definice rotační pozice) a klikněte  (Ano). 
Program zaznamená rotační pozici pro nosítka přístroje (Zymark - 
pozice 2). 

b.  Klikněte  (Definice vertikální pozice) a klikněte  (Ano). 
Program zaznamená vertikální pozici pro nosítka přístroje. 

 
Ověření seřízení 

věže 1 
Je-li poloha podavače mikrodestiček vůči přístroji definována, je možné provést 
seřízení úložných věží podavače a toto seřízení zaznamenat. 
 

1.   Umístěte prázdnou destičku do úložné věže 1. 
 

2.   V programu Zymark Twister klikněte na pozici 4. 

Rameno podavače se natočí nad vstupní věž. 
 

3.   Pomocí příkazů Vertical Positioning (Seřízení ve vertikálním směru) posuňte 
rameno podavače dolů tak, aby bylo 1 cm nad věží, a ověřte, že je vycentrováno. 
Je-li zapotřebí, proveďte vycentrování ramene vůči věži pomocí Nastavení rotace 
(Rotary Adjustment). 

 

4.   Opatrně snižte rameno podavače do úložné věže. Upravte Rotary Adjustment 
(Nastavení rotace) podle potřeby, aby byl úchop uprostřed věže. 

 

5.   Poté co je úchop uvnitř věže, klikněte  (Najít destičku). 
Rameno podavače se pohne směrem dolů k destičce. 

        Ujistěte se, že: 

•   Destička je uprostřed úchopu. 
•   Senzor destičky je v kontaktu s destičkou. 
•   Ani úchop, ani destička se nedotýkají stěn věže. 

 

6.   Klikněte  (Sevřít úchop). 

7.   Klikněte  (Výchozí vertikální pozice). 
Rameno podavače se přesune nahoru. Dotýká-li se destička stěn věže, upravte 
rotační nastavení ramene podavače tak, aby k tomu nedocházelo 

 

Poznámka:  Může se stát, že je kontakt mezi destičkou a stěnou věže (věží) 
nevyhnutelný. Každopádně se jej snažte minimalizovat jak je to jen možné. 
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8.   Klikněte  (Definice rotační pozice) a klikněte  (Ano). 
Program znovu zaznamená rotační pozici ramene pro věž 1 (Zymark – pozice 4). 

 

9.   Přidržujte destičku a klikněte (Otevřít úchop). Vyjměte destičku. 
 

Definice dna 
úložné věže 

Pro správné fungování programu Automation Controller je zapotřebí definovat dno 
všech úložných věží. Tím je zabráněno nárazu ramene podavače na dno úložných 
věží při jeho pohybu směrem dolů. 
 

1.   Vyjměte všechny destičky z přístroje a ramene podavače. 
 

2.   Umístěte prázdnou destičku do úložné věže na zpracované destičky (Zymark – 
      pozice 0). 

 

3.   V programu Zymark Twister klikněte na pozici 0. 

Rameno podavače se přesune nad úložnou věž na zpracované destičky. 
 

4.   Pomocí příkazů Vertical Positioning (Seřízení ve vertikálním směru) posuňte 
rameno podavače dolů tak, aby bylo těsně nad věží. 

 

5.   Ověřte rotační pozici ramene podavače, abyste se ujistili, že úchop: 
•   je přímo nad věží 
•   při pohybu dolů se nedotkne stěn věže 

 

6.   Pomocí šipek v okně Rotary Adjustment (Nastavení rotace) upravte pozici 
úchopu tak, že je přímo nad věží (vycentrován) a při pohybu dolů se nedotkne 
stěn věže. 

 

7.   Pomocí nastavení Vertical Positioning (Seřízení ve vertikálním směru) opatrně 
snižte rameno podavače do úložné věže. Upravte (Nastavení rotace) (Rotary 
Adjustment) podle potřeby, aby byl úchop uprostřed věže. 

 

8.  Poté co je úchop uvnitř věže, klikněte  (Najít destičku). 
Rameno podavače se pohne směrem dolů k destičce. 

Ujistěte se, že: 

•   Destička je uprostřed úchopu. 
•   Senzor destičky je v kontaktu s destičkou. 
•   Úchop se nedotýká stěn věže 

 

9.   Klikněte  (Sevřít úchop). 
Destička je uchopena. 

 

10.   Zvolte  (Výchozí vertikální pozice). 
Rameno podavače se přesune nahoru. Dotýká-li se destička stěn věže, upravte 
rotační nastavení ramene podavače tak, aby k tomu nedocházelo. 

 

Poznámka:  Může se stát, že je kontakt mezi destičkou a stěnou věže (věží) 
nevyhnutelný. Každopádně se jej snažte minimalizovat jak je to jen možné. 

 

11.  Pomocí příkazů Vertical Positioning (Seřízení ve vertikálním směru) přesuňte 
rameno podavače několikrát nahoru a dolů, abyste ověřili správnost seřízení. 

 

12.   Přesuňte rameno podavače směrem dolů a klikněte  (Definice 
rotační pozice) a klikněte  (Ano). 
Program zaznamená rotační pozici ramene pro věž 0.
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13.   Klikněte  (Výchozí vertikální pozice). 
 

14.   Přidržujte destičku a klikněte  (Otevřít úchop). Vyjměte destičku. 
 

15.   V poli Vertical Adjustment (Seřízení ve vertikálním směru) zadejte –3200 
a stiskněte Enter. Rameno podavače se přesune ke dnu úložné věže na 
zpracované destičky. 

 

16.   Opatrně snižte rameno podavače tak, aby bylo přibližně 1–2 mm ode dna věže. 
 

17.   Klikněte  (Definice vertikální pozice), klikněte  (Ano) a 
poznamenejte si číslo v poli Vertical Adjustment (Seřízení ve vertikálním 
směru). Program zaznamená vertikální pozici ramene pro věž 0. 

 

18.  Klikněte  (Výchozí vertikální pozice). Rameno podavače se přesune 
nahoru. 

 

19.   V poli Vertical Adjustment (Seřízení ve vertikálním směru) zadejte definici 
vertikální pozice (Vertical Offset) z kroku 17 a stiskněte Enter. Rameno 
podavače se přesune do definované vertikální pozice. 

 

20.   Je-li zapotřebí, upravte definici pozice Vertical Offset a opakujte kroky 18 a 19, 
 dokud není nastavení správně. 

 
Definice pozic 

zbývajících věží 
1.   Umístěte prázdnou destičku do úložné věže 2 (Zymark – pozice 5). 
 

2.   V programu Zymark Twister klikněte na pozici 5. 

Rameno podavače se přesune nad vstupní věž. 
 

3.  Pomocí příkazů Vertical Positioning (Seřízení ve vertikálním směru) snižte 
rameno podavače tak, aby bylo přibližně 1 cm nad věží a vycentrujte je pomocí 
Nastavení rotace (Rotary Adjustment) podle potřeby. 

 

4.   Opatrně snižte rameno podavače do věže. Pomocí Nastavení rotace (Rotary 
Adjustment) upravte vycentrování úchopu podle potřeby. 

 

5.   Jakmile je rameno podavače uvnitř věže vycentrováno, klikněte  
(Najít destičku). Rameno podavače se pohne směrem dolů k destičce.  

 

Ujistěte se, že: 

•   Destička je uprostřed úchopu. 
•   Senzor destičky je v kontaktu s destičkou. 
•   Ani úchop, ani destička se nedotýkají stěn věže. 

 

6.   Klikněte  (Sevřít úchop). 

7.   Klikněte  (Výchozí vertikální pozice). 
Rameno podavače se přesune nahoru. Dotýká-li se destička stěn věže, upravte 
rotační nastavení ramene podavače tak, aby k tomu nedocházelo. 

 

Poznámka:  Může se stát, že je kontakt mezi destičkou a stěnou věže (věží) 
nevyhnutelný. Každopádně se jej snažte minimalizovat jak je to jen možné. 

 

8.   Pomocí příkazů Vertical Positioning (Seřízení ve vertikálním směru) přesuňte 
rameno podavače několikrát nahoru a dolů, abyste ověřili správnost seřízení. 

 

 Uživatelská příručka pro Real-Time PCR systém ABI PRISM 7900HT 7-47 



Seřízení podavače mikrodestiček            

  

 

 
 

9.   Klikněte  (Definice rotační pozice) a klikněte  (Ano). 
Program zaznamená rotační pozici ramene pro věž 5 (vstupní věž 2). 

 

10.   Opakujte kroky 1 až 9 pro věže 3 a 4, abyste definovali Výchozí rotační pozici 
(Rotary Offset) i pro pozice 6 a 7: 

 
 
 

Zymark - pozice 7 
(vstupní věž 4) 

Zymark - pozice 6 
( vstupní věž 3) 

 
 
 
 

11.   Ukončete program Zymark Twister. 

a.  Klikněte .  

b.  Klikněte Exit (Konec). 
 

Chyba programu Zymark Twister může způsobit, že program zůstane 
neukončený v paměti počítače i poté, co byl ukončen. Jelikož v takovém případě 
dojde ke konfliktu s programem SDS, použijte Správce úloh operačního systému 
Windows. 

 

12.   Ujistěte se, že je program Zymark Twister ukončen. Spusťte Task Manager 
        (Správce úloh). 

a.  Stiskněte najednou klávesy Crtl + Alt + Del. 

b.  V dialogovém okně Windows Security klikněte Task Manager (Správce 
     úloh). 

 

c.  V dialogovém okně Task Manager (Správce úloh) se ujistěte, že se 
program zavřel – nevidíte-li v seznamu úloh (Task) program Zymark 
Twister, je vše v pořádku. Pokud program stále běží, klikněte na jeho 
název a klikněte Close (Zavřít). 

d.  Zvolte File > Exit (Soubor > Konec), čímž Správce úloh ukončíte. 
 

13.   Vraťte zpátky na místo kryty pevně umístěné čtečky čárových kódů  a 
podstavce (odstraněné v kroku 1 na straně 7-41). 

 
 
 
 
 
 
 
 

Kryty pevně umístěné čtečky 
 čárových kódů a podstavce 
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Seřízení pevně umístěné čtečky čárových kódů 
 
 

         Popis Pevně umístěná čtečka čárových kódů musí být nastavena tak, aby mohla 
automaticky skenovat čárové kódy destiček v okamžiku, kdy jsou umístěny pomocí 
ramene podavače do nosítek přístroje. 

 
Přípravné kroky 1.   Odstraňte kryt pevně umístěné čtečky čárových kódů. 

 
 
 
 
 

Kryt pevně umístěné čtečky 
čárových kódů 

 
2.   Zapněte počítač. 

 

3.   Spusťte program Automation Controller. 
 

4.   Klikněte  (Otevřít/Zavřít). 

Nosítka přístroje 7900HT se vysunou ven. 
 

5.   Zvolte File > Exit (Soubor > Konec). 

Program Automation Controller se ukončí. 
 

Umístění čtečky 
čárových kódů 

DŮLEŽITÉ!  Pro seřízení pevně umístěné čtečky čárových kódů musí být nosítka 
přístroje vždy vysunuta. 
 

1.   Umístěte destičku s čárovým kódem do nosítek přístroje. 
 

DŮLEŽITÉ!  Jamka A1 musí odpovídat pozici A1 nosítek přístroje a čárový kód 
je orientován směrem k pevně umístěné čtečce čárových kódů. 

 
 

Jamka A1 
 
 
 
 
 

Čárový kód 
 
 

2.   Zvolte  > Programs > PSC Laser Data > LDHOST. 

Spustí se program LDHOST. 
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3.   Navažte spojení s pevně umístěnou čtečkou čárových kódů: 

a.  Klikněte  (Edit). 

b.  Klikněte  (Terminal). 
Otevřou se dialogová okna Edit Configuration (Změna konfigurace) a 
Terminal. 

c.  V dialogovém okně Device Control (Ovládání zařízení) klikněte  
     (Připojit k zařízení). 

V okně Terminal se zobrazí odpověď čtečky čárových kódů. 

d.  Klikněte  , čímž zavřete informační dialogové okno. 
Na základě komunikace mezi programem LD Host a čtečkou čárových kódů se 
aktualizují nastavení v okně Edit Configuration (Změna konfigurace). 

 

4.   Proveďte tato nastavení: 

a.  V dolní části okna Edit Configuration (Změna konfigurace) zvolte záložku  
Op. Modes (Režimy provozu). 

 
 
 
 

Záložka Op. Modes 
 

Poznámka:  Možná budete při vyhledání záložky Op. Modes (Režimy provozu) 
muset použít šipky ve spodní části dialogového okna. 

 

b.  Z rozbalovací nabídky Mode (Režim) zvolte Test. 
 
 
 
 
 
 
 

Rozbalovací nabídka Mode (Režim) 
 

c.  V dialogovém okně Device Control (Ovládání zařízení) klikněte na tlačítko 
     RAM, čímž se přepnete do režimu EEPROM. 

 
 
 
 
 
 
 
 
 

Tlačítko RAM  
 

 
d.  V dialogovém okně Device Control (Ovládání zařízení) klikněte Send 
     (Odeslat). 

e.  V dialogovém okně Confirm (Potvrdit) klikněte YES (Ano). 
 

Pevně umístěná čtečka čárových kódů začne skenovat čárový kód. Dialogové 
okno Terminal se aktualizuje každou 0,5 sec, čímž udává procentuální počet 
přesných čtení v tomto časovém intervalu. 
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5.   Uvolněte černý nastavovací šroub na pevně umístěné čtečce čárových kódů 
a umístěte čtecí hlavu čtečky co nejdále od destičky, přičemž ale zachováte 
orientaci ve směru k čárovému kódu (viz níže) 

 
Čtecí hlava 
 

 
 
 
 

Nastavovací šroub 
 

 
6.   Pozorujte dialogové okno Terminal a současně pomalu upravte orientaci pevně 

umístěné čtečky čárových kódů tak, aby se v okně zobrazoval co nejvyšší údaj 
(v %). 

 
 
 
 
 
 
 
 
 

Úspěšná čtení (v %) 
 

 
 

Poznámka:  Abyste viděli oblast, kterou čte laser čtečky čárových kódů, 
umístěte list bílého papíru před čárový kód destičky 

 

7.   Je-li seřízení v pořádku, dotáhněte černý nastavovací šroub na čtečce čárových 
kódů. 

 

8.   Uveďte čtečku čárových kódů do normálního režimu provozu: 

a.  V dialogovém okně Edit Configuration (Změna konfigurace) přepněte z 
     nastavení Test zpět na Serial on Line. 

 

 
 
 
 
 

 Rozbalovací nabídka Mode (Režim) 
 
 

b.  V dialogovém okně Device Control (Ovládání zařízení) potvrďte, že je stále 
     zvolen režim EEPROM a klikněte Send (Odeslat). 

c.  V dialogovém okně New Decision (Nová volba) klikněte YES. 
 

Pevně umístěná čtečka čárových kódů přestane skenovat čárový kód a 
přepne se do normálního režimu provozu. 

 

9.   Klikněte Exit (  , Konec) čímž ukončíte program LDHOST. 
 

10.   Připevněte zpět kryt pevně umístěné čtečky čárových kódů (z kroku 1 na 
straně 7-49). 
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Materiál 
 

     Kat. č. 

Souprava Finger Pad Replacement Kit, obsahuje 10 podložek 4315472 

Malý plochý šroubovák — 

Šroubovák Phillips, malý — 

Isopropanol ve střičce — 

 

 
 

Čistění a výměna podložek ramene (pro úchop destiček) 
 

 
      Kdy provádět Některé typy mikrodestiček mají čárové kódy nalepené pomocí adhezívních  

materiálů, které se mohou postupem času nabalovat na podložky ramene podavače 
mikrodestiček Zymark Twister. Následně může docházet k tomu, že podložky ramene 
se na destičky při manipulaci s nimi chytají (lepí) . Abyste tomu zabránili, je zapotřebí 
pravidelně (měsíčně) kontrolovat podložky ramene a v případě potřeby je vyčistit či 
vyměnit. 

 
Potřebné 
pomůcky 

Tabulka 7-3 Pomůcky potřebné pro výměnu podložek ramene 

 
 
 
 
 
 
 
 
 
 
 
 

CHEMICKÉ RIZIKO. Izopropanol je hořlavá tekutina a 
vytváří hořlavé výpary. Způsobuje podráždění očí, kůže a dýchacího ústrojí a může 
způsobit poškození centrálního nervového systému. Přečtěte si bezpečnostní list a 
dodržujte pokyny při manipulaci. Používejte prostředky ochrany očí, ochranný oděv 
a rukavice.. 

 
Čištění podložek 

ramene 
Chcete-li vyčistit podložky ramene, otřete je dokonale izopropanolem. Mají-li 
hrubý povrch nebo na nich nalepená adheziva nelze setřít, vyměňte je podle 
postupu níže. 

 
Výměna podložek 

ramene 
1.   Pomocí šroubováku Phillips vyšroubujte dva malé šroubky vyšroubujte šrouby 

v držácích podložek na každé straně úchopu a držáky sejměte. 
 

Poznámka:  Rameno podavače si posuňte tak, abyste měli ke šroubům snadný 
přístup. 

 

2.   Pomocí plochého šroubováku vyjměte použité podložky z držáků. 
 

Poznámka:  Výrobce doporučuje měnit všechny podložky najednou. 
 

3.   Vyčistěte držáky pomocí izopropanolu. 
 

4.   Vyjměte náhradní podložku z obalu a umístěte ji do držáku. 
 

5.   Opakujte tento krok i pro ostatní podložky. 
 

6.   Nasaďte držáky podložek zpět, podložky směřují do středu úchopu. 
 

7.   Nasaďte a dotáhněte šrouby. 
 

Poznámka:  Dotažením šroubů neprovedete seřízení úchopu. Ujistěte se, že 
podložky jsou v těsném kontaktu s destičkou pokud s ní rameno manipuluje. 
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Část 7.3 Údržba hardwaru a softwaru 
 
 

      V této části Běžná údržba počítače ....................................................................................... 7-54 
Údržba programu SDS....................................................................................... 7-55 
 

 

Poznámka:  Optimální fungování Real-Time PCR systému ABI PRISM 7900HT 
vyžaduje pravidelnou údržbu programu SDS. I když většinu kroků údržby provádí 
servisní technici společnosti Applied Biosystems, v této části naleznete důležité 
údaje, které byste měli znát. 
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Běžná údržba počítače 
 
 

Kroky údržby Počítač připojený k přístroji 7900HT vyžaduje provádění pravidelné údržby tak, aby 
bylo zajištěno optimální fungování všech komponent přístroje ABI PRISM 7900HT. 
Společnost Applied Biosystems doporučuje provádět následující kroky: 

 
Tabulka 7-4  Údržba počítače 

 
 

Krok 
 

Kdy provádět 

Archivace nebo odstranění starých souborů SDS  Týdně 

Defragmentace pevného disku Měsíčně nebo před dosažením 10% 
fragmentace 

Aktualizace operačního systému Je-li k dispozici/doporučena 

Aktualizace programu 7900HT SDS  Je-li k dispozici 

 
Správa dat 

 

Společnost Applied Biosystems doporučuje, abyste zavedli postupy nakládání se 
soubory, vytvářenými programem SDS. Během jediného dne (jsou-li prováděny 
experimenty v reálném čase) může přístroj ABI PRISM 7900HT vytvořit více než 
200 MB dat. Nemáte-li zavedeny postupy, jak s těmito daty dále nakládat, může 
přístroj 7900HT zaplnit pevný disk vašeho počítače během jen několika týdnů 
provozu. Podrobnější informace k tomuto tématu naleznete v části “Správa dat” na 
straně 1-17. 

 
Archivace 

souborů SDS  
Abyste šetřili prostor na pevném disku, lze soubory SDS archivovat pomocí 
kompresních nástrojů, které snižují jejich velikost. Kompresi a dekompresi souborů 
SDS lze provádět opakovaně. 
 

K dispozici je několik komerčně dostupných kompresních nástrojů. Pro operační 
systém Microsoft Windows jsou běžné formáty PKZIP a *.arc. 

 
Defragmentace 
pevného disku 

Společnost Applied Biosystems doporučuje provádět defragmentaci pevného disku 
počítače, který je připojen k přístroji, alespoň jedenkrát týdně nebo předtím, než 
fragmentace dosáhne 10%. S používáním přístroje ABI PRISM 7900HT a vytvářením 
a mazáním souborů SDS dochází k tomu, že volný prostor na disku je dělen do stále 
menších bloků (nazývaných “klastry”). Následně není možné, aby nově vytvářené 
soubory SDS byly uchovávány jako jediný blok, ale počítač rozdělí soubor SDS na 
několik kusů, které uloží do různých částí pevného disku. 
 

Fragmentace souborů SDS vede ke zhoršení fungování jak programu SDS tak 
operačního systému počítače. S postupnou fragmentací pevného disku se prodlužuje 
doba, kterou programy potřebují pro přístup k jednotlivým souborům, neboť musí 
vyhledávat jejich fragmenty. 
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Pro defragmentaci jsou k dispozici různé komerčně dostupné defragmentační nástroje. 
Tyto nástroje spojují fragmenty souborů a ukládají je na jediné místo na pevném 
disku, čímž zlepšují výkon systému. 

 
Aktualizace 
operačního 

systému 

Aktualizaci operačního systému počítače, připojeného k přístroji 7900HT, 
neprovádějte, nejste-li k tomu vyzváni zástupcem společnosti Applied Biosystems. 
Nové verze operačního systému Microsoft Windows nemusí být nutně kompatibilní s 
programem SDS a mohou vést k tomu, že program nebude fungovat. 
 

Servisní technici společnosti Applied Biosystems provádějí aktualizace operačního 
systému v rámci pravidelných kroků údržby. Jsou-li k dispozici aktualizace 
operačního systému počítače a jejich použití je validováno společností Applied 
Biosystems, bude operační systém aktualizován servisním technikem společnosti. 

 

 
 

Údržba programu SDS  
 
 

Přístupová 
práva 

DŮLEŽITÉ!  Pro instalaci a/nebo aktualizaci programu SDS musíte mít pro daný 
počítač administrátorská práva. 

 

 
Aktualizace 

programu SDS  
Společnost Applied Biosystems neustále pracuje na vývoji programu SDS. Tak jak 
jsou k dispozici nové aktualizace programu, jsou i zákazníci společnosti Applied 
Biosystems o těchto aktualizacích informováni. Lze-li instalaci takové aktualizace 
provést uživatelsky, naleznete ji na internetových stránkách společnosti Applied 
Biosystems. 
 

Poznámka:  Servisní technici společnosti Applied Biosystems provádějí 
pravidelné aktualizace softwaru během plánovaných návštěv. 

 
Opakovaná instalace 

programu 
Ve vzácných případech, dojde-li např. k poškození části programu SDS, může být 
nutné program opakovaně instalovat. V takovém případě dodržujte následující 
pokyny: 
 

•   Nebyli-li jste informováni jinak, odstraňte instalovaný program SDS pomocí 
nástroje pro odinstalování softwaru. Nemažte adresář programu z adresáře 
Program Files. 

•   Instalujte program SDS jako uživatel s právy administrátora k danému počítači. 
•   Nebyli-li jste informováni jinak, instalujte program SDS do téhož adresáře, 

v němž byl instalován předešle. 
•   Seznamte se s veškerou dokumentací, týkající se instalované verze programu 

(poznámky k instalaci nebo uživatelská příručka). Nové verze programu mohou 
mít nové vlastnosti vyžadující vaši pozornost. 

 

 Uživatelská příručka pro Real-Time PCR systém ABI PRISM 7900HT 7-55 



  

  

Část 7.3  Údržba hardwaru a softwaru 
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Kapitola 8    Řešení problémů 
 
 

Tabulka problémů 
 
 

Přehled Následující tabulka by vám měla pomoci vyřešit většinu problémů, s nimiž se 
můžete při práci s přístrojem ABI PRISM®  7900HT setkat. 

 

Informace v tabulce jsou uspořádány v následujících kategoriích: 
 

•   Problémy s reagenciemi 
•   Problémy při provádění běhu 
•   Problémy související s přístrojem a jeho příslušenstvím 

 

Součástí každé kategorie jsou i podkategorie, obsahující stručný popis problémů a 
toho jak se projevují. 

 

Tabulku používejte tak, že vyhledáte problém, na který jste narazili. Na stránce 
uvedené v pravém sloupci tabulky vedle problému pak najdete popis možných 
příčin a doporučení pro vyřešení toho konkrétního problému. 

 
Tabulka 8-1 Tabulka problémů 

 
 

Kategorie 
 

Popis 
 

Strana 
 

Problémy s reagenciemi a při provádění běhu 

Nízká přesnost Reagencie 

Nereprodukovatelnost 

8-5 

 

Instalace softwaru 

Nelze dokončit instalaci 
(instalace “zamrzla”) 

Program SDS  

Instalace přerušena 

8-5 

Problémy při provádění běhu 

Software neprovedl extrakci pozadí Kalibrace pozadí 

Příliš vysoké pozadí (vyšší než 2500) 

8-9 

Software neprovedl extrakci barev 

Hrubá data běhu kalibrace barev jsou divná  

Signál vytváří plató (saturace) 

Signál je příliš nízký (< 10,000 FSU) 

Kalibrace barev 

Více než dva odlehlé body (pro jednu barvu) 
v jedné řadě   

8-11 

Eseje v reálném čase (Kvantitativní PCR a analýza disociační křivky) 8-12 

Eseje typu End-Point (Alelická diskriminace) 8-13 
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Tabulka problémů    
 
 

 Tabulka 8-1 Tabulka problémů 
 

 

Kategorie 
 

Popis 
 

Strana 
 

Problémy související s přístrojem a jeho příslušenstvím 

Program SDS nelze spustit 
 

Program vede k “zamrznutí” počítače nebo 
k zobrazení chybové hlášky 

Komunikační chyba 

Chyby teplotního cyklování 

Program Automation Controller nenalezl 
soubor destičky 

Zobrazí se dialogové okno Run Completed 
Successfully (Běh úspěšně ukončen) ale 
počítač nereaguje 

Běh nezačne 

Počítač je při analýze dat, otevírání a 
zavírání dialogových oken a dalších krocích 
pomalý. 

Nelze se přihlásit do operačního systému 
Windows. 

 

Software a přístroj 
7900HT  

Počítač nelze vůbec spustit. 

8-14 

Rameno podavače vydává při zvedání 
nebo ukládání destiček skřípavý zvuk 

Rameno podavače se při pohybu věží 
dotýká jejích stěn 

Rameno podavače umisťuje destičky do věží 
špatně 

Destičky se při umístění do nosítek přístroje 
naklánějí 

Rameno podavače nenalezne nebo neuchopí 
destičku 

Destičky se lepí k podložkám ramene 
podavače 

Rameno podavače nepřeskládá destičky 
na jejich původní místo  

Podavač mikrodestiček 
Zymark Twister a 
pevně umístěná čtečka 
čárových kódů  

Pevně umístěná čtečka čárových kódů 
nečte čárové kódy destiček 

8-17 
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 Tabulka 8-1 Tabulka problémů 
 

 

Kategorie 
 

Popis 
 

Strana 

Po vyjmutí mikrofluidní karty z obalu jsou plnící 
rezervoáry poškozené (zmačkané, ohnuté). 

Po vyjmutí mikrofluidní karty z obalu je její 
krycí hliníková fólie poškozena. 

Po vyjmutí mikrofluidní karty z obalu se na 
reakčních jamkách usazuje prach nebo jiné 
nečistoty.  

Po vyjmutí mikrofluidní karty z obalu na ní 
kondenzuje vlhkost. 

Podařilo se napipetovat příliš málo reakční 
směsi do plnícího rezervoáru. 

Při pipetování reakční směsi dochází k jejímu 
úniku vzduchovým otvorem plnícího rezervoáru. 

Během PCR dochází ke ztrátám reakční směsi. 
 

Mikrofluidní karta 

Po výpočtu průměru a standardní odchylky 
skupiny replikátů se specifický replikát jeví 
jako odlehlý bod. 

8-18 

Archivace nebo získávání dat z databáze 
bylo ukončeno předčasně  

 

Databáze SDS Enterprise  

Nelze se připojit k databázi 

8-20 
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Nízká přesnost nebo nereprodukovatelnost 
 
 

Přehled Důvody vedoucí k tomu, že určitý experiment provedený na přístroji ABI PRISM 
7900HT má nižší než optimální přesnost, mohou být značně rozdílné. Faktory, které 
mají vliv na přesnost, jsou popsány níže. 

 

Nesprávně nastavený práh ........................................................................................ 8-5 
Nepřesné pipetování ................................................................................................. 8-6 
Neprovedená optimalizace reakce ............................................................................ 8-6 
Nedokonalé promíchání ............................................................................................ 8-6 
Vzduchové bubliny ................................................................................................... 8-6 
Destička nebyla centrifugována................................................................................ 8-6 
Kapky........................................................................................................................ 8-7 
Popis destiček ........................................................................................................... 8-7 
Fluorescenční kontaminace destiček......................................................................... 8-7 
Chyby........................................................................................................................ 8-7 
Kontaminace bloku na vzorky .................................................................................. 8-7 
Nesprávný nebo poškozený spotřební plast .............................................................. 8-8 
Nízká koncentrace templátu...................................................................................... 8-8 
Používání reagencií od jiných dodavatelů ................................................................ 8-8 

 
Nesprávně 

nastavený práh 
Klíčem k vysoké přesnosti kvantitativní PCR je přesné rozeznání exponenciální fáze 
amplifikace. Přístroj ABI PRISM 7900HT má – za předpokladu rozumně 
optimalizované PCR reakce – dostatečnou citlivost, aby byly zobrazeny alespoň tři 
cykly v exponenciální fázi reakce. Program SDS následně vypočítá práh (fixní 
intenzitu signálu). Předpokladem detekce amplifikace v určité jamce je právě 
dostatečná intenzita fluorescenčního signálu v této jamce, tak aby tento signál 
překračoval práh. Vypočítaný práh je zapotřebí vždy ověřit a podle potřeby upravit. 
 
Úprava nastavení prahu 
 

U experimentů v reálném čase lze v programu SDS v amplifikačním grafu 
(Amplification plot) změnit vypočítaný práh. Více informací naleznete v části 
“Nastavení pozadí a prahu” na straně 6-46. 
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Nepřesné 
pipetování 

Na kvantifikaci má bezprostřední vliv přesnost pipetování templátu do reakčních 
směsí. Přesnost pipetování má rovněž vliv na další jednotlivě přidávané reagencie 
(např. různé koncentrace hořčíku mají vliv na efektivitu amplifikace). 
 
Používání mastermixů 
 

Z těchto důvodů společnost Applied Biosystems důrazně doporučuje používání 
mastermixů. Všechny složky reakce, u kterých je to možné, by měly být před 
rozpipetováním do jamek destičky promíchány dohromady. Pro další zlepšení 
přesnosti skupin replikátů je pak na místě používání sub-mastermixů. Např. namísto 
pipetování 5 µL téhož templátu do čtyř jamek pipetujte 20 µL templátu do dílčího 
mastermixu a pak jej rozpipetujte do čtyř jamek. Při přípravě mastermixu počítejte s 
dodatečným objemem (5–10% celkového objemu), abyste kompenzovali ztráty 
vzniklé v důsledku pipetování. 
 
Používání pipetmanů 
 

Přesnost pipetování rovněž zlepšíte: 
 

•   Pravidelnou kalibrací a údržbou pipetmanů 
•   Pipetováním větších objemů 
•   Snížením počtu pipetovacích kroků na minimum 

 

Informace o tom, jak správně používat konkrétní pipetman, získáte od jeho výrobce. 
Některými pipetmany například pipetujete žádaný objem při domáčknutí pístu na 
první doraz, takže domáčknutí na druhý doraz může vést k pipetovací chybě. Rovněž 
používáte-li novou špičku pro rozpipetování mastermixu, nejprve ji v mastermixu 
smočte nasátím a opět vytlačením směsi mastermixu. 

 
Neprovedená 
optimalizace 

reakce 

Reakce, jejichž chemizmus nebyl optimalizován, mohou být náchylné 
k nereprodukovatelným výsledkům. Chcete-li maximalizovat přesnost a efektivitu 
reakce, musíte pro každou používanou esej provést optimalizaci koncentrací primerů a 
sond. Informace týkající se optimalizace koncentrací primerů a sond v reakcích 
naleznete v příručce TaqMan Universal PCR Master Mix Protocol (kat. č. 4304449). 

 
Nedokonalé 
promíchání 

Pro docílení maximální přesnosti musí být mastermix PCR dokonale promíchán. Po 
přidání všech jeho součástí vortexujte mastermix 4-5 vteřin a teprve poté jej 
rozpipetujte do jamek destičky. Provádíte-li jakékoliv ředění, naředěnou směs vždy 
opět vortexujte. 

 
  Vzduchové Jsou-li v jamkách destičky vzduchové bubliny, může dojít k lomu a nepřesnostem 
         bubliny  měření fluorescenčního signálu. Pipetujte reagencie do jamek destičky takovým 

způsobem, aby nedocházelo ke tvorbě bublin. Pokud destička přeci jen obsahuje 
bubliny, je možné je odstranit náklonem destičky, poklepem na ní nebo krátkou 
centrifugací. 

 
Destička nebyla 
centrifugována 

Jsou-li PCR reagencie na spodní straně optické adhezívní fólie, může v důsledku 
ohřevu této fólie shora dojít k jejich připečení na fólii, což může vést k nepřesnostem 
měření fluorescenčního signálu. Destičku vždy krátce centrifugujte, aby byly všechny 
reagencie na dně jamek. 
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      Kapky Kapky reagencií na stěnách jamek destičky nemusí být v kontaktu s blokem a 
v konečném důsledku v nich nemusí proběhnout amplifikace. Sklouzne-li taková 
kapka na dno jamky v průběhu PCR, dojde k naředění amplifikovaného produktu a 
zkreslení výsledku v dané jamce ve srovnání s ostatními jamkami v rámci dané 
skupiny replikátů. Dbejte proto při přenosu destičky do přístroje 7900HT, aby 
nedocházelo k tvorbě kapek. Vytvoří-li se kapky, přijměte taková opatření, abyste se 
jich zbavili (např. centrifugace). 

 
Popis destiček   Na optické 384/96-ti jamkové destičky nebo optické kryty nepište. Fluorescenční 

látky v inkoustu mohou zkreslit výsledky měření fluorescence. Poznámky o obsahu 
jednotlivých jamek destičky veďte na list papíru nebo si vytiskněte zadání destičky 
(setup). 

 
Fluorescenční 

kontaminace 
destiček 

Mnohé v laboratořích používané látky jsou fluorescenční a dostanou-li se do 
kontaktu s optickými destičkami, může dojít ke zkreslení výsledků měření 
fluorescence. Například pudr používaný v rukavicích často obsahuje fluorescenční 
látky. Používejte proto pouze rukavice bez pudru a dotýkejte se destiček nebo 
optických víček pouze je-li to nezbytně nutné. 

 
Chyby Lidským chybám jako pipetování do nesprávné jamky nebo chyba v ředění se nelze 

úplně vyhnout.  
 

Chcete-li četnost těchto chyb snížit: 
 

•   Pipetujte systematicky. Například uspořádání vzorků v destičce by mělo být 
intuitivní (nenechávejte mezi vzorky prázdné jamky). 

•   Při pipetování mastermixu se dívejte přímo dolů na dno jamek, abyste viděli 
pipetovanou tekutinu. 

•   Přidáváte-li reagencie o malém objemu jako např. templát, pipetujte je na stěnu 
jamky. Poklepem nebo centrifugací pak dostanete tyto kapky na dno jamek. 

•   Po skončení pipetování se ujistěte, že v jamkách nejsou vytvořeny kapky.  
Poklepem nebo centrifugací dostanete tyto kapky na dno jamek 

•   Provádíte-li sériová ředění, vyměňte po každém ředícím kroku špičku. 
•   Provádějte vizuální kontrolu,  že pipetovaný objem je přibližně správný. 

Běžnou chybou je použití nesprávného pipetmanu (nastavení 20 µL namísto 
2.0 µL). 

•   Provádějte vizuální kontrolu celkového objemu reakce. Soustřeďte se na 
vyhledání jamek, jejichž objem se liší od ostatních jamek. 

 
Kontaminace 

bloku na vzorky 
Jakákoliv kontaminace bloku na vzorky může mít vliv na výsledky. Například 
minerální olej omezuje přenos tepla. Psaní na reakční jamku může vést k absorbci 
světla. 
 

Je zapotřebí provádět pravidelnou kontrolu čistoty bloků na vzorky. Případnou 
kontaminaci v bloku na vzorky můžete zjistit pomocí běhu s destičkou pro kalibraci 
pozadí a následnou analýzou výsledků z hlediska přítomnosti píků s intenzitou signálu 
vyšší než 2500 FSU (viz strana 7-16). Návod na dekontaminaci bloku na vzorky viz 
strana 7-14. 
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Nesprávný 
nebo 

poškozený 
spotřební 

plast 

Na přístroji ABI PRISM 7900HT používejte pouze optické reakční destičky ABI 
PRISM, optické adhezívní fólie a optická plochá víčka ABI PRISM. Plast pro výrobu 
optického spotřebního materiálu je speciálně testován z hlediska přítomnosti 
fluorescenčních kontaminací. Optické reakční destičky jsou matné, aby přesněji 
odrážely světlo. Ohnuté, zdeformované nebo jinak poškozené destičky mohou mít 
vliv na přenos fluorescenčního signálu nebo bránit těsnému uzavření pomocí fólie, 
což může vést k evaporaci, změnám v objemu vzorků a chemizmu reakce. Ujistěte se, 
že používáte odpovídající spotřební materiál a každou destičku před použitím 
zkontrolujte. 
 

Poznámka:  Soupis spotřebního materiálu a reagencií naleznete v příloze C “Kity, 
reagencie a spotřební materiál”. 

 
Nízká 

koncentrace 
templátu 

Amplifikujete-li vzorky obsahující velmi nízká množství nukleových kyselin 
(obecně méně než 100 molekul), musíte předpokládat nižší přesnost díky 
Poissonovské distribuci. Templát o nízké koncentraci je rovněž více náchylný ke 
ztrátám kvůli nespecifické adhezi na plastové jamky, pipetovací špičky apod. 
Přídavek nosičové nukleové kyseliny jako je kvasinková tRNA nebo glykogenu 
může těmto ztrátám zabránit a tím zvýšit přesnost a citlivost eseje. 

 
Používání 

reagencií od 
jiných dodavatelů 

Pufr společnosti Applied Biosystems obsahuje vnitřní pasivní referenci (barva 
ROX™), která slouží k normalizaci fluorescenčního signálu vzorků (viz strana D-6). 
 

DŮLEŽITÉ!  PCR pufry jiných dodavatelů nemusí obsahovat pasivní referenci ROX. 
Při používání těchto pufrů musíte nastavit odpovídající pasivní referenci podle 
postupu v části “Nastavení pasivní reference” na straně 3-16. 

 

 Uživatelská příručka pro Real-Time PCR systém ABI PRISM 7900HT 8-8 



  

  

 

Jev Možná příčina Doporučený krok 

Byl zvolen nesprávný typ 
destičky během zadání  

Proveďte novou kalibraci 
pozadí a definujte 
správný typ destičky. 

Software neprovede 
extrakci pozadí 

Pozadí je příliš vysoké 
(≥ 2500 FSUa) 

Viz níže. 

Kontaminace bloku na 
vzorky 

Pozadí je příliš vysoké 
(=>2500 FSU) 

Kontaminace destičky pro 
kalibraci pozadí 

1.  Vytvořte novou destičku 
pro kalibraci pozadí. 

2.  Viz “Vyhledání 
kontaminovaných 
jamek v bloku” níže 
 

 

           Kalibrace pozadí 
 
 

Kalibrace pozadí 
 
 
Řešení problémů Tabulka 8-2 Řešení problémů kalibrace pozadí 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

a  Fluorescenční standardní jednotky – zobrazovány na ose Y grafu kalibrace pozadí. 
 

 
Vyhledání 

kontaminovaných 
jamek v bloku 

Signál přesahující hodnotu 2500 FSU je považován za signál převyšující normální 
úroveň fluorescence pozadí a je známkou toho, že je buď destička pro kalibraci 
pozadí nebo blok na vzorky kontaminován. 
 

1.   Není-li již otevřen, otevřete dokument destičky pro kalibraci pozadí. 
 

2.   Klikněte na ikonu  (Skrýt/zobrazit hrubá data). 
Program SDS zobrazí hrubá data pro běh kalibrace pozadí. 

 

3.   Zvolte všechny jamky. 
 

4.   Zkontrolujte spektrální profil. 
 

Jamky, v nichž signál přesahuje hodnotu 2500 FSU, mohou být kontaminovány. 
Na následujícím obrázku jsou znázorněna hrubá data získaná s blokem na vzorky, 
v němž je jedna jamka kontaminována. 

 

 
 
 
 

Možná kontaminace 
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Kapitola 8    Řešení problémů 
 
 

5.   Výběrem stále nižšího počtu jamek v destičce identifikujte, která jamka/jamky 
v bloku na vzorky je kontaminována (viz níže). 

 
a.    Hrubá data 

zvolených jamek 
obsahují 
problémový pík. 
Kontaminovaná 
jamka je ve 
sloupcích 7-12. 

 
 
 
 
b.    Hrubá data 

zvolených jamek 
neobsahují 
problémový pík. 
Kontaminovaná 
jamka je 
v posledních 
čtyřech jamkách 
sloupců 7-12. 

 

 
c.   Hrubá data 

zvolených jamek 
obsahují 
problémový pík. 
Kontaminovaná 
jamka je 
v posledních 
čtyřech jamkách 
sloupců 10-12. 

 
 
 
d.   Hrubá data 

zvolených jamek 
obsahují 
problémový pík. 
Kontaminovaná 
jamka je 
v posledních dvou 
jamkách sloupců 
10-12. 

 
 
e.    Postupnou volbou 

jedné jamky za 
druhou zjistíte 
kontaminovanou 
jamku (G10). 
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Jev Možná příčina Doporučený krok 

Byl zvolen nesprávný typ 
destičky během zadání  

Proveďte novou kalibraci 
barev a definujte správný 
typ destičky. 

Software neprovede 
extrakci barev 

Před kalibrací barev nebyla 
provedena kalibrace pozadí 
 

Proveďte kalibraci pozadí a 
pak kalibraci barev 

Hrubá data kalibrace 
barev vypadají divně 
(viz níže) 

Destička pro kalibraci 
barev byla založena 
opačně 

1.  Ověřte, že vlnové délky 
jednotlivých barev 
odpovídají předpokladu. 

2.  Proveďte znovu běh. 

 

Saturace signálu 

Signál je příliš nízký 
(< 10,000 FSU) 

Intenzita je nastavena příliš 
vysoko/nízko 

Kontaktujte technickou 
podporu Applied Biosystems. 

Více než dva odlehlé body 
pro danou barvu v jedné 
řadě 

•   Evaporace 

•   Kontaminace 
Opakujte běh. 

Pokud problém přetrvává, 
použijte novou destičku pro 
kalibraci barvy. 

 

Kalibrace barev 
 
 

6.   Opakujte krok 4 dokud neidentifikujete všechny kontaminované jamky. 
 

7.   Proveďte dekontaminaci bloku na vzorky podle postupu v části “Dekontaminace 
bloku na vzorky” na straně 7-14. 

 

8.   Proveďte kalibraci pozadí, abyste se ujistili, že se podařilo kontaminaci 
      odstranit. 

 

Je-li kontaminace přítomna i po druhém běhu kalibrace pozadí, je 
pravděpodobným zdrojem kontaminace destička pro kalibraci pozadí. 

 
 

Kalibrace barev 
 
Řešení problémů Tabulka 8-3 Řešení problémů kalibrace barev 
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Kapitola 8    Řešení problémů 
 
 

Eseje v reálném čase (Kvantitativní PCR a analýza disociační 
křivky) 

 
 

Řešení 
problémů 

Dostanete-li atypické výsledky, můžete použít program SDS ke zjištění jejich 
možných příčin, ať již souvisejí s chemizmem reakcí nebo s přístrojem. Níže jsou 
uvedena doporuční stran postupu hledání příčin různých problémů. 

 
       Hrubá data  Graf hrubých dat (Raw Data) zobrazuje neanalyzované fluorescenční signály (před 

provedením normalizace) pro zvolené jamky v průběhu každého cyklu Real-Time 
PCR. 

 
Na co se soustředit: 

 

•   Signály jsou uniformní – Jsou hrubá spektra jednotlivých skupin replikátů 
obdobná? Pokud ne, destička nebo blok na vzorky by mohly být kontaminovány. 

•   Charakteristický tvar signálu – Jsou vrcholy píků v odpovídajících vlnových 
délkách? Např. vzorky obsahující pouze barvou FAM™  značené sondy 
TaqMan®  by neměly generovat signál ve vlnové délce odpovídající barvě 
VIC®. Takový signál může být známkou kontaminace vzorku, mastermixu 
nebo jamky. 

•   Charakteristický nárůst signálu – Posunete-li posuvník ve směru k vyšším 
cyklům PCR, dochází k nárůstu signálu podle očekávání? Nedojde-li k nárůstu, 
může to být známkou pipetovací chyby (jamka neobsahuje templát). 

•   Saturace signálu (plató) – Dochází k saturaci signálu? Pokud ano, může to být 
známkou, že jamka obsahuje příliš mnoho templátu nebo fluorescenční barvy. 

 
Multikomponentní 

graf 
Multikomponentní graf slouží k zobrazení normalizovaných signálů jednotlivých 
barev ze zvolené jamky. Zobrazují se signály barev přispívajících k celkovému 
složenému signálu dané jamky. 
 
Na co se soustředit: 
 

•   Zobrazují se správné barvy – Jsou v grafu zobrazeny všechny předpokládané 
barvy? Je-li zobrazena nepředpokládaná barva, může to znamenat chybu 
v definici detektoru, jako např. zadání nesprávné reportérové barvy nebo 
zhášeče. 

•   Fluorescenční signál ROX – Je fluorescence ROX nižší než fluorescence 
reportérových barev? Pokud nikoliv, je možné, že příslušná reportérová barva 
resp. jí značená sonda nebyla pipetována do jamky (pipetovací chyba). 

•   Fluorescence pozadí – Je signál všech barev vyšší než pozadí? Není-li tomu tak, 
je velmi pravděpodobné, že v dané jamce nejsou sondy značené touto barvou 
(jamka neobsahuje sondu, mastermix nebo obojí). 

•   Úroveň MSE –MSE (mean squared error – střední kvadratická chyba) vyjadřuje 
jak přesně multikomponentní data odpovídají hrubým datům. Čím vyšší je 
hodnota MSE, tím vyšší je rozdíl mezi multikomponentními a hrubými daty. 
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Eseje typu End-Point (Alelická diskriminace)    
 
 
Amplifikační graf Amplifikační graf zobrazuje výsledky běhů v reálném čase po normalizaci a 

miltikomponentní analýze. Umožňuje nastavit pozadí (baseline) a práh 
pro daný běh. 

 
Na co se soustředit: 

 

•   Správné nastavení pozadí a prahu – Jsou pozadí a práh nastaveny správně? 
Identifikujte jednotlivé části amplifikační křivky a nastavte pozadí tak, aby 
nárůst amplifikační křivky začínal v cyklu, který má vyšší pořadové číslo, než 
je pořadové číslo horní hranice rozsahu cyklů pro odečet pozadí. 
 

 

DŮLEŽITÉ!  Neměňte přednastavený rozsah cyklů pro odečet pozadí pokud 
nárůst amplifikační křivky začíná až po 15. cyklu. 

 

Identifikujte jednotlivé části amplifikační křivky a nastavte práh tak, aby byl: 
•   Vyšší než pozadí 
•   Níže než je fáze plató a lineární fáze 
•   V exponenciální fázi amplifikační křivky 

•   Nepravidelný průběh amplifikace – Amplifikovaly se všechny vzorky 
normálně? V každé křivce byste měli být schopni identifikovat tři fáze 
amplifikace. 

•   Odlehlé body – Zobrazíte-li výsledky v grafu závislosti CT na pozici 
jamky, jsou výsledky replikátů srovnatelné? CT hodnoty jamek, které se 
výrazně liší od průměru skupiny replikátů, do níž patří, lze považovat za 
odlehlé body. 
Nejsou-li výsledky replikátů srovnatelné, mohlo dojít k odpaření  některých 
vzorků. Ujistěte se, že destička je těsně uzavřena optickou adhezívní fólií. 

 
 

Eseje typu End-Point (Alelická diskriminace) 
 
 
Řešení problémů Dostanete-li atypické výsledky, můžete použít program SDS ke zjištění jejich 

možných příčin, ať již souvisejí s chemizmem reakcí nebo s přístrojem. Níže jsou 
uvedena doporuční stran postupu hledání příčin různých problémů. 

 
Hrubá data Graf hrubých dat (Raw Data) zobrazuje neanalyzované fluorescenční signály (před 

provedením normalizace) pro zvolené jamky v průběhu každého cyklu PCR. 
 

Na co se soustředit... 
 

•   Signály jsou uniformní – Jsou hrubá spektra jednotlivých skupin replikátů 
obdobná? Pokud ne, destička nebo blok na vzorky by mohly být 
kontaminovány. 

•   Charakteristický tvar signálu – Jsou vrcholy píků v odpovídajících vlnových 
délkách? Např. vzorky obsahující pouze barvou FAM™  značené sondy TaqMan®  

by neměly generovat signál ve vlnové délce odpovídající barvě VIC®. Takový 
signál může být známkou kontaminace vzorku, mastermixu nebo jamky. 

•   Saturace signálu (plató) – Dochází k saturaci signálu? Pokud ano, může to být 
známkou, že jamka obsahuje příliš mnoho templátu nebo fluorescenční barvy. 
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Jev Možná příčina Doporučený krok 

Nelze dokončit instalaci 
(instalační program jakoby 
nereaguje) 

Okno instalačního 
programu je skryté 

1.  Stiskněte a držte klávesu Alt. 
 

2.  Stiskněte klávesu Tab a 
zvolte ikonu instalačního 
programu. 

3.  Uvolněte obě klávesy. 
 

Okno instalačního programu se 
zobrazí. 

Verze 2.0 programu SDS po 
instalaci verze 2.2 nefunguje 

Verze 2.0 programu 
SDS je při instalaci 
automaticky 
odstraněna 

Instalujte znovu program  
SDS, verze 2.0 

Postupujte podle návodu níže 
dokud problém nezmizí. 

 

1 

1.  Vypněte přístroj 7900HT. 

2.  Zkontrolujte propojení kabely. 
 

3.  Restartujte počítač a 
přihlašte se do něj. 

4.  Zapněte přístroj 7900HT. 

5.  Spusťte program SDS.  

 

2 

6.  Restartujte počítač a 
přihlašte se do něj. 

7.  Instalujte znovu program SDS. 

8.  Spusťte program SDS. 
 

3 

Při problémech s operačním 
systémem nebo pokud počítač 
vůbec nelze spustit kontaktujte 
servisní oddělení Applied 
Biosystems. Může být zapotřebí 
reinstalovat operační systém. 

 

4 

Program SDS nelze spustit 

Program vede k “zamrznutí” 
počítače nebo k zobrazení 
chybové hlášky 

•   Nesprávné pořadí 
zapnutí 

•   Poškozený program 

•   Selhání hardwaru 
•   Poškození 

operačního systému 
•   Uvolněný kabel 
čtečky čárových 
kódů 

Při problémech s hardwarem 
kontaktujte firmu Dell. 

Kapitola 8    Řešení problémů 
 
 

Software a přístroj 7900HT 
 
 
Řešení problémů Tabulka 8-4 Řešení problémů se softwarem a počítačem 
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Software a přístroj 7900HT    
 
 

 Tabulka 8-4 Řešení problémů se softwarem a počítačem 
 

Jev Možná příčina Doporučený krok 

Komunikační chyba Nesprávně propojené 
kabely 

Ověřte propojení kabelů a 
nastavení portu COM. Viz 
“Zapojení přístroje” na straně 
1-11. 

Chyby teplotního cyklování Blok na vzorky není 
správně umístěn 

Umístěte blok na vzorky do 
přístroje podle postupu v části  
“Výměna bloku na vzorky” na 
straně 7-6. 

Program Automation 
Controller nenalezl soubor 
destičky 

Soubor není 
umístěn tam, kde 
má být 

Odstraňte záznam z řady 
destiček a znovu jej přidejte. 

Zobrazí se dialogové okno 
Run Completed Successfully 
(Běh úspěšně ukončen), ale 
počítač nereaguje 

Java Runtime Error Kliknutím uzavřete dialogové 
okno. 

Chybí kalibrační soubor 

Nebyla provedena 
kalibrace pozadí 

Nebyla provedena 
kalibrace barev  
 

Součástí kalibračního 
souboru nejsou data 
pro barvu, která je 
součástí dokumentu 
destičky 

Kalibrační soubor 
byl vytvořen na 
jiném přístroji 

Proveďte kalibraci pozadí a 
barev. 

 

Viz “Provedení kalibrace 
pozadí” na straně 7-16 a 
“Provedení kalibrace barev” 
na straně 7-20. 

Disk, na němž je 
dokument destičky 
uložený, má méně než 
50 MB volného místa 

Ověřte kapacitu disku. Je-li 
na něm méně než 50 MB 
volného místa, odstraňte 
nebo archivujte datové 
soubory (viz strana 7-54). 

Vyhřívané víko nemůže 
dosáhnout požadované 
teploty, protože v 
nosítkách není destička 

V nosítkách přístroje je 
destička 

Otevřete nosítka přístroje a 
ověřte, že v nich je destička. 

Běh nezačne 

Věž na zpracované 
destičky obsahuje 
destičku/y  

Vyjměte všechny destičky 
z věže předtím, než 
spustíte analýzu řady 
destiček. 
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Kapitola 8    Řešení problémů 
 
 

 Tabulka 8-4 Řešení problémů se softwarem a počítačem 
 

Jev Možná příčina Doporučený krok 

Pevný disk je 
fragmentován 

Defragmentujte pevný disk podle 
postupu v části “Defragmentace 
pevného disku” na straně 7-54. 

Počítač je při analýze dat, 
otevírání a zavírání 
dialogových oken a dalších 
krocích pomalý. 
Nelze se přihlásit do 
operačního systému 
Windows. 

Pevný disk je téměř 
plný 

Odstraňte nebo archivujte 
datové soubory (strana 
7-54). 

Okno Logon 
(Přihlášení) se neobjeví 

Restartujte počítač a přihlaste 
se do něj  

Nejste přihlášeni jako 
Administrator 

1.  Odhlaste se z počítače. 

2.  Přihlaste se znovu jako 
Administrator. 

Počítač nelze vůbec spustit. 
Počítač je při analýze dat, 
otevírání a zavírání 
dialogových oken a dalších 
krocích pomalý. 
Nelze se přihlásit do 
operačního systému Windows. 

Zkusili jste shora 
uvedené možnosti 
ale problém to 
neřeší. 

Kontaktujte technickou podporu 
firmy Dell. 

Zkontrolujte propojení kabelů. Nesprávné propojení 
kabelů 

1.  Spusťte počítač pomocí 
instalačního CD 
Windows NT®  Operating 
System Installation CD. 

 

2.  Spusťte počítač ze 
záchranného disku. 

3.  Instalujte znovu operační 
systém Windows NT.  

Počítač nelze vůbec spustit. 

Zkusili jste shora 
uvedené možnosti 
ale problém to 
neřeší. 

Kontaktujte technickou podporu 
firmy Dell. 
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Jev Možná příčina Doporučený krok 

Vertikální pozice (nastavení 
vertical offset) je příliš nízko 

Rameno podavače vydává 
při zvedání či ukládání 
destiček skřípavý zvuk 

Senzor destiček je 
nastaven příliš vysoko 

Rameno podavače se při 
zvedání či ukládání desti-
ček dotýká úložných věží 

Rameno podavače 
umisťuje destičky do 
úložných věží s problémy 

Destičky se při umístění do 
nosítek přístroje pomocí 
ramene podavače naklánějí 

Výchozí rotační pozice 
ramene je nesprávně 
definována nebo je 
vertikální pozice příliš nízko  

Seřiďte znovu rameno 
podavače podle postupu 
v části “Seřízení ramene 
podavače” na straně 7-41. 

Senzor destiček není 
správně seřízen 

Seřiďte senzor destiček 
podle postupu v části 
“Nastavení citlivosti senzoru 
destiček” na straně 7-37. 

Rameno podavače 
nerozezná nebo neuchopí 
destičku 

Podložky ramene jsou 
opotřebované nebo špinavé   

Vyměňte podložky ramene 
podle postupu v části 
“Čistění a výměna podložek 
ramene” na straně 7-52. 

Destičky se lepí na podložky 
ramene 

Podložky ramene jsou 
opotřebované nebo špinavé   

Vyměňte podložky ramene 
podle postupu v části 
“Čistění a výměna podložek 
ramene” na straně 7-52. 

Rameno podavače 
neumisťuje destičky na 
jejich původní místo 

Nebyla zvolena možnost 
Restack when finished 
(Po skončení přeskládat) 

Nastavte program 
Automation Controller 
podle postupu na straně 
4-40. 

Čtečka není seřízena Pevně umístěná čtečka 
čárových kódů nečte 
čárové kódy 

Čtečka je poškozena 

Seřiďte čtečku podle 
postupu v části “Seřízení 
pevně umístěné čtečky 
čárových kódů” na straně 
7-49. 

 

Podavač mikrodestiček Zymark Twister a pevně umístěná čtečka čárových kódů     
 
 

Podavač mikrodestiček Zymark Twister a pevně umístěná 
čtečka čárových kódů 

 
 
Řešení problémů Tabulka 8-5 Řešení problémů s příslušenstvím pro automatický provoz 
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Jev Možná příčina Doporučený krok 

Po vyjmutí mikrofluidní 
karty z obalu jsou plnící 
rezervoáry poškozené 
(zmačkané, ohnuté). 

- Jsou-li plnící rezervoáry 
poškozené, reakční směs 
se nemusí dostat při 
centrifugaci do reakčních 
jamek. 
 
Mikrofluidní kartu vyhoďte. 

Po vyjmutí mikrofluidní 
karty z obalu je její krycí 
hliníková fólie poškozena. 

- Je-li hliníková fólie 
poškozena, reakční směs 
se nemusí dostat při 
centrifugaci do reakčních 
jamek. 
 
Mikrofluidní kartu vyhoďte. 

Po vyjmutí mikrofluidní 
karty z obalu se na 
reakčních jamkách usazuje 
prach nebo jiné nečistoty.  

- Odstraňte prach nebo 
nečistoty poklepáním nebo 
ofouknutím mikrofluidní 
karty. 
Lze použít i stlačený dusík 
nebo fén. 

DŮLEŽITÉ!  Ujistěte 
se, že prach i částice 
byly odstraněny. 
Reakční jamky 
mikrofluidní karty musí 
být čisté, nesmí na nich 
ulpívat zejména 
fluorescenční částice 

Po vyjmutí mikrofluidní 
karty z obalu na ní 
kondenzuje vlhkost. 

Mikrofluidní karta nebyla před 
vyjmutím z obalu ohřáta na 
pokojovou teplotu. 

Odstraňte vlhkost pomocí 
ofouknutí mikrofluidní karty 
stlačeným dusíkem nebo 
pomocí fénu. 

DŮLEŽITÉ!  Ujistěte se, že 
veškerá kondenzovaná 
vlhkost byla odstraněna. 
Reakční jamky mikrofluidní 
karty musí být bez jakékoliv 
kondenzované vlhkosti. 

Kapitola 8    Řešení problémů 
 
 

Mikrofluidní karta 
 
 
   Řešení problémů Tabulka 8-6 Řešení problémů s mikrofluidní kartou  
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  Mikrofluidní karta 
 
 

Tabulka 8-6 Řešení problémů s mikrofluidní kartou 
 

Jev Možná příčina Doporučený krok 

Podařilo se napipetovat 
příliš málo reakční směsi 
do plnícího rezervoáru. 

Při pipetování reakční směsi 
dochází k jejímu úniku 
vzduchovým otvorem 
plnícího rezervoáru. 

Reakční směs nebyla 
správně pipetována do 
plnícího rezervoáru. 

Při pipetování reakční 
směsi (100 µL) do 
plnícího rezervoáru je 
nezbytné postupovat 
velmi pečlivě. 

1.  Postupujte podle 
návodu v části “Plnění 
mikrofluidních karet” na 
straně 4-13. 

 

2.  Po provedení centrifugace 
zkontrolujte hladinu 
tekutiny v plnících 
rezervoárech podle kroku 
6 na straně 4-17 
 

Během PCR dochází ke 
ztrátám reakční směsi. 
 

Při zaslepení karty mohlo 
dojít k poškození hliníkové 
fólie. 

Mikrofluidní kartu vyhoďte. 

Poznámka:  Zaslepování 
karet - viz “O nástroji na 
zaslepení karet” na straně 
4-13. 

Po výpočtu průměru a 
standardní odchylky 
skupiny replikátů se 
specifický replikát jeví 
jako odlehlý bod. 

- Pro daný replikát 
zkontrolujte 
multikomponentní graf. 
Odlehlý bod vypusťte a 
výsledky znovu analyzujte. 
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Jev Možná příčina Doporučený krok 

Nelze se připojit k databázi - Chcete-li otestovat nebo 
resetovat propojení s 
databází: 

1.  Spusťte program SDS. 
 

2.  Přihlašte se do databáze 
jako uživatel s právy 
administrátora. 

3.  Otestujte a upravte 
propojení s databází 
podle postupu v části 
“Úprava propojení s 
databází” na straně 
A-23. 

Chybová hláška: 
 

java.sql.SQLException: 

Io exception: End of 

TNS data channel 

Zřídka se vyskytující 
chybová hláška (při 
archivaci nebo 
otevírání velkých 
datových souborů 
z databáze). 

Opakujte krok archivace 
nebo otevírání dat 
z databáze. 

 

Kapitola 8    Řešení problémů 
 
 

Databáze SDS Enterprise 
 
 
Řešení problémů Tabulka 8-7 Řešení problémů s databází SDS Enterprise 
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Nástroje programu SDS A 
 
 
 
 

V této příloze Import zadání dokumentu destičky ........................................................................A-2 
Soubory zadání ......................................................................................................A-4 
Export obrázků.....................................................................................................A-16 
Export údajů z dokumentů destičky.....................................................................A-16 
Ovládání programu SDS z příkazové řádky ........................................................A-18 
Vyhledávání .........................................................................................................A-19 
Propojení programu SDS s databází ....................................................................A-21 
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Příloha A   Nástroje programu SDS 
 
 

Import zadání dokumentu destičky 
 
 

O importu 
 

Program SDS umožňuje provádět import zadání dokumentu destičky (detektor, 
úloha detektoru, marker a názvy vzorků) do dokumentu destičky ze souboru ve 
formátu *.txt (tabelátorem oddělená data). Jedná se o nástroj umožňující 
vytváření zadání dokumentů destiček v jiném programu než v programu SDS a 
jejich následný import do programu SDS, což vede k úspoře času. 
 

Aby byl zajištěn úspěšný import dat z textového souboru do dokumentu destičky, 
musí data v tomto souboru: 
 

•   být oddělena pomocí tabelátoru 
•   odpovídat formátům popsaným na straně A-15 

 
 

Vytvoření a 
import zadání 

dokumentu 
destičky 

Import zadání do dokumentu destičky se provádí ve třech hlavních krocích. 
 
Vytvoření prázdného zadání 
 

Prvním krokem je export zadání z prázdného dokumentu. 
 

Poznámka:  Soubor zadání lze vytvořit i pomocí dalších programů (jako Microsoft 
Excel nebo textový editor) – data musí být oddělena tabelátorem a mít formát 
popsaný na straně A-15. 
 

1.   Spusťte program SDS. 
 

2.   Klikněte na ikonu  nebo zvolte File > New (Soubor > Nový). 
 

3.   V dialogovém okně New Document (Nový dokument) zvolte odpovídající typ 
eseje a formát destičky a klikněte . 

 

4.   Klikněte  nebo zvolte File > Export (Soubor > Export). 
 

5.   V poli Look In (Vyhledat) dialogového okna Export vyhledejte adresář, do 
kterého chcete uložit exportovaný soubor. 

 

6.  Zvolte Export > Setup Table (Zadání). 
 

7.   Zvolte tlačítko All Wells (Všechny jamky). 
 

8.   Zvolte tlačítko SDS 2.2. 
 

9.   Klikněte do pole File name (Název souboru) a zadejte název souboru. 
 

10.   Klikněte . 
 

Program exportuje zadání prázdného dokumentu destičky ve formátu 
souboru *.txt (data oddělená tabelátorem). 

 

11.   Vytvořte zadání dokumentu destičky (detektor, úloha, marker a údaje o 
vzorcích) podle postupu na straně A-3. 
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Import zadání dokumentu destičky    
 
 

Zadání údajů do prázdného souboru zadání 
 

Druhým krokem je import prázdného souboru zadání do nějakého jiného 
programu, zadání informací o vzorcích a detektorech a uložení ve formátu *.txt 
(tabelátorem oddělená data). 

 

1.   Spusťte program, který chcete použít pro vytvoření zadání dokumentu destičky. 
 

2.   Importujte prázdné zadání vytvořené v předchozím kroku jako soubor *.txt. 
 

Používáte-li pro vytváření zadání tabulkový procesor, budou tabelátorem 
oddělená data automaticky vložena do buněk tabulky. 

 

3.   Zadejte informace o vzorcích a detektorech v souladu s formátem souboru podle 
      popisu na straně A-4. 

 

4.   Uložte zadání ve formátu *.txt (tabelátorem oddělená data).. 
 

5.   Importujte hotové zadání do prázdného dokumentu destičky podle postupu níže. 
 

Import hotového zadání do dokumentu destičky 
 

Posledním krokem je import hotového zadání ve formátu *.txt (tabelátorem oddělená 
data) do prázdného dokumentu destičky. 

 

1.   Pokud je v programu SDS stále otevřen dokument destičky vytvořený v části 
“Vytvoření prázdného zadání” na straně A-2, pokračujte krokem 2. Jinak 
vytvořte dokument destičky, do nějž budete importovat zadání: 

a.  Spusťte program SDS. 
 

b.  Vytvořte nebo otevřete dokument destičky, do nějž budete importovat 
zadání. 

 

2.   Klikněte  nebo zvolte File > Import (Soubor > Import). 
 

3.   V poli Look In (Vyhledat) dialogového okna Import vyhledejte a zvolte zadání 
dokumentu destičky ve formátu *.txt (tabelátorem oddělená data), vytvořené 
v kroku 4 výše. 

 

4.   Klikněte . 

Program importuje zadání dokumentu destičky z textového souboru a 
automaticky v něm rozezná informace týkající se detektorů, úloh detektorů, 
markerů a údajů o vzorcích. 
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Příloha A   Nástroje programu SDS   

  

 
 

Soubory zadání 
 
 

O souborech 
zadání 

Program SDS umožňuje provádět import zadání dokumentu destičky do dokumentu 
destičky ze souboru ve formátu *.txt (tabelátorem oddělená data). Aby byl zajištěn 
úspěšný import dat z textového souboru do dokumentu destičky, musí data v tomto 
souboru odpovídat formátu uvedenému níže. 

 
                 Formát Informace obsažené v souboru zadání musí být seřazeny následujícím způsobem: 

 

1. Verze souboru (viz strana A-5) 
 

Údaje o destičce 
 

2. Velikost destičky (viz strana A-5) 
3. Identifikace destičky (viz strana A-5) 

 

Údaje o detektorech 
 

4. Počet detektorů (viz strana A-6) 
5. Záhlaví seznamu detektorů (viz strana A-6) 
6. Seznam detektorů (viz strana A-7) 

 

Údaje o markerech 
 

7. Počet markerů (pouze alelická diskriminace) (viz strana A-8) 
8. Záhlaví seznamu markerů (pouze alelická diskriminace) (viz strana A-8) 
9. Seznam markerů (pouze alelická diskriminace) (viz strana A-9) 

 

Detektory v jamkách 
 

10. Záhlaví seznamu detektorů použitých v daných jamkách (viz strana A-10) 
11. Seznam detektorů použitých v daných jamkách (viz strana A-10) 

 

Markery v jamkách 
 

12. Záhlaví seznamu markerů použitých v daných jamkách (pouze alelická 
diskriminace) (viz strana A-12) 
13. Seznam markerů použitých v daných jamkách (pouze alelická diskriminace) 
(viz strana A-12) 

 
Používání textu Níže je text používán následujícím způsobem: 

 

•   courier – Text zobrazený tímto fontem (tučně) musí být v zadání naprosto 
shodně jako je uveden zde. 

•   kurzíva – Text kurzívou je v zadání nahrazen konkrétním textem podle typu 
zadávaných údajů. 

•   [ požadovaný text ] – Text v hranatých závorkách musíte zadat, aby 
jej program SDS mohl importovat. 

•   { volitelný text } – Text ve složených závorkách můžete ale nemusíte 
zadat. 

•   <tab> – klávesa Tabelátor 
•   <cr> – klávesa Enter  

 

DŮLEŽITÉ!  Aby import proběhl úspěšně, musí být v souboru všechny součásti 
a v pořadí popsaném níže. 
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  Soubory zadání   

  

 
 
1. Verze souboru 

 

 
  Popis V této řádce je uvedena verze formátu (file version) souboru SDS Assay Plate File. 

 

Poznámka:  Verze  4 a vyšší nelze importovat přímo do programu SDS 2.0 nebo 
SDS 2.1. 

 
Formát [ *** SDS Setup File Version <tab> version number <cr> ] 

 
   Příklad *** SDS Setup File Version 3 

 

 

Údaje o destičce 
 
 

2. Velikost destičky 
 

 
         Popis V této řádce je uveden počet jamek (number of wells) destičky (384 nebo 96). 

 
Formát [ *** Output Plate Size <tab> number of wells <cr> ] 

 
   Příklad *** Output Plate Size 384 

 

 

3. Identifikace destičky 
 

 
         Popis V této řádce je uvedena identifikace destičky (plate id). Za normální situace je to 
                            čárový kód. 

 
Formát [ *** Output Plate ID <tab> plate id <cr> ] 

 
   Příklad *** Output Plate ID 384N75822034 
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Příloha A   Nástroje programu SDS   

  

 
 

Údaje o detektorech 
 

V bodech 4 až 6 jsou definovány detektory, které se následně používají v popisu 
jednotlivých jamek níže. Údaje o detektorech jsou trojího druhu: počet detektorů, 
záhlaví seznamu detektorů a seznam detektorů. 

 
 

4. Počet detektorů 
 

         Popis V této řádce je uveden celkový počet detektorů (number of detectors) v destičce.  

 

Formát 
 
[ *** Number of Detectors <tab> number of detectors <cr> 

 
]

 
   Příklad *** Number of Detectors 5 

 

 

5. Záhlaví seznamu detektorů 
 

 
         Popis V této řádce je uvedeno záhlaví seznamu detektorů (Detectors List Header) 

souboru zadání, což umožňuje snazší úpravy souboru zadání v programech jako 
je Microsoft Excel. 

 
Formát [ Detector <tab> Reporter <tab> Quencher <tab> Description <tab> 

Comments <cr> ] 

 
   Příklad 

 
 
Příklad A-1 Záhlaví seznamu detektorů 

 
Detector Reporter Quencher Description Comments 
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  Soubory zadání   

  

 

 

6. Seznam detektorů 
 
 

Popis Seznam detektorů (Detectors List) sestává z jedné nebo více řádek zobrazujících 
informace o každém detektoru používaném v dokumentu destičky. 

 

•   Informace o každém detektoru používaném v destičce musí být v seznamu 
detektorů v jediné řádce. 

•   Počet řádek v seznamu detektorů musí být roven počtu detektorů definovaném 
v části Počet detektorů (viz bod 4 výše). 

•   Pro detektory používající barvu SYBR Green I nebo nefluorescenční zhášeč 
ponechte pole zhášeč (Quencher) prázdné. 

 
Formát (pro 

jeden detektor): 
[ detector name <tab> reporter dye <tab> quencher dye <tab> 

description <tab> comments <cr> ] 

 

 

Příklady: 
 
Příklad A-2 Alelická diskriminace 

 
*** SDS Setup File Version 3 

*** Output Plate Size 384 

*** Output Plate ID 384N75822034 

*** Number of Detectors 2 

Detector Reporter Quencher Description Comments 
CYP 2C9*2.1 FAM  PDAR CYP 2C9*2 Al1 Example Probe

CYP 2C9*2.2 VIC  PDAR CYP 2C9*2 Al2 Example Probe

...     
 
Příklad A-3 Absolutní nebo relativní kvantifikace 

 
*** SDS Setup File Version 3 

*** Output Plate Size 96 

*** Output Plate ID 96JG729FF903 

*** Number of Detectors 3 

Detector Reporter Quencher Description Comments 
GAPDH VIC  GAPDH Probe Example Probe

SYBR Green SYBR  SYBR Green I Example Probe

RNase P FAM TAMRA RNase P Probe Example Probe

...     
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Příloha A   Nástroje programu SDS   

  

 
 
Údaje o markerech 

 
V bodech 7 až 9 jsou definovány markery, které se následně používají v popisu 
jednotlivých jamek níže. Údaje o markerech jsou trojího druhu: počet markerů, 
záhlaví seznamu markerů a seznam markerů. 

 
 

7. Počet markerů (pouze alelická diskriminace) 
 

DŮLEŽITÉ!  Údaj o počtu markerů je požadován pouze v zadání dokumentů 
alelické diskriminace. Neobjevuje se v dokumentech absolutní nebo relativní 
kvantifikace. 

 

         Popis V této řádce je uveden celkový počet markerů (number of markers) v destičce.  

 

Formát 
 
[ *** Number of Markers <tab> number of markers <cr> 

 
]

 
   Příklad *** Number of Markers 2 

 

 

8. Záhlaví seznamu markerů (pouze alelická diskriminace) 
 

DŮLEŽITÉ!  Údaj o záhlaví seznamu markerů je požadován pouze v zadání 
dokumentů alelické diskriminace. Neobjevuje se v dokumentech absolutní nebo 
relativní kvantifikace. 

 
        Popis V této řádce je uvedeno záhlaví seznamu markerů (Markers List Header) souboru 

zadání, což umožňuje snazší úpravy souboru zadání v programech jako je 
Microsoft Excel. 

 
Formát [ Marker <tab> AlleleX <tab> AlleleY <tab> Description <tab> Comments 

<cr> ] 

 
   Příklad 

 
Příklad A-4 

 
Marker AlleleX AlleleY Description Comments 
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  Soubory zadání   

  

 

 

9. Seznam markerů (pouze alelická diskriminace) 
 

DŮLEŽITÉ!  Seznamu markerů je požadován pouze v zadání dokumentů alelické 
diskriminace. Neobjevuje se v dokumentech absolutní nebo relativní kvantifikace. 

 

 
        Popis Seznam markerů (Markers List) sestává z jedné nebo více řádek zobrazujících 

informace o každém markeru používaném v dokumentu destičky. 
 

•   Informace o každém markeru používaném v destičce musí být v seznamu 
markerů v jediné řádce. 

•   Počet řádek v seznamu markerů musí být roven počtu markerů definovaném 
v části Počet markerů (viz bod 7 výše). 

•   V zadání pro relativní nebo absolutní kvantifikaci ponechte seznam 
markerů prázdný. (V těchto dokumentech se nepoužívají markery.) 

 
Formát (pro 

jeden marker): 
[ marker name <tab> alleleX <tab> alleleY <tab> description <tab> 

comments <cr> ] 

 

 

    Příklady: 
 
Příklad A-5 Alelická diskriminace 

 
*** SDS Setup File Version 3 

*** Output Plate Size 384 

*** Output Plate ID 384N75822034 

*** Number of Detectors 2 

Detector Reporter Quencher Description Comments 
CYP 2C9*2.1 FAM  PDAR CYP 2C9*2 Al1 Example Probe

CYP 2C9*2.2 VIC  PDAR CYP 2C9*2 Al2 Example Probe

*** Number of Markers 1 

Marker AlleleX AlleleY Description Comments 
CYP 2C9*2 CYP 2C9*2.2 CYP 2C9*2.2 PDAR CYP 2C9*2 Example marker

...     
 
Příklad A-6 Absolutní nebo relativní kvantifikace 

 
*** SDS Setup File Version 3 

*** Output Plate Size 96 

*** Output Plate ID 96JG729FF903 

*** Number of Detectors 3 

Detector Reporter Quencher Description Comments 
GAPDH VIC  GAPDH Probe Example Probe

SYBR Green SYBR  SYBR Green I Example Probe

RNase P FAM TAMRA RNase P Probe Example Probe
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Příloha A   Nástroje programu SDS   

  

 
 
Informace o detektorech v jamkách 

 
V bodech 10 a 11 je definováno, jaké detektory jsou používány v jaké jamce. Tyto 
údaje jsou dvojího druhu: záhlaví seznamu detektorů použitých v daných jamkách 
a seznam detektorů použitých v daných jamkách.  

 
 

10. Záhlaví seznamu detektorů použitých v daných jamkách 
 

 
         Popis  V této řádce je uvedeno záhlaví seznamu detektorů použitých v daných jamkách 

(Well-Detector List Header) souboru zadání, což umožňuje snazší úpravy souboru 
zadání v programech jako je Microsoft Excel. 

 
Formát [ Well <tab> Sample Name <tab> Detektor <tab> Task <tab> Quantity ] { 

... <tab> Detektor <tab> Task <tab> Quantity } [ <cr> ] 

 
   Příklad 

 
Příklad A-7 

 
Well Sample Name Detector Task Quantity Detector Task Quantity 

 

 
11. Seznam detektorů použitých v daných jamkách 

 
 

        Popis V této části je definován obsah jamek. Soubor zadání musí definovat obsah každé 
použité jamky na destičce. Každá jamka je zadána pomocí údajů ukončených <cr>. 
Obsah jamky je definován pomocí údajů trojího druhu: 

 

•   Číslo jamky (Well number) – První tabelátorem oddělený údaj udává číslo 
jamky v destičce. Číslování začíná číslem 1 pro jamku A-1 (horní levý roh 
destičky) a pokračuje zleva doprava a shora dolů. Jamky musí být uvedeny ve 
správném pořadí (1,2,3,…). 

•   Název vzorku (Sample name) – Definuje název vzorku v destičce. 
•   Detektor –  Definuje detektory použité v jamce. Každý detektor je zadán údaji 

trojího druhu: 
–  Název detektoru  

–  Úloha detektoru (UNKN – Unknown - Neznámý, STND - Standard, NTC - 
No Template Control – Netemplátová kontrola) 

–  Množství. (V jamkách, které obsahují standardy, musíte definovat jejich 
množství. V ostatních jamkách bude v poli Množství (Quantity) 0.) 

 

Je-li v dané jamce použito více detektorů, definujte i další detektory. Počet detektorů 
v jamce není nijak omezen. 

 

DŮLEŽITÉ!  Všechny zde používané detektory musí být předešle definovány (viz 
Údaje o detektorech, část 4–6). 
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  Soubory zadání   

  

 
 

Formát 
(pro jednu jamku): 

[ Well number <tab> SDS Sample Name <tab> Detector name <tab> 

Detector task <tab> Detector quantity ] { <tab> Detector name 

<tab> Detector task <tab> Detector quantity … <tab> Detector name 

<tab> Detector task <tab> Detector quantity } [ <cr> ] 

 
   Příklad 

 
Příklad A-8 Alelická diskriminace 

 
*** SDS Setup File Version 3 

*** Output Plate Size 384 

*** Output Plate ID 384N75822034 

*** Number of Detectors 2 

Detector Reporter Quencher Description Comments 
CYP 2C9*2.1 FAM  PDAR CYP 2C9*2 Al1 Example Probe

CYP 2C9*2.2 VIC  PDAR CYP 2C9*2 Al2 Example Probe

*** Number of Markers 1 

Marker AlleleX AlleleY Description Comments 
CYP 2C9*2 CYP 2C9*2.2 CYP 2C9*2.2 PDAR CYP 2C9*2 Example marker

Well Sample Name Detector Task Quantity Detector Task Quantity 

1 Sample 1 

2 Sample 2 

3 ... 

384 Sample 48 
 

 
 

Příklad A-9 Absolutní kvantifikace 
 
*** SDS Setup File Version 3 

*** Output Plate Size 96 

*** Output Plate ID 96JG729FF903 

*** Number of Detectors 1 

Detector Reporter Quencher Description Comments 
RNase P FAM TAMRA RNase P Probe Example Probe

Well Sample Name Detector Task Quantity 

1 Sample 1 GAPDH UNKN 0 
2 Sample 2 GAPDH STND 20000

3 ...    
96 Sample 30 GAPDH UNKN 0 

 
Příklad A-10 Relativní kvantifikace 

 
*** SDS Setup File Version 3 

*** Output Plate Size 96 

*** Output Plate ID 96FRE505SDA2 

*** Number of Detectors 2 

Detector Reporter Quencher Description Comments 
GAPDH VIC  GAPDH Probe Example Probe

TNF-α FAM  TNF-α  Probe Example Probe

Well Sample Name Detector Task Quantity Detector Task Quantity 
1 Calibrator GAPDH ENDO 0 TNF-α UNKN 0 
2 Sample 1 GAPDH ENDO 0 TNF-α UNKN 0 
3 ...       
96 Sample 12 GAPDH ENDO 0 TNF-α UNKN 0 
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Příloha A   Nástroje programu SDS   

  

 
 
Informace o markerech v jamkách 

 
V bodech 12 a 13 je definováno, jaké markery jsou používány v jaké jamce. Tyto 
údaje jsou dvojího druhu: záhlaví seznamu markerů použitých v daných jamkách a 
seznam markerů použitých v daných jamkách.  

 

12. Záhlaví seznamu markerů použitých v daných jamkách (pouze alelická 
      diskriminace) 

 
DŮLEŽITÉ!  Záhlaví seznamu markerů použitých v daných jamkách je požadováno 
pouze v zadání dokumentů alelické diskriminace. Neobjevuje se v dokumentech 
absolutní nebo relativní kvantifikace. 

 
        Popis  V této řádce je uvedeno záhlaví seznamu markerů použitých v daných jamkách 

(Well-Marker List Header) souboru zadání, což umožňuje snazší úpravy souboru 
zadání v programech jako je Microsoft Excel. 

 
Formát [ Well <tab> Sample Name <tab> Detektor <tab> Task <tab> Quantity ] { 

... <tab> Detektor <tab> Task <tab> Quantity } [ <cr> ] 

 
   Příklad 

 
Příklad A-11 

 
Well Sample Name Marker Task Marker Task 

 

 
13. Seznam markerů použitých v daných jamkách (pouze alelická 
      diskriminace) 

 
DŮLEŽITÉ!  Seznam markerů použitých v daných jamkách (Well-Marker 
Definition List) je požadován pouze v zadání dokumentů alelické diskriminace. 
Neobjevuje se v dokumentech absolutní nebo relativní kvantifikace.. 

 

 
      Popis V této části je definován obsah jamek. Soubor zadání musí definovat obsah každé 

použité jamky na destičce. Každá jamka je zadána pomocí údajů ukončených <cr>. 
Obsah jamky je definován pomocí údajů trojího druhu: 

 

•   Číslo jamky (Well number) – První tabelátorem oddělený údaj udává číslo 
jamky v destičce. Číslování začíná číslem 1 pro jamku A-1 (horní levý roh 
destičky) a pokračuje zleva doprava a shora dolů. Jamky musí být uvedeny ve 
správném pořadí (1,2,3,…). 

•   Název vzorku (Sample name) – Definuje název vzorku v destičce 
•   Marker –  Definuje marker použitý v jamce. Každý marker je zadán údaji 

dvojího druhu: 
–  Název markeru 
–  Úloha markeru (UNKN – Unknown - Neznámý, NTC – No Template Control 
     – Netemplátová kontrola) 

 

Je-li v dané jamce použito více markerů, definujte i další detektory. Počet markerů 
v jamce není nijak omezen. 

 

DŮLEŽITÉ!  Všechny zde používané markery musí být předešle definovány (viz 
Údaje o markerech, část 7–9). 
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  Soubory zadání   

  

 
 

Formát 
(pro jednu jamku): 

[ Well number <tab> SDS Sample Name <tab> Marker name <tab> Marker task ] 

{ <tab> Marker name <tab> Marker task <tab> … } [ <cr> ] 

 

 

   Příklad 
 

Příklad A-12 Alelická diskriminace 
 
*** SDS Setup File Version 3 

*** Output Plate Size 384 

*** Output Plate ID 384N75822034 

*** Number of Detectors 2 

Detector Reporter Quencher Description Comments 
CYP 2C9*2.1 FAM  PDAR CYP 2C9*2 Al1 Example Probe

CYP 2C9*2.2 VIC  PDAR CYP 2C9*2 Al2 Example Probe

*** Number of Markers 1 

Marker AlleleX AlleleY Description Comments 
CYP 2C9*2 CYP 2C9*2.2 CYP 2C9*2.2 PDAR CYP 2C9*2 Example marker

Well Sample Name Detektor Task Quantity  
1 Sample 1     
2 Sample 2     
3 ...     
384 Sample 48     
Well Sample Name Marker Task Marker Task

1 Sample 1 CYP 2C9*2 UNKN   
2 Sample 2 CYP 2C9*2 UNKN   
3 ...     
384 Sample 48 CYP 2C9*2 UNKN   

 
Příklad A-13 Absolutní kvantifikace 

 
*** SDS Setup File Version 3 

*** Output Plate Size 96 

*** Output Plate ID 96JG729FF903 

*** Number of Detectors 1 

Detector Reporter Quencher Description Comments 
RNase P FAM TAMRA RNase P Probe Example Probe

Well Sample Name Detector Task Quantity Detector Task Quantity 

1 Sample 1 GAPDH UNKN 0 
2 Sample 2 GAPDH STND 20000

3 ...    
96 Sample 30 GAPDH UNKN 0 

 
Příklad A-14 Relativní kvantifikace 

 
*** SDS Setup File Version 3 

*** Output Plate Size 96 

*** Output Plate ID 96FRE505SDA2 

*** Number of Detectors 2 

Detector Reporter Quencher Description Comments 
GAPDH VIC  GAPDH Probe Example Probe

TNF-α FAM  TNF-α  Probe Example Probe

Well Sample Name Detector Task Quantity Detector Task Quantity 
1 Calibrator GAPDH ENDO 0 TNF-α UNKN 0 
2 Sample 1 GAPDH ENDO 0 TNF-α UNKN 0 
3 ...       
96 Sample 12 GAPDH ENDO 0 TNF-α UNKN 0 
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Příloha A   Nástroje programu SDS   

  

RAP1A FAM  
RhoPK2 FAM  

 
 
cot 

 
 
FAM 

 

p53 FAM  
Well Sample Name Detektor 
 

 
 
Příklady zadání 

 
Příklad A-15 Relativní kvantifikace 

 
*** SDS Setup File Version 3 

*** Output Plate Size 384 

*** Output Plate ID 384JQZ55A4 

*** Number of Detectors 25 

Detector Reporter Quencher Description Comments   
18S-VIC-mgb VIC      
Bcl-2 FAM   Human Bcl-2   
Bcl-xL FAM   Human Bcl-xL   
GAPDH FAM   Human GAPDH   
GBP2 FAM   guanlylate binding protein 2 
GOS2 FAM   Human GOS2 protein gene  
IL-15 FAM   Human IL-15   
IL-17 FAM   Human IL-17   
IL-18 FAM   Human IL-18   
IL-1a FAM   Human IL-1a   
IL-1b FAM   Human IL-1 beta   
IL12p40 FAM   Human IL-12p40   
INF-a2 FAM   Interferon-alpha2   
IP-10 FAM   Human IP-10   
ISG56 FAM   Interferon-induced protein 56
Nfkb-I FAM Nuclear factor of kappa light...

PKCi FAM Protein kinase C, iota 
RAP1A, member of RAS oncogene... 

Homo sapiens Rho-associated... 

TNF-a FAM Human TNF-alpha

c-fos FAM Human c-fos 
c-jun FAM Human c-jun 
c-myc FAM Human c-myc 

Cancer Osaka thyroid oncogene 

Human p53 

Task Quantity 

1 A1 18S-VIC-mgb ENDO  0.0   
2 Liver 18S-VIC-mgb ENDO 0.0 GOS2 TARG 0.0

3 Liver 18S-VIC-mgb ENDO 0.0 cot TARG 0.0

4 Liver 18S-VIC-mgb ENDO 0.0 cot TARG 0.0

5 Liver 18S-VIC-mgb ENDO 0.0 ISG56 TARG 0.0

6 Liver 18S-VIC-mgb ENDO 0.0 ISG56 TARG 0.0

7 Liver 18S-VIC-mgb ENDO 0.0 GOS2 TARG 0.0

8 Liver 18S-VIC-mgb ENDO 0.0 cot TARG 0.0

9 Liver 18S-VIC-mgb ENDO 0.0 cot TARG 0.0

10 Liver 18S-VIC-mgb ENDO 0.0 ISG56 TARG 0.0

11 Liver 18S-VIC-mgb ENDO 0.0 ISG56 TARG 0.0

12 Liver 18S-VIC-mgb ENDO 0.0 GOS2 TARG 0.0

13 Liver 18S-VIC-mgb ENDO 0.0 cot TARG 0.0

14 Liver 18S-VIC-mgb ENDO 0.0 cot TARG 0.0

15 Liver 18S-VIC-mgb ENDO 0.0 ISG56 TARG 0.0

16 Liver 18S-VIC-mgb ENDO 0.0 ISG56 TARG 0.0

...        
381 Liver 18S-VIC-mgb ENDO 0.0 GOS2 TARG 0.0

382 Liver 18S-VIC-mgb ENDO 0.0 cot TARG 0.0

383 Liver 18S-VIC-mgb ENDO 0.0 cot TARG 0.0

384 Liver 18S-VIC-mgb ENDO 0.0 ISG56 TARG 0.0
 

Jamky 17 až 380 vypuštěny kvůli stručnosti. 
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  Soubory zadání   

  

 
 
Příklad A-16 Alelická diskriminace 

 
*** SDS Setup File Version 3 

*** Output Plate Size 384 

*** Output Plate ID NU03000081 

*** Number of Detectors 8 

Detector Reporter Quencher Description Comments 

AL2-1 FAM 

AL1-1 VIC 

AL2-2 FAM 

AL1-2 VIC 

AL2-3 FAM 

AL1-3 VIC 

AL2-4 FAM 

AL1-4 VIC 

*** Number of Markers 4 

Marker AlleleX AlleleY Description Comments

SNP1 AL2-1  AL1-1   
SNP4 AL2-4  AL1-4   
SNP3 AL2-3  AL1-3   
SNP2 AL2-2  AL1-2   
Well Sample Name Detektor Task Quantity

1 A1     
2 A2     
3 A3     
4 A4     
5 A5     
6 A6     
7 A7     
8 A8     
9 A9     
10 A10     
11 A11     
12 A12     
13 A13     
...      
382 P22     
383 P23     
384 P24     
Well Sample Name Marker Task  
1 A1  SNP1 UNKN  
2 A2  SNP1 UNKN  
3 A3  SNP1 UNKN  
4 A4  SNP1 UNKN  
5 A5  SNP1 UNKN  
6 A6  SNP1 UNKN  
7 A7  SNP1 UNKN  
8 A8  SNP1 UNKN  
9 A9  SNP1 UNKN  
10 A10  SNP1 UNKN  
11 A11  SNP1 UNKN  
12 A12  SNP1 UNKN  
13 A13  SNP1 UNKN  
...      
382 P22  SNP4 UNKN  
383 P23  SNP4 UNKN  
384 P24  SNP4 UNKN  

 

Jamky 11 až 381 vypuštěny kvůli stručnosti. 
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Export obrázků 
 
 

Export grafů ve 
formátu JPEG  

Program SDS umožňuje exportovat většinu zobrazení a grafů dokumentu destičky 
ve formátu JPEG (Joint Photographic Experts Group). Formát JPEG je kompatibilní 
s většinou textových a tabulkových editorů a lze jej použít přímo též v dokumentech 
typu HTML. 
 
Chcete-li exportovat část dokumentu destičky jako obrázek: 
 

1.   Zvolte graf nebo zobrazení, které chcete exportovat. 
 

2.   Zvolte jednu z možností: 
–   Exportujete-li graf, upravte jeho rozměry (délka a šířka) jak je chcete mít 

v exportovaném obrázku. Exportovaný obrázek bude mít rozměry tak, jak je 
vidíte na obrazovce. 

–  Exportujete-li zobrazení destičky, velikost jamek neupravujte. Program 
exportuje celé zobrazení bez ohledu na to, jaká část zobrazení je vidět na 
obrazovce. 

 

3.   Klikněte pravým tlačítkem myši do grafu nebo zobrazení a z nabídky zvolte 
Save Plot/Grid to Image File (Uložit graf/zobrazení jako obrázek). 

 

Poznámka:  Pokud dané zobrazení nelze exportovat, v nabídce se možnost 
Save Plot/Grid to Image File nezobrazí. 

 

4.   V dialogovém okně Save As (Uložit jako) vyhledejte adresář, do kterého 
chcete exportovaný obrázek uložit. 

 

5.   V poli File name (Název souboru) zadejte název nového souboru. 
 

6.   Klikněte  (Uložit). 

Program uloží graf nebo zobrazení ve formátu JPEG do zvoleného adresáře. 
 
 

 
Export údajů z dokumentů destičky 

 
 
 

Export dat 
z dokumentu 

destičky 

Program SDS umožňuje exportovat hrubá nebo analyzovaná data ve formátu *.txt 
(tabelátorem oddělená data), a to pro zvolené nebo všechny jamky destičky. 
Exportované soubory lze otevřít ve většině tabulkových editorů. 
 
Chcete-li exportovat data z dokumentu destičky: 
 

1.   Kliknutím zvolte dokument destičky. 
 

2.   Klikněte na ikonu  nebo zvolte File > Export (Soubor > Export). 

3.   Vyhledejte adresář, do kterého chcete exportovat. 
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Export údajů z dokumentu destičky    
 
 

4.   V nabídce Export zvolte, která data chcete exportovat. 
•   Background Spectra (Spektrum pozadí) – Budou exportovány hodnoty 

fluorescence pozadí, použité pro analýzu výsledků v každé jamce. 
•   Clipped (Dílčí data) – Budou exportovány průměrné hodnoty Rn a ∆Rn 

naměřené v každém cyklu v každé jamce. 
•   Dissociation Curve (Disociační křivka) – Budou exportovány: 

Teplota –  Pro každou použitou jamku destičky budou v souboru uvedeny 
teploty v jamkách při čtení dat. 
Hrubá data – Pro každou použitou jamku destičky budou v souboru 
uvedeny hodnoty Rn v jamkách při čtení dat. 
Derivovaná data – Pro každou použitou jamku destičky budou v souboru 
uvedeny hodnoty první derivace hrubých dat. 

•   Multicomponent (Multikomponentní data) – Budou exportovány: 

– Vypočítané příspěvky jednotlivých barev v každé jamce pro každé 
   čtení dat 
– Čistá spektra jednotlivých barev 
– Vypočítaná inverzní matrice 

•   Pure Spectra (Čistá spektra) – Budou exportovány hodnoty fluorescence 
čistých spekter, použité pro analýzu výsledků v každé jamce.  

•   Raw Spectra (Hrubá spektra) – Budou exportovány hodnoty fluorescence 
naměřené pro každý spektrální interval (tzv. bin) v průběhu běhu. 

•   Při exportu program vytvoří adresář a uloží hrubá spektra pro každou 
jamku do zvláštního souboru *.txt. 

•   Results Table (Tabulka výsledků)  – Bude exportován obsah tabulky 
výsledků analyzovaného souboru destičky. 

 

Poznámka:  Struktura exportovaných dat závisí na tom, jakého typu je 
otevřený dokument destičky. 

 

•   Setup Table (Tabulka zadání) – Budou exportovány údaje z tabulky zadání 
dokumentu destičky před analýzou. Struktura exportovaných dat závisí na 
tom, jakého typu je otevřený dokument destičky. Detailní popis zadání viz 
strana A-4. 

 

5.   Chcete-li exportovat data: 
•   Ze všech jamek dokumentu destičky – Zvolte tlačítko All Wells (Všechny 

jamky). 
•   Z vybraných jamek dokumentu destičky – Zvolte tlačítko Selected Wells 
     (Vybrané jamky). 

 

6.   V rozbalovací nabídce Files of type (Typ souboru) zvolte formát exportovaných 
dat. 

 

7.   Klikněte do pole File name (Název souboru) a zadejte název exportovaného 
      souboru. 

 

8.   Klikněte . 

Program uloží exportovaná data do zvoleného adresáře. 
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Příloha A   Nástroje programu SDS 
 
 

Ovládání programu SDS z příkazové řádky 
 
 

  Přehled Program SDS umožňuje provádět analýzu a export výsledků pomocí dávkových 
souborů z příkazové řádky. Toto ovládání je určeno zkušeným uživatelům (jako 
administrátoři, bioinformatici a správci laboratorních sítí), kteří se rozhodnou ovládat 
program pomocí skriptování. 

 

Poznámka:  Pokud neznáte systém Microsoft DOS, společnost Applied Biosystems 
doporučuje používat pro ovládání softwaru jeho uživatelské rozhraní. 

 
Spuštění 

programu 
z příkazové řádky 

1.   Zvolte My Computer > AppliedBiosystems > SDS2.2. 
 

2.   Vytvořte kopii souboru SDS 2.bat a přejmenujte jej (jako třeba 
 SDS_RESULTS.bat). 

 

3.   Pomocí Poznámkového bloku (Notepad) upravte obsah souboru takto: 
 
Příklad A-17 Dávkový soubor SDS2.bat  

 
Text dávkového souboru: 

 

set classpath=./service/config;./service/Lib/audit.jar;./service/Lib/rtc.jar; 

./service/Lib/ab-reqres.jar;./service/Lib/translation.jar;./service/Lib/apv.jar; 

./service/lib/coreutil.jar;./service/JMS/lib/fmprtl.zip;./service/Lib/coregui.jar; 

./service/lib/EmlException.jar;./service/lib/emlhandler.jar;./service/lib/esig.jar; 

./service/lib/esig/exception.jar;./service/lib/Coreutil.jar; 

set path=./lib/algorithm/bin/win32;./lib;%path% 

jre\bin\java -Dab.home=C:\AppliedBiosystems\SDS2.2\service -

Dcom.apldbio.sds.global.approot=. 

-Dcom.apldbio.sds.global.config= .\config\config.properties -Xms110m -Xmx300m 

-Dsource=batchfile -Ddefport=8080 -classpath 

%classpath%;lib\SDS2.jar;lib\common.jar; 

lib\sdsdb.jar;lib\ojdbc14.jar;lib\accesscontrol.jar;lib\sdsdb.jar;lib\activation.jar

; lib\mail.jar;lib\accesscontrol.jar;lib\Coreutil.jar;lib\EmlException.jar 

com.apldbio.sds.shell.SDSMain 

V poslední řádce nahraďte text 
 

com.apldbio.sds.shell.SDSMain 

jiným textem podle toho, chcete-li exportovat : 

•   Multikomponentní data: 

com.apldbio.sds.MulticompAnalyzerMain %* 

 
•   Analyzovaná data: 

com.apldbio.sds.SDSResultsAnalyzerMain %* 

 
•   Multikomponentní a analyzovaná data: 

com.apldbio.sds.MulticompAndResultsAnalyzerMain %* 
 

 

4.   Uložte a zavřete dávkový soubor. 
 

5.   Spusťte soubor z příkazové řádky. Zadejte:  

SDS_RESULTS.bat sdsfile.sds sdsresultsfile.txt, kde:  

• SDS_RESULTS.bat – Je název dávkového souboru, který jste vytvořili. 

•   sdsfile.sds – Je soubor SDS, který analyzujete. 

•   sdsresultsfile.txt – Je název exportovaného souboru. 
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Ovládání programu SDS z příkazové řádky    
 
 

Zvýšení výkonu 
programu SDS 

Výkon (rychlost) programu SDS je možné zvýšit zvětšením části paměti počítače, 
která je programu k dispozici. Chcete-li alokovat programu SDS větší část paměti, 
vložte do jakéhokoliv příkazu programu SDS následující parametry. 

 
jre\bin\java -Dab.home=C:\AppliedBiosystems\SDS2.2\service 

-Dcom.apldbio.sds.global.approot=. -Dcom.apldbio.sds.global.config= 

.\config\config.properties -Xms80m -Xmx90m -Dsource=batchfile 

-Ddefport=8080… 

 
kde: 

 

•  -Xms80m – Je minimální velikost paměti alokované programu SDS. 
•  -Xmx90m – Je maximální velikost paměti alokované programu SDS. 

 

Společnost Applied Biosystems doporučuje následující nastavení: 
 

•   Alelická diskriminace: -Xms20m -Xmx60m 
•   Absolutní nebo relativní kvantifikace): -Xms80m -Xmx90m 
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Příloha A   Nástroje programu SDS 
 
 

Vyhledávání 
 
 

Vyhledávací 
filtry 

Nástroj Vyhledávání (Search) umožňuje organizovat velké soubory dat 
v dialogovém okně Add files (Přidat soubory). Díky tomuto nástroji je možné 
zobrazit pouze vybrané dokumenty destiček na základě předdefinovaných parametrů.  
 

Vyhledávání funguje s obdobnou logikou jako jednoduché programovací jazyky. 
Každý vyhledávací filtr sestává z jedné logické podmínky, která programu říká, jak 
vybrat nebo vyloučit určité dokumenty destiček. Logické podmínky lze vzájemně 
spojovat. 

 
Vyhledávací 

podmínky 
Nástroj Vyhledávání je tabulka, ve které každý řádek představuje jednu podmínku. 
Kdykoliv je do tabulky přidána řádka (podmínka), program otestuje, zda všechny 
dokumenty destiček ve zvoleném adresáři tuto podmínku splňují. Pokud ano, je 
dokument destičky zobrazen v poli Search Results (Výsledky vyhledávání). Pokud 
ne, dokument destičky není zobrazen a data jsou vyloučena z analýzy. Jak je 
vysvětleno níže, nástroj Vyhledávání může použít několik podmínek najednou. 

 
Syntaxe 

vyhledávání 
Na obrázku A-1 je znázorněn filtr vytvořený v dialogovém okně Add Files (Přidat 
soubory). 

 
   Logický operátor 

(IF - Pokud, AND 
- A, OR - Nebo) 

Pole 
Která kategorie je 
testována 

Podmínka 
Jak je testována 

Hodnota 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Obrázek A-1   Dialogové okno Add Files (Přidat soubory) 
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Vyhledávání     
 
 

Logické operátory 
(IF, AND, OR) 

Každá podmínka začíná jedním ze tří logických operátorů: IF - Pokud, OR - Nebo, 
AND - A. Logické operátory definují vztahy mezi jednotlivými podmínkami 
v dialogovém okně Add Files (Přidat soubory). 
 
Podmínky Pokud (IF) 
 

První podmínka je vždy předdefinována tak, aby začínala operátorem IF (Pokud). 
Splňuje-li dokument destičky definované kritérium, je zobrazen v dialogovém okně 
Add Files (Přidat soubory). 
 
Podmínky A (AND) 
 

Podmínka s logickým operátorem AND (A) vyhodnocuje platnost dvou podmínek 
pro dokument destičky – podmínky v řádku s operátorem AND (A) a podmínky 
v předchozím řádku tabulky. Dokument destičky je zobrazen pouze pokud splňuje 
obě podmínky. 
 
Podmínky Nebo (OR) 
 

Obdobně jako podmínky s logickým operátorem AND i logický operátor OR (Nebo) 
vyhodnocuje platnost dvou podmínek (ve svém a předchozím řádku). Je-li tento 
logický operátor použit, dokument destičky je zobrazen, je-li splněna alespoň jedna 
podmínka. 
 

 
Pole Každá podmínka je aplikována na parametr dokumentu destičky, definovaný ve 

sloupci Pole. 
 

 Podmínka Ve sloupci Podmínka je definován vztah mezi parametrem definovaným ve sloupci 
Pole a ve sloupcích Value 1 a Value 2 (Hodnota). V následujícím seznamu jsou 
uvedeny všechny možnosti, které lze použít ve sloupci podmínka. 
 

•   > : Větší než Hodnota 1 
•   >= : Větší nebo roven Hodnotě 1 
•   < : Menší než Hodnota 1 
•   <= : Menší nebo roven Hodnotě 1 
•   equals (rovno) : Roven Hodnotě 1 
•   < > : Není roven Hodnotě 1 
•   between (mezi) : Větší než Hodnota 1 ale menší než Hodnota 2 
•   contains (obsahuje) : Obsahuje abecedněčíslicový řetězec z Hodnoty 1 

 
Hodnota 1 a 2 

 
Hodnoty 1 a 2 definují co má podmínka splňovat. 
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Příloha A   Nástroje programu SDS 
 
 

Propojení programu SDS s databází 
 
 

Požadované 
informace 

DŮLEŽITÉ!  Pro propojení programu SDS s databází musíte mít práva administrátora 
nebo být servisní technik. 
 

Pro propojení programu SDS s databází potřebujete následující informace: 
 

•   Host Name (Server) – Název serveru s databází SDS Enterprise nebo jeho IP 
adresa. Údaje získáte od vašeho administrátora. 

•   Port Number (Číslo portu) – Přednastavené číslo portu je 1521. (Případnou 
změnu portu vám sdělí váš administrátor.) 

•   Service Name (Název služby) – Název služby je definován při instalaci databáze 
    SDS Enterprise. Přednastaveno je SDS22. 

 
Vypnutí/Zapnutí 
funkcí databáze 

v programu SDS 

Program SDS umožňuje uživatelům ze skupiny Administrator vypnout v programu 
SDS funkce databáze. Jsou-li tyto funkce vypnuty, program skryje ikony a nabídky 
pro otevírání a ukládání dat do databáze. 
 

Poznámka:  Vypnutí/Zapnutí funkcí databáze lze použít v okamžiku, kdy není 
k dispozici síťové připojení. Jsou-li funkce databáze vypnuty, program SDS 
nevyžaduje před používáním přístroje 7900HT přihlašování uživatelů. Poté co je 
databáze opět k dispozici, lze do ní do té doby získaná data uložit pomocí nástroje 
SDS Document Loader (viz příručka SDS Enterprise Database Administration 

Guide (Kat. č. 4346513)). 
 
Chcete-li vypnout či zapnout funkce databáze v programu SDS: 
 

DŮLEŽITÉ!  Musíte mít práva administrátora, chcete-li měnit parametry databáze. 
 

1.   Spusťte program SDS (více informací viz strana 2-6). 
 

2.   V dialogovém okně Login (Přihlášení) zadejte uživatelské jméno a heslo 
uživatele patřícího mezi administrátory (o uživatelských účtech získáte více 
informací v příručce SDS Enterprise Database Administration Guide). 

 

3.   Zvolte Tools > Options (Nástroje > Možnosti). 
 

4.   V dialogovém okně Options (Možnosti) zvolte záložku Database (Databáze). 
 

5.   Zvolte nebo naopak odznačte pole Enable Enterprise Options (Zapnout 
funkce databáze). 

 

6.   Klikněte . 
 

7.   Jste-li k tomu vyzváni, zadejte vaše uživatelské jméno a heslo a klikněte 
 . 
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Propojení programu SDS s databází    
 
 

Změna nastavení 
propojení 
databáze 

DŮLEŽITÉ!  Chcete-li změnit nastavení propojení s databází SDS Enterprise, musíte 
patřit mezi uživatele skupiny Administrator (o uživatelských účtech získáte více 
informací v příručce SDS Enterprise Database Administration Guide). 
 

Propojení s databází SDS Enterprise lze změnit z dialogového okna Options 
(Možnosti) podle postupu níže. 
 

1.   Spusťte program SDS (více informací viz strana 2-6). 
 

2.   V dialogovém okně Login (Přihlášení) zadejte uživatelské jméno a heslo 
uživatele patřícího mezi administrátory. 

 

3.   Zvolte Tools > Options (Nástroje > Možnosti). 
 

4.   V dialogovém okně Options (Možnosti) zvolte záložku Database (Databáze). 
 

5.   Změňte aktuální nastavení propojení: 
 

 
Pole Host Name  
Zadejte název nebo IP adresu 
databáze 

 

 
Pole Port Number  
Zadejte číslo portu pro 
spojení s databází 
(přednastaveno je 1521) 

Pole Service Name 
Zadejte název databáze 
(přednastaveno je SDS22) 

 
 

6.   Chcete-li otestovat nové propojení: 

a.  Klikněte  (Ověřit). 

Program rychle ověří, že se databáze nachází na udané IP adrese. Je-li 
propojení úspěšné, program zobrazí dialogové okno Login (Přihlášení). 

b.  V dialogovém okně Test Login (Testovací přihlášení) zadejte vaše 
uživatelské jméno a heslo a klikněte  . 

 

 
 

•   Není-li program SDS schopen se propojit s databází, zobrazí níže 
uvedenou chybovou hlášku. 

 

 
 

7.   Klikněte  . 
 

8.   Přihlaste se do databáze pomocí vašeho uživatelského jména a hesla a 
klikněte  . 
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Příloha A   Nástroje programu SDS 

 Uživatelská příručka pro Real-Time PCR systém ABI PRISM 7900HT A-24 



  

  

B Návrh esejí s chemizmem TaqMan  
 

 

 
 
 
 

V této příloze Doporučení pro návrh esejí ....................................................................................B-2 
Tipy pro návrh esejí alelické diskriminace ............................................................B-4 
Tipy pro návrh kvantitativní PCR..........................................................................B-5 
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Příloha B    Návrh esejí s chemizmem TaqMan 
 
 

Doporučení pro návrh esejí 
 
 

Vývoj esejí 
s chemizmem 

TaqMan  

1.   Identifikujte cílovou sekvenci(e) (viz strana B-2). 
 

2.   Navrhněte sondy TaqMan®  a primery (forward a reverzní) (viz strana B-2). 
 

3.   Objednejte reagencie. 
 

4.   Změřte koncentraci sond a primerů (viz strana B-3). 
 

5.   Připravte mastermix (viz strana B-3). 
 

6.   Proveďte optimalizaci koncentrace primerů (viz strana B-3). 
 

7.   Esej je připravena k použití (viz strana B-3). 
 

Identifikace 
cílové 

sekvence 

Cílovým templátem je DNA, cDNA nebo RNA, případně plazmid nesoucí cílovou 
nukleotidovou sekvenci. Chcete-li dosáhnout optimálních výsledků, měl by templát 
splňovat následující předpoklady: 
 

•   Cílová nukleotidová sekvence musí obsahovat vazebná místa pro oba primery 
a fluorogenní sondu. 

•   Nejlépe fungují krátké amplikony o velikosti 50–150 bp, které dávají 
nejkonzistentnější výsledky. 

•   Navrhujete-li eseje pro kvantitativní PCR, naleznete více informací v části “Tipy 
pro návrh kvantitativní PCR” na straně B-5. 

 
Návrh sond 

a primerů 
Níže jsou uvedena obecná doporučení pro návrh primerů a sond. Specifická 
doporučení naleznete v odpovídajících částech této přílohy: pro alelickou diskriminaci 
na straně B-4 a pro kvantitativní PCR na straně B-5. 
 
Návrh sond 
 

Při návrhu sond typu TaqMan dodržujte následující doporučení: 
 

•   Obsah G-C by měl být v rozsahu 30–80%. 
•   Vyhněte se opakování téhož nukleotidu několikrát za sebou (zejména se to týká 

guaninu, vyhněte se opakování čtyř nebo více G za sebou). 
•   Na 5´ konci nesmí být G. 

•   Teplota tání (Tm) by měla být pro kvantitativní PCR v rozsahu 68-70 °C a pro 
alelickou diskriminaci 65-67 °C (za použití programu Primer Express™). 

•   Zvolte pro návrh řetězec DNA tak, aby sonda měla více C než G. 
•   Pro alelickou diskriminaci (viz strana B-4): 

–  Upravte délku sond tak, aby obě měly stejnou Tm. 
–  Místo polymorfizmu umístěte zhruba do středu každé sondy. 

•   Pro absolutní nebo relativní kvantifikaci (viz strana B-5) 
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       Doporučení pro návrh esejí 
 
 

•   Navrhujete-li sondy pro multiplexní PCR (více sond v jedné reakci), musí mít 
každá sonda různou reportérovou barvu (viz Tabulka B-1). 

 
Tabulka B-1     Reportérové barvy pro multiplexní PCR  

 
  

První sonda 
 

Druhá sonda 
 

Reportérová barva* FAM™ VIC™ 

*Použití barev FAM a VIC v multiplexní PCR je doporučeno z důvodu minimálního překryvu 
jejich spekter. 

 

 
Návrh primerů 

 

Při návrhu primerů pro eseje TaqMan dodržujte následující doporučení: 
 

•   Obsah G-C by měl být v rozsahu 30–80%. 

•   Vyhněte se opakování téhož nukleotidu několikrát za sebou (zejména se to týká 
guaninu, vyhněte se opakování čtyř nebo více G za sebou). 

•   Teplota tání (Tm) by měla být v rozsahu 58-60 °C (za použití programu Primer 
     Express™). 
•   Omezte obsah G a/nebo C na 3´ konci. V sekvenci posledních pěti 

nukleotidů primeru by nemělo být více než dvě G a/nebo C. 
•   Umístěte primery co nejblíže k sondě, aniž dojde k překryvu jejich sekvencí. 
•   Pro kvantitativní PCR používejte teplotu annealingu v rozsahu 58-60 °C, pro 

alelickou diskriminaci 58-60 °C (vyjma TaqMan®  PDAR pro alelickou 
diskriminaci). 

 
Měření koncentrace 

sond a primerů 
Pomocí spektrofotometrie změřte koncentrace primerů a sond, které jste si objednali. 
Více informací o kvantifikaci naleznete v příručce TaqMan Universal PCR Master 
Mix Protocol (Kat. č. 4304449). 

 

 
Příprava 

mastermixu 
Informace o přípravě mastermixu naleznete v příručce TaqMan Universal PCR 
Master Mix Protocol (Kat. č. 4304449). 
 

DŮLEŽITÉ!  PCR mastermix pro použití na přístroji 7900HT musí obsahovat barvu 
použitou jako pasivní referenci. Program SDS používá signál pasivní reference pro 
normalizaci signálu reportérové barvy, což umožňuje vzájemné porovnání 
jednotlivých jamek. Všechny mastermixy společnosti Applied Biosystems obsahují 
jako pasivní referenci barvu ROX v optimální koncentraci. 
 

Poznámka:  Příručky společnosti Applied Biosystem jsou k dispozici na 
internetových stránkách společnosti.  

 
Optimalizace 
koncentrace 

primerů/sond 

Informace o optimalizaci koncentrací primerů a sond naleznete v příručce TaqMan 
Universal PCR Master Mix Protocol (Kat. č. 4304449). 
 

Poznámka:  Příručky společnosti Applied Biosystem jsou k dispozici na 
internetových stránkách společnosti.  

 
Esej je připravena 

k použití 
Poznámka:  Provádíte-li kvantitativní PCR, zvažte používání replikátů pro zvýšení 
přesnosti výsledků.
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Příloha B    Návrh esejí s chemizmem TaqMan 
 
 

Tipy pro návrh esejí alelické diskriminace 
 
 

Diskriminace 
pomocí několika 

sond 

Používáte-li několik sond s různými reportérovými barvami, můžete jejich štěpení 
detekovat v jediné PCR reakci. Jednou z možných aplikací takové eseje je použití 
sond specifických pro různé alely k rozlišení genetického polymorfizmu (Bloch, 1991, 
Lee et al., 1993). Sondy se mohou lišit pouze v jediné bázi. Takto lze použít i sondy 
s reportérovou barvou na 5' konci a nefluorescenčním zhášečem na 3´ konci(Bloch, 
1991). 

 
Návrh sond typu 

TaqMan  
DŮLEŽITÉ!  Při návrhu sond zvažte návrh na základě obou řetězců. 
 

Při návrhu sond typu TaqMan MGB dodržujte níže uvedená doporučení: 
 
Tabulka B-2    Doporučení pro návrh sond typu TaqMan MGB pro alelickou 
                       diskriminaci 
 

Priorita Doporučení 

 
Na 5´ konci sondy nesmí být guaninový zbytek. 

1 Guaninový zbytek v sousedství reportérové barvy působí i po rozštěpení 
sondy jako zhášeč. 

 
2 Navrhněte sondy pomocí programu  Primer Express – přibližná Tm 65–67 °C. 

 
3 Sondy TaqMan MGB musí být co nejkratší, ale ne kratší než 13 nukleotidů. 

 
 

4 Vyhněte se opakování téhož nukleotidu několikrát za sebou (zejména se 
to týká guaninu, vyhněte se opakování čtyř nebo více G za sebou). 

 
 
Místo polymorfizmu umístěte zhruba do střední třetiny každé sondy. 

Poznámka:  Místo polymorfizmu lze posunout i směrem k 3´ konci, ale 
musí být nejméně dva nukleotidy od 3´ konce. 

 

Obrázek níže znázorňuje umístění polymorfizmu ve vzorové sondě (N = 
Nukleotid). 

 
Nejprve zkuste umístit místo 

polymorfizmu do střední třetiny sondy. 
5  

Neumisťovat 
zde. 

 
 

5´ 3´ 
 

  N   N   N   N   N   N   N   N   N   N   N   N   N   N   N   N   N   N   N   N 
 
 

Polymorfizmus Je-li to nutné, lze 
polymorfizmus umístit zde. 
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Tipy pro návrh kvantitativní PCR    
 
 

Tipy pro návrh kvantitativní PCR 
 
 
Umístění amplikonu 
při analýze genové 

exprese 

Vhodným umístěním amplikonu při amplifikaci cílové mRNA lze zajistit, že nebude 
amplifikována genomická DNA, pseudogeny a příbuzné geny. Společnost 
Applied Biosystems doporučuje při volbě umístění amplikonu pro kvantitativní 
PCR dodržovat následující doporučení: 
 

•   Primery a sondy musí být navrženy při dodržení doporučení na straně B-2. 

•   Amplikon by měl být navržen přes rozhraní exon-exon, aby bylo zabráněno 
amplifikaci cílové sekvence z genomické DNA. 

•   Pár primerů musí být specifický pro cílový gen a nesmí vést k amplifikaci 
pseudogenů nebo příbuzných genů. 

•   Otestujte několik různých amplikonů a zvolte takový, který dává nejvyšší poměr 
signálu vůči pozadí (takové  co vedou k nízkým hodnotám CT při použití cDNA 
jako templátu a k žádné amplifikaci s netemplátovou kontrolou nebo genomickou 
DNA). 

•   Pokud takový amplikon nenaleznete, může být nutné otestovat další sekvence a 
případně změnit návrh amplikonu. 

 

Pokud gen, jehož expresi studujete, nemá introny, pak nemůžete navrhnout 
amplikon tak, aby docházelo pouze k amplifikaci mRNA a nikoliv genomické 
DNA. V takovém případě může být zapotřebí použít kontrolní vzorek bez reverzní 
transkripce. 

 
Volba a příprava 

standardů pro 
absolutní 

kvantifikaci 

Abyste získali přesné výsledky, musíte standardy pro absolutní kvantifikaci pečlivě 
navrhnout, validovat a kvantifikovat. Před používáním kvantifikace metodou 
standardní křivky je proto zapotřebí věnovat pozornost následujícím bodům: 
 

•   Používaná  DNA nebo RNA musí být čistá. Např. plazmidová DNA připravená 
izolací z E. coli je často kontaminována RNA, která zkresluje kvantifikaci 
měřením A260. 

•   Obecně nelze používat DNA jako standard pro absolutní kvantifikaci RNA, 
protože v takovém případě není nijak kontrolována efektivita reverzní 
transkripce. 

•   Absolutní množství standardů musíte zjistit nějakou jinou metodou. 
Pro přípravu standardů jsou běžně používány plazmidová DNA nebo in vitro 
transkribovaná RNA. Jejich koncentrace je měřena pomocí A260 a přepočítána 
na počet kopií při znalosti molekulové hmotnosti DNA nebo RNA. 

•   Důležitým faktorem je stabilita ředěných standardů, zejména RNA. Rozdělte 
ředěné standardy do malých alikvotů, uchovávejte je při -80 °C a nechte je roztát 
pouze jedenkrát před použitím. Příkladem přípravy důvěryhodných standardů je 
postup podle Collins et al. (Anal. Biochem. 226:120-129, 1995), kteří popisují 
kroky použité k přípravě RNA standardů pro absolutní kvantifikaci virové 
nálože. 

•   Pipetování musí být přesné, protože standardy se ředí přes několik řádů. 
Plazmidová DNA nebo in vitro transkribovaná RNA musí být pro účel přesného 
měření A260 koncentrovaná. Koncentrovaná DNA nebo RNA musí být poté 
ředěna 106  –1012  -krát, aby měla koncentraci srovnatelnou s koncentrací 
v biologických vzorcích. 
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Kity, reagencie a spotřební materiál C 
 
 
 
 

V této příloze Výměnné bloky na vzorky a příslušenství .............................................................C-2 
Spotřební materiál..................................................................................................C-3 
Údržba přístroje a ověřování funkčnosti................................................................C-5 
Eseje TaqMan a reagencie .....................................................................................C-6 
Syntéza oligonukleotidů na zakázku......................................................................C-6 

 

Poznámka:  Katalogová čísla, uvedená v této příloze, se týkají zákazníků ze 
Spojených Států Amerických. Vaše katalogová čísla a ceny Vám sdělí místní 
zastoupení společnosti Applied Biosystems. 
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Příloha C   Kity, reagencie a spotřební materiál 
 
 

Výměnné bloky na vzorky a příslušenství 
 

Přístroj 7900HT je vybaven vyměnitelnými bloky na ohřev vzorků na bázi 
peltierových článků (technologie odvozená od přístroje GeneAmp®  PCR System 9700). 

 

Výměnné bloky na vzorky: 
 

•   snižují “mrtvý čas” v používání přístroje, protože je možné je okamžitě vyměnit. 
•   umožňují snadný přístup k bloku při řešení problémů s ním souvisejících a při 

jeho údržbě (viz strana 7-14). 
•   umožňují používat různé typy spotřebního materiálu. 

•   umožňují různé režimy provozu (včetně režimu Max a programovatelného 
zvyšování teploty). 

 
Tabulka C-1 Výměnné bloky na vzorky a příslušenství 

 
 

Kat. č. 
 

Popis 
 

Množství 

4331406 384-jamkový výměnný blok na vzorky pro přístroj 
ABI PRISM®  7900HT  

Zahrnuje 384-jamkový blok na vzorky, adapter na 384-
jamkové destičky a spektrální kalibrační kit pro 384-jamkové 
destičky (Kat. č. 4323977) 

1 kit 

4331405 96-ti jamkový  výměnný blok na vzorky pro přístroj 
ABI PRISM®  7900HT  

Zahrnuje 96-ti jamkový blok na vzorky, adapter na 96-ti 
jamkové destičky a spektrální kalibrační kit pro 96-ti 
jamkové destičky (Kat. č. 4328639) 

1 kit 

* Výměnný blok na mikrofluidní karty pro přístroj ABI PRISM® 
7900HT  

 

1 kit 

*kontaktujte Vaše místní zastoupení Applied Biosystems. 
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Spotřební materiál    
 
 

Spotřební materiál 
 

Na přístroji ABI PRISM 7900HT lze používat: 
 

•    Optické 384-jamkové destičky ABI PRISM™  uzavřené pomocí optických 
adhezívních fólií ABI PRISM™   

•    Optické 96-ti jamkové destičky ABI PRISM™  uzavřené pomocí optických 
adhezívních fólií ABI PRISM nebo optických víček ABI PRISM (pouze plochá 
víčka) 

•   Mikrofluidní karty  
 

DŮLEŽITÉ!  Na přístroji 7900HT nepoužívejte optická víčka MicroAmp®  nebo 
optické zkumavky MicroAmp®. Tento spotřební materiál není pro přístroj 7900HT 
určen a může poškodit jeho vnitřní součásti. 

 

Poznámka:  Optické destičky ABI PRISM jsou určeny pro provádění PCR s přímou 
detekcí amplifikace na bázi fluorescence a jsou matné, aby bylo minimalizováno 
riziko přenosu signálu fluorescenční kontaminace z vnějšího prostředí. Před jejich 
použitím na přístroji 7900HT musí být destičky uzavřeny pomocí optické adhezívní 
fólie ABI PRISM. Tyto fólie umožňují přenos světelného signálu z a do jamky optické 
destičky. 

 
Tabulka C-2 Spotřební materiál pro přístroj 7900HT  

 
 

Kat. č. 
 

Popis 
 

Množství 
 

Optické adhezívní kryty ABI PRISM™   

4313663 ABI PRISM™  Optical Adhesive Cover Starter Kit 
Zahrnuje 20 optických adhezívních fólií ABI PRISM, nástroj pro 
uzavření a optickou kompresní podložku ABI PRISM. 

20 fólií 

4311971 Optické adhezívní fólie ABI PRISM™   100 fólií 

4323032 Optická víčka ABI PRISM™  , 8 víček/strip 300 Stripů/ 
bal 

 

2400 víček/ 
bal 

 

384-jamkové optické destičky 

4309849 384-jamkové optické destičky s čárovým kódem ABI PRISM™   
(kód 128) 

50 destiček 

4326270 10 balení, 384-jamkové optické destičky s čárovým kódem ABI 
PRISM™  , (kód 128) 

 

Zahrnuje 10 balení 384-jamkových optických destiček 
s čárovým kódem ABI PRISM™  (Kat. č. 4309849). 

500 destiček 
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Příloha C   Kity, reagencie a spotřební materiál 
 
 

 Tabulka C-2 Spotřební materiál pro přístroj 7900HT 
 

 

Kat. č. 
 

Popis 
 

Množství 
 

96-ti jamkové optické destičky 

4306737 96-ti jamkové optické destičky s čárovým kódem ABI PRISM™   
(kód 128) 

20 destiček 

4326659 25 balení, 96-ti jamkové optické destičky s čárovým kódem ABI 
PRISM™  , (kód 128) 

Zahrnuje 25 balení 96-ti jamkových optických destiček 
s čárovým kódem ABI PRISM™  (Kat. č. 4306737). 

500 destiček 

4314320 96-ti jamkové optické destičky s čárovým kódem ABI PRISM™   
(kód 128) a optické adhezívní fólie ABI PRISM™   

Zahrnuje 100 optických adhezívních fólií ABI PRISM  
(Kat. č. 4311971) a 5 balení 96-ti jamkových optických destiček 
s čárovým kódem ABI PRISM™  (Kat. č. 4306737). 

100 destiček 

100 fólií 

 

Různé 

4312063 Stojánek MicroAmp®  Splash Free Support Base pro 96-ti 
jamkové destičky 

10 stojánků 
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Údržba přístroje a ověřování funkčnosti    
 
 

Údržba přístroje a ověřování funkčnosti 
 

Níže uvedené soupravy a reagencie se používají pro provádění běžné údržby a 
ověřování funkčnosti přístroje ABI PRISM 7900HT. Více informací o používání těchto 
souprav naleznete v kapitole 7 “Údržba přístroje.” 

 
Tabulka C-3 Spotřební materiál pro údržbu a ověřování funkčnosti přístroje 

 
 

Kat. č. 
 

Popis 
 

Množství 

 

Spektrální kalibrační kity 

4328639 Spektrální kalibrační kit, 96-ti jamkové destičky, pro přístroj ABI 
PRISM™  7900HT  

 

Zahrnuje tři optické 96-ti jamkové destičky ABI PRISM: jednu 
destičku pro kalibraci pozadí a dvě destičky pro kalibraci 
barev, obsahující osm různých barevných standardů (FAM™, 
JOE™, NED™, ROX™, SYBR®  Green, TAMRA™, TET™, VIC®). 

3 x 96-ti 
jamkové 
destičky 
 

4323977 Spektrální kalibrační kit, 384-jamkové destičky, pro přístroj ABI 
PRISM™  7900HT 

 

Zahrnuje dvě optické 384-jamkové destičky ABI PRISM: jednu 
destičku pro kalibraci pozadí a jednu destičku pro kalibraci 
barev, obsahující osm různých barevných standardů (FAM™, 
JOE™, NED™, ROX™, SYBR®  Green, TAMRA™, TET™, VIC®). 

2 x 384-
jamkové 
destičky  

 

Ověřovací destičky TaqMan RNáza P  

4310982 Destička TaqMan®  RNáza P pro ověření funkčnosti přístroje 

Zahrnuje jednu 96-ti jamkovou optickou destičku ABI PRISM 

v níž je rozplněna kompletní esej (včetně templátu) pro detekci 
a kvantifikaci genomických kopií lidského genu pro RNázu P. 
 

1 x 96-ti 
jamková 
destička 

4323306 384-jamková destička TaqMan®  RNáza P pro ověření 
funkčnosti přístroje 

 

Zahrnuje jednu 384-jamkovou optickou destičku ABI PRISM 
v níž je rozplněna kompletní esej (včetně templátu) pro detekci 
a kvantifikaci genomických kopií lidského genu pro RNázu P. 

1 x 
384-jamková 
destička 
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Příloha C   Kity, reagencie a spotřební materiál 
 
 

Eseje TaqMan a reagencie 
 

Nejnovější informace o esejích TaqMan pro kvantifikaci genové exprese a 
alelickou diskriminaci naleznete na internetových stránkách společnosti 
Applied Biosystems: 

 

•   www.appliedbiosystems.com 
 
 

Syntéza oligonukleotidů na zakázku 
 

Chcete-li si objednat oligonukleotidy na zakázku: 
 

•   Navštivte on-line obchod společnosti Applied Biosystems  
(http://store.appliedbiosystems.com) nebo 

•   pošlete objednávku emailem na adresu 
OligosUS@appliedbiosystems.com 

 
Tabulka C-4 Oligonukleotidy na zakázku 

 
 

Kat. č. 
 

Popis 

TaqMan®  MGB sondy (5’-fluorescenční značky: 6-FAM, VIC nebo TET) 

4316034 5,000-6,000 pmol 

4316033 15,000-25,000 pmol 

4316032 50,000-100,000 pmol 

TaqMan®  sondy (5’-fluorescenční značky: 6-FAM, VIC nebo TET; 3’-značka: TAMRA) 

450025 5,000-6,000 pmol 

450024 15,000-25,000 pmol 

450023 50,000-100,000 pmol 
 

Primery 

4304970 Minimálně 4,000 pmol 

4304971 Minimálně 40,000 pmol 

4304972 Minimálně 130,000 pmol 
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Principy fungování D 
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Příloha D    Principy fungování 
 
 

Chemizmus 
 
 

Princip 5´ 
nukleázové eseje 

V průběhu PCR dochází díky 5´ nukleázové aktivitě AmpliTaq Gold® DNA 
polymerázy k rozštěpení sondy typu TaqMan®. Sonda TaqMan má na 5´ konci 
navázanou reportérovou barvu a na 3´ konci zhášeč. Dojde-li k rozštěpení sondy, 
dojde i k oddělení reportérové barvy a zhášeče, což vede ke zvýšení fluorescence 
reportéru. Tento mechanizmus slouží k detekci zvyšujícího se množství PCR 
produktu v reakci, neboť nárůst fluorescenčního signálu reportérové barvy je úměrný 
množství degradované sondy a toto množství se s průběhem PCR a akumulací PCR 
produktu stále zvyšuje. Na obrázku D-1 je vyobrazeno schéma PCR amplifikace a 
vytlačování a degradace sondy pomocí 5´–3´ nukleázové aktivity AmpliTaq Gold 
DNA polymerázy. 

 
 

Polymerace 
 

Primer forward  R 
5'  
3' 

R = Reportér 
Z = Zhášeč 

Sonda        Z 
 3' 

5' 

5'  3' 
 5' 

 

Vytlačení řetězce 
 
 

5' 
3' 

 

 
 
Sonda     Z 
 3' 

Reverzní primer 
 
 
 

  5' 

5' 3' 
5' 

Štěpení 
 
 

5' 
3' 

R 
 

Sonda      Z 
  3' 

5' 

5' 3' 
5' 

Polymerace ukončena Z 
R    Sonda 3' 

5' 
3' 5' 

5' 3' 
5' 

 
Obrázek D-1   5´–3´ nukleázová aktivita DNA polymerázy AmpliTaq Gold  

 
 

Dokud nedojde k degradaci sondy, dochází k zhášení fluorescence reportérové barvy 
molekulou zhášeče, neboť ta je v těsné blízkosti reportéru, a to mechanizmem 
Försterova přenosu energie (Förster, 1948; Lakowicz, 1983). Během PCR se sonda 
specificky váže mezi vazebnými místy pro primery. 

 

5´–3´ nukleázová aktivita DNA polymerázy AmpliTaq Gold rozštěpí sondu pouze 
v případě, že se tato váže k cílové nukleové sekvenci. Fragmenty sondy se uvolní od 
nukleové kyseliny, k níž byla sonda navázána, a polymerace pokračuje. 3´ konec 
sondy je blokován, aby nedocházelo k jejímu prodlužování během PCR. Tento proces 
probíhá v každém cyklu PCR a nijak nebrání exponenciální akumulaci produktu 
reakce. 

 

Nárůst fluorescenčního signálu je detekován pouze je-li sonda komplementární 
k cílové sekvenci. Proto nedochází k detekci žádné nespecifické amplifikace. 

 Uživatelská příručka pro Real-Time PCR systém ABI PRISM 7900HT D-2 



  

  

  

  

Chemizmus    
 
 

Chemizmus 
SYBR Green 

Barvivo SYBR® Green 1, které se váže na dvouřetězcovou DNA (dsDNA), lze 
použít pro fluorescenční detekci PCR produktu. Barvivo SYBR Green 1 se váže 
nespecificky na jakoukoliv dsDNA a vytváří obdobný excitační-emisní profil 
jako barva FAM™. Používá-li se v kombinaci s pasivní referencí, lze barvivo 
SYBR Green 1 použít k řadě aplikací včetně kvantitativní PCR a analýzy 
disociační křivky. Na obrázku D-2 je znázorněn princip fungování barviva SYBR 
Green 1 v průběhu jednoho cyklu PCR. 

 
 

3´ 5´ 
5´ 3´ 

Po přidání do reakce se barvivo SYBR Green 1 nespecificky váže 
k dsDNA a fluoreskuje 

 
Disociace 

 

 
3´ 5´ 

 
5´ 3´ 

 

 
Po ukončení denaturace se barvivo SYBR Green 1 uvolní, 
což vede k poklesu fluorescence 

 
Polymerace 

 
Forward 
Primer 

5´ 
3´ 

5´ 

 
 
 

5´ 

3´ 
5´ 

Reverzní 
Primer 

Během polymerace se barvivo SYBR Green 1 váže k PCR produktu 
 

Polymerace ukončena 
 

3´ 5´ 
5´ 3´ 

 

 
3´ 5´ 
5´ 3´ 

Po skončení polymerace se barvivo SYBR Green 1 váže k dsDNA, což 
vede k nárůstu fluorescence 

 

 
Obrázek D-2    Barvivo SYBR Green 1 v průběhu PCR 
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Příloha D    Principy fungování 
 
 

Detekce fluorescence a sběr dat 
 
 

Detekce 
fluorescence 

Během PCR je paprsek argonového laseru postupně směrován na každou jamku 
mikrodestičky. Prochází skrz optickou adhezívní fólii ABI PRISM™ a excituje 
fluorescenční barvy v jamce. Výsledná,z každé jamky emitovaná fluorescence 
(v rozsahu vlnových délek 500 nm až 660 nm) je měřena a čtení údajů z celé destičky 
trvá 7–10 vteřin. 
 

Systém čoček, filtrů a dichroického zrcadla zaměřuje emitovaný fluorescenční signál 
na mřížku. Mřížka rozděluje fluorescenční signál (v závislosti na jeho vlnové délce) 
do obrazce na CCD kameře. Program SDS snímá fluorescenční signály z CCD 
kamery a zpracovává je pomocí matematických algoritmů. 

 
 
 

 
 
         CCD 

 
 

    Čočky  
   kamery 

 

 
Mřížka 

    Emisní filtr 
 
 
 

      Laser      Rozklad  
    paprsku 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 Fresnelova čočka 

 
 

    Čočky (uvnitř destičky 
              s čočkami) 

 
 

Boční pohled 

 
    

384/96-jamková  
optická mikrodestička 

 
 

 Čelní pohled 
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Matematické výpočty       
 
 

Matematické výpočty 
 
 

   Přehled Po skončení běhů typu End-point nebo v reálném čase zpracovává program SDS hrubá 
data pomocí řady matematických transformací. Pojmem ‘hrubá data’ je míněn 
spektrální signál v rozsahu vlnových délek 500 až 660 nm zaznamenaný programem 
SDS pro jednotlivé jamky destičky. Programem SDS prováděné matematické 
transformace hrubých dat jsou popsány níže. 

 
Multikomponentní Multikomponentní analýza je termín označující výpočet příspěvku jedné každé barvy  

     analýza  a pozadí do celkového naměřeného fluorescenčního spektra, které přístroj 7900HT 
zaznamená. V průběhu analýzy hrubých dat pomocí multikomponentního algoritmu 
používá program SDS dílčí algoritmy, aby rozlišil jednotlivá dílčí spektra, která 
přispívají k celkovému naměřenému fluorescenčnímu signálu. 

 

Pomocí kalibračního souboru vytvořeného na základě extrakce signálu pozadí je 
nejprve rozpoznán a eliminován příspěvek pozadí k celkovému naměřenému 
fluorescenčnímu signálu (viz strana 7-16). Současně program rozpočítá celkový 
fluorescenční signál na signály jednotlivých barev, a to pomocí extrahovaných spekter 
čistých barev (viz strana 7-20). Na obrázku D-3 je jedno takové složené spektrum 
znázorněno, a to pro jamku obsahující pasivní referenci a dvě sondy značené 
reportérovými barvami FAM™ a VIC® a nefluorescenčním zhášečem. Z obrázku je 
patrné, jak překryv jednotlivých dílčích signálů přispívá k celkovému zaznamenanému 
signálu.  

 
 
 
 
 
 
 

FAM 

 
 
 
 
VIC 

 

 
 
ROX 

Složené spektrum 
(FAM + VIC + ROX + 
pozadí + MSE) 
 
 
Čisté barvy 

 
 
 
 
 
 
 
 
 
 

500 
 
550 600 650 

Vlnová délka 

Pozadí 
(z běhu pro 
kalibraci pozadí) 

 
Obrázek D-3  Příklad složeného spektra 

 
 

Program používá spektra čistých barev, vytvořená v rámci kalibrace přístroje 
(viz strana 7-20) pro výpočet koeficientů a, b a c v následující rovnici: 

 
Naměřené spektrum =  a( FAM ) + b( VIC) + c( ROX ) + d( pozadí) + MSE 
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kde koeficienty a, b a c představují příspěvek jedné každé barvy do signálu složeného 
spektra. 

 

Poznámka:  Shora uvedený příklad předpokládá provedení kalibrace barev pro 
barvy FAM, VIC a ROX™ a kalibrace pozadí. 

 

Po vypočítání a, b, c a d je vypočítána střední kvadratická chyba (MSE), která je 
měřítkem toho, jak multikomponentní spektrum odpovídá signálu hrubých dat. Na 
obrázku D-4 je znázorněn příklad multikomponentního grafu, znázorňující příspěvek 
každé součásti spektra do celkového signálu (pro jednotlivou jamku). 

 
 
 

12000 

Multikomponentní graf  
komponenta FAM  

 
8000 

 
4000 

 
0 

93 
 

83 
 

73 
 

63 
 

53 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
0:10 0:30 0:50 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
6978 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
1:10 1:30 

 
komponenta VIC  
 

komponenta ROX  
 
pozadí 
 

 
MSE 

Čas 
 

Obrázek D-4   Typické komponenty multiplexní reakce 
 
 

Normalizace 
signálu 

reportérové barvy 

Zatímco multikomponentní analýza vyjadřuje absolutní změny intenzity emitovaného 
signálu, program SDS zobrazuje cyklus po cyklu normalizovaný signál reportérové 
barvy (Rn). Program SDS normalizuje signál každé reportérové barvy tak, že jej 
vydělí fluorescenčním signálem pasivní reference. Jelikož je pasivní reference 
součástí mastermixu, je tato barva v identické koncentraci ve všech jamkách destičky. 
Díky normalizaci vůči signálu pasivní reference může program zohlednit drobné 
fluktuace v intenzitě signálu způsobené nepřesným pipetováním a v konečném 
důsledku provést přesnější porovnání signálu reportérové barvy pro jednotlivé jamky. 
 

Poznámka:  Pro shora uvedený příklad jsou výsledkem normalizované signály barev 
FAM Rn a VIC Rn. 
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Analýza výsledků Real-Time PCR 
 
 

Kinetická analýza/ 
Kvantitativní PCR 

Přístroj 7900HT lze použít ke stanovení absolutního nebo relativního množství cílové 
nukleové kyseliny v testovaném vzorku pomocí analýzy změn intenzity 
fluorescenčního signálu během PCR amplifikace. Tato kvantitativní analýza PCR, 
nazývaná “kinetická analýza”, byla poprvé popsána za použití sekvenčně 
nespecifického fluorescenčního barviva ethidiumbromidu (Higuchi et al., 1992; 
Higuchi et al., 1993). Používání sond TaqMan a dalších reagencií rozšiřuje potenciál 
této metodiky, neboť umožňuje sekvenčně specifickou amplifikaci a kvantifikaci 
různých cílových nukleových kyselin. Čím méně cyklů je zapotřebí pro dosažení 
detekovatelného fluorescenčního signálu, tím vyšší je počáteční počet kopií cílové 
nukleové kyseliny. 

 
Amplifikační graf 

 
8.0 

2.0 
1.0 

 

Fáze 3, plató 
 

Fáze 2, lineární 

 
 Fáze 1, exponenciální 

 
 
 
 
 
 
 
 
 
 

0.0 
0 

 

10 20 30 40 

     Cyklus 

 
Obrázek D-5   Typická amplifikační křivka 

 
 

Znázorníme-li průběh Real-Time PCR jako závislost normalizované fluorescence na 
počtu cyklů, dostaneme graf jako na obrázku D-5. Tato ‘amplifikační’ křivka sestává 
ze tří různých částí: 

 
Fáze 1: Exponenciální (geometrická) 

 

Základem přesnosti kvantifikace pomocí PCR je rozpoznání exponenciální fáze 
reakce. Exponenciální fáze je dána rozsahem cyklů mezi cyklem, v němž je poprvé 
zaznamenán nárůst fluorescence, a cyklu, který odpovídá počátku lineární fáze 
amplifikace, a pro průběh amplifikace v exponenciální fázi je charakteristická 
vysoká a neměnná efektivita reakce. Znázorníme-li průběh Real-Time PCR jako 
závislost logaritmu koncentrace DNA na počtu cyklů, blíží se záznam průběhu 
exponenciální fáze přímce. Za předpokladu optimalizované PCR reakce lze na 
přístroji 7900HT v typickém případě docílit takové citlivosti detekce, aby byly 
zaznamenány alespoň 3 cykly exponenciální fáze. 
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Fáze 2: Lineární 
 

Pro lineární fázi amplifikace je typický pokles sklonu amplifikační křivky. V této fázi 
reakce dochází k poklesu koncentrace jedné nebo více jejích složek pod kritickou 
mez a k poklesu efektivity amplifikace. Této fázi se říká lineární, neboť amplifikace 
je spíše aritmetická než geometrická. Jelikož v průběhu této fáze dochází k poklesu 
efektivity amplifikace, nelze ji použít pro kvantifikaci. 

 
Fáze 3: Plató 

 

Poslední fází amplifikační křivky je fáze plató, v níž se PCR zastaví a hodnota Rn 

zůstává víceméně neměnná. 
 

Stanovení 
počáteční 

koncentrace 
templátu  

V jakémkoliv cyklu v rámci exponenciální fáze PCR je množství produktu úměrné 
výchozímu počtu kopií templátu. Naředíme-li některý templát několikrát, jako např. 
při experimentu s destičkou TaqMan® RNáza P pro ověření funkčnosti přístroje (viz 
příloha C), je pro všechna ředění poměr koncentrace templátu vůči detekovanému 
signálu v rámci exponenciální fáze reakce neměnný (viz obrázek D-6). Tento vztah se 
mění s blížící se fází plató. 
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Obrázek D-6    Amplifikační graf – destička RNáza P pro ověření funkčnosti přístroje 
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Fluorescence a 
akumulace 

produktu 

Při použití sond typu TaqMan na přístroji 7900HT dochází k nárůstu emise 
fluorescence v přímé závislosti na akumulaci specifického amplifikačního produktu. 
Jak je znázorněno na obrázku D-6 na straně D-8, graf závislosti normalizovaného 
signálu reportérové barvy (Rn) na počtu cyklů PCR má tři fáze. Nejprve se hodnota Rn 

nemění, protože fluorescenční signál je nižší, než je detekční limit přístroje. V druhé 
fázi je již signál detekovatelný a roste tak jak dochází k akumulaci produktu PCR. 
S rostoucí akumulací PCR produktu klesá poměr polymerázy AmpliTaq Gold k tomuto 
PCR produktu. Dosáhne-li koncentrace templátu 10-8 M, PCR produkt se přestává 
akumulovat exponenciálně. To je třetí fáze změny Rn, která je přibližně lineární a na 
konec dosáhne plató při koncentraci asi 10-7

 M (Martens and Naes, 1989). 
 

Postupné štěpení sond TaqMan v průběhu PCR umožňuje odvodit korelaci mezi 
počáteční koncentrací templátu a nárůstem fluorescence. Jak ve vzorku roste 
koncentrace amplifikovaného produktu, roste i hodnota parametru Rn. V průběhu 
exponenciální fáze reakce lze vztah množství amplifikovaného PCR produktu 
k počáteční koncentraci templátu vyjádřit následujícím vzorcem: 

 
Nc  =  N ( 1 + E )c 

 
kde Nc je koncentrace amplifikovaného produktu v libovolném cyklu, N je počáteční 
koncentrace templátu, E je efektivita reakce a c je číslo cyklu. 

 
Výpočet 

prahových cyklů 
Přístroj ABI PRISM 7900HT umožňuje kvantifikaci neznámých vzorků na základě 
počtu cyklů, potřebných k dosažení určité úrovně fluorescence. Fluorescence vzorků 
obsahujících vyšší počáteční počet kopií templátu překročí práh po uplynutí nižšího 
počtu cyklů než u vzorků s nižší výchozí koncentrací templátu.  
 

Prahový cyklus (CT) pro danou amplifikační křivku je cyklus, v němž fluorescenční 
signál daného vzorku překročí práh. Hodnota CT představuje detekční práh přístroje 
7900HT a je závislá na dvou faktorech: 
 

•   Výchozím počtu kopií templátu 
•   Efektivitě amplifikace DNA 

 
Jak program SDS stanoví hodnoty CT 
 

Aby mohl stanovit hodnoty CT, použije program SDS nejprve data z fáze tzv. 
‘baseline’ (pozadí – přednastavené pozadí je v rozsahu od 3. do 15. cyklu) a na 
základě hodnot Rn v této fázi vytvoří graf závislosti ∆Rn na počtu cyklů, kde ∆Rn je 
normalizovaná fluorescence po odečtení pozadí . Následně vyhledá v amplifikačním 
grafu bod, v němž hodnota ∆Rn protíná nastavený práh (přednastavený práh je 0.2). 
Cyklus, v němž k tomu dojde, je prahový cyklus (threshold cycle - CT) pro danou 
amplifikační křivku. 
 

Poznámka:  Je možné, že nastavení pozadí (baseline) a prahu bude nutné změnit, 
abyste získali přesné výsledky. Více informací o nastavení pozadí a prahu 
naleznete v části “Nastavení pozadí a prahu” na straně 6-46. 
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Vypovídací 
hodnota 

prahových cyklů 

Ve vzorci, který popisuje exponenciální fázi PCR amplifikace: 
 

 

Xn   = Xm ( 1 + EX ) n – m 

 
znamená: 

 
 
 

Xn = počet cílových molekul v cyklu n (takže n ≥ m) 

Xm = počet cílových molekul v cyklu m (takže m ≤ n) 

EX = efektivita amplifikace (v rozsahu 0–1) 

n - m = počet cyklů, které uplynuly mezi cykly m a n 

 
Amplikony navržené a reakce optimalizované podle doporučení společnosti Applied 
Biosystems (velikost amplikonu <150 bp) mají efektivitu amplifikace blížící se 
100%. Proto platí, že EX=1, takže: 

 
Xn   =  Xm ( 1 + 1 ) n-m 

           =  Xm ( 2 ) n-m 
 

Chcete-li vyjádřit vypovídací hodnotu jednoho cyklu amplifikace, definujete  
n - m = 1 takže: 

 

 

X1   = X0 ( 2 ) 1 

= 2 X0 
 

Každý cyklus PCR tedy odpovídá dvojnásobnému nárůstu množství jejího produktu. 
Obdobně změna prahového cyklu o jedna odpovídá dvojnásobnému rozdílu 
v počáteční koncentraci templátu. 
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X 

Srovnávací CT  metoda relativní kvantifikace    
 
 

Srovnávací CT metoda relativní kvantifikace 
 

 
Aritmetický 

vzorec 
Srovnávací (komparativní) CT metoda je podobná metodě standardní křivky. 
Nicméně pro výpočet relativního množství používá aritmetický vzorec. Množství 
cílové nukleové kyseliny normalizované na endogenní kontrolu a vyjádřené 
relativně ve vztahu ke kalibrátoru je dáno vzorcem: 

 
2–∆∆CT 

 
Odvození vzorce Ve vzorci, který popisuje exponenciální fázi PCR amplifikace: 

Xn   = Xo × ( 1 + EX )n
 

 
znamená: 

 
 

Xn =   počet cílových molekul v cyklu n 
 

Xo =   počáteční počet cílových molekul 
 

EX =   efektivita amplifikace 
 

n =   počet cyklů 
 
 

Prahový cyklus (CT) označuje číslo cyklu, v němž množství amplifikovaného 
produktu dosáhne nastavený práh. 

 

Takže 
 

 

XT   = Xo × ( 1 + EX ) CT,X  =  K 
 

kde: 
 
 

XT =   počet cílových molekul při dosažení prahu 
 

CT,X =   prahový cyklus 
 

KX =   konstanta 
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R 

Pro endogenní kontrolu lze odvodit obdobný vzorec: 
 

 

RT   = Ro × ( 1 + ER ) CT, R =  K 

 
kde: 

 
 

RT =   počet molekul endogenní kontroly při dosažení prahu 
 

Ro =   počáteční počet molekul endogenní kontroly 
 

ER =   efektivita amplifikace endogenní kontroly 
 

CT, R =   prahový cyklus amplifikace endogenní kontroly 
 

KR =   konstanta 
 
 

Vydělíme-li XT a RT, dostaneme následující vztah: 
 
  

 
 
 
Hodnoty XT a RT závisí na řadě faktorů, včetně: 

•   Použité reportérové barvy 
•   Kontextu sekvence, který ovlivňuje fluorescenční vlastnosti sondy 
•   Efektivitě štěpení sondy 
•   Čistotě sondy 
•   Nastavení prahu 

 

Konstanta K tedy nemusí být nutně rovna jedné. 
 

Předpokládáme-li identické efektivity amplifikace cílové nukleové kyseliny a 
endogenní kontroly:  

EX = ER = E, 
 

nebo 

 
 
nebo 
 
 
 
 
 
kde: 

 
 

XN =  Xo/Ro, normalizované množství cílové nukleové kyseliny 
 

∆CT =  CT, X  - CT, R, rozdíl prahových cyklů cílové nukleové kyseliny a endogenní 
kontroly

Srovnávací CT  metoda relativní kvantifikace   
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        Srovnávací CT  metoda relativní kvantifikace 
 
 

Tento vzorec lze napsat následujícím způsobem: 
 

XN   = K × ( 1 + E) –∆CT
 

 
Posledním krokem je vydělit XN pro libovolný vzorek q hodnotou XN pro kalibrátor 
(cb): 
 
 
 
 
 
kde 

 
∆∆CT =  ∆CT,q  – ∆CT,cb 

 
 

Amplikony navržené a reakce optimalizované podle doporučení společnosti 
Applied Biosystems (velikost amplikonu <150 bp) mají efektivitu amplifikace 
blížící se 100%.  Proto je množství cílové nukleové kyseliny normalizované vůči 
endogenní kontrole a vyjádřené relativně vůči kalibrátoru dáno vzorcem: 

 
2–∆∆CT 
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Podmínky záruky E 
 
 
 
 

     Záruka Společnost Applera se prostřednictvím společnosti Applied Biosystems zavazuje, že 
po dobu jeden rok od dokončení instalace nebo patnáct (15) měsíců od data odeslání 
zákazníkovi, podle toho co nastane dříve (dále jen “záruční doba”), bude přístroj ABI 
PRISM®  7900 HT Sequence Detection System (dále jen “přístroj”) bez závad na 
materiálu a provedení a bude fungovat v souladu se svou technickou specifikací, která 
je uvedena na listu, jenž je součástí dodávky, nebo je k dispozici u obchodních 
zástupců společnosti Applied Biosystems. 
 

Dojde-li během záruční doby k poškození přístroje, jeho kontaminaci nebo k jiné 
závadě takového druhu, že přístroj nebude fungovat v souladu se svou technickou 
specifikací, společnost Applied Biosystems na své náklady přístroj opraví nebo 
vymění, aby znovu splňoval uvedené technické specifikace. Dojde-li k poškození nebo 
kontaminaci přístroje nebo ke změně jeho funkčnosti v důsledku používání materiálů 
a/nebo chemikálií jiných než výslovně doporučených společností Applied Biosystems, 
společnost Applied Biosystems tyto závady odstraní na náklady zákazníka. Po 
provedení takového servisního zásahu bude na vyměněné nebo opravené součásti 
přístroje poskytnuta záruka na dobu, která zbývá z původní záruční doby. 
 

Tato záruka se nevztahuje na přístroj nebo jeho součásti, které byly (a) poškozeny 
v důsledku nehody, nesprávného použití nebo zanedbání, (b) pozměněny nebo 
opraveny jinou osobou než společností Applied Biosystems nebo (c) používány 
způsobem, který není v souladu s návodem k použití, jež je součástí dodávky 
přístroje. Tato záruka se nevztahuje na příslušenství nebo spotřební materiál, které 
instaluje sám zákazník, jak je uvedeno v návodu k použití přístroje. Na tyto 
položky se vztahuje jejich vlastní záruka. 
 

Závazky společnosti Applied Biosystems, plynoucí z této záruky, se vztahují pouze 
na opravy závad nebo výměny součástí přístroje, které společnost Applied 
Biosystems považuje za nezbytné provést tak, aby byl přístroj uveden do stavu, jež 
odpovídá jeho technickým specifikacím. Veškeré opravy a výměny vyplývající z této 
záruky  budou provedeny společností Applied Biosystems u zákazníka a na náklady 
společnosti Applied Biosystems. 
 

Žádný zástupce nebo zaměstnanec společnosti Applied Biosystems není oprávněn 
zavázat společnost Applied Biosystems k poskytnutí jakékoliv záruky k přístroji, která 
by nebyla uvedena v tištěných návodech a další literatuře související s přístrojem a 
vydané společností Applied Biosystems, nebo v těchto záručních podmínkách. 
Jakékoliv kroky tohoto druhu, učiněné zástupcem nebo zaměstnancem společnosti 
Applied Biosystems, nejsou pro společnost Applied Biosystems závazné. 
 

Společnost Applied Biosystems nebude zodpovědná za jakékoliv náhodné, zvláštní 
nebo následné ztráty, škody nebo výdaje přímo nebo nepřímo související s pořízením 
nebo používáním přístroje. Společnost Applied Biosystems neposkytuje jakoukoliv 
záruku ve vztahu k výrobkům nebo součástem třetích stran. 
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Příloha E    Podmínky záruky 
 
 

Platnost této záruky se vztahuje pouze na původní umístění přístroje a je nepřenosná. 
 

TATO ZÁRUKA JE JEDINÁ A EXKLUZIVNĚ POSKYTOVANÁ ZÁRUKA NA 
PŘÍSTROJ. SPOLEČNOST APPLIED BIOSYSTEMS VÝSLOVNĚ ODMÍTÁ VEŠKERÉ 
JINÉ ZÁRUKY VE VZTAHU K PŘÍSTROJI, VYJÁDŘENÉ NEBO IMPLICITNÍ, VČETNĚ 
ALE NIKOLIV VÝHRADNĚ ZÁRUK PRODEJNOSTI NEBO VHODNOSTI PRO URČITÝ 
ÚČEL. ZA ŽÁDNÝCH OKOLNOSTÍ NENÍ SPOLEČNOST APPLIED BIOSYSTEMS 
ZODPOVĚDNÁ, AŤ JIŽ NA ZÁKLADĚ SMLOUVY, OBČANSKÉHO PRÁVA, ZÁRUKY 
NEBO JINÉHO USTANOVENÍ NEBO NA JINÉM ZÁKLADĚ, ZA SPECIÁLNÍ, 
VEDLEJŠÍ, NEPŘÍMÉ, TRESTNÍ, MNOHOČETNÉ NEBO NÁSLEDNÉ ŠKODY, 
VZNIKLÉ VE SPOJENÍ S PŘÍSTROJEM, VČETNĚ ALE NIKOLIV VÝHRADNĚ JEHO 
POUŽÍVÁNÍ, NEBO VZNIKLÉ V DŮSLEDKU POUŽÍVÁNÍ TOHOTO DOKUMENTU. 
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Terminologický slovník 
 

 
 
 
 
.sdd Přípona souboru detektoru pro program SDS 2.2. 
 
.sdm Přípona násobného dokumentu destičky (Multiple Plate file - *.sdm) pro program 

SDS 2.2 
 
.sds Přípona dokumentu destičky (*.sds) pro program SDS 2.2. 
 
.sdt Přípona templátu (*.sdt) pro program SDS 2.2. 
 
∆CT Rozdíl prahového cyklu vzorku a prahového cyklu endogenní kontroly: 

∆CT = CT(cílový gen) - CT (endogenní kontrola). 
 
∆∆CT Pro daný cílový gen se jedná o rozdíl průměru ∆CT vzorku a průměru ∆CT 

kalibrátoru: ∆∆CT (vzorek) = Průměr ∆CT (vzorek) – Průměr ∆CT (kalibrátor). Tato 
hodnota se používá pro výpočet relativní změny genové exprese pomocí vzorce: 
Relativní změna genové exprese = 2−∆∆CT. 

 
∆Rn Normalizovaný signál reportérové barvy po odečtení signálu pozadí. Hodnota 

pozadí je stanovena v několika prvních cyklech PCR. Obdobně jako Rn ani ∆Rn 

není neměnná, ale v průběhu PCR se zvyšuje tak, jak se zvyšuje počet kopií 
amplikonu, dokud se reakce nedostane do fáze plató. 

 
5′ nukleázová esej 5′ (pět s čarou) nukleázová esej při současném použití sond typu TaqMan®  je 

základem technologie Real-Time polymerázové řetězové reakce (polymerázové 
řetězové reakce v reálném čase). Více informací viz část “Princip 5´ nukleázové 
eseje” na straně D-2. 

 
absolutní kvantifikace (AQ) 
 Cílem absolutní kvantifikace je přesně stanovit absolutní množství cílové nukleové 

kyseliny v neznámém vzorku. Výsledky absolutní kvantifikace jsou udávány 
v týchž jednotkách, v jakých jsou zadány standardy. 

 
alela Varianta genu v určitém lokusu neboli místě na chromozómu 
 
alelická diskriminace (AD) 
 Proces v němž je stanovena přítomnost dvou variant cílové nukleové kyseliny ve 

vzorcích DNA pomocí reagencií typu TaqMan. Nejčastějšími detekovanými 
variantami jsou jednobodové polymorfizmy - single nucleotide polymorphisms 
(SNPs). 

 

 Uživatelská příručka pro Real-Time PCR systém ABI PRISM 7900HT Terminologický slovník-1 



  

  

 
 
amplikon Část DNA amplifikovaná pomocí PCR 
 
amplifikační graf Amplifikační graf slouží k zobrazení dat z běhů PCR v reálném čase po provedení 

normalizace signálu a multikomponentní analýzy. Amplifikační graf je součástí 
pouze těch dokumentů destičky, které byly analyzovány v reálném čase. Je to 
dvourozměrný graf závislosti normalizované fluorescence reportérové barvy (∆Rn) 
na počtu cyklů PCR. Používá se pro výpočet prahového cyklu (CT). 

 
analytická seance Soubor výsledků analýzy hrubých dat z jediného dokumentu destičky provedené 

v programu SDS 2.2. Analytická séance je uložena v databázi a lze ji zpětně otevřít 
v programu SDS. Z jediného dokumentu destičky lze vytvořit více analytických 
seancí, ale každá musí mít unikátní název. Analytická seance nemusí být nutně 
propojena se studií, ale pokud propojena je, lze ji propojit maximálně s jednou 
studií najednou. 

 
annealing Nasednutí sondy nebo primeru na DNA nebo cDNA v průběhu PCR 
 
Application Program Interface (API) 
 Soubor protokolů a nástrojů pro tvorbu programů. Poskytuje vývojářům všechny 

“stavební kameny” pro propojování jednotlivých součástí systému. 
 
auto increment Nastavení teplotního profilu umožňují zvyšování nebo snižování teploty nebo 

prodlužování či zkracování doby inkubace během cyklů PCR o předem 
definovanou hodnotu. 

 
barvy (pure dyes) Předpokladem fungování multikomponentní analýzy výsledků je provedení 

kalibrace barev. V rámci kalibrace barev program odečte spektrální data standardů 
(jednotlivých barev) (inkubace 2 min při 60 °C). Získaná spektrální data jsou 
uložena do kalibračního souboru v adresáři SDS. Kalibrační soubor je následně 
využíván při multikomponentní analýze. Po skončení běhu program provede 
extrakci signálu každé jednotlivé barvy (komponenty), která přispívá k celkovému 
naměřenému signálu. Jelikož stárnutí a používání přístroje může ovlivnit odečet 
spekter čistých barev, společnost Applied Biosystems doporučuje provést kalibraci 
barev jedenkrát až dvakrát ročně (v závislosti na využití přístroje). 

 
běh/analýza v reálném čase (Real-Time) 
 Označuje způsob analýzy výsledků absolutní a relativní kvantifikace. Přístroj 

7900HT měří fluorescenci vzorků v průběhu každého cyklu PCR.  
 
cDNA (komplementární DNA) 
 Molekula DNA, jejíž nukleotidová sekvence je komplementární k RNA. cDNA je 

vytvořena na základě RNA pomocí enzymu reverzní transkriptázy. RNA je 
převáděna do cDNA, poněvadž cDNA je mnohem stabilnější než RNA, a poněvadž 
pro mnohé aplikace včetně PCR je zapotřebí použít jako templátu DNA. 
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delta CT Viz ∆CT.  
 
delta delta CT Viz ∆∆CT.  
 
delta Rn Viz ∆Rn. 
 
detektor Virtuálně vyjádřená genově nebo alelově specifická kombinace primerů a sondy, 

které jsou používány v dané eseji (při absolutní kvantifikaci, relativní kvantifikaci, 
alelické diskriminaci nebo dalších analýzách, prováděných na přístroji 7900HT).  

 
dílčí (clipped) data V režimu real time je fluorescence celé destičky měřena každých 8,5 vteřiny.Dílčí 

(clipped) data jsou získána na základě výpočtu průměru posledních tří 
vypočítaných hodnot Rn (normalizovaný signál reportérové barvy) získaných 
během fáze polymerace v každém cyklu. Jsou udávána před odečtením signálu 
pozadí (baseline)  - závislost Rn na pořadí cyklu a po odečtení signálu pozadí 
(baseline) – závislost ∆Rn na pořadí cyklu. 

 
dokument destičky (*.sds)  
 Soubor používaný programem SDS 2.2 pro ukládání dat dokumentu destičky na 

disku počítače. Nese informace o použité destičce (spotřebním materiálu) 
obsahující vzorky a reagencie a používané při vlastním běhu. Program používá 
dokument destičky pro ukládání informací o činnosti přístroje (teplotní profil a sběr 
dat), pro ukládání dat zaznamenaných v průběhu PCR, ukládání výsledků běhu a 
nastavení parametrů analýzy a zobrazení výsledků. 

 
endogenní kontrola  Detektor pro gen relativně stabilně exprimovaný ve všech analyzovaných vzorcích. 

Endogenní kontrola se používá pro normalizaci kvantifikace cílové mRNA. 
Účelem je eliminovat nespecifické ovlivnění získaných výsledků v důsledku 
použití nestejného vstupního množství RNA v reakci. 

 
endogenní reference  Viz endogenní kontrola. 

 
end-point eseje (detekované po skončení reakce) 
 Označuje způsob analýzy výsledků alelické diskriminace nebo esejí typu 

plus/mínus. Přístroj 7900HT provede jediné čtení fluorescence po ukončení PCR. 
Výsledkem následné analýzy provedené v programu SDS 2.2 je informace o 
přítomnosti či nepřítomnosti cílové sekvence v neznámých vzorcích. 

 
high throughput (HT) - vysokokapacitní 
 Označuje schopnost analyzovat velké množství vzorků při genotypování nebo 

analýze genové exprese. 
 
hrubá (raw) data Nezpracovaný spektrální signál v rozsahu vlnových délek 500 až 660 nm 

zaznamenaný programem SDS pro jednotlivé jamky destičky.  
 
inkubace (hold) Krok teplotního cyklování PCR, kdy je nastavená teplota udržována delší dobu. 
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jednobodový polymorfizmus  
 (single nucleotide polymorphism – SNP) Jeden pár bází v sekvenci DNA, který 

mají různí jedinci odlišný. 
 
kalibrátor Vzorek, vůči němuž je při relativní kvantifikaci genové exprese vyjadřována její 

změna. 
 
lokus Konkrétní místo na chromozómu, někdy chápané jako poloha nějakého genu, 

obvykle chápané jako poloha nějakého markeru. 
 
marker Kombinace dvou detektorů, z nichž každý je specifický pro jednu alelickou 

variantu. Používá se v dokumentech alelické diskriminace, nikoliv absolutní nebo 
relativní kvantifikace. Dokumenty alelické diskriminace musí obsahovat alespoň 
jeden marker 

 
metoda Protokol, který přístroj ABI PRISM 7900HT používá při provádění PCR. Zahrnuje 

informace o teplotním profilu (doba inkubace a teplota), o rychlosti změny teploty 
(tzv. ramp rates, viz ramp), o možnosti auto-increment (viz příslušné heslo tohoto 
slovníku) a nastavení čtení fluorescence. 

 
minor groove binder (MGB) 
 Protein vážící se do malého žlábku dvoušroubovicové DNA. Je-li navázán na 

oligonukleotid, stabilizuje duplex vytvořený vazbou tohoto oligonukleotidu na 
komplementární DNA, což vede k prudkému nárůstu Tm tohoto oligonukleotidu. 
Fluorogenní sondy, které mají navázán MGB na 3′ konci, bez problémů fungují v 
5′ nukleázové eseji. Díky použití MGB mohou mít tyto sondy kratší sekvenci (13- 
až 20-mery) při zachování optimální Tm. Použití MGB tedy umožňuje konstrukci 
kratších fluorogenních sond s lepší schopností diskriminace. 

 
množství (quantity) (1) množství (koncentrace) standardů v destičce (2) počáteční množství cílové 

nukleové kyseliny vypočítané pro neznámé vzorky v destičce. 
 
multikomponentní analýza  
 Analýza prováděná programem SDS 2.2 k rozlišení příspěvku jednotlivých barev 

do celkového naměřeného signálu (hrubá data). Přesah spekter jednotlivých barev 
přítomných v dané jamce vede ke vzniku složeného spektra a v rámci 
multikomponentní analýzy je definován příspěvek těchto jednotlivých barev. 

 
multiplexní PCR Metoda používající více fluorogenních sond TaqMan®  pro simultánní detekci 

amplifikace dvou nebo více cílových nukleových kyselin ve vzorku DNA. 
 
násobný dokument destičky - Multiple Plate file (*.sdm)  
 Násobný dokument destičky se používá pro analýzu výsledků relativní 

kvantifikace. 
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netemplátová kontrola (NTC) 
 Kontrolní reakce zahrnující všechny komponenty PCR vyjma templátu. Při 

definování úlohy detektoru je jednou z možných úloh i NTC, používaná pro 
všechny detektory negativní kontroly (reakce bez templátu). 

 
normalizovaný signál reportérové barvy (Rn) - Viz Rn. 
 
nukleotid Základní stavební kámen DNA a RNA. Sestává z báze (adenin, tymin/uracil, 

guanin, cytosin), cukerného zbytku a zbytku kyseliny fosforečné. 
 
odlehlý bod Neobvykle se lišící výsledek měření určitého parametru. V programu SDS2.2 

funguje v rámci studií relativní kvantifikace algoritmus automatického odstranění 
odlehlých bodů, který provádí eliminaci těch výsledků měření, u nichž dojde 
k ovlivnění naměřených hodnot CT v důsledku nějakého jiného vlivu, než je 
vstupní množství vzorku. 

 
PCR mastermix Směs všech reagencií pro provedení PCR vyjma templátové DNA a primerů/sond. 

Např. TaqMan Universal PCR mastermix obsahuje AmpliTaq Gold®  DNA 
polymerázu, AmpErase®  UNG, která brání kontaminaci, pasivní referenci pro 
normalizaci signálu všech 5′ nukleázových esejí, dNTPs a reakční pufr. 

 
pozadí (background) Součást fluorescenčního signálu dané eseje, která pochází z přístroje ABI PRISM 

7900HT. Může mít vliv na citlivost detekce a stanovení CT. Proto se signál pozadí 
měří při kalibraci přístroje a je pomocí matematického algoritmu během 
multikomponentní analýzy eliminován. 

 
pozadí (baseline) V terminologii amplifikačního grafu: fluorescence vzorku ve vymezeném rozsahu 

cyklů předtím, než je detekovatelná amplifikace produktu. Pro standardní PCR 
používá program SDS 2.2 při stanovení pozadí eseje (baseline) přednastavený 
rozsah cyklů 3-15. 

práh (threshold) Určitá úroveň normalizovaného signálu reportérové barvy (Rn), používaná pro 
stanovení hodnot CT při provádění PCR v reálném čase. Nastavuje se výše než je 
pozadí (baseline) a dostatečně nízko, aby byl položen ve fázi exponenciální 
amplifikace. Jedná se o čáru, jejíž průnik s amplifikační křivkou definuje hodnotu 
CT. 

 
prahový cyklus Cyklus PCR v němž program SDS poprvé detekuje nárůst fluorescence reportérové 
(threshold cycle - CT) barvy nad úroveň pozadí (baseline). 
 
průměrné množství Statistický průměr množství cílové nukleové kyseliny ve vzorcích v rámci skupiny  
(quantity mean)  replikátů (jamky mající totéž jméno, detektor a úlohu detektoru). Vypočítá se jako 

součet množství cílové nukleové kyseliny v jednotlivých vzorcích dané skupiny 
replikátů vydělený počtem těchto replikátů. 

 
překryv spekter Fluorescenční signál jedné barvy se může překrývat s fluorescenčním signálem jiné 

barvy. Vliv tohoto překryvu je eliminován v rámci multikomponentní analýzy. 

 Uživatelská příručka pro Real-Time PCR systém ABI PRISM 7900HT Terminologický slovník-5 



  

  

 
 
příkazový řádek Některé programy lze spustit pomocí příkazové řádky systému DOS a/nebo ze 

skriptu .bat, většinou bez grafického uživatelského rozhraní. Takové programy 
mohou pomocí příkazové řádky podporovat i zadávání uživatelských hodnot 
vybraných parametrů jako např. názvů souborů, cest k jednotlivým adresářům atp.. 

 
ramp (změna teploty) Interval mezi dvěma nastavenými teplotami, během něhož přístroj ohřívá nebo 

ochlazuje vzorky. 
 
relativní hladina genové exprese 
 Exprese cílového genu vyjádřená ve vztahu k expresi kontrolního genu v témže 

vzorku a vyjádřená relativně k hladině exprese v kalibrátoru. Viz ∆∆CT. 
 
relativní kvantifikace Proces v němž je vyjádřeno množství cílové nukleové kyseliny v jednom vzorku, 

vypočítané relativně vůči kontrolní nukleové kyselině, vůči množství v jiném 
vzorku. Např. množství c-myc v mozkové tkáni je vyjádřeno relativně vůči 
množství c-myc v jaterních buňkách. 

 
reportérová barva Fluorescenční barva navázaná na 5′ konci sondy typu TaqMan®  . Používá se celá 

řada různých barev jako FAM™  a VIC® , kovalentně navázaných na 5′ konec sondy. 
Rn Normalizovaný signál reportérové barvy. Poměr fluorescence reportérové barvy a 

fluorescence pasivní reference v dané jamce. V průběhu PCR hodnota Rn roste tak 
jak dochází k nárůstu počtu kopií amplikonu, dokud reakce nedosáhne fáze plató. 
Při analýzách typu end point je fluorescenční signál měřen pouze jednou po 
skončení PCR. 

 
seance Viz Analytická seance. 

 
singleplexní PCR PCR prováděná s jediným detektorem detekující amplifikaci jediné cílové 

nukleové kyseliny. 
 
SNP Viz jednobodový polymorfizmus. 
 
soubor detektoru  Soubor detektoru je soubor ve formátu *.txt (tabelátorem oddělená data) používaný  
(*.sdd) pro přenos informací o detektoru z a do programu SDS pomocí funkcí Export a 

Import ve správci detektorů. Tento soubor obsahuje: (a) záhlaví 
"SDS2.2[GDF[Global Detector File", (b) tabelátorem oddělené údaje o každém 
z detektorů (název alely, název reportérové barvy, název zhášeče, popis, komentář, 
údaje o osobě, která detektor vytvořila, datum a čas, kdy byl detektor vytvořen, 
datum a čas, kdy byl detektor pozměněn a barvu, kterou je detektor graficky 
zobrazován v programu SDS 2.2). 

 
spektrální bin Část celkového rozsahu spektra měřeného přístrojem 7900HT (přibližně 500-660 

nm). 
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spektrální kalibrace Spektrální kalibrace se provádí na základě výsledků kalibrace barev. Získaná 

spektrální data jsou uložena do kalibračního souboru v adresáři SDS. Po skončení 
běhu program provede extrakci signálu každé jednotlivé barvy (komponenty), která 
přispívá k celkovému naměřenému signálu. Jelikož stárnutí a používání přístroje 
může ovlivnit odečet spekter čistých barev, společnost Applied Biosystems 
doporučuje provést kalibraci barev jedenkrát až dvakrát ročně (v závislosti na 
využití přístroje).  

 
spotřební materiál (1) Plastik pro provedení reakce na přístroji 7900HT (96-ti nebo 384-jamková 

mikrodestička nebo mikrofluidní karta). Používaný spotřební materiál se definuje 
v rozbalovací nabídce Container (Destička) při vytváření dokumentu destičky. (2) 
Soupravy, chemikálie atp. používané v rámci nějaké eseje.  

 
standardní odchylka množství (quantity standard deviation) 
 Statistická standardní odchylka množství cílové nukleové kyseliny ve vzorcích 

v rámci skupiny replikátů (jamky mající totéž jméno, detektor a úlohu detektoru). 
Vypočítá se jako druhá odmocnina součtu druhých mocnin odchylek množství v 
jednotlivých vzorcích od průměrného množství, vydělených n-1 stupni volnosti, 
kde n je počet replikátů. 

 
studie V rámci databáze SDS Enterprise se jedná o soubor analytických seancí alelické 

diskriminace nebo relativní kvantifikace. V rámci programu SDS 2.2 se jedná o 
dokument destičky typu '.sdm', který obsahuje jeden nebo více dokumentů typu 
'.sds' (dokumenty relativní kvantifikace). 

 
templát (*.sdt) Templáty mají totožný formát jako dokumenty *.sds, ale neobsahují hrubá data a 

čárové kódy. 
 
templát (1) Šablona pro vytvoření dokumentu destičky. Pro soubor templátu se používá 

přípona .sdt. Templáty usnadňují vytváření dokumentů destiček a obvykle se 
používají při vytváření většího počtu dokumentů (2) Vzorek DNA amplifikovaný 
v průběhu PCR. 

 
Tm (1) Teplota, při níž je 50% určité DNA v dvouřetězcové formě. (2) Maximální 

hodnota první derivace křivky normalizovaného signálu reportérové barvy (Rn). 
 
typ eseje V rámci programu SDS 2.2 Enterprise: alelická diskriminace, absolutní 

kvantifikace nebo relativní kvantifikace. 
 
ukazatel kvality Odhad pravděpodobnosti, že genotyp stanovený pro daný bod je správný 
(quality value)  (s ohledem na ostatní body v analyzovaném souboru dat). Používá se pouze při 

automatickém odečítání výsledků alelické diskriminace. 
 
úloha detektoru Definovaný parametr detektoru v dané jamce destičky, který určuje, jakým 

způsobem budou použita v dané jamce získaná data. K dispozici jsou různé úlohy 
detektoru podle typu eseje. 
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zhášeč Molekula na 3′ konci sondy typu TaqMan® , která tlumí (zháší) fluorescenci 

reportérové barvy na 5′ konci sondy pomocí mechanizmu FRET. 
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Rejstřík 
 

 
 
 

Symboly 
– 6-31 
↑ 6-33 
↓ 6-33 

 
Číslice 
7900HT, viz přístroj 
9600, režim simulace běhu 3-19 

 
A 
ABI Prism 7700, Real-Time PCR systém, režim simulace 

běhu 3-19 

ABI Prism® nástroj na zaslepení, viz nástroj na zaslepení  

absolutní kvantifikace 
analýza dat 6-9 až 6-13 
o kvantifikaci 6-6 až 6-7 
řešení problémů 8-12 
seznam kroků 6-9 
tipy pro návrh kvantitativní PCR 

 B-5 
volba a příprava standardů B-5 

adapter na destičky, výměna 7-12 

aktualizace 
operačního systému 7-55 
programu SDS 7-55 

alelická diskriminace  
analýza dat 5-10 až 5-18 
o alelické diskriminaci 5-6 až 5-8 
programování běhu 3-18 
řešení problémů 8-13 
seznam kroků 5-10 
tipy pro návrh esejí alelické diskriminace

 B-4 

alelická diskriminace - graf  
export dat  A-16 
export ve formátu jpeg A-16  
genotypická segregace 5-8 
manuální odečítání alel 5-14 
odlehlé body 5-8 
o grafu alelické diskriminace 5-13 
ověření odečtených alel 5-16 
variace klastrů  5-8  

alely - odečítání 
manuální odečítání 5-14 

o odečítání alel 5-15 
ověření 5-16 

amplifikace, reproducibilita 6-19 

amplifikační graf 
export dat A-16 
export ve formátu jpeg A-16 

amplifikační křivka  
exponenciální (geometrická) fáze D-7 
fáze plató D-8 
lineární fáze D-8 
o amplifikační křivce D-7 

analytické seance 5-19 

analýza 
disociační křivky 6-40 až 6-44 
výsledků absolutní kvantifikace 6-9 až 6-13 
výsledků alelické diskriminace 5-10 až 

5-18 
výsledků kalibrace barev 7-25 
výsledků kalibrace pozadí 7-19 
výsledků relativní kvantifikace 6-22 až 

6-35 

architektura 
místní sítě 1-23 
vzdálené sítě 1-24 

archivace souborů 7-54  

automatické odstranění odlehlých bodů 6-19 
 
B 
barvivo SYBR Green 1 ´o barvivu SYBR Green 1 D-3 

běhy typu end-point  
alelická diskriminace, viz alelická diskriminace 
o bězích typu end-point 5-2 

blok na vzorky  
čistění jamek bloku na vzorky 7-15 
kontaminace 8-7 
o bloku na vzorky 1-5 
výměna 7-6 

 
C 
centrifuga 

instalace a provoz 4-12 
mikrofluidní karta, umístění do závěsu 4-15  
nastavení typu závěsu 4-12 
požadavky 4-11 
požadavky na závěsy 4-15 
součásti 4-11 
umístění závěsu do centrifugy 4-16  

centrifugace, mikrofluidní karta 4-15 

CT, viz prahový cyklus 
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Č 
čárové kódy 

zadání do dokumentu destičky 2-26, 3-25 

číslo portu A-22 

čistění 
bloku na vzorky 7-15 
podložek ramene 7-52 

čtečky čárových kódů 
pevně umístěná, viz pevně umístěná čtečka čárových 

kódů 
ruční, viz ruční čtečka čárových kódů 

 
D 
databáze 

ukládání templátů 3-23 
ukládání výsledků 5-19, 6-52  
uložení dokumentů destiček 4-22 

databáze SDS Enterprise  
o databázi 1-22 
databáze SDS 1-26 
program RQ Manager 1-25 
program SNP Manager 1-25 
SDS User Account Manager 1-26 
studie 1-27 
uložení dokumentů destičky   4-22 
uložení templátů 3-23 
uložení výsledků 5-19, 6-52  

defragmentace pevného disku 7-54 

dekontaminace bloku na vzorky 7-14 až 7-15 

destička pro kalibraci barev 
příprava k použití 7-24 
vytvoření 7-27 

destičky 
spuštění jednotlivých destiček 4-23 
spuštění řady destiček 4-37, 4-39 
typy, viz spotřební materiál 

detektory 
import do dokumentu destičky A-2 
kopírování do dokumentu destičky 3-11 
o detektorech 3-9 
přidání do dokumentu destičky 3-11 
úloha, viz úloha detektoru 
vytvoření 3-9 

diagram 
databáze – architektura místní sítě 1-23 
databáze – architektura vzdálené sítě 1-24 

diody, viz přístroj, stavové diody  

disociační křivka 
analýza 6-40 až 6-44 
definice Tm 6-43  
o disociační křivce 6-38 

programování rychlosti změny teploty 3-21 
seznam kroků 6-22, 6-40  

dokumenty destiček 3-8 
definice standardů 3-15  
export 2-13 
import zadání 2-15, A-2 
informace o dokumentu 3-25 
kopírování detektorů 3-11 
kopírování markerů 3-13  
metody, viz metody 
nastavení objemu vzorku 3-20 
nastavení pasivní reference 3-16 
názvy vzorků 3-25  
o dokumentech destiček 2-11 
otevření 2-18 
programování metody 3-17 
přidání do řady destiček 4-33, 4-38 
úloha detektoru 3-14 
uložení 2-16 
uložení do databáze 4-22 
uložení jako jeden soubor 4-22  
uložení jako templát  3-22  
vyjmutí z řady destiček 4-38 
vytvoření 2-12, 3-8 
vytvoření z templátu 3-24, 4-34 
zavření 2-17 

doporučená údržba  7-3  

doporučení 
pro návrh absolutní kvantifikace B-5 
pro návrh alelické diskriminace B-4 
pro návrh relativní kvantifikace B-5 
pro návrh sond TaqMan B-2 až B-3 
pro vkládání destiček do podavače 4-39 

 
E 
endogenní kontrola 6-20 

exponenciální (geometrická) fáze D-7 

export 
dat z dokumentu destičky 2-13, A-16 
grafů a zobrazení ve formátu jpeg A-16 

export dat A-17 

exportovatelná data A-17 

 
F 
fáze plató amplifikační křivky D-8 

fluorescenční kontaminace 8-7 

fluorogenní sonda 
návrh B-2 až B-3 
o fluorogenní sondě D-2 

G 
genomická DNA, minimalizace kontaminace 4-10 
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genotypická segregace klastrů (graf alelické diskriminace)
 5-8 

graf disociační křivky  
o grafu 6-42 
export dat A-16 
export ve formátu jpeg A-16 

graf genové exprese 6-31 

graf standardní křivky 6-13 
export dat A-16 
export ve formátu jpeg A-16 

grafy 
skrytí 2-20  
změna velikosti    2-20, 2-21 
zobrazení 2-20¨ 
zvětšení/zmenšení 2-21 

 
H 
hladina genové exprese  

maximální  6-33  
minimální 6-33 
o hladině genové exprese 6-31 

 
CH 

chemizmus 
neoptimalizovaná reakce 8-6 
řešení problémů 8-5 až 8-8 
SYBR Green D-3 
TaqMan D-2 

 
I 
import zadání 2-15, A-2 

inkubace, přidání do metody 3-19 

instalace 
adaptéru na destičky 7-12 
bloku na vzorky 7-6 
operačního systému 7-55 
programu SDS 7-55 

IP adresa A-22 
 
J 
Java Runtime Environment 1-14 

 
K 
kalibrace barev  

extrakce barev 7-25 
kdy provádět 7-20 
o kalibraci barev 7-20 
provedení 7-24 
řešení problémů 8-11 

vytvoření dokumentu destičky 7-21 

kalibrace pozadí 7-16 až 7-19 
extrakce 7-19 
kdy provádět 7-16 
o kalibraci pozadí 7-16 
příprava destičky 7-17 
příprava destičky pro kalibraci pozadí  7-17 
řešení problémů 8-9 
vytvoření dokumentu destičky 7-17  

kalibrace přístroje 7900HT  
nastavení citlivosti senzoru destiček 7-37 
provedení kalibrace barev (spekter) 7-20 
provedení kalibrace pozadí 7-16 
seřízení pevně umístěné čtečky čárových kódů

 7-49 
seřízení podavače mikrodestiček 7-41 

kalibrátor 6-20 

klávesové zkratky, používání 2-27 

komentář 
přidání do dokumentu destičky 3-25 
přidání k detektoru 3-9 

komparativní CT metoda kvantifikace 
odvození vzorce D-11 
o metodě 6-3, D-11 

koncentrace primerů a sond optimalizace B-3 

kontaminace 
dekontaminace bloku na vzorky 7-14  
fluorescence, běžné zdroje 8-7  
genomická DNA 4-10 
prevence 4-6 
vyhledání v bloku na vzorky 8-9 

kontextové nabídky, používání 2-27 

kontrolní reakce 4-10 

kopírování 
detektorů do dokumentu destičky 3-11 
markerů do dokumentu destičky 3-13 

krok 
přidání do metody 3-19 

kvantifikace 
sond a primerů B-3 
standardů pro absolutní kvantifikaci B-5 

kvantitativní RT-PCR 
absolutní, viz absolutní kvantifikace 
o kvantitativní RT-PCR 6-3 
relativní, viz relativní kvantifikace 
typy 6-3 

 
L 

lineární fáze amplifikační křivky D-8 
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M 
markery 

import do dokumentu destičky A-2 
kopírování do dokumentu destičky 3-13  
o markerech 3-12 
přidání markerů do dokumentu destičky  

3-13  
vytvoření 3-12 

mastermixy  
používání 8-6 
příprava B-3  

maximální hladina genové exprese 6-33 

mazání kroku metody 3-19 

metoda standardní křivky 6-3 

metody 
nastavení objemu vzorku 3-20 
nastavení rychlosti změny teploty 3-21 
odstranění kroku 3-19 
o metodách 3-17 až 3-21 
programování 3-18 až 3-21 
přidání kroku, inkubace nebo cyklu 3-19 
sběr dat 3-20  
změna nastavení času a teploty 3-19  

mikrofluidní karta  
centrifugace  4-15  
doporučení pro plnění 4-13 
jak funguje   4-9  
kontrola jakosti 4-11 
manipulace   4-13  
oddělení po zaslepení 4-20 
plnění 4-13 
plnění rezervoárů, kontrola po centrifugaci

 4-17 
plnění rezervoárů, oddělení po zaslepení

 4-20 
přehled 4-9 
součásti 4-9  
správná laboratorní praxe 4-6 
TaqMan primery a sondy 4-9 
umístění do závěsů 4-15 
umístění závěsu do centrifugy 4-16 
vyjmutí z obalu 4-13 
zaslepení 4-18 

minimální hladina genové exprese  6-33 

množství, zadání do dokumentu destičky 3-15 

multikomponentní analýza D-5 
 
N 
nápověda 

další informace 2-3 
používání 2-3 

nastavení 

běhu 3-19 
citlivosti senzoru destiček 7-37 až 7-40 
možností zobrazení 3-22 
parametrů analýzy absolutní kvantifikace

 6-11 
nastavení zobrazení 3-22  
nástroj pro zaslepení 

instalace 4-13 
přehled 4-13 

Název služby A-22 

názvy vzorků 
import do dokumentu destičky A-2 
zadání do dokumentu destičky 3-25 

nepřesné pipetování 8-6  
nereprodukovatelnost, příčiny 8-5 až 8-8 

nesprávně nastavený práh 8-5  

netemplátová kontrola (NTC) 
odečítání NTC 5-15 
ověření odečtených NTC 5-16 
úloha detektoru 3-14 

nízká koncentrace templátu 8-8 

nízká přesnost 
příčiny nízké přesnosti 8-5 až 8-8 

normalizace 
signálu reportérové barvy D-6 

normalizovaný signál reportérové barvy D-6 

nosítka přístroje 4-42 
otevírání a zavírání (program Automation 

Controller) 4-42 
otevírání a zavírání (program SDS) 4-27 
výměna adaptéru na destičky 7-12 

nové propojení programu SDS 4-28 
 
O 
objem vzorku - nastavení 3-20 

odlehlé body 
alelická diskriminace 5-8 
automatické odstranění odlehlých bodů 6-19 

odpojení programu SDS 4-28  

operační systém  
aktualizace  7-55 
podporovaný 1-7  

optimalizace koncentrace primerů a sond B-3 

otevření 
dokumentů destičky 2-18 
nosítek přístroje (program Automation Controller)

 4-42 
nosítek přístroje (program SDS) 4-27 

ověření fungování přístroje 
karta RNáza P, příprava 7-31 
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ověření odečtených alel 5-16 

ověřovací destičky TaqMan RNáza P 7-30 
analýza 7-33 
kity C-5 
příprava dokumentu destičky 7-32 
spuštění 7-30, 7-31 

ovládání hlavního spínače přístroje 7900HT 2-4 

ovládání programu SDS 2-9  
 
P 
parametr Y (v grafu standardní křivky) 6-13 

pasivní reference  
nastavení 3-16 
použití při multikomponentní analýze D-5 

PCR 
5´ nukleázová esej D-2 
exponenciální (geometrická) fáze D-7 
fáze plató D-8 
chemizmus SYBR Green D-3 
kinetická analýza D-7 
lineární fáze D-8 

pevně umístěná čtečka čárových kódů  
připojení 1-11 
seřízení  7-49 až 7-51  
specifikace 1-8 
umístění 1-8 

pevný disk 
defragmentace 7-54 
rozdělení 1-7 

pipetmany, používání 8-6 

pipetování, chyby 8-6  

počítač 
o počítači 1-7 
rozdělení pevného disku 1-7 
řešení problémů 8-14 
systémové požadavky 1-7 
údržba 7-54 
zapnutí 2-4 

podavač destiček  1-9, 7-36  
čistění podložek ramene 7-52 
pozice úložných věží 7-36 
regulátor nastavení 7-36  
senzor 7-36 
seřízení 7-41 až 7-48 
úchop 7-36 
výměna podložek ramene 7-52 
zapnutí 2-4 

podložky ramene 
čistění 7-52 
výměna 7-52 

podmínky záruky E-1 

Post-read – čtení po skončení běhu (záložka Plate Read)
 4-25 

potřebné vybavení 4-11 

pozadí (baseline) 
automatický výpočet pozadí 6-11 
o pozadí D-9 

práh 
nastavení pro automatickou analýzu 6-11 
nesprávné nastavení 8-5 
o prahu D-9 

prahový cyklus výpočet D-9 
vztah k PCR produktu D-10 

Pre-read – čtení před zahájením běhu (záložka Plate Read)
 4-25 

prevence kontaminace 4-6 

program Archiver 1-26  

program Automation Controller  
odebrání destiček z řady destiček 4-38 
o programu 1-14, 4-37 
přidání destiček do řady destiček 4-38 
sledování průběhu běhů 4-42 
spuštění 4-37 
spuštění řady destiček 4-41 
vložení destiček 4-40 
vysunutí destičky 4-42 
zastavení přístroje 4-42 

program LAVA 
o programu 1-14 
seřízení pevně umístěné čtečky čárových kódů

 7-49 až 7-51 
spuštění 7-49 

program LDHost, viz program LAVA  

programování 
metod (absolutní kvantifikace)   3-19  
metod (alelická diskriminace) 3-18  
metod (analýza disociační křivky) 3-21 
metod (relativní kvantifikace) 3-19 
rychlosti změny teploty 3-21 

program RQ Manager 1-25 

program SDS 
aktualizace 7-55 
dovednosti 2-9 
instalace 7-55  
nové propojení 4-28 
odpojení 4-28  
o programu SDS 1-14 
spuštění  2-6 

program SNP Manager 1-25 

program Zymark Twister o programu 1-14 
seřízení podavače destiček 7-41 až 7-48 
spuštění 7-41 
test citlivosti senzoru 7-39 
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ukončení 7-48 

prohlížeč jamek 2-30 

propojení s databází A-22 

přeskládání destiček 4-40 

přidání cyklu, programování 3-19 

přidání 
čárového kódu do dokumentu destičky 2-26, 3-25 
detektorů do dokumentu destičky 3-11 
dokumentů destiček do řady 4-33, 4-38 
markerů do dokumentu destičky 3-13 
názvů vzorků do dokumentu destičky 3-25 
úlohy detektoru do dokumentu destičky 3-14 
vlastní barvy do sady barev 7-27 

příprava 
destičky 4-6 
mastermixů B-3 

přístroj 1-4 
externí součásti 1-3 
firmware 1-14 
interní součásti 1-4 
o přístroji 1-2 až 1-11 
optický systém 1-6, D-4 
podporované eseje a chemizmy 1-2 
řešení problémů 8-14 
stavové diody 2-5 
údržba 7-3 
vložení destičky 4-23 
zapnutí 2-4 

 
R 
R2 (v grafu standardní křivky) 6-13 

reagencie 
eseje TaqMan a reagencie C-6 
oligonukleotidy na zakázku C-6 
ověřovací destičky TaqMan RNáza P  C-5 
reagencie jiných dodavatelů 8-8 

reagencie TaqMan, popis 4-9 

regulátor nastavení 7-36  

relativní kvantifikace 
analýza výsledků 6-22 až 6-35 
komparativní CT metoda  6-3  
metoda relativní standardní křivky 6-3  
o relativní kvantifikaci 6-3, 6-16 až 6-20 
řešení problémů 8-12 
seznam kroků 6-22 
tipy pro návrh kvantitativní PCR B-5 

replikáty, používání 6-20 

reproducibilita amplifikace 6-19 

režim simulace běhu přístroje 9600 na přístroji 7900 
 3-19 

režimy provozu 1-17  

automatický  1-18  
s databází 1-18 
samostatný přístroj 1-17 

Rn, viz normalizovaný signál reportérové barvy 

RQ Min/Max Confidence 6-28  

ruční čtečka čárových kódů 
používání 2-26 
připojení 1-11  
specifikace  1-8 
umístění 1-8  

 

Ř 

řada destiček 
odebrání dokumentů destiček 4-38 
přidání dokumentů destiček (nástroj Template 

Batch) 4-34 
přidání dokumentů destiček (program Automation 

Controller) 4-38 
přidání dokumentů destiček (program SDS)

 4-33 
spuštění 4-41 
zastavení 4-42 

řešení problémů 8-2 až 8-20 
běhy typu end-point 8-13 
běhy v reálném čase 8-12 
chemizmus 8-5 až 8-8 
kalibrace barev 8-11 
kalibrace pozadí 8-9 
pevně umístěná čtečka čárových kódů 8-17, 8-20 
počítač 8-14 
podavač mikrodestiček Zymark Twister 

 8-17, 8-20 
program SDS 8-14 
přístroj 7900HT 8-14 

 
S 
saturace signálu 7-27  

senzor destičky 7-36 
nastavení citlivosti 7-37 až 7-40 

seřízení 
pevně umístěné čtečky čárových kódů 7-49 až 

7-51 
podavače destiček 7-41 až 7-48 

seznamy kroků 
absolutní kvantifikace   6-9  
alelická diskriminace 5-10  
disociační křivka 6-22, 6-40  
relativní kvantifikace  6-22 

signál reportérové barvy, normalizace D-6 

sonda TaqMan 
návrh B-2 až B-3 
o sondě TaqMan D-2 
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soubory zadání 
o souborech zadání A-4 
export A-17 
formát A-4 
import do dokumentu destičky A-2 
příklady A-4 

součásti 
centrifugy 4-11 
mikrofluidní karty 4-9 

spektrální kalibrace, viz kalibrace barev 

spotřební materiál 
384-jamkové optické reakční destičky C-3 
96-ti jamkové optické reakční destičky C-4 
nesprávný nebo poškozený spotřební plast 8-8 
optická víčka ve stripech C-3 
optické adhezívní kryty C-3 
popis destiček 8-7 

správa dat 1-17  

spuštění 
programu Automation Controller 4-37 
programu SDS 2-6 

spuštění 
běhu v programu SDS 4-23 
jednotlivých destiček 4-23 
řady destiček 4-41 

standardy 
kvantifikace pro absolutní kvantifikaci B-5 
volba pro absolutní kvantifikaci B-5 
volba pro relativní kvantifikace B-5 

stanovení teploty tání 6-44 

studie 1-28 
 

Š  

šedá oddělovací čára, používání 2-20 

šipky v grafu genové exprese  6-31 
 
T 
templáty 

o templátech 2-11 
uložení 3-22 
vytvoření dokumentu destičky 3-24 
vytvoření více dokumentů destiček 4-34 

teplota bloku (záložka Real Time) 4-25 

teplota tání  
definice 6-43 
stanovení     6-44 

teplota víka 4-25 

teplotní blok, viz blok na vzorky 

teplotní protokol, viz metody 

tipy pro návrh esejí 

absolutní kvantifikace B-2 až B-3, B-5 
alelická diskriminace B-2 až B-4 
relativní kvantifikace B-5 

Tm, viz teplota tání 
 
U 
úchop 7-36  

ukazatele standardní chyby 6-31 
osa X 6-31 
osa Y 6-31 

úloha, viz úloha detektoru 

úloha detektoru  
o úloze detektoru 3-14 
import do dokumentu destičky A-2 
nastavení 3-14 

uložení 
dokumentů destiček 2-16, 4-22 
templátů 3-22 

úložné věže 
pozice 7-36 
vložení destiček 4-39, 4-40 

uzavření 
dokumentů destiček 2-17 
nosítek přístroje (program Automation Controller)

 4-42 
nosítek přístroje (program SDS) 4-27 
programu Zymark Twister 7-48 

 
V 
vkládání destiček 

do přístroje 4-23 
do úložných věží 4-40 

vlastní barvy 
přidání do sady barev 7-27 až 7-29 
vytvoření destičky 7-27 

volba jamek v zobrazení destičky 2-23 

vyhřívané víko 1-4 

vyjmutí destičky z přístroje 7900HT 4-27, 4-42 

vyjmutí 
dokumentů destiček z řady destiček 4-38 
kroku metody 3-19 

výměna 
bloku na vzorky 7-6 
podložek ramene 7-52 

vytvoření 
detektorů 3-9 
dokumentů destiček 2-12, 3-8 
dokumentů destiček na základě templátu

 3-24, 4-34 
dokumentů destiček pro kalibraci barvy 7-22 
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dokumentů destiček pro kalibraci pozadí
 7-17 

dokumentů destiček pro kalibraci vlastní barvy 
 7-28 

markerů 3-12 

vzduchové bubliny 8-6  

vzorek 
kalibrátor 6-20 

 
Z 
zadání 
čárových kódů 2-26, 3-25, 4-34 
detektorů v dokumentu destičky 3-11 
komentářů 3-9, 3-25 
markerů v dokumentu destičky 3-13 
názvů vzorků 3-25 
názvů vzorků do dokumentu destičky 3-25 
úlohy detektorů 3-14 

zapnutí systému ABI PRISM 7900HT 2-4 

zaslepení 
doporučení 4-18 
mikrofluidní karty 4-18 
oddělení rezervoárů po plnění 4-20 

zastavení 
běhu v programu SDS 4-26 
řady destiček 4-42 

závora bloku na vzorky 7-8  

změna velikosti panelů a grafů 2-20 

zobrazení, viz zobrazení destičky  

zobrazení 
maximální/minimální 2-21 skrytí 2-20 
změna velikosti    2-20, 2-21 

zobrazení destičky 
o zobrazení destičky 2-28 
volba jamek 2-23 
zobrazení informací o jamce 2-22 
zvětšení zobrazení 2-25 

zobrazení informací o jamce 2-22 

zobrazení tabulky 
export A-16 
o tabulce 2-28 

zpracování velkého počtu vzorků 3-3  

zvětšení/zmenšení grafů a zobrazení 2-21  
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